User's Manual

January 2004

Braunstein + Berndt GmbH / SoundPLAN LLC
# Contents

## 1 Installation and Service

1. Hardware Requirements
2. The Installation
   - New installation of SoundPLAN
   - Upgrading SoundPLAN
3. SoundPLAN Service Modules

## 2 Tutorial

1. Tutorial with the Project "Starter"
   - Part 1 - Road Traffic Noise
   - Part 2 - First steps in the Graphics
   - Part 3 - Industry Noise
   - Part 4 - Industry Noise - Detailed Investigation of the Supermarket
   - Part 5 - Indoor Factory Noise

## 3 SoundPLAN-Manager

1. Data organization
2. Functions of the SoundPLAN Manager
3. Create a new project or select an existing one
   - Create new project
   - Select an existing project
4. Copy, delete, insert and pack projects
   - Copy and paste projects
   - Pack and extract projects
5. Options -> Settings
   - Program Settings
   - Settings for Distributed Computing
   - System Settings
   - Project Settings: Global and Current Project
6. Object Numbering
7. Branching into SoundPLAN modules
8. Hotline Support with e-Mail
## Geo-Database

4  
Working with the Geo-Database 61  
Overview Geo-Database 62  
Structure of the Geo-Database 63  
The data structures in the background 64  
The graphical user interface 65  
The Coordinate Table 66  
Top View, Side Projection and 3D-Wire Model 66  
Rotate 68  
Enter Objects 69  
Elevation data entry 70  
Enter objects with right angles 71  
Object dots (F4) 72  
Measure distances 74  
Generate and edit Situations and Geo-Files 74  
Add an existing/new Geo-File 74  
New Situation / Edit Situationen 76  
Data entry 78  
Digitizing mode 78  
Digitizing from scanned maps (bitmaps) 78  
DXF interface 81  
DXF-Export 84  
Import of SoundPLAN DOS (V4.2) data 84  
ArcView-Interface 85  
ArcView Export 85  
LIMA BNA-interface 86  
ASCII- interface 86  
CARD/1 and Stratis Interface 88  
Use elevations from a Digital Ground Model 88  
Assignment of terrain elevations to Objects 90  
Computing the object height from imported photogrammetry DGMs 90  
Zoom Mode and View port administration 91  
Storing viewports 91  
Editing the data 92  
The edit mode 92  
Properties and coordinates editing dialog 93  
Activate objects 95  
Select (mark) points or objects 95  
Delete points or objects 97  
Insert a point 97  
Move point 97  
Graphics-Object type 98  
Split objects 98  
Invert entry direction 98
Contents

- Change Geo-File-assignment 99
- Convert object type 99
- Coordinate functions 99
- Attribute operations 100
- Search for an object known by it's ID number 102
- Copy object 102
- GeoTools for (marked) selected line objects 102
- Create a buffer 105
- Create intersections and split 105
- Intersections with the terrain 106
- Generate a parallel object 106
- Connect lines and generate areas 106
- Coordinate Transformation 108
- Calculating object height from a DGM 109
- Assign texts to buildings 109
- Reassign receivers to buildings 109
- Prepare buildings 110
- Regenerate new object numbers 111
- Photo Documentation 111

5 Objects 113

Overview 113
- Symbol Bar of SoundPLAN Objects 113
- Entry of a new object 114
- Entry of Elevations 114
- The Coordinate System 116
- Moving Through a List of Coordinates 116

Road Alignments 117
- Road Properties 117
- Cross Sections / Road Profiles 118
- Road bridges 119
- Emission Level Calculation 120

Signal - Intersection Addition 124

Parking Lots 125
- Calculation of the Emission Level of Parking Lots 126

Railways 128
- Railway Properties 129
- Documentation of the emission levels of railways 130
- Railway bridges 130

Industrial Noise Sources 133
- Source Properties 133

Industrial Building 138
- Properties Industrial Building 139
- Indoor Noise 141
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Buildings</td>
<td>143</td>
</tr>
<tr>
<td>Building Properties</td>
<td>143</td>
</tr>
<tr>
<td>Additional Information for Buildings</td>
<td>146</td>
</tr>
<tr>
<td>Spot Heights (Terrain elevation point)</td>
<td>147</td>
</tr>
<tr>
<td>Elevation Lines and Profile Lines</td>
<td>148</td>
</tr>
<tr>
<td>Supply of Elevation Information</td>
<td>148</td>
</tr>
<tr>
<td>Break Lines (Terrain edges)</td>
<td>150</td>
</tr>
<tr>
<td>Walls</td>
<td>150</td>
</tr>
<tr>
<td>Wall Properties</td>
<td>150</td>
</tr>
<tr>
<td>Berms</td>
<td>152</td>
</tr>
<tr>
<td>Berm Properties</td>
<td>153</td>
</tr>
<tr>
<td>Volume Type Absorption (Mitigation Areas) (Forests etc.)</td>
<td>154</td>
</tr>
<tr>
<td>Volume Type Absorption Properties</td>
<td>155</td>
</tr>
<tr>
<td>Ground Areas (Ground Effect)</td>
<td>156</td>
</tr>
<tr>
<td>Floating Screens</td>
<td>156</td>
</tr>
<tr>
<td>Single Point Receivers</td>
<td>157</td>
</tr>
<tr>
<td>Receiver Properties</td>
<td>158</td>
</tr>
<tr>
<td>Cross section</td>
<td>160</td>
</tr>
<tr>
<td>Calculation Area</td>
<td>161</td>
</tr>
<tr>
<td>Geometry Texts</td>
<td>161</td>
</tr>
<tr>
<td>Text Properties</td>
<td>162</td>
</tr>
<tr>
<td>6 Libraries</td>
<td>163</td>
</tr>
<tr>
<td>Overview</td>
<td>163</td>
</tr>
<tr>
<td>Available Libraries and their File Names</td>
<td>163</td>
</tr>
<tr>
<td>Installation Instructions</td>
<td>163</td>
</tr>
<tr>
<td>Importing Libraries</td>
<td>164</td>
</tr>
<tr>
<td>Libraries from SoundPLAN DOS</td>
<td>166</td>
</tr>
<tr>
<td>Working with the Libraries</td>
<td>166</td>
</tr>
<tr>
<td>Emission, Absorption, Transmission and Attenuation</td>
<td>170</td>
</tr>
<tr>
<td>Directivity Library</td>
<td>171</td>
</tr>
<tr>
<td>Day Histogram Library</td>
<td>174</td>
</tr>
<tr>
<td>Assessment Library</td>
<td>175</td>
</tr>
<tr>
<td>The Road Day Histogram Library</td>
<td>177</td>
</tr>
<tr>
<td>Definition and Assignment of the Emission</td>
<td>178</td>
</tr>
<tr>
<td>Print libraries</td>
<td>180</td>
</tr>
<tr>
<td>7 Calculations</td>
<td>181</td>
</tr>
<tr>
<td>Run file and calculations</td>
<td>181</td>
</tr>
<tr>
<td>Generate calculation runs and edit the properties</td>
<td>182</td>
</tr>
<tr>
<td>Calculation run properties</td>
<td>182</td>
</tr>
</tbody>
</table>
Contents

Selection and Assignment of Situations and Geo-Files 186
File number of the results 187
Logbook, Error messages and default settings 188
Default Standards and Run Commands 190
Start or terminate a calculation run 190
Distributed Computing 191
Graphical presentation of geometry in calculations 192
Calculation settings for noise calculations 195
Calculation Types 196
Using a DGM for the calculation 196
Single point receivers sound (SPS) 196
Grid Noise Map Calculations 198
Cross-sectional Noise Map 202
Facade Noise Map Calculations 203
Calculation of the City Noise Map 206

8 Result Tables (Documentation) 209
Overview 209
Procedures 210
Combination Tables (Master/Detail) 210

Column Setup 211
Table Settings 214

Page Layout 216
Page Format 216
Page Layout 217
Headers and Footers 218

The Preview 219
Print Result table 219
Export of the Result table 220

Store and Load a Result table (QRP) 220
New features in the Result Tables in SoundPLAN 6 220

9 Spreadsheet 221
Overview 221
Getting started with the Spreadsheet 222
Components of the Spreadsheets 223
Insert results and additional information 224
Add reference road or railway 225
Add building information columns 226
Filter for new tables in the Spreadsheet 226

Table Setup 228
The Formula Editor 229
Highlighting Cells Using Formulas 233
Update results 235

SoundPLAN Handbook
Design Spreadsheet tables 235
  Column layout 235
  Section Layout 239
Structured Tables 240
Table statistics 242
Page Layout 242

10 Wall Design 243
  Overview 243
  Wall Design's Internal Organization 244
  Wall Design Performance 247
  Using Wall Design 248
  Model restrictions of Wall Design 256

11 Graphics 259
  Overview 259
  General Editing Functions 261
    Color Pallet 262
    Base Settings 263
    Options 265
  Object Types File 265
    Result Object Types 267
    Cartography - Creating user defined object types 272
    Settings in the object types 273
  Zoom Plan 274
  Working with Elements 274
    Create Elements 276
    Enlarge, Shrink and Move Elements 276
    Element Properties 277
  The Sheet 280
    Sheet Properties 280
  The Plan 282
    File Selection Manager 282
    File Operations 286
    Plan Properties 290
    Process Plan Content 292
  The Colored Scale 294
    Edit the colored scale 295
  The Legend 299
    Editing the Legend 299
  Text Boxes 300
    Editing Text Boxes 300
Contents

• vii

Editing the North Arrow 301
The Scale Bar 301
Printing 302

Further Graphics Features with Cartography 303
Contour line texts 303
Level tables 304
Geometry bitmaps 305
Display text attributes 306
Spreadsheet in Graphics 307

Short description of the 3D-Graphics 308
What is displayed in the 3D-Graphics? 308
How and where to work with the 3D Graphics 310
View settings 311
View from Receiver locations (only 3D-Animation) 311
Additional Options for 3D-Animation 311
The Animation 312

Measurement data 313
Import of measurement data 313
Display 314
File operations 314

12 **Expert System for Industrial Noise** 315

Getting Started with the Industry Expert System 315
Concept of the Industry Expert System 318
Detail window 319
Preparation of a noise control concept 324
Assign noise mitigations 325
The Optimization 326
Print and reuse the noise control concept 329

13 **Aircraft Noise** 331

General 331
Procedures 331
Aircraft Noise - Data Entry 332
Airport 332
Runways for Start- and Landing 333
Approach- and Departure Flight Paths 334
Aircraft Classes Library 336
Aircraft Traffic Data 338
Aircraft Noise in the Geo-Database 343
Aircraft Noise in the Calculation 343
The Aircraft Noise Result Documentation 344
Graphical Printouts of Aircraft Noise Calculations 345
New features for Aircraft Noise in SoundPLAN 6 345
14 Air Pollution MISKAM

Introduction 347
The MISKAM – calculation core 347
MISKAM Background Material 348
Motivation 348
Physics of the Model 350
Wind Tunnel Simulations 351
Measurements of Traffic Induced Immissions 352
Model Results 353
Model Numerics 354
MISKAM and MISKAM-SCREENING under SoundPLAN 354
Assessment of the Emission 354
Wind roses, weather statistics, processing results 354
Theory and Praxis 355
The calculation model: What MISKAM can do 355
What MISKAM cannot do... 357
MISKAM project flow under SoundPLAN 359
Object Types for MISKAM in the Geo-Database 359
MISKAM in the Calculation Core 363
MISKAM in the Graphics 368

15 Technical Acoustics in SoundPLAN

Overview 369
Types of Receivers 369
Physical Descriptors of Noise 370
From Levels to Rating Noise 370
Modeling the Real World 371
Physics Versus Standards 371
Calculating Principles 371
Screening 376
Ground Effect, Komega, Directivity 380
Reflection 382
Volume Type Absorption 383
The Search Angle Method 385

16 Principles and Standards

Overview 389
Road Noise 389
Philosophy of Modeling 389
RLS 90 / DIN 18005 391
The Source Level LME 391
The Propagation 392
Deviations from RLS-90 396
A calculation in strict accordance to RLS-90 396
Calculation of Road Traffic Noise (CoRTN) 396
The Reference and Basic Noise Levels 396
The Propagation 397
<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concepts of Screening, Ground Attenuation and Reflection</td>
<td>399</td>
</tr>
<tr>
<td>Deviations from CoRTN</td>
<td>401</td>
</tr>
<tr>
<td>Statens Planverk 48</td>
<td>401</td>
</tr>
<tr>
<td>The Equations of Statens Planverk 48</td>
<td>401</td>
</tr>
<tr>
<td>Ground Effect and Screening</td>
<td>403</td>
</tr>
<tr>
<td>Deviations from Statens Planverk 48</td>
<td>405</td>
</tr>
<tr>
<td>Federal Highway Model (FHWA)</td>
<td>405</td>
</tr>
<tr>
<td>The Equations of FHWA</td>
<td>405</td>
</tr>
<tr>
<td>Traps and Solutions</td>
<td>408</td>
</tr>
<tr>
<td>Deviations from FHWA</td>
<td>408</td>
</tr>
<tr>
<td>Railway Noise</td>
<td>409</td>
</tr>
<tr>
<td>Principles of Emission</td>
<td>409</td>
</tr>
<tr>
<td>Schall 03 / DIN 18005 / Transrapid</td>
<td>410</td>
</tr>
<tr>
<td>The Emission Noise Level Schall 03</td>
<td>410</td>
</tr>
<tr>
<td>The Propagation from a Railway line according to Schall 03</td>
<td>412</td>
</tr>
<tr>
<td>Traps and Solutions</td>
<td>414</td>
</tr>
<tr>
<td>ÖAL 30</td>
<td>414</td>
</tr>
<tr>
<td>The Equations of the Standard</td>
<td>414</td>
</tr>
<tr>
<td>Deviations from the Standard</td>
<td>415</td>
</tr>
<tr>
<td>Calculation of Railway Traffic Noise (CoRN)</td>
<td>416</td>
</tr>
<tr>
<td>The Reference Noise Level CoRN</td>
<td>416</td>
</tr>
<tr>
<td>The Propagation of CoRN</td>
<td>417</td>
</tr>
<tr>
<td>Traps and Solutions</td>
<td>418</td>
</tr>
<tr>
<td>Deviations from the English Railway Traffic Calculation</td>
<td>418</td>
</tr>
<tr>
<td>Nordic Rail Prediction Method</td>
<td>419</td>
</tr>
<tr>
<td>The Reference Noise Level - Nordic Rail Prediction</td>
<td>419</td>
</tr>
<tr>
<td>The Propagation - Nordic Rail Prediction Method</td>
<td>420</td>
</tr>
<tr>
<td>Deviations from Nordic Rail Prediction Method</td>
<td>422</td>
</tr>
<tr>
<td>Industry Noise</td>
<td>422</td>
</tr>
<tr>
<td>Acoustical Schools ( ISO / Nordic / CONCAWE)</td>
<td>422</td>
</tr>
<tr>
<td>Spreading / K\text{e}\text{m}\text{ag} / Ground Effect</td>
<td>423</td>
</tr>
<tr>
<td>From Area and Line to Point Sources</td>
<td>423</td>
</tr>
<tr>
<td>Cross References between Sources and Buildings</td>
<td>426</td>
</tr>
<tr>
<td>VDI 2714, VDI 2720 or ISO 9613</td>
<td>428</td>
</tr>
<tr>
<td>The Equations of VDI 2714/2720, ISO 9613</td>
<td>428</td>
</tr>
<tr>
<td>General Prediction Method</td>
<td>431</td>
</tr>
<tr>
<td>Concepts and Equations (Gen. Pred. Method, ÖAL 28)</td>
<td>431</td>
</tr>
<tr>
<td>Deviations from General Prediction Method, ÖAL28</td>
<td>435</td>
</tr>
<tr>
<td>CONCAWE</td>
<td>436</td>
</tr>
<tr>
<td>The Equations of the Standard (CONCAWE)</td>
<td>436</td>
</tr>
<tr>
<td>Traps and Solutions</td>
<td>438</td>
</tr>
<tr>
<td>Calculations Inside Buildings</td>
<td>439</td>
</tr>
<tr>
<td>VDI 3760E</td>
<td>439</td>
</tr>
<tr>
<td>The Indoor Factory Noise Module Calculation Method</td>
<td>443</td>
</tr>
<tr>
<td>Special Noise Calculation Cases</td>
<td>445</td>
</tr>
<tr>
<td>Buildings as Sources</td>
<td>445</td>
</tr>
<tr>
<td>Tunnel</td>
<td>446</td>
</tr>
<tr>
<td>Bridges</td>
<td>447</td>
</tr>
<tr>
<td>Gallery</td>
<td>448</td>
</tr>
<tr>
<td>Contents</td>
<td>Page</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Implementation of the EU Directive on Environmental Noise</td>
<td>451</td>
</tr>
<tr>
<td>The Interim Calculation methods</td>
<td>451</td>
</tr>
<tr>
<td>Definition of Time Ranges and Standards</td>
<td>452</td>
</tr>
<tr>
<td>Annoyance Analysis</td>
<td>452</td>
</tr>
<tr>
<td>Supplementary Necessary Information</td>
<td>453</td>
</tr>
<tr>
<td>Working on an Annoyance Analysis in SoundPLAN</td>
<td>453</td>
</tr>
</tbody>
</table>

**Index** 457
1 Installation and Service

Hardware Requirements

The hardware listings below are not a minimum configuration, but a configuration enabling professional work. SoundPLAN can be run on a Pentium 200 but the processing speed would be dissatisfying.

Towards the high end there are no limits except economics and availability.

PC Pentium 1 GigaHertz or higher

Operating system Windows 98, Windows NT 4.0, Windows 2000 or WindowsXP

Graphics card with a resolution of minimum 1024 x 768, 256 colors, 16 or 32 MB memory, for 3D-Graphics you need a graphics card with OpenGL drivers and at least 32 MB memory

RAM memory >= 256 MB

Hard disk 20 GigaByte

17" Monitor

WinTab compatible Digitizer (WinTab drivers are available for nearly all current digitizers)

All windows compatible printers and plotters can be used.

The Installation

The first installation of SoundPLAN is done with a CD and a floppy disk containing the license information, user name and address.

The CD has an autorun function, automatically opening the CD browser. Within the browser, you can install the software and demo or test projects, read the manual on screen or print it and view other information on SoundPLAN. If the autorun function is disabled on your PC, please call "start.bat" or "browser.exe" (depending on the CD) from the Windows Explorer.
New installation of SoundPLAN

Before installing a new version, please de-install older version of SoundPLAN 6, SoundPLAN 4.2 DOS and SoundPLAN 5.x are not affected. (De-install via Start -> settings -> control panel -> software). Otherwise sharing jointly used data could pose a problem. Demo version must also be de-installed.

For the installation of SoundPLAN, please login as administrator. (Absolutely necessary if you install SoundPLAN under Windows NT, 2000 and XP!)

- Insert the CD and place the installation disk in the floppy drive. Autorun opens the CD Browser.
- Attach the SoundPLAN hardlock to the parallel or USB port before you start the installation.
- Call the installation in the browser.
- The installation program will prepare the installation and guides you through it. The installation program suggests

  C:\Program files\SoundPLAN 6\

  as the path for the program files. For any other location, enter the new path. Click the button "continue". SoundPLAN copies the files from the CD to your hard disk. The installation program will request the license disk. Make sure that the disk is in the floppy drive and click "OK". SoundPLAN generates a list of activated program modules.

Important: If the installation program requests to reboot your computer after the installation, please make sure that the CD is still in the CD drive and login as the same user as for the installation.

SoundPLAN is now successfully installed on your PC. Run SoundPLAN from the Start menu under the label SoundPLAN in the program group of SoundPLAN.

Hint: Please ensure that the hardlock (dongle) is attached to the parallel or USB port. The hardlock drivers do not recognize hardlocks on the serial port automatically. If for any reason you cannot use the parallel port for the hardlock, please contact Braunstein + Berndt for help.

Upgrading SoundPLAN

After you have installed the latest CD version, updates of SoundPLAN are available for download from the Internet. Via HELP -> UPDATES & DOWNLOADS you get access to the latest update. If you already have the latest revision working on your PC a message will indicate that there is no further update available at this point of time.

A program update is an EXE file. Download the file to your computer, close SoundPLAN, open the EXE file with a double click in the Windows Explorer, select the language and the update is executed.
A license update updates the license information of your version, e.g. if you purchase additional modules. Copy the license file (BABGxxxx.005) to your PC and execute HELP -> UPDATE LICENSE in the SoundPLAN Manager.

SoundPLAN Service Modules

The SoundPLAN Handbook is available in printed form and as an electronic Acrobat Reader pdf document. The Acrobat Reader is enclosed in the CD and can be installed from \CD_50\acrobat.

The SoundPLAN On-Line Help in the program provides information to current problems and is updated with every SoundPLAN version.

The SoundPLAN Hotline is available from your local distributor or SoundPLAN LLC (mailto:support@soundplan.com).

Find information on your local distributor in the SoundPLAN Manager via HELP -> INFO.
2 Tutorial

Tutorial with the Project "Starter"

This is a simple example for SoundPLAN Windows beginners to get an overview on how to work with SoundPLAN. Moreover, advanced SoundPLAN users may learn about the handling of a new SoundPLAN module. During the installation of the demo projects, the project Starter is installed in the sub-folder Demos. If "Starter" is not installed on your PC, call \textbf{INSTALL DEMO PROJECTS} from the SoundPLAN CD-Browser and activate the "Starter" project.

The project only includes a bitmap as data background, it is your job to work it out. Because of the modular structure of SoundPLAN, it is possible that this project deals with modules not covered by your license. In this case, please skip this part of the description and go on with the next part.

Part 1 - Road Traffic Noise

Two terraced houses, each with three flats (an old part and a newer part) are affected by noise from a road and a business district. For these two houses first the noise levels must be calculated (separately for road noise and industrial noise) and then a noise protection wall has to be optimized, so that the limits for traffic noise are kept in the first floor. The results are shown either in tables or in grid noise maps.

Open SoundPLAN with \textbf{START -> PROGRAM FILES -> SOUNDPLAN 6}.

\textbf{General Project Settings}

Select the project "Starter" via \textbf{PROJECT -> NEW / SELECT select project} -> click on the project in the tree view and click \textbf{SELECT}.

The preset calculation guidelines are displayed on the screen. If you want to change the settings or check the enhanced settings, click on the \textbf{STANDARDS}. Click on the symbol with the two small dots to open the enhanced settings of the standard.
As this example has been defined for the handling of SoundPLAN and for all SoundPLAN users all over the world, the calculation standard and the assessment cannot be customized for every country. Therefore we use the German RLS-90 for the calculation of road traffic noise and the ISO 9613-2 for parking lot noise and industrial noise. For the assessment, we selected the DIN 18005 Traffic.

Creation and calculation of the ground model

As the first step, the elevation lines have to be digitized to calculate a digital ground model (DGM). All subsequent elevation information for the objects comes from the DGM.

Open the GEO-DATABASE. With a new project the graphical user interface of the Geo-Database is opened directly.

Load the prepared bitmap:

FUNDAMENTALS -> BITMAP -> LOAD. Select the bitmap "site map". Bitmaps have to be assigned to real world coordinates by entering the actual coordinates at reference points:

The bitmap in this project already shows for reference points, choose at least two but preferably three of them as reference points.

1300/550 bottom left
1550/550 bottom right
1550/850 top right
1300/850 top left

Enter the given coordinates of one reference point into the white cells in the first row and place the cursor roughly on the corresponding reference point in the bitmap. Click once, then a zoom window for exact positioning is opened. Click again at the intersection of the axes - the first point has now been assigned.
Enter the coordinates of the second reference point into the second row of the table and click on the corresponding reference point in the bitmap, and so on. After you have assigned the third reference point, the standard deviation is shown on the top of the bitmap assignment window. In this project, it should be much less than 10. If it is too high, please check the reference points. Click OK.

Next, all the elevation lines in the plan will be digitized. Select OPTIONS -> HEIGHT DIALOG ONLY AT 1. POINT, click on the read digitizing cross in the tool bar and select the object type "elevation line" in the index card "Environment":

Start digitizing for example in the upper left corner with the elevation line 231 m: Click roughly on the first point and then the exact position with another left click in the zoom window and enter 231 in the elevation dialog. Digitize one coordinate after the other in the same way. After you have entered the last coordinate of the elevation line finish the entry of this object with F2 or the symbol button NEW.

Digitize all elevation lines in the project in the same way and check the model via VIEW -> FRONT ELEVATION or F8.

If a coordinate is not entered at the correct position, select the elevation line with the right mouse button -> select object (or pull a frame with the right mouse button around at least one point of the elevation line) and move the coordinate with the left mouse button to the correct position. Should you have entered the wrong elevation for an elevation line, you can correct this selecting the elevation line, call Edit -> Coordinate operation and set h1 to the correct elevation.

Save the situation via FILE -> SAVE SITUATION. As this is the first situation in the project, overwrite "new situation" with "basics" and "new geofile" with "elevation".

Call the CALCULATION CORE (activate the SoundPLAN Manager in the Windows task bar and click on the icon Calculation).

Fill in the properties of the calculation run:
Enter the RUN NAME "Calculate DGM" and select the CALCULATION TYPE "Digital Ground Model" from the selection list in "Geometry". Select the GEOMETRY DATA with the double arrow. Currently, only one situation is available. Double click on the situation "basics" or push it with drag & drop to the right hand side to use it in the calculation. In every calculation, SoundPLAN needs a number for the result files. We choose NUMBER 9999 in order to make it easier to sort the true calculations.

Click OK and start the calculation with \( \text{\text{Run Properties}} \). The triangulation only takes a few seconds.

Save the calculation table under the name "all calculations" and switch to the Geo-Database via the Windows task bar.

**Entry and calculation of road traffic noise**

The first step is the calculation of the road traffic noise. Save the open situation "basics" via File -> save as under a new name. The name of the situation is: "road name without noise protection" and click OK.

Create a new Geofile for the geometry of the residential area: Click on the icon \( \text{\text{NEW GEOFILE}} \) and then the icon \( \text{\text{Load Geofile}} \). Overwrite the name "new geofile" with "residential area".

Additionally load the DGM: FUNDAMENTALS -> DGM -> LOAD. Double click on the file "RDGM9999.dgm". You can view the triangles and the elevation of the cursor position via the menu VIEW.

Now digitize the first building (2, Jefferson road).

Select the Geofile "residential area" from the Geofile selection list.

Click on the building symbol building in the index card "environment". *(If you want to see the icons for all objects, switch to options object selection: all objects.)*

Click on the read digitizing cross.
Entry modes:  

The entry modes: There is the following difference between the black cross and the red cross: The first time the black cross digitizes the coordinates. Afterwards, the left mouse button is used to open the properties of the appropriate object, the right mouse button hosts edit functions. If points are close together, it might be impossible to set new coordinates, as the program automatically enters the properties of an existing point. In this case the red cursor helps. Here the left mouse button is only used to enter new coordinates, the right mouse button captures a coordinate, to connect a new object to an existing object.

Put the cursor on the first building coordinate (upper left corner) and click on the left mouse button. The vicinity of the cursor position is enlarged in the zoom window.

Now click on the exact position. The elevations in the elevation dialog are filled in from the values in the DGM, correct the terrain elevation to 232.5 m and click OK.

Enter the BUILDING PROPERTIES in the property dialog box:

ROAD NAME: Jefferson Street, NO.2, double click on the field NAME to overtake the settings.

REFLECTION LOSS: 1 (non absorbent)

HEIGHT OF BUILDING: 6 m

RELATIVE HEIGHT OF GROUND FLOOR: 2.4 m

HEIGHT OF FLOORS: 2.8 m

NUMBER OF FLOORS: 2

DECISIVE FLOOR: 1

AREA USAGE: WA (residential area)

The building has two floors, as the noise protection wall shall be dimensioned for the ground floor, the ground floor is determined the decisive floor.

Leave the dialogue with OK and enter the other coordinates of the building.

New object

After you have entered the last coordinate (upper right corner) finish the entry of this object.

The building is closed and hatched in light blue.

The facade at the Whitefield Drive should be divided at the property borders of the terrace houses (especially for the calculation of a Facade Noise Map), the back of the building need not be divided.

Select the magnifying glass on the tool bar and enlarge the view, clicking several times with the left mouse button on the viewport.
Select the black cross and activate the object dots with F4 or VIEW -> EXTENDED OBJECT VIEW. Click on the first point of the building with the right mouse button and select INSERT AFTER from the popup menu.

The inserted coordinate is placed in the middle of the two edge points and marked with a small black square.

Drag the marked point (with the left mouse button pressed) to the first property border. Insert another point after the point just inserted and move it to the second property border.

Normally, the input accuracy is not that exact, so that the building won't be right angled. This can be corrected with a GeoTool if necessary. Select the black cross from the tool bar, place the cursor near the upper left corner of the building, keep the right mouse button pressed and pull a frame. At least one coordinate of the building must be within the frame. You can also click on one coordinate of the building with the right mouse button and select SELECT OBJECT from the popup menu.

Select GEOTOOL -> POLYLINE -> CALCULATE RIGHT ANGLED.

Deactivate the marks by dragging the mouse with the right mouse button pressed from bottom to top. Or click the right mouse button and select CLEAR SELECTION from the popup menu.

Digitize the second building - 4, Jefferson Street. Click on the bottom left edge coordinate of the first building with the right mouse button (black cross from the
tool bar) and select CAPTURE COORDINATE from the popup menu. The properties of the new building are automatically carried over from the other building. Change the house number to "4" and double click on the field NAME. Call this coordinate once again with the right mouse button (the name in the selection list is 4, Jefferson Street), select EDIT COORDINATES and change the terrain elevation to 232.5 m. Enter the building and divide the Whitefield Drive facade at the property borders of the terrace houses.

The buildings should look like the sketch on the left hand side if you switch on VIEW -> EXTENDED OBJECT VIEW.

Three receivers are assigned to the buildings One receiver should be located in the northernmost part of the first building and two further receivers at the northernmost and the southernmost terrace house of the second building. Click on the icon receiver from the icon bar (tab index card "receivers").

Place one point near the desired building facade. Confirm the elevation dialog box with OK. No elevation information is needed because the receiver will be assigned to the building together with the elevation information. Elevations coming from the DGM will be ignored, too. Set the check mark in the field CENT. (centered) in the receiver properties and click on the upper third of the facade in the picture.

As you can see, all the relevant building information is transferred to the receiver. Click OK.

Repeat the actions with the two other receivers. Add a "a" to the first and a "d" to the second receiver to the receiver name before the semicolon.

Now create a new Geofile for the supermarket and the sheet metal factory on the left hand side of the road.

The name of the Geofile is "industrial buildings".
Select the building icon from the icon bar. Ground floor elevation and terrain elevation are equal and are taken from the DGM. The wall height of the supermarket is 4.5 m, the wall height of the sheet metal factory and the residential building next door is 6 m (the residential building is the small part of the building). All buildings are within an industrial area. Assign a receiver to the residential building of the sheet metal factory.

For the first calculation, only the road is still missing.

Create another Geofile, named "Road". Select the icon for the road.

Place the first road coordinate at the upper edge of the bitmap in the middle of the road. The emission lines are created automatically from the definition of the profile in the road properties. Object elevation (upper edge of the road) and terrain elevation are the same and are taken from the DGM.

Regarding the **ROAD PROPERTIES** the following properties have to be entered:

**NAME**: Whitefield Drive

Select the calculated mode with the **CALCULATED** field check box for the emission level (LmE) and click on the **POCKET CALCULATOR**:

**INPUT TYPE**: City roads

**ADT** (average daily traffic) 12300 vehicles/24

**SPEED**: vCar/vTruck= 50 km/h

For all other fields, use the preset values. Click OK to leave the emission calculation.

As a situation can contain more than one road, the road for the reference kilometer for receivers and noise protection walls must be determined in the road properties.

The check box "reference axis" can only be set at the first road coordinate. Set the check box for the **REFERENCE AXIS**.

**PROFILE** 3,25/3,25 (RQ 9,5) (Tab index card "profile")

Digitize the course of the road making sure to enter coordinates at all positions of the small squares on the bitmap. These squares indicate a change in the traffic data. If you don’t want the elevation dialog to appear at every coordinate, select **ELEVATION DIALOG ONLY 1. POINT** from the **OPTIONS** menu.

After digitizing the road, select the black cross and left click on the point which is on the box at the junction with Jefferson Street to change the emission.
At the junction with the Jefferson Street, the ADT increases to 12700 vehicles/24. Left click on the road point to open the properties and then on the pocket calculator to change the traffic volume.

At the next junction, the traffic volume increases to 13100 vehicles/24, then in the south of the terrace buildings, the SPEED increases to 70 km/h for cars and trucks. At the motorway access, the traffic volume decreases to 8500 vehicles/24h.

Use Ctrl+ R or call VIEW -> REFRESH to display the created emission lines and select VIEW -> EXTENDED OBJECT VIEW (F4).

The double circles indicate the coordinates where at least one property changes. In the road properties you can jump with and from one coordinate where the properties change to the next one. (The other arrows go to the first or last coordinate and to the next or previous coordinate).

If you only want to see the road, as in the picture on the left hand side, select VIEW -> CURRENT OBJECT TYPE and click on the road icon from the icon bar.

The work in the Geodatabase is done. Save the situation via FILE -> SAVE SITUATION.

Call the CALCULATION and load the existing run file "all calculations".

Click on "+" to create a new calculation run. Place the cursor in the empty line in the fields "name" or "calculation type" and double click or select EDIT -> RUN PROPERTIES.

RUN NAME: "Road noise without noise protection". This text fills the place holder "calculation title" in the results tables.

CALCULATION TYPE: Select from the left selection list "Outdoor noise" and on the right side "Single point sound".

DATA: Click on the double arrow, you will see a window which shows the available situations on the left side and the situations selected for the calculation on the right side. The file type "situations" is selected in the selection list for the file type. Drag the situation "road noise without noise protection" to the right side or double click on the situation.
NUMBER OF RESULT FILES: This number may only be assigned once! For big projects it might be possible to create several run files for different areas. For small project it is better to use only one run file. The numbers can have 4 digits. Enter the number "1" for this calculation.

Tab index card SETTINGS:
Set angle increment, number of reflections and reflection depth to "1".

Tab index card STANDARDS: RLS-90
Assessment: DIN 18005 Traffic, the limits are 55/45 dB(A) (day/night) for the residential area and 65/55 dB(A) for the business district.

Tab index card SPS (single point sound): PLAIN RESULT TABLES AND LEVEL CHARTS should be selected, then click OK.

If an error message occurs, saying that something is wrong with the data, look at the tab index card LOG BOOK, go back to the Geodatabase and correct the error.

Start the calculation with ➡️

Controlling the calculation:

Stop calculation, pause, calculate all runs marked with "yes", single run

The results for the currently calculated receiver are displayed on the screens. To check the result of a special receiver, switch to another tab index card and then back to the graphics tab index card. Right click on the receiver to display the level chart and the result. This method is extremely useful if you want to verify a result, as geometry, level chart and result are displayed together.
Check the results in the Result Tables (Documentation)

Call the RESULT TABLES from the SoundPLAN Manager and open the file RSPS0001.res. The file name is a combination of "R" for results, The calculation type, here "SPS" and the number of the calculation. You will see four tab index cards.

RUN INFO, containing the information on the run settings and data in the calculation.

SINGLE RECEIVERS, containing the results of the single point calculation for every receiver and the difference from the target values.

DETAILS + GRAPHICS, containing the detailed information for every receiver (in this case only the day histogram of the road, because "detailed result tables" has not been set in the calculation run.)

ROADS, containing detailed information on the emission level of the road.

Look at the tab index card SINGLE RECEIVERS first: The results exceed the given limits - it might be possible to reach the limits for the ground floor with a noise protection wall.

Before printing the table, look at the column settings and the page layout. Choose the COLUMN SETUP from the right mouse menu and check the visible columns, column width, texts and legends for the column header.

Go to the tab index card TABLE SETTINGS. Here the title of the table and if necessary two further texts can be defined.

Page layout

Click on the icon PAGE LAYOUT (or the right click in the single point table), check page format, layout (with company logo) and header and footer texts. In the header + footer text tab index card, the variables for the project name (from the SoundPLAN Manager), the run name (from the calculation run) and the table title (from the column setup) are included. Further texts can be added to the table header and footer. The texts are centre justified, for the fields in the middle, and left and right for the fields on the left or right side.

ASCII or Excel export

Click on preview to check the table format and for printing the table. Moreover the table can be exported to Excel or ASCII, click on the SAVE button and select the desired format (in both cases without the table headers).

The format of the table with column headers and legend texts is stored with every table under the name "file name.fmt" in the project.

Input of a noise protection wall or dimensioning of the wall with Wall Design

It the module Wall Design is not covered by your license, enter the wall with a defined height to calculate the level reduction of the noise protection wall.

Wall Design needs the following steps:
• Determine the base line of the noise protection wall and place it into a separate Geofile.
• Precalculation with the calculation type Wall Design.
• Calling Wall design and creation of the noise protection wall.
• Saving the result in a new Situation (with noise protection).

Call the GEODATABASE, the situation "without noise protection" should still be open. Select FILE -> SAVE SITUATION AS and type in the file name "Wall dimensioning" (users without Wall Design type in "Road noise with noise protection").

The receiver in the business district is not relevant when dimensioning the noise protection wall, so select the Geofile "industrial buildings" (only if you dimension the wall) in the Geofile selection list and click the remove icon.

You can switch off the bitmap via the selection list on the right hand side (NO BITMAP SELECTED) or just fade it out (clear check box). The DGM is stored with the situation and used for the calculation, unless you close it via FUNDAMENTALS -> DGM -> CLOSE.

Create a new Geofile for the wall base line or the noise protection wall.

The name of the Geofile should be "Wall base line" or "Noise protection wall" as appropriate. Choose the icon "noise protection wall from the icon bar. For the dimensioning of the wall, the wall base line must anyway be stored in a separate Geofile.

The base line passes along with the property border of the terraced houses.

The noise protection wall starts at the property border in the Jefferson Street and ends approximately at the y coordinate 650.

The object elevation is taken from the DGM. Properties:

Those, who are working with Wall Design, should set the OPTIMIZATION property, the wall height for the base line is 0.
If you do not have Wall Design set the wall height to 3 m and leave optimization unset. (To check which modules you have installed look in Help -> Program Modules, in the SoundPLAN Manager.)

For the other properties the default settings are retained.

Digitize the coordinates of the wall.

Then select the wall (click on one coordinate with the right mouse button, select SELECT OBJECT from the popup menu) and split the wall in constant segments of 5 meters: GEOTOOLS -> POLY LINE -> INTERPOLATION -> CREATE SEGMENTS WITH CONSTANT DISTANCE IN [M] and enter 5.

Save the situation and open the CALCULATION.

Load the run file "all calculations". Place the cursor in the line "calculation without noise protection", right click and select copy and then with another right click PASTE IN NEW ROW.

Go to the new calculation run and open the calculation properties via double click on the cell "Name" or the right mouse menu.

Those who don't have Wall Design, can skip the next section.

NAME OF THE CALCULATION RUN: Wall design precalculation

CALCULATION TYPE: Wall Design - Single points

DATA: Click on the double arrow and assign the situation "Wall dimensioning" instead of "road noise without noise protection" with drag & drop and click OK.

NUMBER FOR RESULT FILES:2

There are no changes in the tab index cards "Settings" and "Standards". Settings in the tab index card "Wall Design":

WALL ELEMENT HEIGHT: 0,25 m

MAXIMUM WALL HEIGHT: 20 elements

The property IGNORE WALL HEIGHT ... is deactivated.

Leave the properties with OK, switch to the graphics tab index card and run the calculation (start selected single run).

Leave the calculation core after the calculation has been successfully executed (please save the run file!) open WALL DESIGN from the SoundPLAN Manager.

Open the file RWDN0002.res.

On the left hand side of the screen, you will see the run info and some tables, on the right the site map and a front view of the geometry data. Site map and front elevation can be rotated via the right mouse button, you can also change the draw type (3D-map).

Without changing the settings, just let Wall Design optimize the wall for the minimum surface. Click on the RECEIVER LOCATIONS tab index card, the levels of all receivers is colored red, which means that the level exceeds the limit.
With the icon the wall is built up until either all limit levels are reached or all available wall elements are used. The icon is used to build up the wall elements step by step. With every mouse click, a new element is put on the wall.

After the first optimization, the tab index cards receiver locations, wall segments and history show different perspectives of the wall which can be used to analyse the automatic optimization.

As the shape of the wall is not satisfactory, limit the maximum wall height to 3 m. Menu WALL -> SET MAXIMUM HEIGHTS ->12.

Click on the green arrow to start the calculation again. The visual appearance of the result looks more or less OK. Click on the history tab index to see a graph showing the effectiveness of the elements. This can be plotted against surface area or cost. Where the curves flatten out the increase in cost is out of proportion to the reductions in noise. Clicking on the graph at any point along the cost/area axis will display the wall heights at that step so the cost effectiveness of the wall can be optimized.

Should the wall look uneven, adjust the wall height (number of elements) in the "wall segments" tab index card.

Store wall

Store the optimized wall back to the Geodatabase. SoundPLAN automatically creates a new Situation and replaces the Geofile which contains the base line with the optimized noise protection wall. Please enter new names for the Situation and the Geofile:

The name of the Situation is "Road noise with noise protection" and the name of the Geofile is "noise protection wall" (please overwrite the default "Design002").

Go back to the GEODATABASE, call FILE -> OPEN SITUATION, click on the + in front of the situation "Road noise with noise protection" and assign the Geofile "industrial buildings" with drag & drop. Open the situation with a double click.

Look at the wall in the front view VIEW -> FRONT ELEVATION (F8). Not all of the wall segments have been used for the optimization of the wall.

Please delete the coordinates without a wall height as follows:

Click on the first point with the wall height 0 in the site map with the right mouse button and select SELECT POINT from the popup menu. Press the shift key and click on the last point (right mouse button) and select SELECT POINT again. Delete the coordinates with CTRL+ DEL.

Repeat this procedure and delete the coordinates with wall height 0 at the end of the wall. Save the situation and switch over to the CALCULATION.

Those, who do not work with Wall Design should continue from here.

Open the file "all calculations" and insert another calculation with the + button. Open the run properties.

RUN NAME: "Road noise with noise protection".

CALCULATION TYPE: Single point sound

DATA: Situation "Road noise with noise protection"
NUMBER OF THE RESULT FILES: 3
Tab index card SETTINGS:
Set angle increment, number of reflections and reflection depth to "1".
Please set the "plain result tables" property in the tab index card SPS. Leave the run properties and calculate this calculation with \[ \text{calculation button} \] (start selected single calculation).
Save the run file and leave the calculation core.

**Combination of results with the Spreadsheet**

Now the results with and without noise protection will be compared with the limit values.

Call the SPREADSHEET from the SoundPLAN Manager.
Select "difference" in the template selection list on the left hand side of the icon bar.
Select FILE -> NEW and select the file RSPS0001.res.

The results are automatically read into the level columns 19 and 20, together with further properties, such as the name of the receiver location or the limit levels.

Add the levels with noise protection to the columns 21 and 22:
FILE -> LOAD RESULTS AND FURTHER INFORMATION -> ADD RESULT COLUMNS , select RSPS0003.res. In the next dialog click on the selection list for the level column and select 21 (column for the day time range) and click OK. The limits are the same, therefore the limit columns don't have to be changed.

Recalculate all columns

Now the levels for the calculation are filled in, but the differences have not been updated. These columns contain formulae. Click on the pocket calculator to update the calculation and confirm the message that you really want to calculate all columns. If you want to have a look at a formula, click on the column header of column 23 with the right mouse button and select FORMULA from the menu.

The table itself is ready. If you want, you can change the layout - change text fonts or column layout, add your own text or value columns etc.

The dotted red line shows page breaks and the page width, defined in the page layout.

Please change the layout of the table to your needs using the menu items or the icons:
Some hints:

- Spreadsheets are divided into two parts: Title and data.
- The right mouse menu is accessed from the column header.
- The column layout can be adapted for more than one column at a time, if at least one cell of the desired columns is highlighted.
- The cell layout can be used in combination with "calculate and highlight" from the right mouse menu. Via a formula, selected cells are highlighted (e.g. x19 > 55; (The semicolon determines the end of a formula)).
- If you change the text size in the icon bar, it changes the text size for data and title, whereby the displayed size is the text size of the data; the title size is two points bigger.

Call the page layout (FILE -> PAGE LAYOUT) to set header and footer texts, table format etc.

If you are ready, the table can be printed.

When you are used working with the Spreadsheet, you will find out the flexibility of the Spreadsheet defining the contents and the appearance of your tables. The formulae help to get any needed statement or statistics. For the appearance you can highlight limit violations in another color or structure the table to make it easier to read.

<table>
<thead>
<tr>
<th>6</th>
<th>7</th>
<th>15</th>
<th>17</th>
<th>18</th>
<th>19</th>
<th>20</th>
<th>21</th>
<th>22</th>
<th>23</th>
<th>24</th>
</tr>
</thead>
<tbody>
<tr>
<td>Floor</td>
<td>Direction</td>
<td>Level</td>
<td>Status</td>
<td>Level</td>
<td>Prognosis</td>
<td>Level reduction</td>
<td>Diff. Prognoses</td>
<td>M</td>
<td>N</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td></td>
<td>in dB(A)</td>
<td></td>
<td>in dB(A)</td>
<td></td>
<td></td>
<td>in dB(A)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jefferson Street 2a</td>
<td>residential district</td>
<td>Limit level 55.0 45.0 day / night</td>
<td>1</td>
<td>W</td>
<td>52.9 51.2</td>
<td>55.0</td>
<td>44.7</td>
<td>9.3</td>
<td>-9.9</td>
<td>-9.2</td>
</tr>
<tr>
<td>2</td>
<td>V</td>
<td>56.9 50.9</td>
<td>56.8</td>
<td>48.1</td>
<td>7.7</td>
<td>-7.7</td>
<td>3.3</td>
<td>3.7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jefferson Street 4a</td>
<td>residential district</td>
<td>Limit level 55.0 45.0 day / night</td>
<td>1</td>
<td>W</td>
<td>63.1 52.0</td>
<td>64.7</td>
<td>44.5</td>
<td>8.4</td>
<td>-8.4</td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td>V</td>
<td>54.5 50.0</td>
<td>54.7</td>
<td>49.0</td>
<td>7.8</td>
<td>-7.8</td>
<td>1.7</td>
<td>1.6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jefferson Street 6a</td>
<td>residential district</td>
<td>Limit level 55.0 45.0 day / night</td>
<td>1</td>
<td>W</td>
<td>52.2 50.0</td>
<td>55.0</td>
<td>45.2</td>
<td>5.0</td>
<td>-5.0</td>
<td>5.5</td>
</tr>
<tr>
<td>2</td>
<td>V</td>
<td>80.8 50.0</td>
<td>80.8</td>
<td>48.8</td>
<td>7.0</td>
<td>-7.0</td>
<td>5.8</td>
<td>5.8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sheet metal factory</td>
<td>industrial district</td>
<td>Limit level 55.0 55.0 day / night</td>
<td>1</td>
<td>E</td>
<td>80.8 53.0</td>
<td>80.8</td>
<td>53.0</td>
<td>0.1</td>
<td>-0.1</td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td>E</td>
<td>58.4 50.0</td>
<td>58.4</td>
<td>46.8</td>
<td>0.1</td>
<td>-0.1</td>
<td>-</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Example table structure

**Calculation of a Grid Noise Map**

For the graphical documentation of the calculation results, grid noise maps have to be created 2 m above ground for the situations with and without noise protection and the differences. The length scale is 1:1000 and the page format is letter or A4.

First define a calculation area in the **GEODETIC**, then execute the **CALCULATION**.
The Geodatabase is still open. Select the icon calculation area from the icon bar. Activate the bitmap and digitize the calculation area roughly on the basis of the coordinates 1300/900, 1500/900, 1500/500, 1300/500 (use the red cross).

The calculation area has to be surrounded by elevation information, so that the receiver elevation can be calculated for all grid points.

The calculation area should be in a separate Geofile, so the Geofile assignment has to be changed now.

Create a new Geofile named "calculation area".

Select the calculation area (Alt+ left mouse button anywhere within the area - the object type calculation area must be active), call EDIT -> CHANGE GEOFILE ASSIGNMENT and select the Geofile "calculation area" from the selection list.

The Geofile "calculation area" shall not be part of a situation, but is added to the Grid noise map calculations separately. Make sure, that the Geofile "calculation area" is still the current Geofile in the selection list and click "remove current Geofile", Confirm, that the changes should be saved.

Call the CALCULATION CORE.

Open the run file "all calculations" and copy the calculation run "road noise without noise protection" (right mouse button -> COPY, right mouse button -> PASTE IN NEW ROW).

Double click in the run name to edit the properties:

**CALCULATION TYPE:** Grid noise map

**DATA:** Load the Geofile "calculation area" in addition to the Situation "road noise without noise protection". Click on the double arrow, select "Geofiles" from the selection list and add the Geofile "calculation area" to the already assigned data.

**NUMBER FOR RESULT FILES:** 11

The settings in the tab index cards "settings" and "standards" do not change.

Set the specifications in the new tab index card GRID MAP, the GRID SPACE is 5 meters, and select CALCULATE DGM, all other settings are not changed.

Switch to the GRAPHICS tab index card and start the calculation. First the digital ground model is calculated, then the ground elevation is displayed with a colored scale. This is an important tool for checking the elevation model. Click STOP, if necessary, to check the elevation. After that, the real calculation is started.

Use the same procedure for the situation with noise protection:

Copy the "grid noise map without noise protection" calculation run, modify the name of the calculation, double click on the cell data, change the situation "road noise without noise protection" to "road noise with noise protection".

**NUMBER FOR RESULT FILES:** 13

Start the calculation.
If you have huge grid noise maps, it is often useful, to run the calculation overnight. In this case, enter all calculation runs, double click in the cell **CALCULATE** in order to select them with "yes" and start the batch calculation with the green arrow.

**Part 2 - First steps in the Graphics**

Call Graphics from the SoundPLAN Manager. You will see an empty map on a sheet (discernible because of the double frame). Click on the map and move the right marker to the left, because we want to add a text box with legend and descriptions later.

Click the right mouse button in the map, select **FILE SELECTION MANAGER**.

Select the situation "Road noise without noise protection" via the arrow to the map and confirm the legend selection. A new legend is automatically created.

Select the **FILE TYPE** "Grid Noise Map" from the selection list, and the calculation without noise control. The following dialog defines the time range (select "day") and the colored scale. A new colored scale is automatically created. Click OK twice to get back to the map.

**Geometry parameters**

The next step is to adapt the length scale. (If feet is the correct measure in your country, select Options -> Presettings -> and change the setting in the branch "graphics"). Double click on the map (or right mouse button -> **EDIT CONTENTS**).

Call **GEOMETRY VIEWPORT -> GEOMETRY PARAMETERS** and enter the 1:1000 (respectively 80 feet). Click OK.

**Change geometry viewport**

The geometry viewport has to be moved a little bit to the left. Call **GEOMETRY VIEWPORT -> CHANGE GEOMETRY VIEWPORT** and then from the right mouse menu **MOVE**. Move the frame, so that the grid map is within the viewport.

Close "edit map contents" with OK.

**Create text box**

Create a text box, keep the left mouse button pressed and crate a box outside the map. The size doesn't really matter. Select right mouse button -> **PROPERTIES**.

Select alignment "right" in the tab index card "name, position and size:

<table>
<thead>
<tr>
<th>Alignment</th>
<th>None</th>
<th>Left</th>
<th>Top</th>
<th>FILL</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Leave the box properties. You see that the position of the text box is now on the right hand side. The width of the box can be changed, all other positions are fixed. Pull the box to the outer frame of the map.
Check the printable range of your printer. SoundPLAN works printer independent. The printable range of every printer is different, therefore we have to adapt the size of the sheet to the printer. Click on print, and you will probably get the following message:

For the printout, the Graphics gets the printable range from the printer and displays it in the message. The selection **FIT SHEET IN PAPER SIZE** is activated. Click on **EXECUTE**. The new sheet and map sizes are displayed (they need not to be identical with the printable range, because the proportion between width and length is kept) - click on **CANCEL**.

The size of the map and the description block now fit to the printer size.

Now create a further text box and draw it within the first text box. Double click on the new box or right mouse button -> **EDIT CONTENTS**. Enter the following text:

- Introductory Project SoundPLAN [Ctrl+ Return]
- Road noise without noise protection [Return]
- Time range day, Calculation 2 m above ground

**Section layout**

Go to the first line and select the section layout "title". Ctrl+ Return divides the text in two paragraphs, so that "standard text" is still assigned to the other lines. The section layout can be adapted to your needs with the icon **ABSATZLAYOUT**. Make sure that **ADAPT BOX TO CONTENTS** is set and click **OK**.

Right mouse button -> **PROPERTIES**: Deactivate the edge lines and select the alignment "top" in the tab index card "Name, position and size".

To activate an inner (child) element, the selection marks of a "parent" element must be cleared with the arrow icon.

**"paintbrush" icon**

Click on the colored scale and cut it out (icon scissors or right mouse button -> cut) - don't worry if the grid noise map disappears - activate the big text box and paste the colored scale. Refresh the screen with the "paintbrush" icon, the grid noise map is displayed again.

**("force refresh")**

Go to the properties and set the alignment to "top".

Now activate the legend (the box created with the geometry data at the start of this section), cut -> activate the colored scale box -> paste legend box. The alignment should be "right".
SoundPLAN creates the **COLORED SCALE** according to the minimum and maximum values of the calculation, but it can be adapted. Double click on the colored scale box and select the scale type "Color W1 <= W2".

**Automatic scaling**

Select the symbol for the **AUTOMATIC SCALING**. Make the lowest value 45, number of intervals 12 and increment 2. Click OK, the adapted scale is displayed. Try different scale types and intervals until it fits to your needs. In order to highlight the limit value, you could change the color of the interval 55 - 57 manually. Click on the color field and select another color.

**Scale layout**

Click on the icon **SCALE LAYOUT** and change the row height, so that the color fields have a distance. Additionally, you can set the edge lines around each of the color fields.

Leave the scale layout and the scale editing.

If you want to change the colors in general or if you want to add further colors, close scale editing and select **PARAMETERS -> COLORS** or **PARAMETERS -> PROJECT COLORS**.

The **OBJECT TYPE** receivers will not be displayed on the map, but is part of the Situation.

Activate the map and call the **MAP OBJECT TYPES** from the right mouse menu.

Deselect the "show" and "use in legend" check boxes. Click OK.

**Delete row**

As the legend has been created while loading the data, the entry receiver has to be deleted manually. Double click on the legend box to **EDIT THE CONTENTS**, highlight the row receiver and delete it with the icon **DELETE ROW**.

For the Grid Map, the output parameters will be changed. Call the **MAP OBJECT TYPES** again and select the grid noise map in the branch results. Deselect "show edge line". Leave the masks with OK.

You can now insert the length scale, the north arrow, the company logo (graphics box) and another text box for the company name from the icon bar into the description box and modify contents and properties as for the described graphics elements.

Save the sheet (file name: Road noise without noise protection) and print it.
The layout of this map may be used as the basis for further graphics and can be saved as a template. Please select FILE -> SAVE AS TEMPLATE and enter the file name and description (file name: GNM A4, description: basic template A4 (letter) with colored scale).

Templates are always stored in the folder "Globdata" in the SoundPLAN program folder and can be used for all projects.

New sheet

Now we need to create the sheet with noise protection. Call a new sheet, select FILE -> OPEN TEMPLATE and open the template "GNM A4". The formats have been stored without the data. Select the map and go to the File Selection Manager on the right mouse menu and load the situation "Road noise with noise protection" and the grid noise map "with noise protection". As a legend has been stored with the template, "template1" is preselected and the check box "complete" is active. This means that objects contained in addition to the objects in the stored legend are completed. For the colored scale, the colored scale1 is preselected. Confirm both settings. Click OK to close the file selection manager. Change the contents of the text box containing the description of the plan, save the sheet and print.

For the difference map, open the template "GNM" again and select the file selection manager from the right mouse menu. Load the Situation "with noise protection", then the file type GRID OPERATIONS and click on the double arrow.

Assign the grid noise map without noise protection to the base file and the grid noise map with noise protection to the operation file (time range day for both maps).
Click **CONTINUE** and then **OK**. The grid map will not be saved in a new file. Click **OK** to load the data. A new colored scale has automatically been created. Delete this scale, so that the difference map uses the existing colored scale in the description block. The colored scale has to be adapted to the difference values, also, the intervals will be changed to go from white to blue.

Call **PARAMETERS -> COLORS**, to create a new colored scale. Click on the color field white and then **→**. Place the cursor to the first field of a completely black row and click **←**. Select a color field with a dark blue and click **→** again. Place the cursor on the last field of this row and click **←**. Now click on the pocket calculator: The RGB values of the colors are interpolated between white and dark blue.

Close the color definition with **OK**.

Now edit the colored scale with a double click or **EDIT CONTENTS**. Open the automatic scaling and enter the following settings:
Close the dialog and change the header of the colored scale to "noise reduction". Close the scale editing - the third map is ready.

With extended modules, there are many methods for displaying the calculation results in the graphics. Here are three examples. The steps for creating these plans are always the same. The data are loaded in the file selection manager and afterwards designed in the map object types. For some of the display types, special calculations are needed, others just use the results we have already created.

This graphical output shows the differences between the two situations without and with noise protection, together with the level tables at the facades (single point calculation) and the geo referenced bitmap we used in the Geodatabase (both module Cartography).
The cross section map (module Cross Section Map) shows the effect of the noise protection wall. The cross section is entered in the Geodatabase and calculated with a grid cross section calculation.

This is a 3D view on the grid noise map (module 3D Model). Some of the object types have special 3D properties. It is also possible to display facade points (Facade Noise Map) or cross section maps in 3D.

Part 3 - Industry Noise

Now it will be investigated, whether a small supermarket can be built in the business district. The sheet metal factory already exists.

The business district emits with 65 dB(A)/m².

Both companies on the other road side are in a business district. In the first place, it must be defined, what area level is allowable to keep a limit level of 55 dB(A) for the day and 40 dB(A) for the night at the border of the residential area.

Please create a new Situation in the Geodatabase. This Situation only contains the residential buildings but not the buildings in the business district. The business district contains the two company properties. Both properties should be defined separately.

Working with the Geo-Database

The first steps should be known now:
New situation

Call OPEN SITUATION (if you open the Geodatabase, you will automatically see the Situation Manager), click on NEW SITUATION; name it "industry noise", assign the Geofile "residential area" with a double click and open the Situation. Load the bitmap to the background.

Area source

Create a new Geofile named "industrial sources", double click to load it to the situation and select the icon area source from the icon bar.

Digitize the property of the supermarket according to the following sketch.

The object elevation of the area source is 235 m, the terrain elevation is 0, so that ground effects are disabled.

Properties:

NAME: Property supermarket

Group: Right click on the field "not defined", select INSERT, type in "supermarket" and press enter on the keyboard.

DAY HISTOGRAM:

The source emits during the day with 65 dB(A)/m², in the night with 50 dB(A)/m². As there is only one entry possible for the level, we have to use the day histogram and assign 65 dB(A) for the day and 50 dB(A) for the night. There is another possibility: Define 2 sources with the same geometry, one for day and one for night.

Access the day histogram library with [Library]. SoundPLAN opens the day histogram library of this project. Enter the element name "industrial area", switch over to the VALUES tab index card and select "dB" from the selection list.

![Day Histogram Library](image)

Assign the value 50 to the hours 01-06 am and 10-12 pm, and 65 to the daytime hours (highlight the cells with shift+ arrow key). Click ACCEPT to assign the library entry to the Geodatabase.

Use the preset values for all other properties. The calculation will be done with a center frequency of 500 Hz and the level entered in the day histogram library is per m².

![Day Histogram Values](image)

Enter the other coordinates, then [Apply]
Capture the two edge coordinates of the first property for the input of the second industrial property with right mouse button -> **CAPTURE COORDINATE**. The elevation is stored, the property dialog is opened directly. Enter the **SOURCE NAME** "Property sheet metal factory" and insert a new **GROUP** "sheet metal factory". All other properties are equal.

Capture the second edge coordinate and digitize the other coordinates of this area.

![Image of the area with coordinates]

Save the situation and open the Calculation.

**Working in the Calculation core:**

Open the run file "All calculations" and create a new calculation run.

Please enter the calculation properties:

- **NAME OF THE CALCULATION RUN**: noise contingent investigations
- **CALCULATION TYPE**: Single points sound
- **DATA**: industry noise.sit
- **NUMBER FOR RESULT FILES**: 101

Use the preset values in the **SETTINGS** tab index card.

Make sure that the ISO 9613, Part 2 is selected in the **STANDARDS** tab index card for industry noise. Create a new assessment i.e. call the assessment library with the double arrow. Create a new library element with +, the element name will be "industry noise". Fill in the first time range: Name: Day, Short: LrD, Hours 6-22, Ta 16.0, Nloudest: 0 Then click "add" to add the second time range. Name: Night, Short: LrN, Hours: 22-6, Ta: 8, Nloudest: 1. Ta indicates the number of hours for averaging the time range in the assessment level (Lr). Go to the "Limits" tab index card and enter 55 dB(A) / day and 40 dB(A) / night for the residential area (WA). Click "Accept" and confirm that you want to save the library element "industry noise".

Tab index card **SPS**: Set "plain result tables" and "detailed result tables".

Close the run properties with **OK**, switch to the graphics of the calculation and calculate this single run. As the sources are entered with a center frequency, SoundPLAN states during the calculation that the ground absorption for these sources is calculated according to the alternative method of the ISO 9613-2.

**Working in the Result tables**
Open the file RSPS0101.res and look at the results in the tab index card single receivers.

The assessment levels exceed the limits by about 5 dB(A).

The first aim is to create a source contribution table. Receiver names, limit levels and assessment levels are displayed in a header row, the sources and their contribution at the receivers in the data rows.

This display type consists of two tables, fit into each other.

<table>
<thead>
<tr>
<th>Source name</th>
<th>Type</th>
<th>Contribution level day (dBA)</th>
<th>Contribution level night (dBA)</th>
<th>A (dBA)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jefferson street 1</td>
<td></td>
<td>56.8</td>
<td>41.8</td>
<td>0.0</td>
</tr>
<tr>
<td>Property super market</td>
<td>Area</td>
<td>74.3</td>
<td>39.7</td>
<td>0.0</td>
</tr>
<tr>
<td>Jefferson street 2</td>
<td></td>
<td>56.8</td>
<td>41.8</td>
<td>0.0</td>
</tr>
<tr>
<td>Property super market</td>
<td>Area</td>
<td>74.3</td>
<td>39.7</td>
<td>0.0</td>
</tr>
<tr>
<td>Jefferson street 3</td>
<td></td>
<td>56.8</td>
<td>41.8</td>
<td>0.0</td>
</tr>
<tr>
<td>Property super market</td>
<td>Area</td>
<td>74.3</td>
<td>39.7</td>
<td>0.0</td>
</tr>
<tr>
<td>Jefferson street 4</td>
<td></td>
<td>56.8</td>
<td>41.8</td>
<td>0.0</td>
</tr>
<tr>
<td>Property super market</td>
<td>Area</td>
<td>74.3</td>
<td>39.7</td>
<td>0.0</td>
</tr>
<tr>
<td>Jefferson street 5</td>
<td></td>
<td>56.8</td>
<td>41.8</td>
<td>0.0</td>
</tr>
<tr>
<td>Property super market</td>
<td>Area</td>
<td>74.3</td>
<td>39.7</td>
<td>0.0</td>
</tr>
</tbody>
</table>

Go to the DETAILS + GRAPHICS tab index card and then in the lower table to the SOURCE CONTRIBUTION tab index card.

The assessment level at the receiver is displayed in the upper table, the contribution level of the sources in the lower table. For projects with more data, it might be useful to sort the single receiver table, e.g. according to the highest assessment level. The sort order is also used for the upper table in the "details and graphics" tab index card.

Click the right mouse button in one of the tables and select SOURCE CONTRIBUTION REPORT -> ALL RECEIVERS.

If you look at the header rows, you will see, that the receiver location is without a text in front of it, the other values are described by a text. This can be handled with the DETAIL HEADER SETUP in the upper table, accessible with the right mouse button (close the preview):
The receiver name is in the second row. It is set but without a column header (look at the legend text below, to identify the contents of the column).

Close the detail header setup again and open the COLUMN SETUP from the lower table.

For the column "LrD" enter "Contribution level" in the first title row and "day" in the second title row. Click centered for title and column alignment. Proceed the same way for column "LrN".

Switch to the table settings tab index card an set "title 2" so that it will be displayed in the column header. You can also allow page breaks in the detail list for larger tables.

Open the contribution report (preview) again, and check the layout.

Limitation of the maximum emission level by use of the attenuation column:
As the assessment levels day and night exceeded the given limits by about 5 dB(A), we have to restrict the sources to a maximum emission level.

An attenuation for the sources can be defined in the last column of the source contribution table.

Enter the value by which the source should be attenuated, SoundPLAN calculates immediately the assessment levels at the receivers. The attenuations are entered as positive values. Try out and enter different values, until the limit levels are kept.

One of the sources has to be reduced by 6 dB(A), the other by 5 dB(A).

Prepare the table for the printout: Select PAGE LAYOUT from the right mouse menu, or the icon bar, check the settings and texts, call the PREVIEW and print the table.
Part 4 - Industry Noise - Detailed Investigation of the Supermarket

The limits for residential areas 55 dB(A) during the day and 40 dB(A) in the loudest hour of the night have to be kept in the neighborhood of the supermarket. The contribution levels between 6 and 7 am and 20 and 22 pm will get an addition of 6 dB(A) for the rest period.

At night the maximum level must not exceed the limit by 20 dB(A), during the day by 30 dB(A).

The task of the investigation is, whether the limits are kept and to propose noise reduction measures if needed. Please take into account, that the limit levels have to be divided between the sheet metal factory and the new supermarket. As the sheet metal factory does not work at night time, the supermarket can use the whole noise limitation. During the daytime, the level must be split up. The level for residential areas has to be reduced by 3 dB(A), approximately according to the proportion of the contribution levels in the above example.

These examples have been created to show how to use SoundPLAN. Not all of the assumptions are checked in detail. Please do not use these assumptions in real life!

The delivery with heavy trucks begins before 6 o'clock in the morning. The opening hours of the supermarket are from 8 am to 20 pm.

The following sources are relevant:

Delivery with heavy trucks:
- Between 5 and 6 am 2 trucks
- Between 6 and 7 am 2 trucks
- Between 7 am and 8 pm 8 trucks

A loading procedure with fork lifters which lasts 8 minutes is assigned to each of the trucks. The sound power level of the truck is 65 dB(A)/m, the sound power level of the fork lifter is 90 dB(A).

There are two parking lots with 100 (east parking lot) and 40 (west parking lot) places. There are 2 car movements per parking place during the opening hours. Later, the parking lots will be completely empty.

A heating system with the opening of the air condition is at the southern facade of the building, with a sound power level of 65 dB(A) all day and night.

Only the sound sources on the property of the supermarket are taken into account. The ISO 9613 part 2 is used for the propagation calculation. The Bavarian parking lot study 1994 is used for the emission calculation of the parking lots.

Working in the Geo-Database

Create a new Situation in the Situation Manager duplicating the situation "road noise without noise protection" and assign the name "supermarket". Open the new Situation.
All contained Geofiles are now part of the new situation.

Please remove the Geofile "Road" (select Geofile "road" in the selection list and press ). Activate the bitmap "site map" in the selection list and check whether the DGM is still loaded.

There is a building in the north of the supermarket that has to be absolutely part of the investigation. Create a new Geofile, digitize the new building and assign a receiver at the southern facade. The name of the Geofile is "mixed area". The building name is "4 Pine tree lane" and has two floors, the area usage is a mixed area.

Create another Geofile named "sources supermarket" for all sources of the supermarket.

Let's start with the trucks.

The trucks access the property on the west side of the supermarket, and then reverse towards the unload place. So two truck movements have to be assigned per truck.

Enter the line source according to the above graphics and change the object elevation in the dialog to 233 m. The following properties are assigned:

NAME: Approach truck

GROUP: Select "supermarket" from the selection list.

COMMENT (not absolutely necessary): Level: 1 movement per hour and meter

DAY HISTOGRAM: Create a new day histogram. Click on the double arrow to access the library, create a new element with the plus and enter the name "truck approach".

Go to the "values" tab index card and select "U/h" (units per hour) from the selection list.

Enter the operating hours: 4 movements between 5 and 6 am and 4 movements between 6 and 7 am. The 8 trucks during the day can be split up to the operation hours or assigned to any hour between 7 am and 20 pm.
Click **ACCEPT**. The new element is updated in the source properties dialog.

The **CALCULATION MODE** is a center frequency of 500 Hz.

Enter a level of 75 dB(A) per meter (this level is derived from the sound power level of the truck considering the time needed for the distance of 1 meter).

Next, enter the uploading with fork lifters. As sometimes two trucks can be uploaded at the same time, the uploading zone is defined as an area source. An uploading period of 8 minutes is assigned to every truck. The sound power level for the uploading duration of one hour is set to 90 dB(A) for the total uploading zone. The source is 1 meter above ground.

```
<table>
<thead>
<tr>
<th>Day</th>
<th>00:00</th>
<th>01:00</th>
<th>02:00</th>
<th>03:00</th>
<th>04:00</th>
<th>05:00</th>
<th>06:00</th>
<th>07:00</th>
<th>08:00</th>
<th>09:00</th>
<th>10:00</th>
<th>11:00</th>
<th>12:00</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>
```

Digitize the uploading zone according to the above graphics, using the following properties:

**DAY HISTOGRAM:** Copy the element "truck approach" with right mouse click -> **COPY TO** -> ..\starter\time.db (project library), select **NEW ELEMENT** from the dialog and enter the name "uploading zone". Go to the values tab index card, select min/h (minutes per hour) from the selection list and assign 8 minutes to each truck.

The **CALCULATION MODE** is a center frequency of 500 Hz.

**SOUND POWER LEVEL:** 90 dB(A) per unit

Close to the area source is a small annex to the supermarket, which we have not yet digitized. Select the Geofile “industrial buildings” and digitize the building. The building is 4 m high.
Go back to the Geofile "sources supermarket". Next we will define the west parking lot.

As with the other noise sources, we will define a day histogram out of the movement in units/h.

The number of places is only used to calculate the addition for the lanes. The fields "number of movements" can be omitted.

**Parking lot**

Select the icon "parking lot" from the icon bar and digitize the first parking lot with the following properties:

- **NAME**: "West parking lot"
- **NUMBER OF PARKING LOTS N**: 40
- **DAY HISTOGRAM TOTAL PARKING LOT**: Create a new element named "west parking lot".

It has 40 places, that is 80 movements/h. After the opening hours of the supermarket (between 8 and 9 pm) there are still 40 movements until the parking lot is empty.

<table>
<thead>
<tr>
<th>Time</th>
<th>00-12h</th>
<th>12-24h</th>
</tr>
</thead>
<tbody>
<tr>
<td>00-01h</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>01-02h</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>02-03h</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>03-04h</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>04-05h</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>05-06h</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>06-07h</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>07-08h</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>08-09h</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>09-10h</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>10-11h</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>11-12h</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Activate the check boxes for "addition 'Taxtmaximalpegel'" (addition for the impulse) and "addition for lanes".
Finish the entry of the west parking lot.

Digitize the second parking lot (Name: East parking lot, 100 places, the other properties are the same). Create a new element in the day histogram library. Copy the Element "west parking lot" as described above and assign 200 units instead of 80 units (and 100 units instead of 40 units).

The above graphics shows the two parking lots.

The last source is the opening of the air condition at the southern facade of the supermarket. It is placed at a distance of 10 m from the southwest corner of the building, 4 m above ground (or 30 m from the southeast corner - this depends on the input direction of the building (activate VIEW -> EXTENDED OBJECT VIEW F4)). The opening is a point source and is assigned to the building.

Select the icon point source from the icon bar, place the point source near the southern facade of the supermarket and confirm the elevation dialog with OK.

Enter the point source properties:

NAME: Air condition
GROUP: Supermarket
DAY HISTOGRAM: 100 % each hour (new element in the day histogram library)
SOUND POWER LEVEL 65 dB(A)
Go to the Geometry/Building ref. tab index card. Now assign the point source to the building, entering the dist. corner (10 m) and the height above ground floor (4 m) and clicking on the southern facade of the supermarket. If you entered the building clockwise (you can see this from the small arrow at the first building facade), enter 30 m, as now the distance refers to the southeast corner.

The definition in the Geodatabase is complete, save the situation.

**Working in the run file**

Call the calculation and load the existing run file "all calculations". Create a new calculation run and enter the following calculation properties:

**NAME OF THE CALCULATION RUN**: Supermarket without noise protection  
**CALCULATION TYPE**: Single points sound  
**DATA**: Supermarket.sit  
**NUMBER FOR RESULT FILES**: 102

Check the **SETTINGS** tab index card: number of reflections 3, reflection depth 1 and set enable side diffraction.

For sources without spectra the ground absorption of the ISO 9613-2 is automatically calculated according to the alternative method.

As the limit value during the day time has to be split up between the sheet metal factory and the supermarket, we have to define a new assessment, derived from the library element "Industry noise". Click >>, select the element "industry noise", click the right mouse button and copy it to the project name and enter the name "supermarket". Go to the limits tab index card, enter 60/50 day/night for mixed areas, 65/55 day/night for business districts and reduce the limit level for the
residential area to 52 (day). Between 6 and 7 am and 8 and 10 pm we have to add a penalty of 6 dB(A) to the residential area. Click accept.

Go to the SPS tab index card and set "plain result tables" and "detailed result tables".

Start the calculation. As the sources are entered with a center frequency, SoundPLAN states during the calculation that the ground absorption for these sources is calculated according to the alternative method of the ISO 9613-2.

Results

The limit level day is kept for the receivers in the residential area. The values at night are exceeding the limits at the receiver "4 Pine tree lane" and in the second floor of the receiver "2a Jefferson Street".

<table>
<thead>
<tr>
<th>Receiver</th>
<th>Usage</th>
<th>Floor</th>
<th>DR</th>
<th>L20, max</th>
<th>L10, max</th>
<th>L20</th>
<th>L10</th>
<th>L90</th>
<th>L95</th>
</tr>
</thead>
<tbody>
<tr>
<td>2a Jefferson Street</td>
<td>GR</td>
<td>1</td>
<td>52</td>
<td>40</td>
<td>43.4</td>
<td>39.1</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>2a Jefferson Street</td>
<td>GR</td>
<td>2</td>
<td>52</td>
<td>40</td>
<td>43.5</td>
<td>40.2</td>
<td>---</td>
<td>0.2</td>
<td>---</td>
</tr>
<tr>
<td>2b Jefferson Street</td>
<td>GR</td>
<td>1</td>
<td>52</td>
<td>40</td>
<td>42.7</td>
<td>38.1</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>2b Jefferson Street</td>
<td>GR</td>
<td>2</td>
<td>52</td>
<td>40</td>
<td>43.9</td>
<td>39.3</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>3a Jefferson Street</td>
<td>GR</td>
<td>1</td>
<td>52</td>
<td>40</td>
<td>41.9</td>
<td>36.2</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>3a Jefferson Street</td>
<td>GR</td>
<td>2</td>
<td>52</td>
<td>40</td>
<td>43.3</td>
<td>38.3</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>1 First tree lane</td>
<td>MA</td>
<td>1</td>
<td>E</td>
<td>65</td>
<td>50</td>
<td>50.0</td>
<td>55.4</td>
<td>---</td>
<td>5.4</td>
</tr>
<tr>
<td>2 First tree lane</td>
<td>MA</td>
<td>3</td>
<td>E</td>
<td>60</td>
<td>52</td>
<td>52.3</td>
<td>56.0</td>
<td>---</td>
<td>6.9</td>
</tr>
<tr>
<td>Sheet metal factory</td>
<td>BD</td>
<td>1</td>
<td>E</td>
<td>65</td>
<td>55</td>
<td>43.4</td>
<td>29.3</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Sheet metal factory</td>
<td>BD</td>
<td>2</td>
<td>E</td>
<td>65</td>
<td>55</td>
<td>43.8</td>
<td>32.3</td>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>

Attenuation measures have to be designed in the Geodatabase. The original sound sources will not be changed. Open the Situation Manager with FILE -> OPEN SITUATION, duplicate the Situation "supermarket" (new name "supermarket with noise protection") and the Geofile "sources supermarket" (new name "supermarket sources with attenuation"). Replace the Geofile "sources supermarket" with "supermarket sources with attenuation".

What could be attenuation measures? Here are some proposals:

- Limitation of the number of trucks before 6 am (change of the day histogram) or use of noise reduced trucks (change of the sound power level).

- Change of the track of the trucks, with separate access for both directions.

- Better screening between the truck access and the building in the mixed area.

- Other ideas?

You see how important it is to have the possibility of building different scenarios in the Situation Manager! But one condition must be taken into account: Please do not copy buildings to another Geofile, if receivers or sources are assigned to the buildings. The receivers and sources would have to be reassigned afterwards.
Part 5 - Indoor Factory Noise

Calculation of the indoor level and the calculation from indoor to outdoor

A sheet metal factory is established in the south of the supermarket. The factory works in two shifts, from 6:00 am to 10:00 pm. We know the indoor noise sources, the absorption areas and the attenuation of the components of the building. The inner level is calculated according to VDI 3670, afterwards the outdoor propagation calculation is executed according to ISO 9613-2.

The calculation of the indoor level is executed in the middle of the inner facades. Steps:

1. Preparatory work in the library: Copy of transmission spectra, absorption spectra and the emission spectra form the system library to the project library.
2. Definition of the industrial building
3. Transformation of the facades in noise sources and assignment of the transmission spectra
4. Definition of the general properties for the indoor noise calculation
5. Assignment of the absorption spectra to the facades and definition of embedded components
6. Definition of the noise sources within the industrial building
7. Calculation indoor to outdoor (Hallout)
8. Outdoor calculation

Preparatory work and entry of the industrial building
Copy the desired emission spectra, transmission spectra and absorption spectra from the system library to the project library:

Open the library from the SoundPLAN Manager and call the system transmission library and the project transmission library via LIBRARIES -> SYSTEM -> TRANSMISSION and LIBRARIES -> PROJECT -> TRANSMISSION. (The local empty transmission library is created). Select the elements "double glazing 4/8/4" and "1 mm sheet steel trapezium profile" in the system library (keep the Ctrl key pressed, click the right mouse button and copy them to the project library:

<table>
<thead>
<tr>
<th>#</th>
<th>Transmission spectra</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>Open door</td>
</tr>
<tr>
<td>14</td>
<td>1 mm sheet steel trapezium profile d=45 mm</td>
</tr>
<tr>
<td>15</td>
<td>Double glazing 4/8/4 mm</td>
</tr>
</tbody>
</table>
Do the same procedure for the following elements of the emission and absorption libraries (the locale absorption library is just created, too):

- **Emission spectra**
  - Metal Shop (Sanding, Hammering)
  - Sheet Metal Shop (Punching Sheet Metal)

- **Absorption spectra**
  - Uncoated wall or ceiling
  - Scattering objects metal (machinery)
  - Double glazing, 2.3 mm thickness

Next open the Geodatabase and create a new Situation. Select the Situation "supermarket", duplicate it and name it as "sheet metal factory". Remove the Geofile "supermarket sources" from the Situation (right mouse button -> remove or drag & drop). Create a new Geofile named "sheet metal factory" and open the Situation.

The sheet metal factory (factory building and residential building) has been digitized as one building. Now we need to split it into the factory building (object type industrial building) and the residential building (object type building). The building of the supermarket has to be copied to the Geofile "sheet metal factory".

Select the object type "building", click on the red cross cursor and make sure that the Geofile "sheet metal factory" is selected. Capture the edges of the residential building with the right mouse button and change the name of the building to "residential building of sheet metal factory". Select the object type "industrial building" and capture the edges of the factory building. Ignore the properties of the industrial building at the moment (close the properties with OK).

**Transformation of the facades to noise sources**

Click on one coordinate of the factory building with the left mouse button and assign the base properties name = sheet metal factory, height = 6 m and refection loss = 1 dB.

Go to the sources tab index card. Apart from of the joint facade with the residential building, all facades of the factory building have the same properties. As already defined properties are adopted to further objects (here facades), we define one facade in detail first, so that we only have to change the joint facade afterwards.

Right click on the first facade in the right hand window and select **DEFINE AS SOURCE**.
In the new **Level definition** tab index card, select Li(Calc)-6-R from the selection list in the field LW. (Calc means that the indoor level is entered after the SoundPLAN indoor calculation).

The table below shows the values for the indoor level, the transmission and the sound pressure level of the area that is emitting to outdoor. We have to assign only the transmission spectra, as the indoor level is calculated and the sound pressure level results from \( L_w = L_i - 6 - R \) following the equation 7a of the VDI 2571.

Click on the double arrow in the row "R" and assign the element "1 mm sheet steel trapezium profile". As the library element was defined in octaves, also the table in the factory building is in octaves.

Further properties, group name and day histogram are entered in the general tab index card (lower part of the properties dialog). Create a new element in the day histogram library. Click on the double arrow and create the element "sheet metal". The factory works 100 % from 6 am to 10 pm.

Assign the group "sheet metal factory" from the selection list, which was created during the calculation of the noise limitation.

All properties of the first facade are defined. Right click on any of the facades in the right hand window and select **DEFINE ALL FACADES**. The roof has to be converted separately to a source (right click on the roof and define it as source) and put back the properties of the joint facade with the residential building, as nothing is emitting to outdoor at this facade. Click on this facade in the right hand window and unset the property **DEFINE AS SOURCE**. You can name the facades in the **GENERAL** tab index card.

The northern and the southern facade have embedded sources, at the southern facade an open door and a window, and a light band at the northern facade.

Click left on the southern facade (facade 3) in the tree window. An embedded component can either be entered with the mouse in the graphical window or with its coordinates (right mouse button). The coordinates refer to the lower left corner of the facade. You have got to be aware that all coordinates of an embedded component are within the facade.

The below pictures shows the position of the components and the coordinates of the door ...
the coordinates for the window at the southern facade ...

and the coordinates of the light band on the northern facade (facade 5).
Assign the properties and transmission spectra to the new sound sources. For the open door, we have to create a new library element. Select the **LEVEL DEFINITION** tab index card, click on the double arrow in the row R and create a new element called "open door" with +, select **octaves** and enter **0** to all frequencies. The window and the light band have the transmission spectrum "double glazing".

**Indoor calculation**

Go to the Indoor tab index card. First, we need to define the base properties and the absorption properties of the components.

Base properties:

<table>
<thead>
<tr>
<th>Component</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Density</td>
<td>0.00</td>
</tr>
<tr>
<td>Absorption</td>
<td>0.00</td>
</tr>
</tbody>
</table>

It is necessary that values are assigned to all components of the building including floor and ceiling. So assign the default spectrum to all components with **ALL FACADES ABSORPTIVE**. The default spectrum is assigned to all components.

Embedded components with different absorption spectra can be defined either by the percentage of the area or with length and width. In our case, the components embedded in the facades for the transmission can also be used for the absorption inside the building.

Select **COPY SOURCES AS ABSORPTION AREAS** in the tree window for the facades containing embedded components.

The embedded components are displayed, if you click on the + in the tree structure.

Assign the absorption spectra to the embedded components - the absorption spectrum for the open door has not yet been created. Click on the double arrow and create a new element named "open door". The values are **1** for every frequency. The window and the light band have the absorption spectrum "double glazing". Close the property dialog of the building.

**Definition of the noise sources within the industrial building**

The sound sources in the factory building are separate object types, without ground elevation. The elevation of the sources is the elevation above sea level. To make the handling of the indoor sound sources easier, a local coordinate system has been created together with the industrial building. The reference elevation of the indoor sound sources is the floor of the industrial building. Switch to the local coordinate system with **FUNDAMENTALS -> LOCAL SYSTEM -> SHEET METAL FACTORY**. The x and y coordinates refer to the first building side of the factory building.
The sound sources (two point sources and one area source) have the following position:

![Sketch of sound sources](image)

Select the object types from the indoor Noise tab index card:

Geometry: According to the above sketch, the relative height above floor is 2 m.

Saw, grind, hammer: Spectrum Sheet metal shop (sand blasting and hammering), unset USE LIBRARY DEFINITION and enter a sound power level of 105 dB(A) / unit.

Punching press 1 and punching press Spectrum Sheet metal (punching sheet metal), unset USE LIBRARY DEFINITION and enter a sound power level of 110 dB(A) each.

The noise sources within the factory building won't get a day histogram and a group.

The last step in the Geodatabase is the definition of indoor receivers and/or a line for the sound propagation curve (SPC). For a grid noise map calculation, no calculation area is needed, as the industrial building is automatically used.

Save the situation and open the CALCULATION.

Load the run file "all calculations" and create new calculation runs for the indoor calculation, the calculation indoor to outdoor (calculates the noise emitting from the components) and a single point calculation outdoor.

For the indoor to outdoor calculation the receivers are automatically created in the middle of the components, 0.2 cm shifted to the inner side.

NAME: Indoor to outdoor (for the calculation of the emitting areas) and Indoor calculation (for the calculation inside the industrial building)

CALCULATION TYPE: Hallout (In -> Out) for the first calculation run and Indoor SPS for the second one.

DATA: sheet metal.sit for both calculation runs

Make sure that PLAIN RESULT TABLES is set in the SPS tab index card Use the preset values in the "indoor" tab index card.

NUMBER FOR RESULT FILES: 103 and 104

When the situation in the Geodatabase has been saved, SoundPLAN adds entries in the emission library for Li, which are filled in during the indoor to outdoor calculation. The indoor level is entered into the properties of the industrial building.
in the Geodatabase. For the result tables, the results are stored under the name RHOTxxxx.res. You will find the reverberation time here.

The relevant receivers (2 and 4 a/d Jefferson Street and 4 Pine tree lane) have already been defined and are part of this situation. So we can execute the outdoor calculation right now.

NAME: Sheet metal - calculation outdoor

CALCULATION TYPE: Single points sound

DATA: Sheet metal.sit

RESULT: 105

Settings in the SETTINGS tab index card:

SEARCH ANGLE: 1 degree

NUMBER OF REFLECTIONS: 5

REFLEXION DEPTH: 1

SIDE DIFFRACTION enabled

Set the PLAIN RESULT TABLES in the SPS tab index card.

The assessment levels are not critical as long as the sheet metal factory doesn't enlarge the production to the night time range.
3 SoundPLAN-Manager

SoundPLAN consists of multiple programs that jointly assure the functionality of the suite of SoundPLAN. Each of the programs is specially geared to fulfill special functions where you can concentrate on the task and not have all menus of the entire program cluttering the screen. As the program is split into individual program modules it is possible to edit data for one variation while another is prepared for the plotter and another is being calculated. Multitasking with SoundPLAN not only works within the same project but can also be applied for different projects.

Data organization

In SoundPLAN a project folder (subdirectory) is generated for each project. This way it is guaranteed that all data belonging to the project are stored together. This procedure helps you and your colleagues to efficiently manage projects big and small.

In the SoundPLAN-Manager you can generate new general subdirectories and new project folders. This way it is possible further organize the project to keep for example bitmaps and imported files separate from the rest of the project.

Functions of the SoundPLAN Manager
The SoundPLAN Manager coordinates the entire program suite and defines the global settings and enables sending hotline e-mails and the access to the closed SoundPLAN user forum.

**Change display options**

Each program module of the suite contains a short description which may be displayed when the mouse is on the symbol. Under OPTIONS -> DISPLAY OPTIONS you can activate and deactivate the display of the module name and the descriptive text. In the section FONT you can customize the fonts, size and color of the description:

![Change display options](image)

**Project-Info**

*Edit project-info* On the right hand of the SoundPLAN Manager screen the project information and the selected standards are displayed. The project info is generated with the creation of a new project. If you want to modify the description, either click on the project description or on the icon or open the menu PROJECT -> PROJECT-INFO.

---

### Create a new project or select an existing one

*Project new / Select* When you start SoundPLAN for the very first time the project selection is opened directly to let you create a new project or open a project which has already been installed on your PC. Later on SoundPLAN will always open the last project you worked on. If you want to select a different project or create a new one open PROJECT -> NEW / SELECT.

### Create new project

*Create new project* First navigate to the place where you want the new project to be located and the click on the symbol “new project”.

SoundPLAN projects are presented in the pick list as blue folders with the stylized "SoundPLAN - snail". This way SoundPLAN projects can be recognized and distinguished from normal folders.

It may be necessary to convert normal Windows folders into SoundPLAN projects, for example when you generated the folder and already stored the bitmaps or other external data in it. To convert the folder right click on the folder and select the option CONVERT TO VERSION 6 PROJECT. Or mark the folder and select the option EDIT -> CONVERT TO VERSION 6 PROJECT.
When creating a new project first enter the name of the project. The usual restriction of Windows concerning the length and the use of special characters applies. Over length project names will be truncated. To describe the project or the course of action in the entire project, use the project info freely, there is enough space for an in depth description although only a limited text will be displayed on the screen of the SoundPLAN Manager.

![Image of Project Info window]

Enter the project title, the project engineer and the client. The field **DESCRIPTION** enables you to write a long description of the project. The project info can be read and edited any time by selecting **PROJECT -> PROJECT-INFO**. Click on **OK** and the project folder is created, with a click on the **SELECT** button the project is opened.

**Select an existing project**

In SoundPLAN the project that was active when the program was terminated last is loaded as the default project. Select a different one with **PROJECT -> NEW/SELECT**.
If the project is in a different folder on the same drive, get into the next higher folder and select the appropriate path. If the project resides on a different drive first select the correct drive with \ and then navigate to the correct path as described above.

**Hint**: Drives on the network must be first connected with **EXTRAS -> NET CONNECTION** to get a drive letter then proceed as above.

In the info field on the right side the SoundPLAN project description you entered is displayed.

**Hint**: Projects on a CD-ROM cannot be opened directly as the Windows operating system marks files on the CD as read only. Therefore the project must be first copied to the harddisk. With the Windows explorer copy the project and then right click on the folder to remove the read only mark on the subdir. The dialog is under “properties”. Click OK and confirm the attribute change to be „applied changes to this folder, subfolder and files.“

SoundPLAN projects can be selected by double clicking or with the button **SELECT**.

### Copy, delete, insert and pack projects

All functions described here can either be called through the menu „Edit“ or by right clicking on a project. This description only describes the way via the menu. Some of the functions are not accessible all of the time, for example the option „Paste“ can only be used after a project has been copied before.

### Copy and paste projects

Click on the project you want to copy – it changes to a blue background. Select **EDIT -> COPY** (available on the right mouse button as well). SoundPLAN in addition shows the project name so that you can be certain to always open and process the right project. Copying projects is very quick as SoundPLAN only stores the project info in the clipboard, the physical copying is done when you paste the project. Select the target path and select **EDIT -> PASTE**. Now SoundPLAN copies the project. If a project folder of the same name already exists, the project is copied into a folder with the name „Copy of project name.”
**Delete or rename projects**

Click on a project and select the option **EDIT -> DELETE** or press the **DELETE** key. SoundPLAN will ask for a confirmation of this procedure. In case you still answered this wrong, you will find your project in the Recycle bin from where you can restore the project if needed.

To rename a project click on the project to activate it and select **EDIT -> RENAME** (or **F2**), the project name is highlighted in blue and you can edit the name.

**Pack and extract projects**

To save space when archiving projects or when you want to send the project to someone, SoundPLAN has the capability to compress entire projects into packed archives. To pack your project open **EDIT -> PACK**. In the following definition box set additional parameters for the zipped archive.

The first entry is the path of the project to be packed, the next entry field defines the path where the packed archive shall be stored.

When data are sent to an overseeing agency or to the hotline, some of the data may not be necessary but would inflate the packed file. Therefore SoundPLAN has a menu to customize what will be stored in the archive and what is not.

The files to be stored are filtered via the file extension, select which file types shall be stored and which not. The setting **EXCLUDE TEMPORARY AND NON SOUNDPLAN FILES** should be clicked in most cases.

The full list of the files to be included and excluded can be viewed in detail and edited after it is opened with **EDIT LIST**.

After packing the files with **PACK**, the size of the archive is displayed on the bottom of the entry box.
To extract a project, click on the project and click on **EDIT -> EXTRACT** and enter the path where the archive is to be extracted to.

---

**Options -> Settings**

![Settings Window]

The options provide various pre-settings, that are stored globally and edited to meet the requirements of each project.

### Program Settings

The **SHARED PATH FOR GLOBAL SETTINGS** determines a folder, for example on the server, where the color palette, the global object types, as well as templates for general plots, results tables, spreadsheets and graphics sheets are stored. The files are **not** automatically stored to this folder, but for organizing reasons the user himself must copy them. In order to solve questions such as "How should SoundPLAN react if the network is not available?" or "Who has priority, when two people want to access files in this directory?"

Therefore, SoundPLAN still uses a fix folder for the global settings (..\SoundPLAN 6\Globdata). To adjust the data, right click in the tree view on the left side on **program -> COPY THE CONTENTS OF THE GLOBAL FOLDER TO GLOBDATA**, or **COPY THE CONTENTS OF GLOBDATA TO THE GLOBAL FOLDER**.

The **PATH FOR GLOBAL LIBRARIES** defines where the global libraries are stored. If the global path is not accessible, you will not be able to open the global libraries.

The **NUMBER OF RECENTLY OPENED FILES** defines for all parts of SoundPLAN the number of files displayed in the history list of the menu file.

### Settings for Distributed Computing

Distributed computing (DC) uses other PC's in a network, not currently in use, for calculations. One PC, called the workstation PC or client PC controls the allocation
of calculation jobs to the server PC's. In order to make a PC a server PC, at least a demo version of SoundPLAN and a control program, DC control, must be installed. The SoundPLAN version on the server PCs must be the same as the version on the workstation PC. If not, SoundPLAN will abort the calculation with an error message.

The network port for the workstation PC, the server PC and DC control can be changed here if necessary. The ports must be identical for all PC's used for distributed computing.

For server PCs, data is stored during the calculation, that later are deleted. Because the server PC cannot calculate if there is not enough hard disk space available, it is possible to change the PATH FOR DISTRIBUTED COMPUTING DATA.

System Settings

Some computers have hardware components that do not fully support the 3D-Graphics and the bitmap processing. In order to run these modules satisfactorily, you can change some of the system settings.

Most of the graphics cards have a double buffer for the intermediate storage of complex graphics data. This second storage is used when moving a scene in the 3D-Graphics so that it moves smoothly. If you cannot open 3D-Graphics perhaps your graphics card does not support the second storage. In this case, switch USE DOUBLE BUFFER FOR 3D-GRAPHICS to NO.

Hint: It might also be that the graphics card generally supports the second storage, but that it is switched off in the graphics card settings. Please contact your hardware specialist first.

If geometry bitmaps are not printed or are printed incorrectly, the printer driver might not support the more effective standard routine for bitmap output. In this case, switch USE ALTERNATIVE PRINT ROUTINE FOR BITMAPS to YES.

The NEAREST CLIP PLANE is also relevant for 3D-Graphics. Even good graphics cards often have difficulties displaying the nearest clip plane, which is 0,1m for the 3D-Graphics. This may lead to incorrect display of areas.

Set the nearest clip plane to 5 m for example and check the result in the 3D-Graphics.

Example: Clip plane 0,1 m
Example: Clip plane 5 m
It is possible to change the nearest clip plane in the 3D-Graphics for each scene (GEOMETRY PARAMETERS when editing the 3D model).

STANDARD PRINTER FOR THE GRAPHICS: Often a different printer than the Windows standard printer is used for the graphical printouts. Therefore, you can select another printer installed on your system. The Windows standard printer is still used for the table printouts.

Project Settings: Global and Current Project

Define project settings as needed in most of your projects. When creating new projects, SoundPLAN automatically uses global pre-settings for the new project. You can change these settings for the current project.

To transfer settings from one project to another or to the global settings, right click on the tree view to the left, select LOAD SETTINGS, select the project6.ini from the desired project and press OK.

The GRAPHICS-SETTINGS provide the color palette and the object types. You can now edit the global object directly.

For the length scale you can also select 'feet'.

The USAGES descriptions are now defined in the settings and no longer in the graphics. If you have changed the description in the settings and want to use them in the graphics of an existing project, select EDIT -> INSERT USAGE DESCRIPTIONS FROM THE PRESETTINGS in the project object types.

It is possible to change the standard properties of some objects in the GEO-DATABASE in the settings (e.g. the height of the first floor above the ground floor, which determines the position of the first receiver, the height of the floors, the distance of a receiver from the facade and the alignment of road and house number.

The STANDARDS are set globally and for the current project but you can set them in the calculation kernel for each calculation run.

Use CALCULATION TYPE to predefine standard settings that the calculation kernel will use when this calculation type is used. Set the definitions for each calculation type in the tab index card "settings" in the run properties and set the parameters for the calculation type itself, such as the grid size or the calculation height above ground for a grid noise map calculation.

Please check the run properties in the calculation kernel if you copy calculation runs and change the calculation type afterwards. SoundPLAN automatically uses the presets.

Object Numbering

Glossary definition: Because of the new object numbering, it is important to define very clearly the words used in SoundPLAN for different numbers.

Object ID - is a unique key, automatically assigned to the objects during the input or import in the Geo-Database. It appears in the status bar. The ID is displayed in the
calculation log book if error messages occur (e.g. road attributes of road #2333 are missing) and it can be used to find an object in the Geo-Database.

**Serial number** - is automatically assigned to each receiver during the calculation according to the sequence of the data. Since the serial number is assigned automatically, it might change after a recalculation.

**Object number** - the user assigns the object number to receivers, buildings and noise sources in the Geo-Database. The object number doesn't change - unless you consciously change the number.

The object number is not a value but a text. This has the advantage that the object number is not sorted alpha-numerically but via a freely definable sort sequence. The object number is incremented automatically, so the sort order for receivers or sources in the tables is 1, 2, … 10 instead of 1, 10, 2, … without any changes of the pre-settings.

Changing the format string and sort order allows you to accomplish many tasks. For example:

- Mark free field receivers separately, but sort continuously.
- Add additional receivers or sources later, without changing the original sort order.
- Insert receivers or sources at a defined location in the table.
- Use specified object numbers, e.g. for different parts of a project.

**Input and display of the object number**

Definitions for the format string and an additional sort order are located in the settings in the SoundPLAN Manager. During data entry in the Geo-Database, enter the number as you want it to appear in the output.

### Define new basic number

Use **DEFINE OBJECT NUMBER** to define the number just entered as the new basic number, from which the number for additional objects is automatically incremented.

If the defined format string contains letters and/or separation signs, the object number might be A100 or 11.1, for example.

The entry of the format string uses placeholders for letters and numbers in the SoundPLAN Manager in **OPTIONS -> SETTINGS**:

- `0,(9)` as place holders for numbers (9 fills the numbers from the left to the right)
- `A,a` as place holder for characters
- `.,;` as separation marks
Definition of the numbering in the settings

**Hint:** If you want to change the format for the object number while you are working on a project, call OPTIONS -> PRE-SETTINGS in the Geo-Database and change the format string or the sort order for the current project. The changes take effect as soon as you close the settings and return to the Geo-Database.

The object number is written to the result file during the calculation and is added afterwards to the table output in the results tables and the spreadsheets. For the graphical output, you can use the object number as a reference in the file type "level tables".

**Object number and stored sort string in the tables and as a reference in the graphical output**

The sort order according to the defined object number uses the column with the format for the sort order (format string).

In the results table, call the sort order via the right mouse button and select the column **FORMATTED OBJECT NUMBER**. The column does not have to be set to visible.

In the SoundPLAN spreadsheet, the column ‘formatted object number’ must be set to visible in the TABLE SETTINGS. Click in the table header of the column and select **SORT -> ASCENDING** or **DESCENDING**. Afterwards, set the column to invisible again.
Examples for format string and sort order

Add additional receivers or sources to a later stage of a project, without changing the original sort order.

Format string 0 0 0 . 0
Sort order 1 2 3 4 5

<table>
<thead>
<tr>
<th>Entry in the Geo-Database</th>
<th>Display in tables / graphics</th>
<th>stored format for the sort order</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>001.0</td>
</tr>
<tr>
<td>1.1</td>
<td></td>
<td>001.1</td>
</tr>
<tr>
<td>1.2</td>
<td></td>
<td>001.2</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>002.0</td>
</tr>
<tr>
<td>2.1</td>
<td></td>
<td>002.1</td>
</tr>
</tbody>
</table>

The original format string in a project was 00 …

<table>
<thead>
<tr>
<th>Entry in the Geo-Database</th>
<th>Display in tables / graphics</th>
<th>stored format for the sort order</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>01</td>
</tr>
<tr>
<td>11</td>
<td></td>
<td>11</td>
</tr>
</tbody>
</table>

… now you want to add more receivers and you need to use three-digit numbers. Supplement the format string to 000.0.

The display for existing receivers will not change, only the stored format changes:

<table>
<thead>
<tr>
<th>Entry in the Geo-Database</th>
<th>Display in tables / graphics</th>
<th>stored format for the sort order</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>001.0</td>
</tr>
<tr>
<td>1.1</td>
<td></td>
<td>001.1</td>
</tr>
<tr>
<td>11</td>
<td></td>
<td>011.0</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>002.0</td>
</tr>
</tbody>
</table>

In addition, you can use characters to identify receivers and sources, (for example for free field receivers).

Because the objects should be sorted according to the actual number, the sort order becomes important.

Format string A A 0 0 0 0 A
Sort order 5 6 1 2 3 4 7
Entry in the Geo-Database = Display in tables/graphics | stored format for the sort order
---|---
T 1 | 0001T
2 | 0002
G 3 | 0003G
5 | 0005
5a | 0005_a
T-5 | 005T-

The sort order defines the order in which the characters should be considered. Assign a number to each component of the format string: 1 for the first sort order, 2 for the second sort order and so on.

Use separation marks to separate character blocks and number blocks. Valid separation marks are , . and ;

In character blocks, any characters, spaces and special characters are allowed, but no separation marks and numbers. A format string may contain several character blocks.

Small characters in the format string are displayed the way the user entered them (small or capital letters). Capital letters in the format string are always displayed in capital letters.

### Branching into SoundPLAN modules

Via the SoundPLAN-Manager you have access to all modules of the program. Select the icon of the program module and click on it to get into:

- **Library:**
  Access to the emission-, absorption-, transmissions- and mitigation library, the definitions of 2D- and 3D-directivity as well as day histograms, wind statistics, pollution component library (MISKAM) and the assessment library. The library comes with limited data and is ready to host your project and global data.

- **Geo-Database**
  Entry of data via digitizer and on screen on top of a scanned bitmap, import of data from older SoundPLAN versions, DXF, Autocad and GIS systems. Data are assembled to Geo-Files that can freely combined to form Situations.

- **Calculation Core**
  Calculation on the basis of the data entered in the Geo-Database. Extensive log book functions with error and warning log, graphics control of the calculation, spreadsheet type definition of the calculation to calculate multiple calculations in a row.

- **Documentation**
  Table type preparation of the result data from single point calculation and Façade Noise Maps. Master/detail organization of the data, scalable detail for receivers, sources and the transmission path. Table type presentation on the printer.
• **Spreadsheet**
  Spreadsheet type presentation of results from SoundPLAN single point receivers and Facade Noise Maps. Extra columns can be generated for text and values, additional calculation results can be read into the extra columns, result columns can be added and formulas to do numerics with results from multiple calculations. The window dimensioning feeds off this spreadsheet.

• **Expert Industry**
  Detailed analysis of the interaction of sources and receivers, sorted lists of sources, receivers and source contributions. Generation of noise control concepts with cost optimization. 3D solid graphics modeling to see where the sources and receivers are located. Additional detail windows for diagrams.

• **Wall Design**
  Dimensioning of noise protection walls and berms for multiple receivers, minimization of cost of the walls, interactive dimensioning with corrections to the wall form and instant results, 3D solid view of wall and surrounding, Wall performance diagram.

• **Graphics**
  Graphics presentation of calculation results in various formats. Flexible arrangement of different map types with multiple maps per sheet. Templates to define an office standard.

• **Long Straight Road**
  Rough screening type calculations according to German RLS 90 for road noise to determine the necessary height of noise protection walls and berms.

• **City Noise Screening**
  Rough screening type calculations according to the German RLS 90 for road noise. Works for long straight roads and buildings left and right.

• **Aircraft noise definition**
  Define the airport, the runways and flight paths and add flight schedules to create the entry data for aircraft noise calculations according to AZB and ECAC.

• **Socket Server**
  Start the communication interface for the Distributed Computing (DC). Selecting the menu item EXECUTE->SOCKET SERVER will trigger the socket server to be loaded. This little communication program needs to be running on all PCs that are supposed to take part in Distributed Computing calculations. To use the computer for DC the box ENABLE REMOTE COMPUTING ON THIS COMPUTER needs to be clicked. LAUNCH DC SERVER ON WINDOWS STARTUP enables the DC socket server to be launched every time Windows is started.
Hotline Support with e-Mail

Open the menu entry HELP -> SEND EMAIL to send an e-mail to the SoundPLAN hotline. The e-mail form should already have the mail address of your SoundPLAN service partner, if not, the e-mail address can be found in the file support.ini in your SoundPLAN folder. If you submit a hotline problem, please describe in detail what the nature of the problem is, for example the calculation run, the situation, the graphics sheet that is causing questions. Questions to the functionality of the license, hardlock etc should always be accompanied with the file UPDATE.LOG and the BABG file for your license. Having the answers makes the turn around time of the help line much faster.
4 Geo-Database

Working with the Geo-Database

The Geo-Database contains all data required for the processing of your project. Aside from geometrical data the descriptive information for acoustical and air pollution calculations is stored here.

The Geo-Database with the built in access to the library where emission spectra, reflective properties, day histograms and other descriptive data are managed, offers a very efficient and consistent toolbox for noise and air pollution projects, regardless if a small area or big agglomerations are noise mapped.

In the following paragraph you can read a short synopsis of the tools and processes of the Geo-Database. For details of individual functions and the steps of the operations please read the subchapters.

When you open the Geo-Database the program generates a situation with a Geo-File.

Data entry: Depending on the data type and format please select the data entry (often you will combine different entry modes):

<table>
<thead>
<tr>
<th>Basis</th>
<th>Functionality</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper plan</td>
<td>Digitizer: DIGITIZER -&gt; INITIALIZE, enter the reference coordinates, check the scale and in case you have more than 2 reference coordinates the standard deviation. After this request a Geo-File, select the object type and digitize.</td>
</tr>
<tr>
<td>Scanned map</td>
<td>The plan must be available as a bitmap (*.bmp). FUNDAMENTALS -&gt; BITMAP -&gt; LOAD, enter reference coordinates, check the scale and in case you have more than 2 reference coordinates the standard deviation. Then request a Geo-File, select the object type and digitize on screen.</td>
</tr>
<tr>
<td>DXF data</td>
<td>The data must be available as AutoCAD DXF 12/13. FILE -&gt; IMPORT -&gt; DXF. Load the DXF file and select the layer and additional import properties. The data are imported in the SoundPLAN format as general points, lines, areas and texts. After import screen the data and convert the object type and the Geo-File-assignment.</td>
</tr>
<tr>
<td>CARD/1, Stratis</td>
<td>FILE -&gt; IMPORT -&gt; CARD/1, STRATIS, open file, read the data. The data are automatically converted into the right SoundPLAN object types.</td>
</tr>
</tbody>
</table>
### ASCII

**FILE -> IMPORT -> ASCII FORMAT**, load file, define format, select SoundPLAN Geo-File and object type, select the column in the ASCII file and possibly define standard object properties.

### ESRI Shape file

**FILE -> IMPORT -> ESRI SHAPE FILE**, load file, select SoundPLAN Geo-File and object type, assign SoundPLAN properties to Shape file properties and possibly define standard properties.

#### Elevation model creation

If your data did not contain a complete and consistent elevation model it is wise to create a situation for the sole purpose of generating and managing such a 3D elevation model. With this situation you generate a DGM (Digital Ground Model) calculation run. Afterwards the finished DGM is loaded into the Geo-Database (**FUNDAMENTALS -> DGM -> LOAD**) in the background and is supplying the elevation basis for many steps of generating and refining your model.

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digitizing with mouse or digitizer</td>
<td>The object and the terrain elevations are extracted from the loaded DGM</td>
</tr>
<tr>
<td>(absolute coordinates)</td>
<td></td>
</tr>
<tr>
<td>Digitizing with mouse or digitizer</td>
<td>The terrain elevation is extracted from the DGM the object elevation is</td>
</tr>
<tr>
<td>(relative coordinates)</td>
<td>entered relative to the DGM</td>
</tr>
<tr>
<td>Objects without elevation information</td>
<td>Mark objects, call <strong>EDIT -&gt; COORDINATE OPERATIONS</strong>, select h1 respectively h2 and execute the function =DGM.</td>
</tr>
<tr>
<td>Elevation of the bottom of the roof or top of walls known</td>
<td>Mark objects, <strong>GEO TOOLS -&gt; CALC. OBJECT HEIGHT FROM DGM</strong> places the objects relative on the terrain and stores the difference between the top of the object and the terrain as the wall height.</td>
</tr>
</tbody>
</table>

Enter objects: Select the object type from the list, select the correct Geo-File, enter the first coordinate, check elevations and if needed enter them. Enter the object properties and if required additional coordinates. Line and area type objects are finished by requesting a new object with **NEW** or **F2**.

Editing the data: Generally objects need to be marked (selected) before they can be edited. The exception are some operations valid for the entire object with the access through the right mouse button.

---

### Overview Geo-Database

In the Geo-Database you enter the geometry of all objects relevant for your investigation and add attributes for it. Aside from the coordinates, the object elevations above sea level and if needed the terrain elevation, additional descriptive attributes are assigned to the objects. Depending on the object type the type and amount of descriptive information varies from object to object. A road for example amongst other attributes has the cross section and the emission calculations as attributes, a noise protection wall needs the height of the wall and the reflective properties.

The entry of the data is accomplished either with the digitizer or by digitizing on screen on top of a scanned map or by importing digital data from outside sources.
The entry with the digitizer (for the external digitizer or for digitizing on screen) is the same for all objects. You enter the first coordinate of the object and then define the elevation with the elevation dialogue or set it to the elevations suggested by the digital ground model. In the next step fill out the input mask for the object attributes. Lastly you digitize additional coordinates until the object is defined completely. As the object properties of neighboring objects are often the same, the properties of the next objects are preset with the attributes of the one entered last, therefore it is advisable to digitize similar objects together.

It is important that the data are managed in logical blocks. The Geo-Database allows structuring the data in Geo-Files and Situations. Geo-Files are the smallest blocks of data that can be arranged in the Situation Manager to form Situations. A Geo-File can be part of multiple Situations so that the geometry can be freely arranged for different planning variations and purposes without creating redundant data.

All data entered into the Geo-Database can be edited further. This is particularly important for data imported from other software programs. For example, filtering data to a manageable size or connecting lines to polygons are important data processing tools. Attribute operations, generating parallel objects and other functions are forming the tool box that make the Geo-Database an efficient tool edit and customize your data.

**Structure of the Geo-Database**

In the Geo-Database you work in Situations that consist of a single or multiple Geo-Files. The Geo-File is the smallest storage unit and can contain a single object (for example a road), multiple objects of the same type (example all elevation lines in the investigation area) or multiple objects of different types (for example the entire geometry of the noise analysis).

Geo-Files are assembled in the Situation Manager to form larger units the Situations.

![Diagram of different content of Geo-Files and their assembly to Situations](image)

*Example of the different content of the Geo-Files and their assembly to Situations.*

Situations and Geo-Files are used by the calculation core for the computation of the noise propagation and in the graphics for the presentation of the geometry. A Geo-
File can be part of multiple Situations, so that the geometry is assembled depending on the planning variation or type of calculation that is to be performed, without the need to copy data into redundant data structures.

Geo-Files do not have to be assigned to Situations. In some cases, for example with the objects calculation area, cross section line or receivers, it may be sensible to keep them in Geo-Files of their own and adding them to the calculation in the form of Geo-Files rather than Situations.

In the picture above the base data are assigned to Geo-Files (1..7) according to object type. In the Situation Manager these Geo-Files are assembled to form the Situations A, B, C. As data supply for the calculation of the „prognosis with noise control“ a Grid-Noise calculation needs Situation C and Geo-File 6 as data supply. For the calculation of selected single stand alone receivers the Situation C and Geo-File 7 would be required. For the graphical display you probably will not want to present the calculation area as an object, so the file selection here should only contain the Situation C and the result data.

How you want to manage the geometrical data depends on the size of the project and your preferences. The Geo-Database is very flexible and accommodate small, medium and huge projects very efficiently.

The data structures in the background

Geo-Files (*.geo) contain the coordinates and elevation information and all attributes of the objects.

Situations (*.sit) are a list of all Geo-Files included in the Situation. The Geo-Files are not stored physically in the situation, only references are stored here. This has the big advantage that as no redundant data is generated, it is not necessary to edit the same data in each Situation where they occur. If a Geo-File in a Situation is renamed, the name will automatically be updated in all other situations where this Geo-File is referenced.

When a Situation is opened, a database copy of the properties of the included objects (TmpWorks.*) is generated. During the editing of data you actually work with the copy of the data, until you save the Situation. When the data are stored, the temporary copy is replaced and all attributes are stored again in the Geo-Files. The last version of the Geo-Files or the Situation is always saved as a backup copy under the normal names with the extensions *.~si or *.~ge. Aside from the „undo“ function this feature of backup copies of the data is increasing the data security.
The graphical user interface

Regardless if your data are available in paper form or are from an imported file or a scanned bitmap, the data entry is fast and well organized.

This picture gives you a first overview of the elements found on screen:

The top part of the screen shows the current Geo-File, all new data will be stored in this file unless a new one is made the current file. Next to it you see the Geo-File-administration and the currently selected object type. Below you see the grouped object selection icons (you can also opt to see all object types at the same time with OPTIONS -> OBJECT SELECTION 2).

Below follow the controls for the selection of the view port and next to it the functions for the scaling and rotation of the map (in 90°-steps or continuous). The definition of view port windows and rotations are not possible when bitmaps are loaded into the background. When a bitmap is loaded, the view control area contains 4 more control arrows to fine tune the fit between the bitmap and the other data.

On the left side of the map area you can see icons for different modes of input. With each mode the functions assigned to the mouse buttons may vary.

In the status line on the bottom of the screen you see on the left side the world coordinate of the position of the cursor on the map. From the second coordinate the distance between the last coordinate and the new cursor position is displayed. Keep the left mouse button pressed to determine the distance between any two coordinates on the screen. When you move the cursor to an already digitized coordinate, the middle of the status line will present the coordinate and height (object and terrain) and on the right the name of the object and the object ID.
The Coordinate Table

The **COORDINATE TABLE** aids you with checking your coordinates. The table is not shown by default, it needs to be activated either through the **VIEW** menu or with the key strokes `<Ctrl-T>`.

It is advisable to place the windows for the table and the map view as side by side windows with the commands for **WINDOW -> TILE**.

Either the map view or the table is active. To find a certain object in the table, select the object from the object list. In the graphics window the coordinates of the object are shown with little circles. Increase the size of the object dots with **VIEW -> POINT SIZE** to better see the object in the map view.

When the graphics map view is active and you move the cursor to a coordinate of an object, the cursor in the coordinate table moves to this coordinate as well.

Red coordinate lines are indicating that there are attributes assigned to this coordinate.

**Top View, Side Projection and 3D-Wire Model**

As an important tool for the elevation control of your data you can toggle in the Geo-Database between top view, projections and a 3D wire frame presentation. Select **VIEW -> FRONT ELEVATION (F8)**, **SIDE ELEVATION (F9)** or **3D WIREFRAME (F10)**.
Front elevation projection in the Geo-Database

You see all objects contained in the current situation in the top view (site map) and as a projection. The following information is displayed (some information only when the object dots and the object properties are activated (VIEW -> ENHANCED OBJECT VIEW (F4) and VIEW -> OBJECT OPTIONS -> PROPERTIES):

- The building reference plane of buildings is marked with a thick blue line.
- Coordinates that contain attributes are depicted with a bigger dot than regular coordinates.
- When the object elevation is different from the terrain elevation, the difference is drawn with a gray hatch pattern.
- For receivers that are assigned to buildings the base elevation is drawn as a double circle; the receivers relevant for the calculation are displayed as circles.
- The lowest elevations found in the set of data are shown on screen as a dashed line.
- Objects with "zero elevation" are depicted below the dashed line and have no influence on the height scale. There are some objects that do not contain elevation information, for example calculation areas or the cross section line. In case other objects do not contain elevations, please check your data.
- **Hint**: Use the GeoTool SELECT OBJECTS WITH ELEVATION <= [M] to find objects that do not have correct elevations.
Errors in the model can be identified by looking for object lines crossing the dotted line. In this case some coordinates still must have the elevation set to zero.

With the mouse you can move to the objects in the projection and see the elevation of the cursor position in the status line on the bottom. In addition you can invoke the property dialogue (left mouse click) and the elevation dialogue (right mouse button) in projections and 3D model.

The elevation stretch factor can be zoomed by pulling up the frame of the lower window. Click on the upper edge of this window and keep the left mouse button pressed. When the cursor shape changes to ⬇️, move the mouse upwards.

An additional aid in checking your model is the 3D wire frame model. Open it with VIEW -> 3D WIREFRAME F10.

TILTING the model is accomplished with the selection box on the right side of the bar on top of the graphics window.

Hint: In the wire frame model you zoom by choosing the magnifying glass cursor and clicking on the screen. Click with the left mouse button to zoom in and zoom out using the right mouse button.

Rotate

The data can be rotated in steps of 90 degrees by clicking on the arrow buttons or any increment with the slider. The controls are as follows:
**Tip:** With the arrow left/right arrow keys of the keyboard the view is rotated in increments of 2 degrees for each click.

It is not possible to rotate the geometry when a bitmap is loaded.

### Enter Objects

The coordinates x and y are entered either with the pointing device of the digitizer or by left clicking with the mouse on a bitmap on screen. The elevations (object elevation and terrain elevation) and additional object properties are entered in the appropriate dialogue boxes. If you want to connect (reuse location and elevation) to an already existing coordinate, you can do so by right clicking and selecting the option **CAPTURE COORDINATE**.

For entering the data first click on the object type icon on the object type bar or select the object type from the object list.

Select the data entry cursor: As the Geo-Database handles the entry of data as well as the editing of already existing data, some of the cursors in addition to the normal mode have specialized data entry functions.

**Data entry mode**

Data entry mode: This mode is only for entering data. With the left mouse button you digitize the data with the right mouse button you capture coordinates that are in the background as base data. Properties of existing data objects cannot be accessed in this mode.

**Data editing mode**

Data editing mode: As long as no other objects are within the capture circle, you can still digitize new objects in the editing mode. When another object is in close proximity, the shape of the cursor changes from a cross into an arrow and with left clicking you can enter into the objects property dialogue. The right mouse buttons have additional functions assigned to them.
When the object needs elevation information and the settings of the elevations dialog in the options menu have the option activated, the elevation entry box is opened. After this the box for the definition of the object properties is opened. As each object has its own set of properties and its own entry screens see the chapter „Objects“ for details.

Starting with the second coordinate of a line object, the distance between the new coordinate and the last coordinate entered is presented in the status line on the bottom of the screen.

**Elevation data entry**

As elevations are a major factor in noise simulations, the elevation dialog is opened directly after the entry of the coordinate. Depending on the object type there will be an entry field for the objects elevation and often for the terrain at the object also. For some objects the elevations has a special meaning, the description can be found with the description of the object. In the menu OPTIONS you can select if the elevation dialog is suppressed or only opened at the first coordinate of a string or always. ELEVATION DIALOG ALWAYS is the default setting. To enter elevation lines, buildings etc it is sufficient to enter the elevation only with the first coordinate, to define a ridge of a mountain or a master alignment of a road, the dialog needs to be invoked for each coordinate. When you have loaded a digital ground model in the background, ELEVATION DIALOG ALWAYS is the standard setting.

![Elevation dialog](image)

**Entry of elevations**

When object and terrain elevations are the same, enter the object elevation, the terrain elevation is set to the same elevation by double clicking in the data entry field for terrain elevation. When a Digital Ground Model is loaded the object and terrain elevation is derived from the DGM but can be overwritten any time.

**Hint:** The elevation dialog is only opened for objects that need elevation information (texts, calculation areas and cross section lines do not need elevations). The properties dialogs are only opened for objects that have attributes (elevation lines and spot heights do not need descriptive attributes).

**Working with relative elevations**

To work with relative elevations click on the icon in the symbol bar on the left side of the screen. If a DGM is loaded in the situation the terrain elevation is extracted from the DGM, the object elevation needs to be defined relative to the terrain. When the relative elevations are defined using the DGM, the elevation will remain correct even when DGM is corrected at a later stage. If no DGM is loaded, the relative elevations are always referenced to a ground elevation of 0 meters.
Via the GEOTOOLS RELATIVE -> ABSOLUTE ELEVATION and ABSOLUTE -> RELATIVE ELEVATION coordinates can be changed from relative to absolute elevations and vice versa. To make the elevations absolute, the elevation of the DGM is entered in the terrain elevation and the relative height of the object is added to generate the object elevation. Changing absolute elevations into relative ones, the will place the difference between the DGM and the absolute elevation into the terrain elevation spot, the object elevation then takes the difference between the terrain and the object elevation.

Objects that only have the object elevation but no terrain elevation (walls, berms and elevation lines) receive an additional slot for the terrain elevation when the elevation is switched from absolute to relative elevations. Caution: Do not confuse the object elevation with the wall height!

When relative elevations are selected, the elevation dialog will show in brackets that the object elevations are in relative heights. When passing with the cursor over an object, the status line will show [R] in front of the coordinates to show that the elevations in the coordinate are defined relative.

Enter objects with right angles

Click on the icon in the symbol bar on the left side of the screen to enter the objects with right angles.

From the third coordinate of a string the entry cursor can only be moved in a right angle to the last coordinate. When closing the object, the last coordinate is moved so that all angles of the object are right angles.

As coordinates can be only entered in an imaginary line perpendicular to the last line segment, it may be difficult to move the cursor to the new object icon. In this case either use F2 or move the cursor to the gray frame around the data entry area.

Hint: The right angle mode automatically calculates the last coordinate of an area object, so that you do not need to enter it.

Marked area objects can be converted into right angle objects with the menu item GEOTOOLS -> POLYLINE -> CALCULATE RIGHT ANGLES. If the angle is out of the correctable range, a warning message is dispatched.
Object dots (F4)

The object dots mark the location of the coordinates, double rings indicate that the object has the definition of descriptive attributes. With VIEW -> ENHANCED OBJECT VIEW or with Function key <F4> the object dots can be toggled. In the menu VIEW -> OBJECT OPTIONS -> OBJECT DOT SIZE the size of the dots can be in customized. It is much easier to find the coordinates when the object dots are activated, on the other hand the editing speed is much slower.

Object dots do not change with the zoom factor of the normal map view. When you are displaying large amounts of data with a big magnification, the object dots may become so big that it may be necessary to resize the object dot size or deactivate the object dots all together. In this case it might be necessary to change the object dot size or zoom in the data.

Object dots and the start of string/entry direction marker

When digitizing new objects, the object dots of the new object are always visible. Coordinates with attached attribute definitions are displayed with a double circle, the data entry direction is marked with an arrow. All other coordinates are drawn with a single circle.

**Hint:** The start arrow of an object helps you in determining if data loaded from external sources are present as polyline or were imported as single stand alone line segments. See the GeoTool „Connect lines and generate areas“ on page 106.

The object properties are always defined at a coordinate. For some line type objects (roads, railways, noise protection walls...) it is also possible to modify the object definitions at any coordinate of the string. The object properties are valid until they are replaced by a new definition. To open the object definitions close in on the coordinate until the mouse cursor changes into an arrow and left clicks.

When you are still entering a new object or have activated an existing object, the last coordinate is displayed with a red circle, this helps finding the object to continue with the data entry.

When SoundPLAN finds multiple coordinates within the search range of the arrow cursor, a pick list is displayed where you can pick the correct object for editing. Select the object of choice and continue. If there are too many objects found within the search radius you can either resize the SEARCH RADIUS in the menu OPTIONS or zoom into the area. See the paragraph "Editing the data" on page 92.
The screen section above shows which additional attributes are offered in the object dot presentation:

- The arrow marks the first coordinate of a string and defines the direction of data entry.
- Coordinates with an object definition are highlighted with a double circle.
- For roads the emission level is drawn next to coordinates where the level definition changes.
- For roads and railways the kilometer post is displayed.
- For noise protection walls the height of the wall is printed next to each coordinate where the height of the wall changes.
- Facades of buildings enabled for Façade-Noise Calculations are marked with a bold blue line, facades not marked for the calculation are drawn with a thin blue line.
- For receivers, industrial sources and photo points the object number is displayed.
- If a 2D-directivity is assigned to the frequency spectrum of an industrial source, the direction is shown.
- For photo points, the view direction and the view angle are printed.
- Receivers assigned to a building are displayed in green color, receivers not assigned to buildings are drawn in yellow. Receivers that were originally assigned to a building where the reference has been lost (by deleting the building or copying them for example) are marked in red. In addition the sweeping angle from where the noise can be received is drawn with a blue arc. Full circles indicate that the incoming noise is not restricted, a half circle a sweep angle of 180 degrees.
- The rate of incline on roads can be visualized.
Measure distances

If no DGM is loaded, you can see the difference between the last entered coordinate and the cursor position in the left part of the status bar:

| X: 991.59 | Y: 765.58 | D: 29.70 |

You can also measure the distance between any position on the screen: Keep the left mouse button pressed and move the mouse from one position to the next. Go to the digitizing mode, to measure the distance between two points.

Generate and edit Situations and Geo-Files

With the first opening of the Geo-Database in a new project, the program automatically generates a new situation (New Situation.sit) with a Geo-File (New GeoFile.geo) so that you can start with entering or importing data right away. When you leave the Geo-Database you are asked to rename the situation and after this to rename the Geo-File.

![Add an existing/new Geo-File](image)

Click on the symbol next to the Geo-File pick list to request a new Geo-File or to activate an existing Geo-File and open it for editing in the current Situation.
Geo-File Selection

**Hint:** Only Geo-Files not already open in the existing Situation are presented. When all Geo-Files of your project are activated in the open Situation, the pick list will be empty.

In the Geo-File selection you can add Geo-Files to the situation, generate new Geo-Files, delete or duplicate them. In the window on the left side you see the file name and if details are enabled the information with date and time when the file was edited last.

On the right side the description and a preview picture of the Geo-File are presented. With **VIEW -> DETAILS** you can monitor the Geo-File history instead of the preview picture. The history contains all information about the Geo-File, from which project it originates, if it was imported or has been renamed etc..

The following functions are available either with the menu **FILE** or via the right mouse button or the symbol icons.
You can select multiple adjacent Geo-Files by using the shift + left click or can select single files with Ctrl = left click. In addition you can activate all Geo-Files (EDIT -> SELECT ALL OBJECTS respective Ctrl-A) or can invert the selection (EDIT -> INVERT SELECTION).

With ok or a double click on the Geo-File you get back into the data editing mode.

**View filters for Geo-Files**

Especially in huge projects containing a multitude of Geo-Files, the Geo-File list may become so overcrowded that it is cumbersome to navigate. For this case the program allows to filter all file names, descriptions and contained view ports contained in a project.

As a filter you can either show all files that contain the filter keyword in the file name or you use the file description to host the searchable keywords. If you filter via the file name the filter text "building" would find all Geo-Files, where a part of the file name is "building". If you filter via the description, using e.g. variant 1 as a key word finds all Geo-Files relevant for variant 1.

Click ✗ to terminate the filter definition and to view all Geo-Files again.

**New Situation / Edit Situationen**

Call the menu topic FILE -> OPEN SITUATION. On the screen you see the following box:

On the left side you see all situations of the project, on the right side the description and graphics preview of the highlighted situation.

Situations like Geo-Files can be duplicated, renamed or deleted. Invoke the function via the symbol icons the menu SITUATION or the right mouse button.
NEW generates a new empty situation which you need to name first and then assign Geo-Files (existing ones or new ones).

As soon as you click on the + the display changes. Instead of the situation information you now see the Geo-Files contained in the Situation. In the middle section of the box all Geo-Files of the project are displayed, on the right side is a description and the preview graphics, respective the file history.

Geo-Files contained in the Situation are printed in gray, once they are assigned to the situation, they cannot be assigned a second time to the same situation. In case you still want to assign the file again, you need to duplicate the file first and then assign it and modify it.

You can jointly move the assignment of Geo-Files to a Situation. To mark adjoining Geo-Files press the shift key and left click on the first and last Geo-File. Single Geo-Files are selected with Ctrl and left click.

With a double click on the Situation or the OK icon open the selected Situation.

In the Geo-Database user interface you not only can generate and activate additional Geo-Files but also can unassign the Geo-Files from the situation. Please observe that when you unassign a Geo-File it is always the Geo-File shown in the Geo-File selection picklist. In case you had made changes to the Geo-File you are unassigning, you will be asked if you want to store the data.

- Opens the Geo-File selection (new Geo-File/assign existing file)
- Unassigns the Geo-File "buildings 1" from the Situation.
- Stores the Geo-File "building 1".
- Stores the Geo-File "building 1" under a new name.
Data entry

SoundPLAN allows data entry in many different forms and ways depending on the format of your data. If you have physical plans you can either use a digitizing tablet or scan them and digitize on screen with the mouse. If your data are already in electronic form you can import them with the interfaces to external data (ArcView, DXF) or via the free programmable ASCII interface. In addition you can use a Digital Ground Model as the basis of the elevation model and can extract the elevations from it for each coordinate or place coordinates that were generated without elevation information on top of the DGM. Differences to the DGM can also be used to define the height of objects (tops of buildings from a special DGM can be use to set the building height

Digitizing mode

When coordinates are close together it often happens that the cursor homes in on an existing coordinate and changes into an arrow. As this is most of the time is not desirable when digitizing new objects, the Geo-Database offers an additional entry mode that does not home into other objects. Click on the red cross icon on the left side of the data entry area. The cursor changes into a crosshair cursor. It is not possible to edit the properties here. In this mode it is not possible however to edit the object attributes of already digitized coordinates, to do so you need to activate the default editing mode by clicking on the black cross icon.

Capture coordinates

You can capture coordinates that are already present in your situation. Capturing copies the location and elevation information, thus the coordinates are twice in your data set. The data are handled separate from one another so if one gets moved to a new location, the other one will not automatically move.

To capture a single coordinate right click on the coordinate and select -> CAPTURE COORDINATE (data entry mode - black cross). For multiple coordinates it is advisable to activate the digitizing mode and to right click on each of the coordinates. When a coordinate has been captured and the X, Y and Z component has been taken over there is a confirmation gong.

Hint: Identical coordinates are visible when you pull a „rubber band“ frame around it by moving the mouse with the right button pressed over it. The marking for double coordinates are canceling each other out so that the movement cursor becomes visible when you home in on the coordinate but the coordinate appears to be unmarked.

Digitizing from scanned maps (bitmaps)

Nowadays copy shops and blueprint printing facilities offer the service to scale even big A0 size plans. So it is becoming more and more popular to digitize the data off bitmaps rather than with a digitizing tablet as long as they are not available in digital form. Please keep in mind that the color depth of the bitmap should not too high and think about possibly reducing a color bit map to a gray scale one. The larger the
bitmap the more memory is consumed by it and the slower the processing speed. To work with scanned plans in SoundPLAN they need to be in the format *.bmp. If your bitmap is in any other format, you need to convert it in an external bitmap software into the bitmap format.

**Load Bitmap and enter the reference points**

Bitmaps, scanned plans, must be loaded into memory and then adapted to the world coordinate scale. Call **FUNDAMENTALS -> BITMAP -> LOAD** and open the scanned map. SoundPLAN loads the map and presents it in the reference coordinate entry screen.

With the magnifying glass you can enlarge/decrease the scale factor of the view port. Click on the symbol . Left click as long as the scale is still too big. With the right mouse button, you increase the scale factor of the map. When the scanned plan is larger than window move the plan with the scroll bars within the window.

For the entry of the reference coordinates click on the digitizing cross. The scale in a plane is fixed with 2 reference coordinates however it is advisable to use 3 reference coordinates. When more than 2 reference coordinates are used, the program will use a Helmert transformation to minimize the error that might be in the data from scanning the plan. The reference coordinates should be as far apart as possible and should encompass the study area as much as possible.

Enter the numerical value of the reference coordinates with the keyboard in the white fields and then click with the mouse on the coordinate in the graphics. To accurately enter the data even with a relative big scale, the first mouse click opens a zoom window with the coordinate in its center. Home in on the reference coordinate as accurately as possible and click again. Repeat this procedure with the other reference coordinates.
The standard deviation is computed if at least 3 reference coordinate pairs are entered. The standard deviation is the mean square deviation between the scales of all reference coordinate combinations.

The magnitude of the standard deviation decreases with the number of coordinate pairs and increases with the scale of the plan.

The standard deviation should not exceed:

<table>
<thead>
<tr>
<th>Scale</th>
<th>Standard Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:500</td>
<td>5</td>
</tr>
<tr>
<td>1:5000</td>
<td>20</td>
</tr>
<tr>
<td>1:10000</td>
<td>30</td>
</tr>
</tbody>
</table>

When the standard deviation is too high the reason could be:

- Entry not precise enough (activate the reference coordinates in the table and click on the coordinates on screen again).
- X and Y swapped (Correct the values in the table)

Press OK to leave the reference coordinate entry and start digitizing on screen. The reference coordinates are stored with the bitmap so the calibration of the map needs to be done only once for this project.

Data entry with bitmap basis

Select which object you want to digitize. When you click with the digitizing cross on a coordinate, a zoom window is opened where you now can more precisely enter the coordinate. Confirm the entry with another left click on the coordinate.

With the zoom window you can leave the view with a relative big scale. This has the advantage that you do not have to move the view port with the scroll bar. With zooming in more closely to the area, you can position the cursor first roughly and then pinpoint the coordinate in the zoom window. This saves time and the eyes.

The zoom window at data entry shows the original scale factor of the bitmap.

Working with multiple bitmaps

Projects may have multiple bitmaps however in the Geo-Database only a single bitmap can be open at a time. To make loading different already calibrated bitmaps
easier there is a new control on the screen next to the rotation control to select a bitmap and a click box to hide the bitmap. Additional controls allow the bitmap to be moved in small increments.

![Multi bitmap selection and move controls](image)

**Restrictions when working with bitmaps**

Certain restrictions are imposed when a bitmap is loaded on screen. Neither the 3D wire frame model nor the projections can be used while the bitmap is loaded. Rotating the screen was disabled because it would take too much calculation time to rectify rotated bitmaps on screen. While the bitmap is in memory the customary viewports are disabled.

**DXF interface**

The DXF-format definition is based on the AutoCAD DXF Version 11/12 (AC1009). This little bit older standard is supported by many graphics and cad programs so that it is the most widely used interface format to GIS and graphics programs.

**Tip:** If you receive data from external sources that SoundPLAN has problems interpreting, ask the source of your data to store the data in the format of AutoCAD 11/12. This way you can make sure that objects all objects will be interpreted correctly.

The geometry (X, Y, Z coordinate) from the DXF file is imported as general point, line and area information. The actual object type is not known.

To efficiently work with DXF data it is paramount that you know the organization of the data in the DXF file.

In AutoCAD layers are generated and attributes are assigned to the data. Knowledge of the layers in the file, the naming convention and eventually a description of the layers (layer list) is important for the distribution of the incoming data to SoundPLAN object types. In AutoCAD there is no fixed naming convention for the layers, so it is advisable to get information about the layer names from the data supplier. The least amount of work you have with importing the data if the supplier of the data only exported the data you need, however in praxis this will be seldom the case.

Call **FILE -> IMPORT -> DXF** and load the DXF-file. The layer list is generated from the content of the file and is shown on screen.
DXF-Import layer list

By default all layers marked with a green hook are imported and are written into permanent DXF Geo-Files. You can now click on ok to load the data and display them on screen.

Layers you do not want to import you deactivate with a double click on the green mark. With the menu SELECT ALL or INVERT SELECTION customize your selection.

The layer can be imported either into temporary or permanent Geo-Files depending on the selection LOAD AS TEMPORARY GEO-FILES or LOAD AS PERMANENT GEO-FILES. Temporary Geo-Files (TMP_LAYERNAME) are only stored after they have been assigned to user defined Geo-Files, SoundPLAN ignores the temporary data when saving the Situation. Permanently imported Layer (DXF_LAYERNAME) are always stored in the Situation.

When importing DXF data without knowing the content and structure of the file, it is advisable to import all data into temporary Geo-Files and then to select the view to look at the data Geo-File by Geo-File (VIEW -> CURRENT GEO-FILE). By scrolling through the list of Geo-Files you see the content of each file as a graphics on screen. If you discover that you only need the data from a few Geo-Files, you can scroll to the temporary Geo-File, mark the data and then move the data to a different Geo-File with EDIT -> CHANGE ASSIGNED GEO-FILE. You do not need to delete the other temporary Geo-Files, when you close the situation, the temporary Geo-Files are discarded. If you need most of the data from the DXF file in multiple layers it may be faster to import the data again, this time into PERMANENT GEO-FILES.

**You see how important the data preparation is!**

The following objects are imported, some of them with additional attributes and functions:
Coordinates with the elevation equal to zero can be ignored when importing.

Individual line elements are connected to polylines when the setting CONNECT LINES is activated. Several lines are connected to polylines if the end coordinate of one line is identical to the begin coordinate of the following line. The lines must be adjacent in the data file to one another for this function to work.

Circles and arcs are transformed into polylines. For the conversion you can set the density of coordinates in the polyline to low, middle and high.

Texts are imported as Geometry texts which you can assign sizes at import time.

Furthermore there is the possibility to directly convert texts into spot heights. Often the DXF file is not 3 dimensional but the heights are written on the plan as a text. With the setting IMPORT AS SPOT HEIGHT you convert the text into the Z part of a coordinate. When activating this setting make sure that you only import the layers where the elevation information is hosted, the data would become unusable if the property numbers or the address of a building would be converted into the elevation information.

With the COORDINATE TRANSFORMATION reference coordinates from a local DXF-scale can be transformed into the world coordinate system SoundPLAN uses. You need to read the coordinate twice, once to locate the local coordinates of the reference coordinates and the second time to assign the coordinates to the reference points. Select 3 or 4 reference points that you can identify in the local coordinate system and in the world coordinate system. The reference coordinates should be apart as far as possible to minimize potential coordinate errors. SoundPLAN uses the Helmert transformation to convert coordinates from the local into the world coordinate system. SoundPLAN stores the coordinates, so that you must execute the coordinate transformation only once per project.

With pressing the ok button, the DXF-data are imported and converted into SoundPLAN unspecified objects of the type point, line, area and texts. Edit the
data with the functions "Convert object type" page99 and "Change Geo-File-assignment" page 99.

**DXF-Export**

Situations from the Geo-Database can be exported into DXF files. Select the menu **FILE -> EXPORT -> DXF**. SoundPLAN exports the geometry data contained in the situation with the name of the Situation as the filename for example a Situation „Analysis“ would be exported into the DXF file ANALYSIS.DXF. The layers in the file are named after the object types used in SoundPLAN. The file is written into the project subdirectory.

**Import of SoundPLAN DOS (V4.2) data**

Old data generated from the SoundPLAN DOS version 4.0 and newer can be imported directly into the Geo-Database. Select **FILE -> IMPORT -> SOUNDPLAN DOS**.

In the entry screen first select the path to your DOS data in the right field and then select from the pick list the data type you want to import. The available files are in the right field. When you mark a file, the first comment lines of the DOS files are printed in the info box. Mark the files you want to import by left clicking, multiple successive files are marked with shift+ left click and multiple single files with Ctrl+ left click. Press OK to import the data.

The following object types are converted from the DOS format to the Windows version, some of the object properties have changed and many properties are new, others do not have an equivalent under Windows:

- **Road alignments** - The emission level is calculated and the width of the traffic lanes are assigned to the new object.
- **Railway lines** - Only the geometry is imported, the emission level needs to be recomputed.
- **Industrial noise sources** - Only the geometry is imported, all other object properties need to be redefined.
- **Buildings** - are imported with the geometry and properties, however the area usage needs to be defined.
- Receivers - are imported with geometry and property but without the assignment of the area usage. When receivers are located at buildings, the assignment of the receiver to a specific building must be redone.
- **Elevation lines, spot heights, calculation area** - are imported completely, no attributes needed.
- **Mitigation areas** - are imported with geometry and attributes
- **Noise screens** - are interpreted as noise protection walls and the properties are assigned.
- **Ground effect** - is imported with geometry and properties.
ArcView-Interface

Via the ArcView interface Shape files from GIS software can be imported into SoundPLAN, the file can only contain data from a single object type but hosts coordinates and descriptive attributes.

Rather than creating temporary Geo-Files, the interface is loading the data directly into a Geo-File of your choice with the correct data type and the correctly set attributes.

Invoke the import via FILE -> IMPORT -> ESRI SHAPEFILE:

Define, to where (object type and Geo-File) and how (assignment of columns from the source file to the imported to the SoundPLAN objects.

OBJECT TYPE AND GEO-FILE: Select the object type and select the Geo-File into which the data are to be imported. It is also possible to create a new Geo-File. With the switch DEFINE STANDARD PROPERTIES you can define the default properties for all attributes that are not explicitly defined in the Shapefile. The assignment of the standard object properties are activated when all data are in the entry menu are defined and you are starting the import by pressing on the CONTINUE button.

FILTER DEFINITION AND OBJECT TYPE PROPERTIES: The SOURCE FIELD shows the column headers from the shape file. In the column TARGET FIELD all fields of the respective SoundPLAN object type are listed. You can assign the connection from source to target field with a double click or the arrow key. Click on the CONTINUE button to import the file and, if clicked, invoke the standard property dialog.

You can import further properties or update already imported properties for existing objects via a SEARCH KEY.

Example: You have imported buildings without information on the building height. Afterwards you receive data with building heights. Assign the column identifying the objects (e.g. name or object ID) and the new properties. Double clicking the identifier defines the search key and displays it in red. Proceeding the import will change the building height, all other properties remain unchanged.

ArcView Export

Define for the Export to ESRI shape files which properties shall be exported in addition to the coordinates. Enter the name of the folder, in which the exported shape files shall be written, the default setting is the name of the situation.

In a tree structure all object types contained in the situation are listed, for each object type all in SoundPLAN entered attributes are listed as the next level. By double clicking on the object or clicking on the object „+“ sign the tree structure is opened up and displays all details.
Double clicking on an attribute assures that this parameter will be exported. The objects and attributes defined for the export are displayed in the window on the right hand side.

Field names in the Shape files can only be 10 characters long. As SoundPLAN truncates the names the identifiers can become unreadable. Press F2 to enter a meaningful label but observe that neither spaces nor special characters may be part of the label.

You can store and load the selections and settings either for the project or in the global context.

**LIMA BNA-interface**

The LIMA BNA interface automatically imports the data and assigns the appropriate object properties. With the standard Geo-File menu select the Geo-File where you want the data to be imported and set the object type to the type you want to import and then call the import menu with FILE -> IMPORT -> LIMA BNA. The attributes are imported as much as possible, however with some objects like roads the emission level is imported but not the parameters that are used in the computation of the emission level.

**ASCII- interface**

With the ASCII interface you can import ASCII data (*.ASC, *.CSV, *.TXT,) and ASCII exported SoundPLAN DOS data (coordinates + attributes) into SoundPLAN. As soon as attributes are contained in the same file the import file must be restricted to a single object type. As soon as attributes are contained in the same file the import file must be restricted to a single object type.

Rather than creating temporary Geo-Files, the interface is loading the data directly into a Geo-File of your choice with the correct data type and the correctly set attributes.
Call the import with FILE -> IMPORT -> ASCII-FORMAT and answer the entry fields:

**FILE:** Enter the path to your file here.

**FIXED COLUMN WIDTH / FIELD SEPARATOR:** Data can be imported from files where the they have been written either with a fixed format or the program can separate the format into columns with the help of field separators contained in the text (either semicolon, TAB, blanc or a user selected sign). If you are unsure of the file format import it and see what is in the file. The first lines of the file are shown in the file preview window. With fixed column width you need to define what is in which column by moving the slider to the left or right for each column. For files stored with field separators select one of the predefined choices or enter the appropriate field separator.

**IMPORT STARTING FROM LINE:** determines how many lines of file header are not interpreted as regular data. It is important to keep in mind:

**FIRST LINE CONTAINS THE COLUMN HEADERS:** sets the operation to expect the first line of the file to contain the column descriptions. The table header is important for the correct assignment of the data.

**OBJECT SEPARATOR:** Here you select how different objects are separated. It can be done either with an EMPTY LINE line or a single other character or a sequence of characters (LINE BEGINS WITH SUBSTRING). When the procedure with the substring is selected, enter the string in the box next to the selection.

**COMMENT LINES BEGIN WITH:** Defines how comment and text lines are marked so that they are filtered out (for example ‘*’ for SoundPLAN DOS Import)

With NEXT the box for the FILTER DEFINITION opens.

Define, to where (object type and Geo-File) and how (assignment of columns from the source file to the imported to the SoundPLAN objects.

**OBJECT TYPE AND GEO-FILE:** Select the object type and select the Geo-File into which the data are to be imported. It is also possible to create a new Geo-File. With the switch DEFINE STANDARD PROPERTIES you assign the default settings to the data that are not defined by the object on file itself. The assignment of the standard object properties are activated when all data are in the entry menu are defined and you are starting the import by pressing on the CONTINUE button.

**FILTER DEFINITION AND OBJECT TYPE-PROPERTIES:** If all settings in the format menu are correct, the column headers from the imported file are presented in the SOURCE FIELD. In the column TARGET FIELD all fields of the respective SoundPLAN object type are listed. You can assign the connection from source to target field with a double click or the small arrows.

<table>
<thead>
<tr>
<th>Source Field</th>
<th>Target Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>x</td>
</tr>
<tr>
<td>Y</td>
<td>y</td>
</tr>
<tr>
<td>H</td>
<td>h1</td>
</tr>
<tr>
<td>TE</td>
<td>h2</td>
</tr>
<tr>
<td>Signal</td>
<td>no import</td>
</tr>
</tbody>
</table>
Click on the CONTINUE button to import the file and, if clicked, invoke the standard property dialog.

You can import further properties or update already imported properties for existing objects via a SEARCH KEY.

Example: You have imported buildings without information on the building height. Afterwards you receive data with building heights. Assign the column identifying the objects (e.g. name or object ID) and the new properties. Double clicking the identifier defines the search key and displays it in red. Proceeding the import will change the building height, all other properties remain unchanged.

**CARD/1 and Stratis Interface**

Select FILE -> IMPORT -> CARD/ Stratis (German road planning software.)

As the exporting programs have a dedicated SoundPLAN export interface, the data are already assembled to import an entire project in the correct format for SoundPLAN. The object types are assigned automatically but you still must define some of the object properties in the edit object properties menu.

---

**Use elevations from a Digital Ground Model**

If you import terrain information or have already digitized elevation lines and spot heights, start a calculation run to generate a digital ground model (DGM). This DGM then will be the basis of the elevation generation when digitizing new objects. In case a DGM was generated using the tops of buildings or noise screens, the attributes of the building height and the height of noise protection walls can be derived from the DGM.

This way you for example can first digitize the elevation lines and spot heights in your project and then set all elevations later on as relative elevations, relative to the DGM.

Procedure: Digitize first all elevation relevant data or import the elevation data from file.

Open the calculation core now and generate a new calculation run (if the project does not already have a run file a new run file is first automatically created). Double click on the cell „name‘ to open the calculation run definitions.
Define calculation run

Select the calculation run type for **DIGITAL GROUND MODEL** and via a click on the double arrow in the field „data“ open the file selection and define which file contains your elevation information which you want to triangulate. In the field for the result data file enter the number for the result file and store the calculation definition by clicking on the OK button. Start the calculation by clicking on the green arrow above the calculation table header.

Switch to the Geo-Database and open the DGM with the menu entry **BASIC DATA -> DGM -> LOAD**. In the menu View customize the appearance of the DGM on screen.

**DGM ELEVATIONS** shows the elevation of the current cursor position is presented in the status line of the Geo-Database screen. The (+) and (-) sign indicates if the elevations in the path or the cursor movement is increasing or decreasing. When you activate the **DGM TRIANGLES** all triangles are presented in light gray on screen. DGM border shows the outer edge of the DGM. For the entry of the geometry the
best way is to activate the DGM BORDER and deactivate the DGM TRIANGLES, this gives you the best overview of the screen.

You can place both the DGM and a bitmap into the background of the Geo-Database screen.

**Assignment of terrain elevations to Objects**

Data that are only available in 2 dimensions can be easily set to the terrain elevations with the coordinate function.

![Coordinate function](image)

*Coordinate function: Referencing object elevations to the DGM*

Mark the objects you want to define and then select **EDIT -> COORDINATE FUNCTION** and set the parameter for h1=DGM. Click on **EXECUTE**. The screen remains active so that you can set the elevation of the object (h2) without starting from the beginning. Enter the parameter h2 and set it =DGM. With **OK** execute and leave this function. For buildings the elevation h1 is defined as the building reference elevation (most of the time the elevation of the ground floor). The building reference elevation is the same for the entire building, the values of all coordinates of the building are averaged and assigned to all coordinates of the building.

**Hint:** The coordinate function only allows a single operation at a time. In order to set the building reference plane to half a meter above the ground, first the elevation h1 must be set to the terrain elevation h1=DGM and then in a second step the elevation is increased by half a meter with h1+0,5.

**Computing the object height from imported photogrammetry DGMs**

In the processing of aerial photography data the files can contain the tops of buildings and the tops of noise protection walls. A SoundPLAN GeoTool calculates the wall height by evaluating the tops of the object with the elevation found in the DGM. A SoundPLAN GeoTool calculates the heights of the objects by overlaying the DGM over the terrain elevations and storing the difference as the objects height. The results are averaged and assigned to the parameter of wall/building height.

Mark the objects and select **GEOTOOLS -> CALC. OBJECT HEIGHT FORM DGM**. View the results in the 3D view or side projection.
Zoom Mode and Viewport administration

Using the coordinate range of the input data, SoundPLAN generates a viewport called TOTAL VIEW. At any time you can generate and store additional viewports. When the overview is active you see all available viewports as black frames with a little black square in the top left hand corner.

In the zoom mode you define views, store the viewports or enlarge or zoom in to them.

Select the magnifying glass icon on the left border of the screen, position the cursor in the upper left hand corner of the window you want to generate, press the left mouse button and pull a “rubber band” around the area you want to enlarge.

Reset viewport to "total view":

When opening the Geo-Database, the size in the field ZOOM is set to 100%. In the field INC select the factor by which you want to scale the viewport up and down. The default setting is 50 meaning that the view is zoomed in/out by 50%. You can change the viewport step by step by clicking on the arrows or by left clicking (enlarge) or right click (shrink). Other controls are the arrow keys on the keyboard with enlargement up and shrinking down. Clicking on the switch the view is switched to the overview.

At present the screen only can handle a maximum zoom factor of 3350%. If you want to zoom in further, please store this view as a viewport and select it, this procedure will regenerate the screen with a zoom factor of 100%.

Object zoom

When you want to zoom a specific object to the maximal size, the object zoom is the suitable tool. Select the magnifying glass cursor and hold the ALT key pressed. The magnifying glass cursor has an additional mark with the letters OBJ as soon as the cursor is within the reach of an object. Clicking the left mouse button will enlarge the object to maximal size with the scale factor set to 100% so that you can zoom in further. If multiple objects are found in the search radius a selection list is displayed from which you can pick the correct object.

Storing viewports

When you want to store a detail as a repeatable viewport, zoom and move to the desired settings and store the viewport with SAVE CURRENT VIEWPORT and enter a name for the view.

The stored viewports are not part of the situation but of the project. Therefore the viewports are displayed with each situation in a project. You can hide the viewports clicking on VIEW -> VIEW VIEWPORTS to deselect it.

When you want to recall a viewport to screen, either click in the overview window on the little square in the top left hand corner of a viewport or select the viewport by name from the viewport list.
Editing the data

After initially entering or importing the data, the objects need to be further defined and corrected. SoundPLAN offers many different editing tools. The editing tools are located in the menus **EDIT** and **GEOTOOLS**. Some of the functions have a redundant access through the right mouse button. In all cases where the editing function is not triggered through the right mouse button, the object needs to be marked before the editing can take place.

### The edit mode

In the edit mode, existing coordinates or their properties are opened for editing by moving the cursor to the coordinate dot. When the cursor is within the catch radius of the coordinate, the appearance changes from the original crosshair cursor to into an arrow.

For editing your data, it is a good advice to activate the object dots.

### Selection arrow

The arrow cursor is important for editing the data. When the cursor comes close to a coordinate, the shape of the cursor changes from the edit cross to the selection arrow.

Define the distance to the coordinate, in which the cursor changes to the selection arrow in **OPTIONS -> SEARCH RADIUS=X**. The default setting of the search radius is 5 pixels.

Often more than one object is found within the search radius. In this case a list is presented with all objects found to select the appropriate object. When you select an object in the list, the current object is highlighted, which makes it easier to find the desired object.
Selection list of objects found

The object selection list shows object type, object name and object ID. During the entry or the import in the GeoDatabase the object ID is generated automatically in ascending order. If you copy objects, the objects will lie on top of each other. The higher object ID identifies the copied object.

As soon as the selection arrow appears, the status line will present the coordinates and elevations of the coordinate.

By left clicking you open the property dialog of the object (as long as the object type has properties), with right clicking you open a properties and options editing dialog.

Properties and coordinates editing dialog

(Right mouse button) This menu option shows the object type, object number, the coordinates and elevations in the status line. With this function you can edit the x, y coordinates and both (terrain and object) elevations. The second elevation is only present when the object type requires separate terrain and object elevations. Use the selection arrows to step through the list of coordinates and check the elevations.

Caution, clicking on the icon deletes the coordinate without further confirm dialog.

Navigation arrows

With the arrow icons you move in the object properties edit function from one object to the next/last object of the same object type.

You can activate additional object information in the VIEW menu:
VIEW -> GEO-FILE: Shows the Geo-File that the object is assigned to. The assignment can be modified via a pick list of Geo-Files.

VIEW -> GRAPHICS-OBJECT TYPE: Each object has a graphics object type to display it in the graphics section of SoundPLAN. If your license contains the module for Cartography, you can define your own graphics object types and thus influence how the object appears in the graphics modules. At present only the number of the graphics object type is shown here but in the future this will be extended to edit the graphics object type here.

VIEW -> PROPERTIES: Coordinates that contain properties will show a summary or all parameters in the property information field. The properties are grouped in blocks that are organized in a tree structure. With the black cross you can delete individual blocks of properties, with the red cross you delete all properties on an object.

Some properties, for example "calculate emissions" for roads and railway lines are switches that can be activated and deactivated. Here "0" means deactivated and "1" means activated. Properties of existing data objects cannot be accessed in this mode.

**Undo**

Use EDIT -> UNDO (Ctrl+ Z) to cancel changes for coordinates and property definition until you stored the situation. The action for "undo" is included in the menu.
Activate objects

If you want to amend an object by adding or inserting coordinates, you must first activate the object. With the right mouse button select -> ACTIVATE OBJECT. You see that the coordinates already entered, the start arrow and the last coordinate now appears in red. You only can continue digitizing at the last coordinate of a string. If you want to add coordinates at the beginning of the string, you first need to change the data entry direction.

Select (mark) points or objects

Already existing objects and object coordinates often need to be marked in order to edit them. Some of the Geotools refer to all objects visible on the screen if no objects are selected (marked).

if you only want to edit a particular object, many editing steps can be also directly invoked by right clicking on the object and selecting the editing option from the menu.

Under VIEW -> SELECTED OBJECTS (F3) you can show only objects that are selected. Marking objects always is in reference to the data shown on screen. To limit the selection use the filter options in the VIEW menu.

To mark objects there are several options that can be used alone or in combination:

Select objects with the right mouse button

Click the right mouse button on an object and select the menu entry SELECT POINT or SELECT OBJECT. Multiple coordinates in a row (for example of a noise protection wall with zero wall height after dimensioning the wall) you activate by holding the Alt-key pressed, with the Ctrl-key pressed you can activate multiple not adjacent coordinates. When multiple objects are within the search radius, first select the appropriate object from the pick list.

To mark multiple objects or all objects in an area, click with the mouse on the top left hand corner of the area and hold the left mouse button down while moving over the area where you want to mark the coordinates. All objects touching the activation rectangle are marked. If you hold down the Ctrl-key, you can repeatedly activate areas with all objects of subsequent swipes marked.

Select objects with the Alt + left mouse button

Objects can also be activated with the Alt+ left mouse button by clicking on the object of choice. To activate additional objects hold the Ctrl-key pressed. For area type objects the correct object type must be selected. With an additional click (with the Alt and Ctrl-keys still pressed) you unmark the object.

Select all objects

EDIT -> SELECT ALL OBJECTS CTRL+ A, selects all objects loaded. If you want to mark all objects fitting a filter first filter out the objects with VIEW -> CURRENT OBJECT TYPE or VIEW -> CURRENT GEO-FILE and then select all objects.
Select objects via a line or an area

Mark a line or area and invoke the menu EDIT -> SELECT OBJECTS VIA AREA OR LINE to mark all objects that are intersected by the line or are inside the area. You can either use an existing object or generate an auxiliary line or polygon. The line or area object if it is marked in the process will remain marked and thus can be deleted later on. If you do not want to delete the object used to mark the others undo the marking with Alt+ Ctrl+ left click on the object before you delete all marked objects.

This function too is applied to all visible data, so use the filter possibilities in VIEW -> CURRENT OBJECT TYPE or VIEW -> CURRENT GEO-FILE to show only certain objects.

Invert the selection

The function EDIT -> INVERT SELECTION to unmark all previously marked objects and mark all previously unmarked objects. This is an easy option to crop data that were imported and are exceeding the scope of the study. Generate a polygon around the area you want to keep, mark the coordinates in the area with SELECT OBJECTS VIA AREA OR LINE and then invert the marking to select all data outside the polygon.

Selecting objects via the attributes

If you want to mark all objects of the same object type and common properties, open menu EDIT -> SELECT WITH ATTRIBUTES.

To define the criteria the relationship operators <, >, =, <=, >= and * (part) can be used. Select the object type and the attribute for the selection. Use the criterion * to find all objects of one object type with a common part in one of the properties.

When the attribute has the addition named index or ID, you cannot directly use the name but first find the reference number for the name and then use the index number or the number of a library element. Internally often there are references in the database rather than the full object attributes.

Example:

The index No. of the area usage in buildings, receivers and usage area definitions is in reference to the sequence in the area definition list of the object type (0 = not defined, 2 = general area, 4 = mixed residential and small business, 7 = general residential etc.)

Properties that are assigned from the library (source spectra, absorption spectra, day histograms etc.) reference the library via the number of the element in the project
library. The element number is always presented in the library when you move the mouse over the element name.

**Select objects with elevation <= [m]**

The GeoTool **SELECT OBJECTS WITH ELEVATION <= [M]** is a tool to find and select objects with an elevation smaller than the entered value. This tool is especially interesting for data that were imported without elevation information. Delete the selected objects or use a DGM to provide the elevation information.

Tip: If you import DXF data, you can ignore coordinates without elevation information during the import.

**Select objects with length <= [m]**

**SELECT OBJECTS WITH LENGTH <= [M]** marks all line objects that have a length smaller than a threshold value.

**Select objects with an area <= [m²]**

With this GeoTool **SELECT OBJECTS WITH AN AREA <= [M²]** auxiliary buildings like garages can be identified and selected. This tool is useful to make sure that Facade-Noise-Maps do not include buildings where no residents will live. The auxiliary buildings once marked can be transferred into a Geo-File of their own.

**Clear selection**

Unmark selected objects with **EDIT -> CLEAR SELECTION**, the menu on the right mouse button or by moving the mouse cursor to the lower right hand of the entry screen, and moving the mouse with the right button pressed to the top left position.

**Delete points or objects**

Move the cursor to the point you want to delete until the cursor changes from the crosshair into the arrow. Right click and select **DELETE POINT** or **DELETE OBJECT**.

To delete points and objects with the right mouse button, the coordinates do not need to be selected.

Selected objects are deleted with **EDIT -> DELETE (CTRL+ DEL)**.

**Insert a point**

If you want to insert a coordinate into an already existing object, select the coordinate in front (in data entry direction), press the right mouse button and select the menu entry **INSERT POINT AFTER**. The new coordinate is generated in the middle between the selected coordinate and the next one. The elevation is interpolated between the 2 bordering coordinates and the point is marked so that you can move it to the correct position.

**Move point**

When a point or an object is selected, the cursor changes into the movement when you are getting in range or the search radius around the point.
**Movement cursor**

The point now can be freely moved to a new position. Even if the entire object is marked, only the single point is moved where the cursor is positioned. If you keep the **right mouse button** pressed, you can move a point to identical coordinates of an existing point. When you release the right mouse button and the cursor is close enough to the new position, the new coordinate is assumed with x, y and elevations, if you were not close enough, the point reverts to the original position.

**Graphics-Object type**

If you have access to the module Cartography, you can assign object types that you created through the options menu of the SoundPLAN Manager to Geo-Database objects. The freely defined objects must reside in the projects object setup. The presentation of the object according to the object design is only done in the Graphics, not in the Geo-Database. Select the objects you want to process and execute **EDIT -> GRAPHIC-OBJECT TYPE**. In the list you find all possible variations for the selected graphics object type. Select the Graphics object type, store the situation and then view it in the Graphics. A single object can be assigned a Graphics Object Type by right clicking and then executing **GRAPHICS -OBJECT TYPE**.

**Hint:** For buildings the Graphics object type is also responsible for distinguishing between main and auxiliary buildings.

**Split objects**

Use this function to split an object into 2 separate objects. Right click on the point where the new object should start and object invoke the function **ENHANCED FUNCTIONS -> SPLIT OBJECT**. If the object dots are activated, you will see that the attribute definition mark is repeated at the beginning of the new object and that the new object has between the first and second coordinate a new direction arrow.

**Invert entry direction**

Sometimes it is necessary to change the entry direction of a line object (for example when you want to add coordinates at the beginning of the line). Another use of this facility is to uniform the entry of buildings so that the documentation provides a better overview. Trigger the function with right clicking and **ENHANCED FUNCTIONS -> CHANGE INPUT DIRECTION**. Some properties cannot be assigned correctly when changing the entry direction. If this is the case, SoundPLAN will issue a warning message.

For industrial buildings the entry direction is automatically adjusted to have the entry of the coordinates in a counter clockwise direction.
Change Geo-File-assignment

Select the objects you want to move into another Geo-File, invoke the menu **EDIT -> CHANGE ASSIGNED GEO-FILE** (or click the right mouse button in an area where you do not home in on another existing coordinate). All Geo-Files present in the situation are listed in the selection box. When storing your data next, all objects that were selected are removed from the old Geo-File and are moved to the newly assigned one.

![Change Geo-File](image)

*Change assigned Geo-File*

With right clicking on a single object and selecting the function **ENHANCED FUNCTIONS -> CHANGE ASSIGNED GEO-FILE** you can move this object to the Geo-File currently displayed in the box of the active Geo-File. No further file selection is triggered here. Or open right mouse menu -> **EDIT OBJECT PROPERTIES** and select another Geo-File included in the Situation.

**Convert object type**

Select the objects you want to convert and trigger the function **EDIT -> CONVERT OBJECT TYPE** (or right click at a place where you do not home in to another coordinate) and select the new object type from the pick list.

![Convert object type](image)

*Convert object type*

If the object in the existing object type has defined attributes they will be lost when converting to the new object type. If this is the case SoundPLAN will give you a warning.

The convert function can also be triggered with a right click and the selection of function **ENHANCED FUNCTIONS -> CONVERT OBJECT TYPE**. In this case the object type will automatically change to the object type that is currently active in the object type selection bar, no further selection pick list is shown. No further file selection is triggered here.

**Coordinate functions**

With the coordinate functions you can modify the x and y coordinates and, which is more likely, the object and terrain elevations for one or multiple objects at the same time.
time. Select the objects and trigger the function EDIT -> COORDINATE OPERATIONS (or right click in an area where you do not activate another coordinate). In the selection box select the parameter that should be modified x, y, h1 or h2 (h1 is the default setting), in the field below enter the function you want to use for example +0,5 or =125.

In rare cases it your data may be stored with y, x instead of x, y coordinates. In this case you must swap the x and y coordinates via the "Coordinate Transformation" on page 108.

Coordinate functions

The following operations are possible:

- Set equal to (=)
- Add (+)
- Subtract (-)
- Multiply (*)
- Divide by (/)
- For h1 the function =h2 is also possible
- For h1 and h2 the function =DGM will set the coordinates to a digital ground model if one is loaded in memory and the coordinate is within the area of the DGM. See "Use elevations from a Digital Ground Model" on page 88.

Attribute operations

Attribute operations are used to modify the properties of attributes associated with a single object type for one or many objects at the same time. Not all (especially the complex attributes) can be edited this way, for some object types there are no attribute functions. Up to now the attribute operations do not allow to edit all properties of all object types. Attributes that were calculated or are derived from the library cannot be set with this function.

Select the object type from the symbol bar or via the pick list. Now SoundPLAN knows which attributes you will be able to choose from for the selected object type.

Select the objects you want to modify and trigger the function EDIT -> ATTRIBUTE OPERATIONS (or right click on an area where the cursor will not snap to a coordinate). Select the attribute from the pick list and enter the desired operation in the field below. For example +3, =102,5 or =Mainstreet.
The following functions are possible:

- Set equal to (=)
- Add (+)
- Subtract (-)
- Multiply (*)
- Divide by (/)

For texts only the set equal to is possible (=).

Hint for attributes organized in a selection list: Use the sequence number in the selection list (0 first item, 1 second item...). For example the area usage in the building properties or receiver properties is referenced to the index number in the table rather than to the identifier (so that you can customize the identifier to your needs). Use the sequence number in the list (0 = not defined, 2 = general area, 4 = mixed residential and small business, 7 = general residential etc.). For library elements use the element number of the library element.

Hint: Main buildings are converted into auxiliary buildings with the function EDIT -> GRAPHICS OBJECT TYPE.

In the attribute operations you can reference to fields in the same attribute block. The operand must be enclosed in square brackets "[]". This way for example you can copy the noise level in the road emission from one time slice to another one.

This function is necessary for guidelines, that are only delivered with 3 time slices (e.g. StL 97 Switzerland), and entered (not calculated) emissions day / night have been updated to the time slices day / evening instead of day / night.
Search for an object known by its ID number

In the logbook of the SoundPLAN calculation core the warning and error messages are sometimes indicating that a particular object in a situation/Geo-File has a problem. (For example "Road attributes of road #1793 are missing"). The search function helps to find the object with the ID that is listed in the error message. Select EDIT -> SEARCH OBJECT and enter the object ID number (or right click on an area where the cursor will not snap to a coordinate). The data on screen are redrawn in a way that shows the maximum size of the searched object, the last coordinate of the object is marked with a red circle.

To continue digitizing the existing object, it must be selected. In this case it is probably easier to right click on the object and then select the SELECT OBJECT function.

Copy object

Select the object you want to copy into another Geo-File and invoke the function EDIT -> COPY OBJECT. In contrast to the function "Change Geo-File assignment" a new object is generated here.

GeoTools for (marked) selected line objects

Some GeoTools are explicitly working only on line type objects when they are selected. The menu options are only shown when the object has been selected (marked).

Filter coordinates

When you have imported external data, that were created for the most part for different purposes than for a noise calculation, the data often are too detailed to be used as they are. The amount of data included in a calculation has great influence on the calculation time. To optimize the calculation time it is wise to thin the data where they are excessively detailed.
Select the objects and invoke the function GEOTOOLS -> POLYLINE -> FILTER. Enter the filter width and click the OK button. The coordinates selected, for the filter width of 2 meters as in the above example, are all within a zone of 2 meters left and 2 meters right between existing, unselected coordinated. Elevation differences are not considered in the selection. Delete the selected coordinates with CTRL+DEL or EDIT -> DELETE.

**Interpolation -> n points per segments**

The line must at least contain 3 coordinates. SoundPLAN inserts the number of coordinates you requested in a 3 dimensional spline, the already existing coordinates will not be modified. Trigger the function GEOTOOLS -> LINIE -> INTERPOLATION -> CREATE N POINTS EACH SEGMENT and enter the desired number of intermediate coordinates. The interpolated coordinates are selected and the terrain elevation is set to zero. The picture above shows the result in the projection.

**Interpolation -> constant segment size**

The line must at least contain 3 coordinates. SoundPLAN inserts coordinates on a 3 dimensional spline in the spacing you requested. The existing coordinates remain
unchanged. Invoke the function with GEOTOOLS -> LINE -> INTERPOLATION -> CREATE SEGMENTS WITH CONST. DISTANCE IN [M] and enter the desired spacing or coordinates along the line in [m]. The spacing may not be smaller than the closest distance of coordinates of the line. The interpolated coordinates are selected and the terrain elevation is set to zero. The picture above shows the result in the projection.

**Interpolation -> Create a point in a defined distance**

Coordinates are connected with straight lines, which will result in a light error of road length in curved roads and railway lines. This tool inserts a coordinate in a selected distance from the start of the line. The distance is calculated using a 3 dimensional spline rather than the straight line connections so the distance from the start coordinate is very accurate. The line must at least contain 3 coordinates. Trigger the function with GEOTOOLS -> LINE -> INTERPOLATION -> CREATE POINT WITH DEFINED DISTANCE TO THE FIRST POINT The interpolated coordinate is selected and the terrain elevation of the new coordinate is set to 0.

**Smooth elevations**

When the digital ground model was inaccurate it will happen that some of the road sections show jumps in elevations that will exceed the allowable limits for roads and will cause excessive road incline additions in the emission calculations.

The elevations of the existing coordinates are moved in and iterative way so that it does not result in a systematic error.

Open GEOTOOLS -> LINE -> SMOOTH ELEVATIONS and enter the number of iterations. The terrain elevations will remain unchanged. As the coordinates remain marked, you can view the results afterwards and if needed run additional iterations.

This function is also very useful to smooth a road that shall be used as an animation track for the 3D-Graphics.

**Divide sections**

Lines and areas can be divided into smaller sections so that noise protection walls or facades of buildings can be structured more.
Trigger GEOTOOLS -> LINE -> DIVIDE SECTIONS and enter the new distance between points in [m]. The elevation of the new coordinates is interpolated. The existing points are remaining, if the requested distance is smaller than the min distance, no further coordinate is inserted.

Create a buffer

For line type objects you can generate buffers that are made by drawing a parallel to the existing line to the left and another one to the right and generating an area out of the new lines. This way you generate an area around your line type object for example to select and eliminate elevation lines in this area later with the GeoTool CREATE INTERSECTIONS AND SPLIT.

Invoke GEOTOOLS -> CREATE A BUFFER and enter the distance between the line around which you want to create a buffer and the outer edge of the buffer (for example enter 4.5m if you want to create a buffer with a width of 9 meters).

Create intersections and split

If you want to split the lines and cut them so that the buffer remains free of the line, use this GeoTool. It generates points along the marked intersection line and splits the objects. The area itself and the objects within are marked so that both are deleted when you hit the Ctrl + Del. When inserting cutting points along a line, the cutting line will remain selected.

Procedure with the example of an area, the functions are the same as with the line. You can either use an existing area or digitize an auxiliary polygon. Select the area and trigger GEOTOOLS -> CREATE INTERSECTIONS AND SPLIT.

The start arrows indicate that the elevation lines within the area now are objects of their own and are also selected. With Ctrl + Del the elevation lines in the area are delete. If the original area (that was used to mark and split the elevation lines) shall not be deleted, eliminate the mark with a Alt + Ctrl left click on the area. Be aware that the object type for the area must be the currently selected type!

Another option to generate the cutting polygon is via the GeoTool CREATE BUFFER. The pictures below present the results (on the right side the cutting polygon was retained, on the left the cutting polygon was deleted as well):
Intersections with the terrain

A line can be fit into the terrain in such a way that all intersections with objects containing elevation information will be defined in their elevations. If the object and the terrain elevation differ, the terrain elevation will be used. The terrain elevation of the cutting line will remain untouched.

Trigger GEOTOOLS -> INTERSECTIONS WITH TERRAIN. In the projection you can see that the inserted points are placed on to the terrain. The original line remains marked so that you can delete it with Ctrl+ Del or EDIT -> DELETE.

Generate a parallel object

The function GENERATE PARALLEL OBJECT often is used to generate a parallel line to a road alignment and define this line as the base of a noise protection wall. Another useful option is the generation of parallel source lines for example of a 2 track railway line. Select the object and trigger the function GEOTOOLS -> GENERATE PARALLEL OBJECT.

Generate a parallel object

Select the object type from the pick list (the object type selected in the object selection bar is the default setting for this operation) and enter the distance in [m] between the existing line and the new one. A positive value will generate the new line to the right (in entry direction of the existing line) and a negative value will generate the parallel to the left of the existing line.

Connect lines and generate areas

Data imported from external sources sometimes are not present as complete lines and areas but rather as fragments. With F4 activate the OBJECT DOTS to check the data. To process the objects in SoundPLAN, the line fragments should be combined to polylines and completed area. This function is done with GEOTOOLS -> CONNECT OBJECTS and GEOTOOLS -> GENERATE AREAS.
The prerequisite for CONNECT LINES: The last coordinate of a line must be identical to the first coordinate of the following line.

The algorithm GENERATE AREAS still is able to generate the areas if the coordinates defining line elements are within 10 cm of each other. The algorithm recognizes the area and connects the polyline and converts it into areas.

Select all lines you want to connect and then trigger the function CONNECT LINES or GENERATE AREAS from the menu GEOTOOLS. Activate the object dots to check if all object coordinates now share a single start arrow.

Hint: If not all line fragments are connected into a polyline the most likely reason is that the first and last coordinate of subsequent line elements are not identical or for areas the distance is bigger than 10 cm. On selected objects that share the same coordinates the object mark is not visible. The second drawing of the mark "undraws" the first drawing.

The example below shows how the lines should look before and after connecting the lines:

![Lines converted to polylines](image)

and lines converted to areas

When the two sets of coordinates are not identical a bit of extra work is needed: Either mark the lines and pull the last coordinate of a line segment with the right mouse button depressed on to the first coordinate of the next line (when the marking vanishes, the point is available twice). The other option, specially suitable if the gap between the objects is bigger, is to select the first line with the right mouse button and the option SELECT OBJECT, and then capture the first coordinate of the following line with the CAPTURE COORDINATE command of the right mouse button. When both lines have different entry directions, the direction of the selected object will set the direction for the new object.

Hint: You should carry out operations like concatenating lines before you define the objects attributes. When the lines come with different sets of attributes, they may get lost in the concatenation of the lines because the entry direction of some line elements must be changed in the process and then the attributes will have a wrong range of validity.
Coordinate Transformation

The GeoTool Coordinate Transformation offers two alternate transformation methods. The first method requires a fixed point for the rotation and a rotation angle, the second one uses the same transformation procedures as is used to transform the coordinate systems of bitmaps, digitizers and DXF data.

The transformation is a very useful tool to rotate entire groups of objects for example to reorient a planned industrial plant with sources and buildings.

Select one or multiple objects and use the GEOTOOLS -> COORDINATE TRANSFORMATION. To rotate selected objects enter the rotation angle and the coordinate around which the rotation shall be carried out (for example the corner of the plant).

Coordinate transformation with rotation

To move the data to their new location via the full transformation, open the tab General and enter at least 2 pairs of reference coordinates.

Coordinate transformation via reference coordinates

If you enter more than 2 pairs you can also stretch the objects and correct them further.
Calculating object height from a DGM

In the processing of aerial photography data the files can contain the tops of buildings and the tops of noise protection walls. A SoundPLAN GeoTool calculates the wall height by evaluating the tops of the object with the elevation found in the DGM. A SoundPLAN GeoTool calculates the heights of the objects by overlaying the DGM over the terrain elevations and storing the difference as the objects height. If multiple coordinates are available SoundPLAN averages the heights and writes the results into the field “wall height” for walls and respectively “building height” for buildings.

Mark the objects and select GEOTOOLS -> CALC. OBJECT HEIGHT FORM DGM. View the results in the 3D view or side projection.

Assign texts to buildings

Texts that have the position marker (black plus sign) inside the building can be automatically assigned to the building properties.

Buildings and texts do not have to reside in the same Geo-File. The buildings must be visible on screen. Select (mark) the texts and with GEOTOOLS -> ASSIGN TEXT TO BUILDING the text will be stored in one of the fields building name, house number, building height or road name.

Reassign receivers to buildings

You can reassign receivers to buildings, if the Geodatabase lost the assignment. As every object in the Geodatabase has a unique object ID and the ID is used as the building reference for the receiver, assignment can be lost, e.g. because the buildings have been copied.

Hint: You can see lost assignments, if receivers assigned to buildings are displayed in red instead of green. See "Object dots " on page 72.

Objects do not have to be selected. Call GEOTOOLS -> REASSIGN RECEIVERS TO BUILDINGS and check the result. In case the receiver was not assigned, the distance of the receiver to the facade was exceeding the possible max. distance. The façade can be found if it is within twice the distance as set in the field of the receiver setting the “Dist. Façade”.

Jefferson Road 2
Prepare buildings

GEOTOOLS -> PREPARE BUILDINGS is very useful to jointly prepare many buildings in an imported set of data and set the needed parameters for the Façade Noise Map. The automatic definitions are entered into the properties of the buildings.

Entry screen "Prepare buildings"

Select the buildings you want to process. DEFINE BUILDING NAME fills in the field building name with road name and house number. You can create a ROAD NAME as well as a continuous HOUSE NUMBER. The number can be automatically converted into a GeoText. Most often the road names and house numbers are present and so that these can be assigned to the buildings properties.

SELECT ALL FACADES FOR THE FACADE NOISE MAP means all facades of all marked buildings that are longer than the MINIMAL LENGTH (min. length in [m]) are marked. Use the minimum length to exclude garages and very small areas of the main buildings. When you activate VIEW -> ENHANCED OBJECT VIEW you can see which facades are selected for the Façade Noise Map as thick blue lines.

You can also use this function to deactivate facades for selected buildings. Enter a value which is bigger than the longest facade (e.g. 1000) in the field MINIMAL LENGTH.

With the height of the building in place, SoundPLAN can CALCULATE THE NUMBER OF FLOORS of the building and define the positions of the receivers. The calculation assumes the height of each floor as 2,80 m. If in addition to the box ADAPT HEIGHT OF 1. FLOOR is activated, the first receiver is placed in 2,40 m above the ground floor and every subsequent receiver is increased by the value of the floor height (2,80 m).

Tip: Data imported from other programs often do not place main buildings and auxiliary buildings (garages etc.) into separate layers. For auxiliary buildings no Façade Noise Map needs to be produced. Use the GeoTool SELECT OBJECTS WITH AREA <= [M²] to select auxiliary buildings and place them into a separate Geo-File. Before using the GeoTool PREPARE BUILDINGS you should switch VIEW to CURRENT GEO-FILE and select the Geo-File with the main buildings only.
HOUSE NUMBER AS GEOTEXT creates a geotext within the building from value in the field house number.

OBJECT NUMBER AS GEOTEXT creates a geotext within the building from value in the field object number.

Regenerate new object numbers

Object numbers can be regenerated for a special area (select objects) or for all objects included in the situation in accordance with the format string.

Select TOOLS -> OBJECT NUMBER and select whether you want to generate new object numbers for receivers, buildings or sources. SoundPLAN knows the last used object number for this object type and offers the next free number. Enter any number, in accordance to the format string. If the number does not correspond to the format string SoundPLAN shows a message with the current format string.

Photo Documentation

The photo documentation in the Geo-Database enables you to document the situation with photos taken with a digital camera. The dataflow is complete from the entry in the Geo Data-Base over the display of the photo locations in the Graphics to the printout of the photos. As you can use the page layout you can easily create the photo documentation for the annex of you report.

The pictures (*.bmp or *.jpg) you have defined as photo locations in the Geo-Database are automatically transferred into the folder "Photo" in you current project. In the properties of the photo define the view direction and angle and under the tab INFO write your description of the photo. Enter an object number for the photos to ensure that you can identify the photo locations in the Graphics sheet in the printout.

Open the photo documentation in the Geo-Database with DOCUMENTATION -> PHOTO auf.
Customize the layout of the printout. The placeholder shows the placement of portrait and landscape pictures within the frame and adjusts with modifying the number of pictures on the page. The actual layout on the page is visible in the preview section.

On top of the photo you can enter the photo number and the title (name) from the photo point definition as well as the file name. Below the picture the description from the photo definition can be placed. Customize content and layout under SHOW/FONT.

Define which information with which layout shall be included in the photo documentation. View the changes in the layout in the layout preview.

Under the tab PICTURE AREA define the spacing of texts and pictures and the size of frames and lines.

Via PAGE LAYOUT define the page layout with the customary header and footer sections. The line width determines the line width of the outer frame line.
5 Objects

Overview

This chapter explains which SoundPLAN objects are used for which purpose, and how the objects are entered in the Geo-Database. Additional information about the objects behavior is in the chapters Technical Acoustics in SoundPLAN (page 369) and Principles and Standards (page 389).

Aside from the source and receiver, additional objects describing the path from the source to the receiver are needed for the noise propagation and pollution dispersion modeling.

Symbol Bar of SoundPLAN Objects

For the entry of objects, choose the appropriate object icon from the symbol bar or activate it in the object list.

The appearance of the symbol icon bar can be configured in two ways. In the menu OPTIONS select either OBJECT SELECTION 1 or OBJECT SELECTION 2. The difference between the two options is the organization scheme. Selection type 1 has grouped all objects into logical groups with only the icons of the active group depicted in the icon bar. Selection 2 does not have a pre-selector and thus all possible icons are placed in the object menu bar. Select the setting according to personal preference. When the mouse cursor is moved to an object icon, a short statement explains the object type. Object Selection type 2 allows you to undock the menu bar and move it as a menu box, or you can dock it to the right of the data entry window. Double clicking on the menu anchors it again in the top position.
Entry of a new object

- Set cursor to [edit mode] or [Digitizing mode]
- Select Geo-File or create a new Geo-File
- Select Object type
- Load bitmap or initialize digitizer
- Press left mouse button to enter the first coordinate
- Enter elevation(s) (window is not displayed, if no elevation is necessary for the object type)
- Enter properties (window is not displayed, if no properties are available for this object type)
- Enter further coordinates with the left mouse button
- Finish the object with F2 or icon NEW.

Entry of Elevations

As all noise calculations are 3 dimensional models, all relevant objects supply a specialized dialogue to enter the elevations. Some objects only contain the elevation of the object above sea level as elevation information, others contain the object elevation and a reference to the ground at the object. The dialogs are specific to the object to be entered.

Entry of elevations

Double click on the field terrain elevation to set the terrain elevation to the entered elevation of the object elevation. If the elevations are different, please enter the second elevation directly in the "Terrain height" field.

Hint: If the elevations are not available from external data, digitize the ground model with the object types elevation line, terrain edge and / or elevation point, then calculate a digital ground model (DGM) and use it for the elevation information of further objects. The elevations in the elevation dialog are filled in automatically from the DGM. See Use elevations from a Digital Ground Model on page 88.
In the menu **OPTIONS** you select if the elevation dialog is activated for each coordinate entered for the object, for only the first coordinate entered, or never. The default setting is **ELEVATION DIALOG ONLY AT 1. POINT**. For the entry of isoelevation lines, buildings, etc. this is sufficient, but for roads the dialog should be activated for each coordinate.

### Relative Elevation

Click ![Relative Elevation Icon](image) in the symbol bar to the left of the screen to work with relative elevation. If a Digital Ground Model (DGM) is loaded in a Situation, the DGM is used for the terrain elevation for relative defined coordinates and the object elevation is entered relative to the DGM. If you enter the relative height above the DGM, the difference between the object elevation and the ground is still correct even if you correct the DGM during the project development. If no DGM is loaded, the relative elevation always refers to the terrain elevation 0 meters.

You can convert the coordinates with the **GEOTOOLS RELATIVE -> ABSOLUTE ELEVATION** and **ABSOLUTE -> RELATIVE ELEVATION**. If you entered coordinates with absolute elevation and want to convert them to relative elevation, the difference between terrain elevation and object elevation is entered in the object elevation. Vice versa, if you convert relative to absolute elevation, terrain elevation + object elevation is entered in the object elevation.

Objects, with only the object elevation, such as walls, berms or elevation lines, receive an additional terrain elevation when used with relative elevation.

**Attention:** Don't mix object up the elevation with the wall height!

If relative elevation is selected, the elevation dialogue shows in brackets, that the object elevation has to be entered relative. If the cursor moves over relative defined objects, an [R] in the status bar shows that you have defined relative elevation.
The Coordinate System

SoundPLAN uses a Cartesian coordinate system. The x axis equals 0° and the y axis is rotated 90° in the mathematically positive direction:

![Coordinate System Diagram]

The SoundPLAN coordinate system

Moving Through a List of Coordinates

In the entry boxes for defining the properties of line type objects (roads, railways, noise protection walls..) that may have variances in the properties within the same object, you will find the following symbols:

![Coordinate List Diagram]

Industrial sources, building geometry, texts and receivers do not allow a change in the object properties within the string of coordinates of the same object. In this case you will find the following symbols:

![Object Type Diagram]

Previous and next object refer to the entry order. Point, line and area sources are handled as the same object type.
Road Alignments

The object type road alignments represents the object type for roads. The object is used in the acoustics and air pollution modeling as a line element.

The road master alignment is entered with X and Y coordinates, the elevation of the object and the terrain elevation. The width of the road and the distance of the emission bands are defined in the definition box „Cross section.“ The elevation of the emission band is computed automatically from the elevation of the object. (Most often the emission is placed 0.5 meters above the road surface.)

For noise simulations, the height of the source above the terrain usually has a dominant influence on the calculation of ground effect. Therefore the terrain height is directly linked to the object instead of calculating it from other data. The terrain height is also used as a fix point for digital terrain models.

Meaning of the Terrain Elevation

The terrain elevation is set equal to the road elevation by default. For roads level with the surrounding terrain or in a cutting, this information is sufficient, but for roads on a fill situation, the adjustments need to be made individually.

The calculation of the terrain height can be accomplished in two ways. Both methods produce the same results.

1. Enter the height of the terrain in the status before building the road into the dialog field for terrain height. A value is needed only for elevated roads. Otherwise the height of the road surface is sufficient.

2. Enter the foot of the berm as an elevation line. For the propagation calculation it is irrelevant if the field terrain height of the elevation dialog contains an extra value.

Caution: The source elevation is calculated from the elevation entry of the road surface. For elevated roads, the edges of the road are not automatically checked to determine if they act as a berm for other emitters. If this may be the case, extra elevation lines are needed at the side of the road.

Road Properties

The properties menu for roads is divided into separate entry boxes for the noise emission, the kilometer post and the road cross section. The kilometer post and cross section are the same for all the calculation methods. The emission properties depend on the calculation standard and are different for each of the calculation standards in SoundPLAN.

Kilometer posts and Reference axis

The km post is used in the SoundPLAN Spreadsheet, in the emission table of roads and in Wall Design and can be displayed in the Graphics, if desired, together with the reference kilometer of a noise protection wall (Cartography).
A kilometer post is assigned to each road coordinate together with the direction (ascending or descending). You can enter the kilometer post manually or let SoundPLAN calculate the distances. Activate the check box CALCULATED for the automatic calculation. As line objects are entered as straight lines in SoundPLAN, there might be differences between the calculation and the real world. Deactivate the automatic calculation in the course of the road entry, if needed, and enter a correct value. The automatic calculation is continued with the manually entered value.

View the kilometer in the Geo-Database with VIEW -> EXTENDED OBJECT VIEW (activate the PROPERTIES in the OBJECT OPTIONS).

In order to use the kilometer in the Spreadsheet and in the Graphics, one road axis must be defined as REFERENCE AXIS. Activate the checkbox at the first coordinate of the road.

![Image of a road with kilometer posts and road axis]

Load the reference axis in the Spreadsheet with FILE -> INSERT RESULTS AND FURTHER INFORMATION.

**Documentation of the Emission Level**

During the calculation of a calculation run which includes road noise, SoundPLAN creates a table for the documentation of the emission levels of the included roads. Access this table in the Result Tables in the tab index card Roads.

**Cross Sections / Road Profiles**

Roads are digitized as line objects. The line depicts the road master alignment. For the acoustics calculations, the place of emission is not always the middle of the road. For the exact definitions of your standard, please consult the SoundPLAN reference manual. In the RLS 90, the emission is placed in the middle of both outer lanes. Check the single emission line box if a single lane is used. Enter the lane width, the distances of the emission bands for both lanes, and the dimensions of the middle divider. The values entered here will apply for both the acoustical simulation and the graphics for the band type noise map and the gray road band depicting the road.
Definition of road profile

For single lanes, mark the box **SINGLE EMISSION BAND road at the first coordinate of the road axis**.

The predefined road profiles cover a wide range of symmetrical profiles as well as some asymmetrical profiles needed to define turning lanes. Here are some samples:

Examples for variations in the road profiles and the distances of the lanes

Road bridges

The bridge definition uses its own tab index card. Activate the check box bridge at the first coordinate of the bridge and enter the distance between the axis and the bridge edge (left and right from the axis) and if necessary the height of a screen on the bridge above the gradient. Deactivate the bridge check box at the end of the bridge again.

Please observe the following characteristics:

1. Bridge surface and bottom and the screens on a bridge are not reflective.
2. Define the bridge only once, even if a road is divided into several single emission lanes.
3. Enter the bottom of the valley for all roads in the terrain elevation field.

Full functionality of the bridge properties can only be offered for calculation guidelines, which use a closed handling of the sound diffraction on the basis of the total sound path.
Emission Level Calculation

A road section can only be evaluated in a noise simulation if the first coordinate of the section is associated with acoustical properties defining the source strength of the emission line. The emission level according to the RLS 90 is defined as the noise level which would occur under free field conditions at 25 meter distance at 4 meters above the terrain. Only spreading and ground effect are evaluated for the emission level. The level is abbreviated LME or more correctly $L_{me}$ (Level mean emission). The value can be calculated, set, or imported from the traffic database (not yet implemented). At all locations where the emission changes due to a change in traffic volume, road surface, traffic speed, etc., a new reference coordinate with a new LME properties definition is needed. Each of the LME definitions is valid from the coordinate of origin to the end of the data string or to the place where a new definition is present.

For roads with 2 separate emission bands, SoundPLAN assumes equal conditions in both lanes, so the LME for both lanes will be equal. If this is not the case and you want to enter both lanes with different properties, you must define 2 separate emission bands.

If you already know the LME, you may enter the figure in the road properties. If you need to calculate the LME from the number of vehicles, speeds etc., activate the field calculated in the LME definition and click on the pocket calculator $\text{\textbullet}$. Depending on the set calculation standard, additional entry fields are displayed with the parameters needed in the standard.

**RLS 90**

The RLS 90 assumes the source for normal roads to be 0.5 meters above the middle of the two outer lanes. Each of the lanes receives half the traffic volume. A single source line in the middle of the road receives all of the traffic for one way streets. The emission level referred to as LME Level Mean Emission is the noise level to be measured 25 meters from the center of the road, 4 meters above the ground.

![Data entry screen for the RLS 90](image-url)
Entry Type

You can enter the data in different ways depending on the type of traffic volume information available. The values can be entered with the average daily traffic (ADT) and adjustment factors or as hourly values for maximum or average hour. In table 3 of the RLS 90 there are set values given for the conversion of the ADT for different road types. In this table the conversion factor for night time was not defined as an exact factor. The RLS attempts to be on the safe side, therefore the traffic numbers add to more than 100% of the ADT. If you have the correct number of vehicles, you may correct the figures by hand.

Traffic Speed

First enter the posted speed for cars and trucks in [km/h]. (The RLS uses the posted maximum speed versus measured speed. This extra safety margin is already included in the correction function.) For cars, the speed of 30 [km/h] is internally applied when the speed entered is less than 30, analog the speed of 130 is used for any speed entered >130 [km/h]. For trucks, the analog range is 30 .. 80 [km/h].

SoundPLAN allows a number of different choices for traffic data entry. After long time traffic observation, the German Road Research Department (Bundesanstalt für Straßenwesen) derived certain traffic types where only the number of vehicles is entered, and the percentage of heavy vehicles and a factor to calculate the traffic load at night are calculated from a table. ADT will be used as the abbreviation for Average Daily Traffic.

<table>
<thead>
<tr>
<th>Street class</th>
<th>Day</th>
<th>Night</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>06:00 - 22:00</td>
<td>22:00 - 06:00</td>
</tr>
<tr>
<td></td>
<td>M</td>
<td>P</td>
</tr>
<tr>
<td></td>
<td>Vehicle / hour</td>
<td>%</td>
</tr>
<tr>
<td>Federal freeway</td>
<td>0.06*ADT</td>
<td>25</td>
</tr>
<tr>
<td>Federal roads</td>
<td>0.06*ADT</td>
<td>20</td>
</tr>
<tr>
<td>Undivided highways</td>
<td>0.06*ADT</td>
<td>20</td>
</tr>
<tr>
<td>Secondary road system out of town</td>
<td>0.06*ADT</td>
<td>10</td>
</tr>
<tr>
<td>Roads within the city</td>
<td>0.06*ADT</td>
<td>10</td>
</tr>
</tbody>
</table>

Aside from the predefined table, you can define the numbers for the average daily traffic or enter the number of vehicles directly. For the ADT extra parameters, you need to define the percent of heavy vehicles and the ADT multiplication factor to calculate the hourly traffic at night.

The calculation can be performed for the RLS 90 and the DIN 18005, which is identical to older versions of the RLS 81. As small differences exist, the LME calculation needs to be version specific.

The speed is the permitted speed in km / h. Note that trucks are only permitted to drive 80 km/h. The validity of an extrapolation of the formulas will be questionable.

Level Additions

The free field noise level at 25 meters distance was measured for certain standardized conditions. If the conditions vary, additions to the basic LME are
The definition box contains additions for roads climbing up hills, road surface and multiple reflections in street canyons.

**Definition of additions and compilation of the LME**

Select the **road surface additions** from the selection list. The right field shows the magnitude of the addition. As not all road surfaces are standardized, and you may have evidence for another road surface addition, the „own road type“ entry can be used to enter your measured value. Some road surface additions are valid only for a certain speed range. These factors are considered automatically. For a prognosis calculation, very often the assumed value is „Asphalt Concrete“ with a deduction of 2 [dB(A)] for all speeds above 60 [km/h].

The following table details the different entries. Note that the components are speed dependent.

<table>
<thead>
<tr>
<th>Road surface</th>
<th>Maximum permitted speed in km/h</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>30 km/h</td>
</tr>
<tr>
<td>Non grooved asphalts, asphalt concrete</td>
<td>0</td>
</tr>
<tr>
<td>Concrete or grooved asphalts</td>
<td>1</td>
</tr>
<tr>
<td>Cobblestone with smooth texture</td>
<td>2</td>
</tr>
<tr>
<td>Cobblestone with rough texture</td>
<td>3</td>
</tr>
<tr>
<td>Concrete with metal broom treatment</td>
<td>1</td>
</tr>
<tr>
<td>Concrete with burlap cloth (smooth)</td>
<td>0</td>
</tr>
<tr>
<td>Asphalt concrete without grit</td>
<td>0</td>
</tr>
<tr>
<td>Porous asphalt with more than 15% pores 0/11 type</td>
<td>0</td>
</tr>
<tr>
<td>Porous asphalt with more than 15% pores 0/8 type</td>
<td>0</td>
</tr>
</tbody>
</table>

**Multiple reflections** in street canyons are added as an add on value to the LME. In this case the propagation calculation shall only evaluate the first reflection as otherwise the multiple reflections are overcompensated. The multiple reflection depends on the average building height of the lower side of the street (hBeb[m]) and width (w[m]) of the street canyon, as well as the average reflection loss. The reflection loss only distinguishes between reflective and absorbent of the reflecting walls.
The RLS 90 states that roads in a retained cut can be calculated with an increased emission level. The increase of the emission level follows the formula:

\[ D_{\text{refl}} = 4 \times \frac{\text{Height of walls}}{\text{Distance of retaining walls}} \leq 3.2 \text{ dB} \]

If the walls have been built with absorbent material the formula changes to:

\[ D_{\text{refl}} = 2 \times \frac{\text{Height of walls}}{\text{Distance of retaining walls}} \leq 1.6 \text{ dB} \]

The gradient (rate of climb/decent) of the road is entered in %. The value can be entered by hand or SoundPLAN will evaluate it between each set of coordinates. Please mark your choice. The noise is the same for both incline and decline! The increase of noise for inclines follows the formula:

\[ D_{\text{incline}} = 0.6 \times \text{gradient} - 3 \text{ (for gradient > 5%) } \]

**CoRTN**

CoRTN assumes one source line 3.5 meters in from the nearest curb. The source is located 0.5 meters above the road surface. The noise levels to be calculated are the hourly L10 and the average of the hourly L10 for the 18 hour period from 06:00 to 24:00.

**Speed**

The speed entered is the permitted speed. For trucks (heavy vehicles) driving up an incline, CoRTN reduces the speed. The reduced speed is not directly visible.

**Number of Vehicles and gradient**

The number of vehicles is to be entered for the following slots:

1. Hourly vehicle count for the calculation of the L10 (q)
2. % of heavy vehicles for the hourly L10
3. Vehicle count for the 18 hour L10 (Q)
4. % of heavy vehicles for the 18 hour L10

The gradient of a road changes the traffic speed and increases the noise with the correction:

\[ G \text{ in dB(A)} \quad G = \text{Gradient in %} \]

The value in dB(A) caused by the gradient of a road is shown in the table as DG.

**Road surface**

The road surface is classified for the following additions:

<table>
<thead>
<tr>
<th>Road surface type</th>
<th>Valid for speed</th>
<th>Surface Correction</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 own additions</td>
<td>own addition</td>
<td>own addition</td>
</tr>
<tr>
<td>2 Concrete</td>
<td>&gt;=75 km/h</td>
<td>10<em>log(90</em>TD+30)-20dB(A)</td>
</tr>
<tr>
<td>3 Asphalt</td>
<td>&gt;=75 km/h</td>
<td>10<em>log(90</em>TD+60)-20dB(A)</td>
</tr>
<tr>
<td>4 Impervious road surface</td>
<td>&lt;75 km/h</td>
<td>-1</td>
</tr>
<tr>
<td>5 Pervious road surface</td>
<td>all speeds</td>
<td>-3.5</td>
</tr>
</tbody>
</table>
The correction is calculated with the texture depth (TD) of the road which can be measured with the sand-patch test. (How this is accomplished is unknown to this author!)

**Multiple reflections**

The multiple reflection assessment included in the L10 calculation is not part of CoRTN. If this is used, it is a deviation from the standard. However, it may be good practice. Multiple reflections in street canyons are added as an add on value to the LME. In this case the propagation calculation shall only evaluate the first reflection as otherwise the multiple reflections are overcompensated. The multiple reflection depends on the average building height of the lower side of the street (h[m]) and width (w[m]) of the street canyon, as well as the average reflection loss. The reflection loss only distinguishes between hard and absorbent of the reflecting walls.

---

**Signal - Intersection Addition**

The signal addition accounts for the increased annoyance of traffic noise close to a traffic signal. As the physical effect is hardly measurable, the addition is very questionable. However, as it is part of the RLS 90, it is part of SoundPLAN. The signal addition is calculated for receivers at certain distances from the traffic light.

The intersection of the crossing road axis is marked with a signal mark. The best way to enter the coordinate is to use the function „Capture Coordinate“ if there is a coordinate in the intersection. In the next box the signal mark is assigned to the road. The traffic light can be active all day (0:00 to 24:00), during day time (6:00 to 22:00) or during night time (22:00 to 6:00).

Depending on the distance between the receiver and the traffic signal, the addition is between 1 and 3 dB(A).

For the signal addition, the 3 dimensional distance between the axis intersection and the receiver is evaluated:

<table>
<thead>
<tr>
<th>Range</th>
<th>Addition (dB(A))</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 m to 40 m</td>
<td>+3.0 dB(A)</td>
</tr>
<tr>
<td>from 40 m to 70 m</td>
<td>+2.0 dB(A)</td>
</tr>
<tr>
<td>from 70 m to 100 m</td>
<td>+1.0 dB(A)</td>
</tr>
</tbody>
</table>
Definition of the signal and position marks

Enter the intersection points in the preview box to the right. The cursor is shown as a small cross. When SoundPLAN gets close to one of the intersection points, the signal position is marked with an asterisk.

The tab index card ASSIGNED ROADS lets you check the automatic assignment of the signal addition to the road axis. If a road has been assigned an addition, but does not have a traffic signal, click on the road and delete it from the list using the delete button on the keyboard.

Parking Lots

Parking lots are area sources with a uniform sound power. The source modeling is performed in accordance to calculation standards (RLS 90, DIN 18005, Bavarian Parking Lot Study). The propagation either uses the German RLS 90 or the ISO 9613 industrial model. The complete parking lot is assigned a uniform sound power (sound pressure in 25 meters distance) depending on the type of parking lot, turn over, and calculation standard. The DIN 18005 and RLS 90 consider the parking lot a uniform area source, the Bavarian Study divides the parking lot into an area source and the driving paths between the parking bays. The area source in this case is calculated with the industrial model and the road part with the RLS 90. The parking lot is entered with the outside border and SoundPLAN triangulates it at calculation time.

To enter the parking lot, enter the outside border. The terrain and source elevations are identical. SoundPLAN adds 0.5 meters for the source height above the terrain. For special elevated park decks, the ground elevation needs to be defined with extra elevation lines.

If sections of the parking lot are used by different vehicle types or the usage of the parking lot is not uniform, subdivide the parking lot into homogenous units.
Calculation of the Emission Level of Parking Lots

SoundPLAN offers 3 calculation methods for parking lot emissions:

1. **Calculation in Accordance to DIN 18005**
   - The rough assessment of the DIN 18005 can be viewed as outdated. It was used for preplanning.
   - The total traffic load of the parking lot is divided into the time slots day and night. For the vehicle classes, cars, trucks, and motorcycles and the number of turnovers per hour for all parking bays is entered. One time parking converts into two moves - coming and going.
   - From the source data, the DIN 18005 calculates the total noise emission which is then distributed evenly over the parking lot.

2. **Calculation in Accordance with RLS 90**
   - The calculation is performed in accordance with the 16th Federal German Immission Law. The emission is assessed in accordance to the number of parking lots, the turnover per hour at day and night time, and the parking lot type.
   - The RLS 90 offers additions for different parking lot types:
     - Car parking: 0 dB
     - Motorcycle parking: 5 dB
     - Truck and bus parking: 10 dB
   - The emission of the parking lot is calculated from the vehicle turnover number with the addition from the parking lot type automatically added to the emission level. If you have evidence that the additions do not fit your situation, the field „own entry“ allows you to enter and document your own values.

3. **Calculation in Accordance to the Bavarian Parking Lot Study**
   - The SoundPLAN adaptation is based on the 3rd and 4th revision of the „Parkplatzlärmsstudie des Bayerischen Landesamts für Umweltschutz“ (Bavarian Parking Lot Study of the Bavarian department for environmental protection).
The study contains two methods. The estimate method assesses the driving lanes as part of the overall noise emission level per square meter. The „in depth method“ discounts the driving lanes from the parking lot and requests they be modeled separately.

The traffic volume of the parking lot is entered with the number of vehicle moves per parking bay and the day and night time hour separately. The number is multiplied by the number of bays available.

The „in depth“ method separates the calculation into the road part to be calculated according to the RLS 90 and the parking specific noise (opening doors and trunks, reverse driving out of the bay, etc...) to be calculated with the ISO 9613.

Different parking lot types are assessed with type specific additions. The value of the additions are added to the emission level calculated. The field „own values“ allows for a value and description of parking lot types of your own or differences in the values from the parking lot study.

**Caution:** If the „in depth“ method is used, remember to model the driving lanes within the parking lot.

**Additions for the driving lanes within the parking lot**

The „estimate method“ is used when the traffic volume in the driving lanes cannot be estimated sufficiently. In this case, the per unit sound power is increased with a driving lane addition. Mark the appropriate button in the dialog box when entering the number of parking bays.

**Calculation of the Tact Maximum Noise Level**

Aside from the \( L_{eq} \) for the parking lot, the maximum noise level according to the „tact Maximum Noise Level“ can be assessed according to the „TA Lärm“ or „VDI 2058.“ If this is required, mark the button „TA Lärm Maximum.“

The Bavarian parking lot guideline has been revised completely in 2003 and is available in the guideline selection for parking lots as emission calculation in addition to the parking lot guideline 1994. The major changes are:

- Adaptation to the requirements of the German TA-Lärm
- Complete revision of the emission data
- Additional parking lot types
- Additional figures such as netto sales areas, hotel beds ...
- The combined method (in the old version estimate method) is now the standard method. The separate method (in the old version "in depth" method) should only be used in special cases.
- More information on noise peak
- Calculation methods for multi-storey car parks and underground car parks.
Railways

The object type „Railways“ is used to mark the emission line of a railway for noise simulations and for maps. The track master alignment is entered with the coordinates, the object elevation and the terrain elevation. Multiple tracks are defined as a set of single track railway lines. The geometry can be generated by using the functions to create parallel polylines.

**Meaning of the Terrain Elevation**

For assessing the ground effect in a noise propagation simulation, the height of the source above the terrain is of great importance. The railhead is assumed as the main source. The terrain next to the rail line can be entered in two ways. The terrain height can be directly entered in the height dialog with the elevation of the source. When the source elevation is entered, the terrain height is set to the same value and can be replaced manually with the value of the terrain next to the rail bed. The other possible way is to establish the terrain height explicitly with one or multiple elevation lines.

**Data Entry via the Terrain Height:**

When the railway is placed on an elevated structure (normally the ballast bed is elevated), enter the elevation of the terrain next to the rail structure in the terrain height field. If the railway is in a cutting, the entry can be omitted because the exact location of the upper edge is needed to solve the question of diffraction and therefore requires an elevation line.

**Data Entry with Elevation Lines:**

Enter the foot of the railway berm as an elevation line. In this case the entry of the terrain height becomes obsolete.

**Caution:** The elevation of the source is calculated from the elevation entry of the railway surface. For elevated railways, the edges of the railway are not automatically checked if they act as a berm for other emitters. If this may be the case, extra elevation lines are needed at the side of the railway.
Railway Properties

The definition cards for the railway properties are divided into the „description“ of the railway line, the „LME“ emission calculation, the definition of correction factors and the entry for the mile posts.

Kilometer posts and Reference axis

The km post is used in the SoundPLAN Spreadsheet, in the railway emission documentation in the Geo-Database (DOCUMENTATION -> RAILWAY) emission table of roads and in Wall Design and can be displayed in the Graphics, if desired, together with the reference kilometer of a noise protection wall (Cartography).

A kilometer post is assigned to each road coordinate together with the direction (ascending or descending). You can enter the kilometer post manually or let SoundPLAN calculate the distances. Activate the check box CALCULATED for the
automatic calculation. As line objects are entered as straight lines in SoundPLAN, there might be differences between the calculation and the real world. Deactivate the automatic calculation in the course of the road entry, if needed, and enter a correct value. The automatic calculation is continued with the manually entered value.

View the kilometer in the Geo-Database with **VIEW -> EXTENDED OBJECT VIEW** (activate the **PROPERTIES** in the **OBJECT OPTIONS**).

In order to use the kilometer in the Spreadsheet and in the Graphics, one railway axis must be defined as **REFERENCE AXIS**. Activate the checkbox at the first coordinate of the railway.

Load the reference axis in the Spreadsheet with **FILE -> INSERT RESULTS AND FURTHER INFORMATION**.

**Document the emission levels of railways**

**ASCII Export:** View the documentation of the emission calculation of railways in the Geo-Database via **DOCUMENTATION -> RAILWAY**. You can view and print the emission table (table of trains and the resulting emission level), the emission succession table (changes in the emission table according to track depending corrections) or the complete table including all information. Moreover you can export it to an ASCII file or copy it to the clipboard.

The definition of the page layout is described in the chapter Result Tables.

**Railway bridges**

The bridge definition uses its own tab index card. Activate the check box bridge at the first coordinate of the bridge and enter the distance between the axis and the bridge edge (left and right from the axis) and if necessary the height of a screen on the bridge above the gradient. Deactivate the bridge check box at the end of the bridge again.

Please observe the following characteristics:

1. Bridge surface and bottom and the screens on a bridge are not reflective.
2. Define the bridge only once, even if a railway has several axes.
3. Enter the bottom of the valley for all railways in the terrain elevation field.

Full functionality of the bridge properties can only be offered for calculation guidelines, which use a closed handling of the sound diffraction on the basis of the total sound path.

**Definition of the LME According to Schall03**

Please observe: A section of the railway line can only be evaluated for noise calculation purposes when the first coordinate of the section contains information about the noise emitted. The emission level LME (Level Mean Emission) can be calculated in SoundPLAN or it can be set directly if the values are known. The values are valid from the coordinate to where they are attached to the end of the coordinate string or the definition is replaced. Every time the conditions, the speed, or the rail ballast bed or bridges change, a new coordinate with a new definition of the LME is needed.

First define the description of the rail line, the track number, direction, the status and state the purpose of the calculation as analytical or as a prognosis for a prognosis year.

Then open the emission calculation for Schall03. The list of trains traveling on the line is opened.

**Emission calculation LME according to Schall03**

In SoundPLAN, the train types and properties are taken directly from the tables of Schall03.

These figures are recommendations and not fixed law. Please check the validity of the settings for your special case. (Train types match, the % of disk breaks is correct...)

**Predefined Train Types**

Click on the first field of the table to open the selection list of predefined train types. When selecting the predefined trains, the settings are copied from the setup and must be checked. The speed entered is the maximum speed the train can travel, therefore you must define the actual train speed and the number of trains on the line.
**Hint:** The train type ICE has been given an addition of 1 dB(A) when traveling faster than 250 km/h. Therefore there are two types of ICE in the setup - one for lower speeds and one for high speeds.

**User Defined Train Types**

Select the selector „Own Entries“ from the list and enter the values for your set of trains.

The emission is normally calculated separately for each track for the time slots day and night. The noise levels for each train type on the line is evaluated and the sum is drawn and displayed as the LME for the track.

**Parameters Used in the LME-Calculation According to Schall03**

In order to calculate the LME according to the Schall03 the following parameters are needed:

- Number of trains day/night for each type of train
- Train type addition and break type percentage (disk versus wheel)
- Train speed
- Train length

**Track Specific Corrections for the LME**

The track dependent additions are defined in the section „Correction.“

*Definition of the track dependent corrections*

For assessing the radius and curve addition, the selection tables according to Schall03 are supplied.

To account for level crossings, increase the LME 5 dB(A) for a section twice the road width. The correction (firm track) may not be applied for the same section.

The correction for Multiple reflections can be evaluated as follows:
Calculation of the multiple reflection addition

Multiple reflections are accounted as an addition to the emission level LME. Please observe that when the multiple reflection addition is applied, the propagation calculation needs to be limited to the first order reflection. The height of the walls of the railway canyon (the lower side height), the width of the canyon and the average reflection losses (reflective, absorbent) are necessary parameters in the multiple reflection calculation. SoundPLAN calculates the addition and automatically applies it to the LME.

The increased noise from **bridges** is accounted for with a 3 dB(A) addition. If the bridge already exists, it is advisable to measure the increased noise level and enter the increase.

---

**Industrial Noise Sources**

The noise sources for industrial applications (and sports and leisure facilities) can be point, line and area sources.

Sources are described geometrically with coordinate x, y, h and the terrain height:

For **point sources**, the coordinate marks the source.

**Line sources** can be approximated using a polygon. Whenever the sound power per meter of source changes, a new line source must be generated.

**Area sources** are defined by the border coordinates. Area sources can be placed in any shape or orientation, but they must always form a plane. Small deviations are automatically adjusted. If the source does not form a plane, subdivide the source into smaller units that are planes. Inserted areas of a different sound power are possible.

The ground effect is greatly influenced by the height of the source above the terrain. As SoundPLAN automatically triangulates the source, the terrain height can be evaluated for every possible source position.

The terrain height of the source is not used for generating the digital terrain model the Grid Noise Maps are based upon.

**Source Properties**

The properties for a source are identical for point, line and area sources.
Properties of industrial sources

Enter the **Source Name** for the documentation of your project data.

The organization unit **Group** gathers the results of multiple sources under a single label for the result tables. The selection list shows already existing groups (or "not defined" in a new project). Select one of the entries or click the right mouse button and select **INSERT** from the popup menu to generate a new group.

**Comment** is used to describe the source. This comment can be placed in the documentation.

The calculation type allows you to choose between mean frequency or entire spectral calculations.

If you want to calculate only the noise in the mean frequency, enter the value of the mean frequency in the **MEAN FREQUENCY** box. If spectral data are unknown, industrial applications in the project phase most often are calculated using the mean frequency of 500 Hz.

For spectral calculations, select a **FREQUENCY SPECTRUM** from the SoundPLAN library or generate a new entry in the library and assign it.

**Assignment of DAY HISTOGRAMS.**

Most industrial sources do not operate 24 hours a day at a constant sound power output. In order to assess the noise for day and night, and possibly evaluate special quiet times, the sound power output must be known for 24 hours. SoundPLAN averages the values for day and night time.
The **SOUND POWER** can be assigned to line and area noise sources either as a noise level for the complete **unit** or as a level **per meter** (square meter).

If the sound power is defined per unit, the total emission of the entire source is entered and will be distributed evenly over the entire source line / area.

The setting per meter will interpret the entered sound power as a sound power per meter of length of a line source and as a level per square meter for an area source. The total sound power of the source is the value entered plus 10 * log (size of source).

Spectra are referenced in the library as a sound power per unit or as the value of the entire unit. When the data is assigned a source, the reference is automatically transferred. In this case no further modifications are possible. If calculating with the option mean frequency, set the correct sound power reference and possibly adjust the figure to accommodate the source size.

### Assigning Sources to Buildings

SoundPLAN allows individual point, line and area sources to be assigned directly to buildings so the $k_{1, \text{wall}}$ can be evaluated directly and the 3 dB(A) can be added to the source. The first reflection on this facade is suppressed in the calculation.

Area sources can be defined with different object elevations so windows and doors of an industrial building can be simulated.

Define the source and open the index card Geometry/Building Ref. A zoomed view of the site map appears in the preview window. Use the left mouse button to click the side of the building where you want to assign the source. In the field „Building Ref.“ you will see the building ID. When the ID equals „0“ no reference to a building has been established.
Sources can be referenced to a building if they are no more than 20 cm away from the facade. $K_{\Omega, \text{wall}}$ is automatically set to 3 dB(A) and the first reflection on this facade is suppressed for this source.

You can anchor the source at a set distance from the beginning of a wall. The data entry direction of the building is marked with a small arrow.

The building’s elevation above ground floor is the elevation of the source. Therefore the elevation does not need to be defined in the dialog box. An exception would be if you want to position a vertical area source on a building. In this case the elevation dialog should be set to request an elevation with each coordinate entered.

### Additional Information Index Card

In the section “additional“ parameters, the values for correction factors $K_{\Omega, \text{wall}}$ and $K_{\Omega, \text{ground}}$, the addition for impulse type noise, and the tonality addition are defined. You must also define the main direction of the source when using 2-dimensional directivity.

### Correction Factors $k_\Omega$ Wall and Ground, $kT$ and $kl$

In the section “Additional Corrections,” the correction factors $K_{\Omega, \text{wall}}$ and $K_{\Omega, \text{ground}}$ for impulse and tonal sources are defined.

<table>
<thead>
<tr>
<th>Correction Factors</th>
<th>$k_{\Omega, \text{wall}}$</th>
<th>$kT$</th>
<th>$kl$</th>
</tr>
</thead>
<tbody>
<tr>
<td>$k_{\Omega, \text{ground}}$</td>
<td>1.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>

**Correction factors for sources**

Sources with a non-spherical radiation pattern need to be associated with a directivity. There are multiple reasons why noise radiates this way and there are multiple ways to adjust the propagation calculation for it. The most simple example is a source close to the ground. The radiation is in a half sphere, so the noise distributed in the rest should be increased 3 dB. Different standards describe this fact in different ways. The VDI standard 2714 issues a $k_{\Omega, \text{ground}}$ correction of 3 dB for this situation, but the Nordic General Prediction Method (and ÖAL 28) calculates the effect as part of the Ground Effect. For details, see the SoundPLAN Reference Handbook. If the source is located on a building, radiation is also restricted and can be adjusted by associating it with a directivity or by assigning $k_{\Omega, \text{wall}}$ as a correction. See the table below for details.

The $k_{\Omega, \text{Wall}}$ additions can be omitted when the source is associated with a directivity already accounting for the uneven radiation. In this case set the factor $k_{\Omega, \text{wall}}$ to „0.“
### kΩ in SoundPLAN

#### kΩ in SoundPLAN

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 dB</td>
<td>For spherical radiation (example: from a smoke stack)</td>
</tr>
<tr>
<td></td>
<td>Set the factor ( k_{Ω,\text{ground}} = 0 )</td>
</tr>
<tr>
<td>+3 dB</td>
<td>For a radiation into the half sphere (example: from a fork lifter on the stock yard)</td>
</tr>
<tr>
<td></td>
<td>Set ( k_{Ω,\text{ground}} = 3 ) in the VDI/ISO 9613 and set ( k_{Ω,\text{ground}} = 0 ) in the Nordic/ÖAL/Concawe</td>
</tr>
<tr>
<td>+6 dB</td>
<td>For Sources on vertical walls (quarter spherical propagation), ( k_{Ω,\text{ground}}=3 ) and ( k_{Ω,\text{Wall}}=3 ) are set. The source is positioned directly on the wall, the wall reflections are ignored. If the connection from source to wall is not desired, SoundPLAN will attempt to calculate the reflection (depending on the geometry). In this case the ( k_{Ω,\text{Wall}} ) should be set to zero.</td>
</tr>
<tr>
<td>+9 dB</td>
<td>For sources propagating into an eighth of a sphere (source in a building corner) ( k_{Ω,\text{ground}} ) is set to 3 and ( k_{Ω,\text{Wall}} ) is set to 6 dB. For this case the reflections from both adjacent walls will be disabled. For all other cases set ( k_{Ω,\text{ground}} ) to 3 dB and ( k_{Ω,\text{Wall}} ) to 3 dB and assign the source to a single wall. The second wall will automatically assess the reflections.</td>
</tr>
</tbody>
</table>

The corrections \( k_T \) and \( k_I \) take account of the increased annoyance of sources with an impulse characteristic and sources with a strong tonal component. Physically, both adjustments should be assigned as add-ons to the noise level at the receiver because a tonal or impulse adjustment may be justified for some receivers but not for those with a different propagation geometry. When one source is dominant, the corrections may be needed. When the ambient noise level masks the previously dominant source, the additions should be removed.

### 2-Dimensional Directivity

The 2-dimensional directivity of a source is assigned to the source in the library, but the orientation must be established under the additional information index card in the „direction“ field „Rotation Angle.“ The source is now depicted with an additional direction arrow for the mean direction of the source.

### 3D Directivity

When a source in the library is associated with a 3D directivity, the index card for additional information requires values for the orientation of the source in the 3D space (X, Y, Z). For example, a loudspeaker can be directed north, east, south or west and pointed up or down to some degree.
Assigning a 3D Directivity

The directivity can be rotated around the basic axis or around an already rotated axis.

Industrial Building

With the industrial building calculate the area dependent sound power level which emits to outdoors from the inner level in the industrial building, taking into account the attenuation of the embedded components of the facade. The inner level may come from measurement, from literature or from a Indoor calculation.

Select the object type industrial building and enter the name, the building height and the reflection loss. Finish the entry of the geometry before you start defining the sources. Industrial sources need to be entered counter clockwise. If you entered it clockwise, the input direction is automatically changed.

Important: Later changes in the geometry (e.g. insert points, calculate right angled, change the building height) may lead to errors. For example if a source does no longer correspond to a facade. Therefore define the geometry before you start to define the sources!

Open the properties of the industrial building again and define the embedded sources.
Properties of industrial buildings

Click on the tab index card **SOURCES**. In the graphics window on the left hand side you see the facades of the building and the roof together with already embedded sources. In the tree view on the right you see the facades and the embedded sources.

You can convert the facades into sources. Right click on the facade in the tree view and select **DEFINE AS SOURCE**. SoundPLAN converted the facade and displays the level definition dialog.

As SoundPLAN uses the properties of the last entered source for the next one, it is advisable to enter similar sources one after the other.

Embedded sources can be entered with the mouse or via known coordinates.

Highlight the facade or source in which the new source is to be embedded. Select the desired source type with the icons.

Each facade has a local coordinate system. 0/0 is in the lower left corner. When you want to enter the source with the mouse, click on the facade to create a point source or pull the mouse for a line or area source. To enter the source via known coordinates, right click on the facade and select **INSERT** from the popup menu.
Define source with known values

The dialog depends on the source type. For area sources enter \( P_t \) (distance from the left edge), \( P_h \) (distance from the bottom), the width and the height. The areas of the embedded sources are subtracted from the facades.

Then assign the source properties. For \( L_w \) select from the following list:

- **CENTER FREQUENCY**: Enter the frequency and the emitting sound power level in the lowest row of the entry lines. In most cases select "meter" in the field reference, the emitting sound power level refers to one square meter.

- **FROM LIBRARY**: Click on the double arrow in the lowest entry line and select the library element. If you want to change the summed up sound power level, deselect the check box `USE LIBRARY DEFINITION`.

  **LI - 6 – R**: This method corresponds to the equation 7a of the German VDI 2571. Assign the inner level and the transmission in octaves or third octaves from the library. SoundPLAN calculates the emitting \( L''w \). If \( L_i \) and \( R \) do not have the same value range, only the intersection is taken into account. If necessary, complete the value range in the library. The row \( L_i \) can also be filled in with the calculated inner level from a Indoor Noise calculation \( (L_i(CALC) - 6 - R) \).

  **LI - 4 – RW**: This method corresponds to the equation 7b of the German VDI 2571. Enter inner level and transmission as single values.
According to EN DIN 12354 the diffusion term $C_d$ is dependent on the room properties and on the surface properties of the inner side of the building.

### Situation $C_d$ in dB

- Relatively small, uniform rooms (diffuse field) in front of reflective surface: $-6$
- Relatively small uniform rooms (diffuse field) in front of absorptive surface: $-3$
- Big flat or long halls, many sound sources (average industrial building) in front of reflective surface: $-5$
- Industrial building, few dominant and directed emitting sources in front of reflective surface: $-3$
- Industrial building, few dominant and directed emitting sources in front of absorptive surface: $0$

**Indoor Noise**

The module Indoor Noise is used to calculate the sound pressure level in industrial buildings according to the German VDI 3760. Any ground plan of the building is possible, but floor and ceiling are always parallel to each other. Inner walls are possible but only from floor to ceiling. For the calculation of indoor factory noise only one industrial building is allowed in the data.

Define the average room height (the height of the inner room height may differ from the outside), the scattering object density and the absorption of floor, ceiling, scattering objects and facades. Absorption of heterogeneous facades is automatically calculated according to the area parts of the different surfaces or by entering the dimensions of embedded sources. If you have already defined component emitting to outdoors, you can transfer these component for the entry of the absorption spectra. Use the Indoor Noise module to execute the following calculations:
- Single point sound (use the locale coordinate system (GEO-DATABASE -> FUNDAMENTALS -> LOCALE SYSTEM) to define receivers and sound sources inside the industrial building). Day histograms and assessments are taken into account. Select the object types in the tab index card "indoor noise" for the definition of receivers, sources and indoor walls.

- SCP calculation (sound propagation curve). Enter a sound propagation curve with 2 points.

- Indoor Noise + Grid Noise Map: If no calculation area is part of the Situation (smaller than the industrial building), the Grid Noise Map is calculated for the area of the industrial building.

- Calculation from inside the industrial building to the outside. All components, defined as sound sources must have the setting „Li(Calc)-6-R”. Day histograms of the indoor sound sources are not taken into account!

**Entry of the Industrial Building for Indoor Noise Calculations**

Click on the tab index card Indoor Noise in the industrial building. Enter the average room height, the scattering object density and the absorption of the scattering objects. In addition define the absorption spectrum you will need most in this industrial building as DEFAULT ABSORPTION SPECTRUM. Click the button all FACADES ABSORPTIVE to transfer the spectrum to all facades and to convert them into absorptive areas.

Click on the facades with a different absorption spectrum in the tree view and select another element from the library with the double arrow. You can also add additional embedded absorptive areas in the graphic window or via right mouse click -> INSERT. Transform already existing embedded components with right mouse click - > COPY SOURCE AS ABSORPTIVE AREA.

Close the industrial building after you have defined all facades, components, ceiling and floor.

Assign the local coordinate system (FUNDAMENTALS -> LOCAL SYSTEM). A local coordinate system is automatically created for every industrial building. 0/0 is the ground floor elevation of the first coordinate of the industrial building, the x axis goes along the first side. You can also load a bitmap via FUNDAMENTALS -> LOAD -> BITMAP.

**Indoor Noise objects**

Enter the indoor noise objects, sources, walls, receivers and sound propagation curves relative to the ground of the industrial building.

You do not need to enter a calculation area for a Grid Noise Map calculation, the industrial building is automatically used.

If you select the global coordinate system instead of the local, the relative entered elevations are transformed to absolute elevations.

**Calculation and Evaluation**

Calculate indoor noise single points, indoor noise grid maps, sound propagation curves and indoor to outdoor separately. We recommend a search angle of 1 degree and an accuracy of 0,5 dB.
SoundPLAN automatically creates result tables for indoor to outdoor calculations and for sound propagation curves. For indoor noise single points, define the stored results in the tab index card SPS. We recommend a color printer for the printout of sound propagation curves.

**Buildings**

Buildings are an important factor in both the outdoor noise propagation assessment and the MISKAM air pollution dispersion model. For TA-Luft (Gaussian air pollution model) and aircraft noise calculations, buildings are used for display purposes only.

The object is referenced to the ground floor elevation (z). All heights (building height, receivers, etc...) are measured from this position. The terrain elevation may be different for each coordinate of a building. The mean terrain elevation in the middle of the building is used in the digital ground model.

The ground floor is located at a fixed height above the terrain.

**Definition of buildings**

**Building Properties**

A building is defined with the elevations of the corners (terrain elevations) and the elevation of the ground floor reference (z).

Each building has only a single set of property information. Variations in the building height can be assigned via the terrain elevation. If necessary, additional buildings may be needed to complete the building.

Pressing F2 or the icon closes the building.

The street name and house number, height of the building in meters and the of the building are entered in the properties dialog:
Building properties

If receivers are assigned to a building later, all relevant data is entered with the building and by referencing the receiver to the building, the parameters are reused for each of the receivers on that building. In this way the number of floors, height of the floors, area usage, building names and other parameters are defined only once.

The **RECEIVER HEIGHT ABV. GROUND** defines the height above the ground floor elevation of the first attached or automatically generated receiver. All receivers above the first one are placed according to the value (in [m]) entered in **HEIGHT OF FLOORS** up to the **NUMBER OF FLOORS**. Use View -> FRONT ELEVATION (F8) to check the position of the receivers.

The information in the fields above is important for the position of both, single point receivers attached to buildings or automatically generated receivers for a Facade Noise Map (GEOTOOLS -> PREPARE BUILDINGS).

SoundPLAN accommodates up to 256 floors in one calculation. Enter the number of floors in the appropriate field.

**Decisive Floor**

The „decisive floor“ is the floor where only a single receiver can be displayed at a time. All of the following parameters are shown by default for the decisive floor:

- Presentation of the level chart during the calculation
- Dimensioning of noise protection walls (Wall Design)
- Upon request, tabular results can be presented for the decisive floor only (Result Tables and Spreadsheet)
Area Usage

The area usage uses common area definitions. In the case of noise, it sets the noise limits for an area. The resulting noise levels (assessment levels) can be compared with the noise limits and the noise excess can be mapped as a conflict. The area usage definition is assigned directly to a building and is transferred to the receivers assigned to the building. The area information is used to establish the maximum noise levels acceptable in the area and thus is used in the facade noise map and for dimensioning noise protection walls.

Facade Noise Map - Activate Facades

Activate all facades to be calculated for the Facade Noise Map

For Facade Noise Maps, all facades need to be marked where the receivers should be placed and calculated automatically. The check box for this is located in the index card „Facade Noise Map.“ In the graphics window you see a view of the building and its surroundings. The cursor marking the facades is a small cross. Click on all sides of the buildings you want included in the calculation. Use the GeoTool PREPARE BUILDINGS (see page 110) to define several buildings.

Tab Index Card Additional

Additionally, each building can be assigned the name of the property owner and the property number and the number of occupants. These parameters are transferred to the Spreadsheet and can be displayed upon request.
Additional Information for Buildings

**Adjust Right Angles**

Area polygons (buildings and others) can be entered with right angles. Enter all polygons or buildings and mark the buildings to be rectified:

Make sure „Buildings“ in the object list is activated. Select the „actual object“ from the „View.“ Now the buildings are the only objects visible on screen. Press the right mouse button in the top left corner of the screen and pull the frame around all the objects. They will be marked when you release the button.

Next, select „calculate right angled“ from the „polyline“ sub menu of the „GeoTools“ menu. All buildings with angles in an acceptable range will be rectified. If you see the warning message „identical coordinates found“ a side of a building has a line segment less than 1 cm. Please check your data and try again. If the message „angles not in acceptable range“ is shown, the program cannot decide if an angle is 90 or 180 degrees. In both cases SoundPLAN leaves the original version of the data unchanged.

**Hints for Creating the Model**

Buildings act as barriers. In most cases it is sufficient to enter the building as a block with a flat roof and linearize the ridge of the roof.

*Linearize the ridge of the roof by pulling Up the sides of the building (use your judgement)*

Site map

Side view Front view

Display the ridge separately

Site map

Side view Front view (Gable)

*View: buildings as obstacles*

**Reflection Loss**

The reflection loss describes the loss of energy occurring at each reflection of sound waves off an object. The magnitude of the loss depends on the material of the wall, the impact angel, the frequency, and the size of the wall. For normal noise...
assessments, the reflection losses are "guesstimated" with the following table. Average reflective walls are assigned a loss of 1 dB to account for windows, balconies and uneven portions of the facade.

For traffic noise, the following ranges are applied:

<table>
<thead>
<tr>
<th>Facade type</th>
<th>Reflection loss in dB(A)</th>
</tr>
</thead>
<tbody>
<tr>
<td>smooth facade of a building</td>
<td>1</td>
</tr>
<tr>
<td>facade with balconies and uneven fronts</td>
<td>2</td>
</tr>
</tbody>
</table>

The absorption of sound at a reflection is a frequency dependent phenomena. In general, higher frequencies are absorbed more than lower frequencies. This means the higher frequencies are lost first while the lower ones remain. With the spectrum change, the reflection losses are diminished. To compensate for this, the reflection loss is discounted 10 % for higher orders of reflections.

**Caution:** As tilted reflection walls are not part of any of the calculation regulations, they are not implemented in SoundPLAN. A rough estimate can be obtained by placing a substitute mirror source where the program would have to place a mirror source and disabling the reflection for the calculation.

**Hatch Types of Buildings in the Plotter Graphics**

Buildings can be assigned hatch fills under 90 or 45 degrees from the first face of the building. The different hatch types should identify buildings as main or auxiliary buildings. The hatch type is assigned in the building properties. The direction of the hatch is dependent on the first face:

![Hatch Types Diagram](image)

*Vertical and slanted hatch pattern depending on building entry direction.*

The vertical hatch is drawn perpendicular to the first face of the building. The slanted hatch is drawn under a 45 degree angle. The small arrow marks the first corner of the building.

**Spot Heights (Terrain elevation point)**

Singular elevation information (spot heights) can be used to supply details for the digital terrain model. Via the terrain model, they influence the location of receivers. The noise propagation calculation is not influenced by spot heights.

Often external data include a grid of spot heights. You can use spot heights in a calculation if you calculate a DGM and use this DGM for the calculation. In this case it is not necessary to create elevation lines from a spot height grid.
Elevation Lines and Profile Lines

The object type „elevation lines“ applies to ISO elevation lines in the cartographic sense and to lines following a terrain. The first type represents lines of the same elevation, whereas the second type models elevation profiles and cutting edges. In SoundPLAN the same object type represents both functions.

In noise calculations, elevation lines are evaluated to calculate the ground effect and the screening (if applicable). The particular functions of the elevation lines depend on the calculation standard. Some standards tie the ground effect to the average height of the line of sight above the terrain, whereas others calculate the ground reflection position in great detail. Please read the chapters detailing the ground effect in the SoundPLAN reference handbook. Although the screening does depend on the standard, please remember an effect which may not seem so obvious. Most calculation standards require the screening to be evaluated not only in the shadow zone but also in the illuminated zone. Only regular screens and break lines provide screening in the shadow.

The elevation coordinates and break lines are used in generating the digital terrain model.

Elevation lines consist of the coordinate information x and y and the elevation. For normal elevation lines, the elevation remains the same for multiple coordinates. Therefore the default configuration of the Geo-Database requests new elevation information for only the first coordinate of a string. For break lines, the elevation dialog can be configured to request elevation information for each coordinate. Change the setting in the „Options“ menu to suit your needs.

Hint: If you want to know the elevation of a coordinate, move the mouse cursor close enough to change it’s appearance to an arrow. The x and y coordinates and the elevation are shown in the screen’s status bar.

See the reference manual for details how to use elevation lines for generating the model.

Supply of Elevation Information

Only the following data types are used to generate the digital ground model for the Grid Noise Map:

- Elevation lines
- Elevation information in road and railroad file. The elevation of the master alignment string is ignored, and only terrain information is used. If the value is zero, use the elevation of the master alignment string.
- For buildings, all coordinates are averaged and the mean value is used as an elevation reference. If the building is not closed, every wall section generates an elevation point.
- Elevation points
The coordinates from all these data types are used for the digital ground model. All data is automatically loaded and triangulated.

Lines from all line type data (elevation lines, roads and railroad) are used in the triangulation as line information. This ensures that no triangle generated during triangulation connects coordinates across the lines. Cross connecting the left and right cutting edge across the road would have devastating results.

In spite of all possible checking, the model generation can and should influence how the triangulation is accomplished. One problem is the tendency for plates to form. This often happens when the data is loaded from other programs and has many coordinates along elevation lines and uses a rough spacing in the elevation. Eliminating some coordinates or inserting extra lines in an elevation line file prevents plates forming.
### Break Lines (Terrain edges)

In addition to the normal elevation lines, SoundPLAN supplies the data type "Terrain edge". The major difference is that break lines are evaluated for screening in shadow and illuminated zones. Even when the line of site is not interrupted, the program will calculate the screening! (This, of course, also depends on the requirements of the particular standard.)

![Break line](image)

**Definition break line**

Break lines can be assigned two different elevations - one for the left and right side as seen from the data entry direction. In this way vertical walls filled on the back can be simulated. Break lines are always incorporated into the digital ground model.

---

### Walls

Walls are used to describe noise control walls and retaining walls for the noise calculation. Sometimes they are also used to define the ridge of a roof.

#### Wall Properties

![Wall properties](image)
Wall Height

The wall height is always referenced to the foot of the wall. For example, for a wall height of 4 meters, the screening edge is located 4 meters above the base of the wall. Therefore a wall with the height „0“ will also be used to test for any possible screening effect. Only the elevation of the screening edge is the elevation of the base.

Changes in Wall Height

In the noise calculation, the top of the wall is always evaluated. The wall top depends on the elevation of the foot and the wall height. When a search ray intercepts a line element, the elevation is calculated from the elevations of the last and next points, and the distances to these coordinates. For a noise control wall, the interpolated position is the base of the wall. An interpolation of the wall height for the intersection position is used to calculate the top of the wall.

Noise control walls often have sudden changes of height. For example, there may be a 5 meter noise control wall which at one point changes to 3 meters. In this case the wall height should not be interpolated. To prevent interpolation, mark the checkbox for „constant wall height.“

For constant wall height, the wall is parallel to the ground and the height remains constant within a wall section. If the checkbox is not marked, the wall top is adjusted to the height of the next point. In this case the height of the wall changes with the changing terrain height.

Reflection Losses

The dialog box which allows you to enter the wall height has a definition box to select the reflective properties of the wall. The type of reflection can be „No reflections,“ „both sides same reflective properties,“ „only left side,“ „only right side reflective“ and „different reflective properties on both sides.“ Left and right sides are always referenced from the data entry direction. The first coordinate of a string is marked. In accordance to the type of reflective properties chosen, the data entry boxes for the reflection losses appear.
Walls can be associated with a single value reflection loss like the buildings or they can be associated with a spectral absorption coefficient from the SoundPLAN library. The reflection loss depends on the material used. Reflective walls in general have a reflection loss of 1 dB (A).

For traffic noise calculations or other simulations where the spectral calculations of the reflection losses are not required, you can set the losses according to the following table:

<table>
<thead>
<tr>
<th>Wall type</th>
<th>Reflection loss in dB(A)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reflective surfaces</td>
<td>1</td>
</tr>
<tr>
<td>Absorbent noise control walls</td>
<td>4</td>
</tr>
<tr>
<td>Highly absorbent noise control walls</td>
<td>8</td>
</tr>
</tbody>
</table>

Please enter reflection losses as a single value in the left field. Spectral entries are taken from the library. Press to open the library. Look at the SoundPLAN noise libraries for details.

**Hints for Model Generation with Walls**

Reflective bridge bases are connected to the terrain as follows:

---

Reflective surfaces as obstacles

**Caution:** Tilted reflective objects cannot be automatically calculated in SoundPLAN at this time. You need to estimate the energy reflected in a direction and adjust the reflection loss to accommodate for the reduced influx of noise at a receiver. If this does not help, think about constructing a mirror image source minus the sound power of the reflection.

**Berms**

For berms constructed as noise abatement facilities, the foot of the wall is digitized. The top of the berm is constructed from the height, tilt and top width. This is done in SoundPLAN without user interaction.
Berm Properties

Enter the height of the berm, the tilt and the top width. The tilt of the back side is irrelevant for noise control calculations but is used for assessing the mass to be moved when constructing the berm.

The berm tilt is calculated using the factor of 1:m:

Principle sketch of the berm tilt

The factor for the wall tilt and the top width are always entered in regards to the data entry direction. Positive values will cause the berm (and top) to be constructed to the right of the entered line, negative values will construct them to the left of the line.

Data entry of a berm with tilt and top width
Volume Type Absorption (Mitigation Areas)
(Forests etc.)

Volume type absorption can be used in SoundPLAN to simulate forests and congested areas.

Volume type absorption areas are considered only for noise calculations and to depict forests and closed residential sections in 3D-Graphics.

For big scale noise maps it may be impossible to digitize every building. Therefore it may be wise to gather uniform residential areas into a Volume Type Absorption area. For forests, this object type is a sufficient description of the absorptive properties.

Enter the polygon enclosing the area. The direction of entry is irrelevant. The areas must be entered so the bottom of the area forms a plane. If the area does not form a large plane, please make several smaller absorption areas.

The first line of buildings, as viewed from the receiver, should be modeled as buildings to correctly establish the reflective properties. The buildings behind the first row can be modeled as a volume type absorption. Volume type areas can be inserted in each other if the top height of the area or the absorption coefficient differs. To avoid confusing SoundPLAN about which area is valid, a clear hierarchy of areas must be established. Areas can be included in other areas, but a polygon of volume absorption should not touch the enclosing polygon.

The absorption \( D \) is processed as follows:

\[
D = f \times S_G
\]

\( S_G \) Absorbing distance [m]

\( f \) Absorption factor [dB/m]

The absorbing distance \( S_G \) is the length of a 5 km arc positioned between source and receiver. If between screens, buildings and other impermeable objects are found between source and receiver, all distances between the tops of the objects are connected with 5 Km arcs.

If a search ray passes through multiple volume type absorption areas, the total absorption is calculated as follows:

\[
D_G = \sum_{i=1}^{n} f_i \times S_{Gi}
\]

\( f_i \times S_{Gi} \) Absorption area \( i \)

\( D_G \) Total absorption

Caution! Avoid buildings within absorption areas. Sources can be located within the absorption areas.

Mitigation areas are referenced to the DGM or to elevation lines respectively.
When a DGM was selected for the calculation of the ground absorption in the Calculation core the mitigation area is placed on this DGM.

In the Geo-Database no elevations information are needed any longer, only the height of the mitigation area above the ground, however the elevation is not displayed in the projection of the Geo-Database. Check the location of the mitigation area if needed with a cross section line in the Graphics.

**Volume Type Absorption Properties**

![Volume Attenuation Properties]

Properties of Volume Type Absorption Areas

Select the absorption area type of Buildings or Forests. The effective height is the height of the absorbing area above the ground. The absorption factor is entered in dB(A) per meter. Values between 0.05 and 0.1 dB/m are found in the literature.
Ground Areas (Ground Effect)

Most standards use the ground absorption factor to evaluate the ground effect. Unless the ground type is defined, the whole area is soft. When defining areas, only areas with hard ground need defining.

The ground type is evaluated in almost all non-German calculation standards. The German standards make the ground effect dependent only on the average height of the line of sight and the distance between source and receiver. The VDI 2714 uses $k_{\text{ground}}$ to adjust for the propagation into the half sphere. Most other calculation methods calculate the effects directly.

With regards to the ground effect, the path from source to receiver can be divided into three parts:
- Area around the source
- Area between source and receiver
- Area around the receiver

The ground effect depends on phase effects of the waves. Depending on the “softness of the ground,” some frequencies can be suppressed while others are unattenuated. The ground absorption coefficient defines the softness. Hard ground is nonabsorbent and soft ground is fully absorbent. The area is defined by the polygon surrounding it. The direction of data entry is irrelevant. To close a polygon press NEW or <F2>.

Ground Effect Properties

Ground absorption is defined as follows:
- G 0: hard ground such as asphalt and water
- G 1: soft ground such as fields and grass (default setting)
- G p/100: Set G to any value representing an average of soft and hard ground.

Floating Screens

Floating screens can be used to define a horizontal screen with a defined object elevation above ground, for example the roof of a petrol station. The floating screen is not reflective. You can define a wall height for the floating screen which may
change within the object, e.g. if you want to define a wall only at one edge of the floating screen. The wall height can be negative.

Floating screen properties

**Calculation of the insertion loss:**

An additional insertion loss is calculated and added to the normal insertion loss caused by normal screens (may include side screening). The normal insertion loss takes in most cases the ground effect into account.

Calculation of the insertion loss: A "rubber band path" is determined. The partial insertion losses for each of the "rubber band path" segments are determined and summed up. The total insertion loss is limited to the value of the maximum screening loss for multiple screening.

Calculation of the partial insertion loss: If the line of sight is not blocked a negative extra path length is determined, otherwise the smallest extra path length (over the top or below) is computed.

The insertion loss is calculated from the extra path length and is limited to the maximum value for single screening loss. The formula is taken from the VDI 2720 with C3=1 and C2=20 (single screen).

---

**Single Point Receivers**

Single point receivers are locations where a noise or air pollution calculation is to be performed.

Receivers can be assigned directly to buildings. Therefore, receivers connected to a building do not need an elevation dialogue.
Connecting Receivers to Buildings

When receivers are attached directly to buildings, SoundPLAN can make sure the receivers are not accidentally located inside the building. By placing the receiver directly on the facade, the section where the noise can be received is corrected and reflections on the „own“ facade are suppressed. If you are using the CoRTN standard, the receiver will be placed 1 m in front of the facade. Digitize a receiver near the building where you want it attached. In the properties dialog a zoomed window of the area around the receiver is displayed. To attach the receiver to a building, click the side of the building you want used as a base for the receiver. SoundPLAN now references the receiver to the building and shows the street name and number derived from connecting the building to the road. The property number and area usage identifier are transferred. The section where the receiver can receive the noise is also adjusted to coincide with the direction of the facade.

As the buildings are always referenced with their height to the ground floor, the receivers can be set relative to this position. By default SoundPLAN will position the receivers 2.4 meters above the ground floor. For additional floors, the receiver position is derived by adding 2.8 meters to the height. The default settings can be modified to suit your needs via OPTIONS -> PRESETTINGS.
Definition of receivers

SoundPLAN can simultaneously calculate buildings with up to 255 floors. Please enter the number of floors in the appropriate box.

It is good practice to calculate all floors in one run. Memory intensive actions like displaying level charts are only done for a single floor. Please mark this floor as the „decisive“ floor. The numbering of the floors starts with 1.

Geometry definition in the receiver properties

In the geometry definition, the x, y and z receiver coordinates are mapped. You can also enter the angles of the segment from which the receiver will receive the noise. Most often the noise is assessed for 360° to include the noise from the other side of the building. However, some standards or assessments require a limited segment for noise intake.

For many noise evaluations, especially for traffic noise, it is sufficient to calculate only the noise from the exposed side. To do this, right click on the facade.
**Receivers in Front of the Building and in the Free Field**

When calculating single receivers not attached to a building, the receivers must be given the exact elevation of the receiver and the elevation of the terrain. Set the number of floors to 1 and the relative height to the ground floor to 0.

If the receiver is placed on a balcony in front of the main facade, the influx of noise should be set to 360 degrees and the reflection on the „own“ facade enabled.

**Calculation of the Ground Effect**

When receivers are attached to buildings, the reference to the terrain height of the receiver is established automatically via the terrain height of the building. The height of the receiver above the terrain is used in all standards for calculating the ground effect.

The calculation of \( h_I \) for receivers not attached to buildings is slightly different.

**Cross section**

Cross sections are used to define the the cross section for cross sectional grid noise map calculations.

Enter the two coordinates for the cross section. Elevation lines, spot heights, roads, railways and berms are used to define the terrain. The ground relief is automatically calculated out of the highest and the lowest point of the relief.

A cross section of the input data can also be defined in the graphics.
**Display of Objects in the Cross Section**

Point objects are displayed and used for the calculation if the distance between the point and the cross section is smaller than a defined maximum distance. The maximum distance for the calculation is defined in the run kernel. For the display of point objects, the distance can be entered in the graphics.

There are two types of line objects. The one has a wall height, such as walls, the other is only available as a line, such as line sources, emission bands and so on. Walls are displayed as a vertical line, the others as horizontal lines with a length of 10 cm.

Also with areas there is a difference in the definition. Areas with height (buildings, volume absorption areas) are displayed as a cross section through the area, areas without height (road and railway bands) are displayed with a thickness of 10 cm.

---

**Calculation Area**

Calculation areas are used to define the area for grid type calculations for noise and air pollution calculations. As the calculation area for MISKAM-calculations has special requirements, the generation of these calculation areas has it’s own start symbol.

A grid of receivers is generated within the calculation area, with all receivers at a user defined height above the ground. The noise or air pollution values are either calculated or interpolated for each of the grid points.

The calculation area can be any form or shape, convex or concave.

The calculation area polygon itself does not require elevation information. As all grid points within the calculation area are positioned at a specific height, the elevation information comes from other sources (spot heights, elevation lines, receivers...).

---

**Geometry Texts**

Geometry texts, as the name indicates, describe the geometry. Road names, house numbers and other describing texts are positioned at a location fixed in world coordinates. Texts describing particular elements of a plot should be entered in the Graphics as Plotter texts.

Location and size of geometry texts are managed in the world coordinate system. The geometry texts are bound to coordinates and are zoomed up and down with the drawing.
Text Properties

Enter the text in the appropriated field and look at the text in the graphics window. The cross marks the text coordinates. The text size is shown in [m]. For control, purposed the conversion into points is given as well. Define the text font, character size, color and attributes (normal, bold, cursive, underlined). Click the appropriate field. Clicking the color selection field opens the color palette.

Entry of Text Angle

The text direction can be entered in degrees manually or by dragging it with the mouse. To change the angle, activate the „angle“ field. Move the mouse with the left button depressed until the text is suitably aligned. Or align the text along another line by pressing the left mouse button and moving along the line.

Text Direction

The text direction determines the text direction from the text anchor:

- Vertical alignment
  - top
  - centered
  - bottom

- Horizontal alignment
  - left
  - centered
  - right

The position of the little cross at the text is the anchor for rotating text. The angle of rotation is entered in degrees.

For all fields in text properties aside from the rotation angle, you can reposition the text with the little cross cursor. Move the cross to a new location and the text is anchored at the new location.
6 Libraries

Overview

In SoundPLAN, data that might be applied in different projects are managed in global libraries. To deliver a consistent approach and maintain a greater flexibility, the libraries consist of three parts - a system library, delivered with SoundPLAN (not changeable because it will be overwritten with SoundPLAN updates) a global library to host the reusable information, and a project dependent library to store the data that applies only to the local project.

Available Libraries and their File Names

Within the libraries you can both copy and start new, empty libraries.

Installation Instructions

The libraries are installed in the SoundPLAN program sub directory under the path „LIBS.“ This sub directory is overwritten with each new installation of SoundPLAN. As the user can (and should) amend and customize the libraries, they need to be safeguarded against overwriting. The best way to do this is to create a
new, individualized folder for the libraries. Open the library and select **LIBRARY -> GLOBAL PATH**.

As a networked approach means that data on the server may be changed, it is mandatory that a local copy of the data is available that cannot be changed by someone else. Therefore, when the library is opened for the first time in a project, SoundPLAN creates a local copy of the library in the project folder. If no library data is accessed in your project, no local libraries are cluttering your harddisk. Data to be used in a project originating in the global library must first be copied to the local copy of the library before it can be used.

To safeguard the global library in a folder of your choice, you can create the new path and copy the data files with the Explorer or use a SoundPLAN copy function. If you want to use the data contained in the SoundPLAN library at delivery time, it is probably wise to mark all files in the library and pull them into the new folder. As the libraries are databases, you need to copy all files from the **Libs** folder.

### Importing Libraries

Select the path, where you want to import the data. For the global emission library for example **LIBRARIES -> GLOBAL -> EMISSION**.

Open the import via **FILE -> IMPORT** and select the desired file format (Excel, ASCII or SoundPLAN DOS library).

#### Import definition for an Excel or ASCII file

The column of the Excel or ASCII file have to be assigned to the fields in the library. SoundPLAN offers an **AUTOMATIC LINK** to compare the column headers with the library fields. The automatic link only works properly, if the column...
headers correspond to the library field names. The list of assigned columns is displayed in the field on the left side of the import dialog.

Import templates for Excel files are included in the SoundPLAN installation. Access them with the Windows Explorer SoundPLAN 6 -> System -> Libs. If you arrange your Excel libraries in the format of the templates, you must only select AUTOMATIC LINK, check the result and then START IMPORT in the Excel import dialog.

Column assignment via the automatic link

Check the links. If not all columns are assigned correctly, you can define further assignments manually.

Click DEFINE LINK to define a new assignment or double click on an automatic link to change it. Define the assignment of single columns with the library fields or a text which is automatically added to all imported library elements in a defined field.

Manual column assignment

Select the desired column and assign a library field from the lower selection list.

You can add a text or a value to a defined column. This is useful, if you want to add an "A" to the library field filter, because the imported spectra are A-weighted. Activate the field FIX and enter the text or value.

APPLY adds the link to the list of links without leaving the dialog. If you want to define several links, it is faster to use apply instead of OK.

Remove existing links with DELETE LINK.

Enter the data range for the new library elements WITH START IMPORT FROM LINE NO. The column definition (field names from the library) is displayed in the first header row, the data from the Excel or ASCII file in the following rows.
If necessary, activate the check box **STOP IMPORT IN LINE NO.**, e.g. if additional information is part of the file or if you only want to import some of the elements in the file.

After all assignments are correct, import the library elements with **START IMPORT**.

**Libraries from SoundPLAN DOS**

If you created and used the SoundPLAN libraries in the DOS version, you can import the libraries selecting **FILE -> IMPORT**. The program requires the path to the SoundPLAN DOS program and will show you the available libraries. Click Open to import the DOS library.

**Working with the Libraries**

The libraries are automatically opened when data from the libraries is required in the properties of an object. This is the case for day histograms and spectral data describing sources and the absorptive characteristics of reflective walls.

According to the needs of the respective library, the number and content of the index cards may vary. The next section describes the general features of the library and the special requirements of the libraries.

The Libraries with the Example of the Source Library

The libraries consist of two parts. A list of all elements is shown in the left window. New entries are inserted in this list. The right window is fitted with several index cards that are specific to the library type. The index cards contain spectra, numerical values, group definitions, noise limits, diagrams, etc...
Edit Library Records

The library elements are managed in a database. Each element is a record which can be edited, generated and deleted. The symbol bar is used to control the records:

Hint: When you are editing a library element and want to move to the next element, SoundPLAN asks if you want to store the changes in the library or continue editing. If you do not want to permanently store the data in the library, press undo the changes, otherwise you will not be able to leave the edit mode.

Copy Library Records

Records can be copied from the global to the local library and vice versa.

To copy the records, open both libraries, select the record to be copied (Ctrl+ left mouse click for single elements and Shift+ arrow keys for an element block) and click the right mouse button or select EDIT -> COPY TO. If two libraries are open, both paths are listed. Mark the library where you want to copy the elements. If one of the element already exists in the target library, there are several options how to handle it:

Record Already Exists

Enter Comments and Numeric Values

For each record, you can enter a comment of any length and descriptive parameters. It is often useful to document the origin of the data, the literature where information was found, the reliability of the data and any special knowledge about the component.
Comment Field

Up to 4 characteristic values can be made in individual fields for size, weight, speed etc..

Group Reference

A library element can be assigned up to four groups. The groups function as search criteria and will appear in the source documentation.

Index Cards Groups

To assign a record to a group, open the index card for groups. The four empty fields can now be assigned a group by opening the selection arrow. If none of the present groups fit your needs, a new group can be created using the navigation keys.

If several people in your office use SoundPLAN, coordinate the nomenclature so the group will not lose its usefulness quickly.

Delete (the minus in the navigation bar) removes a group definition. Caution!! All records belonging to this group will lose the member state to the group!!! Please think first and delete later!
Scale of the Y Axis

For the graphical presentation of spectra (source, absorption, transmission and attenuation) the Y axis default is set to the auto scale mode and is filling the entire available area optimally. If you want to browse and compare spectra quickly, it may be advisable to disable the auto scale function and assign a value range. To do this, open „View“ and disable the „Auto Scale“ mode in the „Y-Scale“ entry. The fields Min and Max indicate the range you will see from the spectral data in the graphical form.

![Y-Scale]

Scaling the Y Axis

Colors

Colors can be customized for the printout of the libraries and graphics within the documentation.

Select Colors in the View menu. If selection positions are not available, then they do not apply to the library currently open (assessment library). Clicking on the „Edit“ bar modifies the colors.

![Customize Colors in the Library]

Customize Colors in the Library

Click any of the existing colors or define your own colors using „Define Colors.“ The user defined colors use RGB values (0..255) or the color number, brightness and saturation (0..240). „ADD Color“ accepts the color in the palette and you can then select it for your color scheme.
Emission, Absorption, Transmission and Attenuation

The data entry in the libraries for emission (source spectra), absorption, transmission and attenuation (noise control measures) is so similar they are described together. The emission library has some additional functions.

Index Card Values

The value field offers either octave or third octave spectra according to your needs. As the acoustical problems vary, so can the upper and lower boundary of the spectrum. After customizing the record, enter the values in the table. Depending on the library type, either the total noise level (sources) or the total rated transmission loss is shown in the gray field in the top left corner.

Hide Element Box

If you need more room on screen for data entry or for graphics, you can hide the list of all available records by opening the „View“ menu and clicking „Hide Element Box.“ By clicking the same selection again, the element box reappears. In most libraries the element box can be toggled with "<<" and ">>".

Additional Parameters in the Emission Library

Check your data to see if it is linear, or weighted with an A..D filter, and select the filter type accordingly.

If your data is available in [dB], but you want to keep it in the library as an A weighted spectrum, enter the data as a linear spectrum and after the data is typed in, change the weighting to [dB(A)]. SoundPLAN understands this as a command to change the weighting and converts it to dB(A).
In the field „Reference,“ please enter the values as sound pressure level (for transmission purposes), as power spectrum per meter (or square meter for area sources), or as the total spectrum of the entire source.

You can assign 2D or 3D directivity adjustments to the source. To enter the data, double click on the text fields for one of the options. 2D directivity can be horizontal or vertical or both.

You can also define a source with a rotational symmetry around the Z Axis much more easily than with the full 3D directivity.

**Directivity Library**

2-dimensional and 3-dimensional directivities are defined in the directivity library and assigned directly to the source. When the source spectrum is taken from the library to the source properties, the directivity is assigned implicitly and with the definition of the mean direction all parameters needed for the directivity are included.

**2D-Directivity**

Data entry is accomplished numerically in a table or by pointing and clicking with the mouse on the diagram.

Directivities are entered in the table as pairs of values with the direction in degrees and the value of the level change in dB(A).

![Directivity Diagram of a Fighter Jet](image.png)

0° is the axis of the source. When assigning a source to a building, this axis should be the normal vector of the facade.

Create a new element, enter the new element’s name and enter the value pairs consisting of direction and dB(A) change under the index card „values.” In the index card „diagram,” select the interpolation of the values. SoundPLAN interpolates the directivity in such a way that every 10 degrees a value is available.
The interpolation can be carried out either as a 3rd order polynomial or as an exponential spline with tension factors ranging from 1 to 20. The tension factor is a parameter for the smoothness of the resulting curves with a factor of 1 being equivalent to the 3rd order polynomial. The interpolation line is shown as a green line. When the values created by the interpolation are accurate enough, accept the values into the table as the final set of data. The values now are present every 10 degrees.

SoundPLAN recognizes certain symmetries (mirrored at the x or the y axis), so if values are entered only between 0° and <90° they are extrapolated for all quadrants, and when the values are entered between 0° and <180° the data is extrapolated for the second half.

**Data Entry for Single Symmetry:**

<table>
<thead>
<tr>
<th>Angle</th>
<th>Delta [dB]</th>
</tr>
</thead>
<tbody>
<tr>
<td>30</td>
<td>5</td>
</tr>
<tr>
<td>60</td>
<td>5</td>
</tr>
<tr>
<td>90</td>
<td>4</td>
</tr>
<tr>
<td>120</td>
<td>3</td>
</tr>
<tr>
<td>150</td>
<td>2</td>
</tr>
<tr>
<td>179</td>
<td>1</td>
</tr>
</tbody>
</table>

**CAUTION: DO NOT ENTER A VALUE OF 180 DEGREES!**

**Data Entry for Double Symmetry:**

<table>
<thead>
<tr>
<th>Angle</th>
<th>Delta [dB]</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>5</td>
</tr>
<tr>
<td>20</td>
<td>5</td>
</tr>
<tr>
<td>30</td>
<td>4</td>
</tr>
<tr>
<td>40</td>
<td>3</td>
</tr>
<tr>
<td>50</td>
<td>2</td>
</tr>
<tr>
<td>60</td>
<td>1</td>
</tr>
<tr>
<td>70</td>
<td>-1</td>
</tr>
<tr>
<td>80</td>
<td>-2</td>
</tr>
<tr>
<td>89</td>
<td>-3</td>
</tr>
</tbody>
</table>

**CAUTION: DO NOT ENTER A VALUE OF 90 DEGREES!**

Select the index card for **Diagram** and select the interpolation. SoundPLAN shows the interpolation for all quadrants. When the values seem right, accept them.

SoundPLAN now fills the table every 10 degrees with the interpolated values, and the missing values generated by the symmetries are extrapolated.

Use the mouse to enter the values directly in the directivity diagram. Request an empty diagram with the checkbox „New.“ The cursor changes to a small cross. With the left mouse button click on the positions the diagram should use and then proceed with the interpolation the same as with the tabular data entry.
The directivity diagram can be zeroed so the addition of the directivity diagram to a source does not change the overall sound power. The values of the diagram are increased or decreased so that the sum of the values in the diagram becomes zero dB.

As the directivity can be made for the horizontal plane or for the rotational symmetry around the Z-axis, numerous cases where a 3D directivity is called for but no values are available can be simulated.

**3D directivity**

The full 3D directivity requires much more data entry than the 2D version. For every 10 degrees of latitude a directivity diagram is needed.

Example of the 3D Directivity with the Value Table

An example demonstrates the complex matter of the 3D directivity. The directivity is shown in the X-Y plane. The angle between the Z axis and 0° is drawn in the diagram in the bottom right corner as a red line.
Values for the 3D directivity usually are available from the manufacturer of the component. The 3D directivities delivered in the library represent zeroed directivities for loudspeakers. The mean direction of the speaker is the Z axis, so the speakers directivity need to be positioned.

**Day Histogram Library**

The day histogram or times of operation are needed for sources not transmitting a constant sound power over 24 hours. Often the noise assessments prescribe a quiet time during the day where a penalty is added to the noise level of quiet hours. Single descriptors similar to SEL, LDN and others can be created and customized only if the sound power is known for the entire day.

For each hour of the day the information on the status of the source is needed. The source can be active 100% or a fraction of it. The definitions of the fraction can be either the number of noise events during the hour or the fraction of time during which the source is active (either so many minutes or seconds per hour or as a percentage). If the selected base data is events per hour, the sound power needs to represent a single event.
Example: A fork lifter drives 20 times an hour between the store and the production hall. In this case the sound power of the source should be set to cover a single event and the day histogram should be for 20 events per hour.

Use the + to request a new element and click on the index card for "values." Enter the duration of the event.

You can define the hours of operation in one of the following modes:
- minutes / hour
- seconds / hour
- units / hour
- %
- dB

**Assessment Library**

The assessment library contains noise limits for defined usage areas and procedures for evaluating the level. SoundPLAN is delivered with a number of assessment standards, but the library can be amended with your procedures and noise limits.

The noise limits vary depending on the type of noise, the assessment procedure and the characteristic of the area for which the assessment is targeted (area usage). SoundPLAN uses the abbreviated area identifiers as keys so they cannot yet be modified. Only the name of the object can be overwritten the SETTINGS of the SoundPLAN Manager, branch AREA USAGE.

When entering a new project in the SoundPLAN Manager, check the assessment in the SETTINGS, branch STANDARDS. In the calculation core you can change the assignment locally for a single calculation run.
Creating a New Assessment Record

Create a new element. In the index card „define“ set the time slots for which the assessed noise levels shall be calculated from the 24 hours of the day. A single time slot is the minimum requirement.

Assessment Library with the Definition of Time Slots

Enter the name of time slot and identifier in the appropriate fields and define the hours assigned to a specific time slot. If no further definitions are given, the identifier is used to characterize the time slot in the documentation. Ta is the number of hours for averaging the time slot in the assessment level. No entry in the field “Ta” has to be made if the time slot is the same as Ta. Some standards the hours in the time slot and the hours for averaging the time slot are not the same. In this case, please enter the averaging time into the field “Ta”. SoundPLAN calculates the evaluation level using the formula:

$$10 \log \left( \frac{1}{T_a} \cdot \sum_{i=1}^{n} 10^{0.1 \cdot L_i} \right)$$

The assignment of hours to a time slot can overlap. For example, the overall L_{eq} and the loudest hour at night time can form individual time slots.

Some assessment procedures demand only the noisiest hours within a time period. In this case enter the number of hours in the field „N loudest.“ For the single loudest hour at night, enter the value „1.“ The loudest hour will be used from the hours assigned to the time slot night time.

ADD is used to define new time slots. The number of time slots is not limited. If you want to delete a time slot, make sure the index card you want to delete is active before you click DELETE.

Enter the noise limit for each time slot in the index card LIMITS. The values are preset with „0“ and only the time slots associated with a limiting value need to be set.

The index card PENALTIES is used to define penalty times for certain area usages and hours. In the table you can assign the same value to multiple fields by clicking...
on a field and moving the mouse with the left button pressed. All marked fields will be set to the value of the base cell.

The Road Day Histogram Library

For different road types, the number of vehicles or factors for each hour are entered in the road day histogram library. The library manages the vehicle types defined in the appropriate standard. Therefore, SoundPLAN divides the vehicle types into cars / trucks or cars, noise reduced / normal heavy and light trucks. If the calculation has to be executed according to different standards with different vehicle type classifications, the library element has to be defined for the different standards.

Assign the road types in the road properties of the Geo-Database, according to the entry type of the emission calculation.

You can either enter the number of vehicles of an actual traffic count or the factors of a characteristic time distribution for a specific road type.

Use the DISPLAY FORMAT to select if decimal places should be displayed and how many to display. You can also choose to display "-" for values equal 0, to get better clarity. The definition of the display format is fixed, so you have to define negative values (in the middle range), too, even if it doesn't make sense in this case.

<table>
<thead>
<tr>
<th>+;:-0</th>
<th>Definition of the value range</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.00;:-</td>
<td>Shows positive values with two decimal places and 0 as &quot;.&quot;.</td>
</tr>
<tr>
<td>0</td>
<td>Shows all values without decimal places.</td>
</tr>
</tbody>
</table>

A semicolon separates the ranges; a point separates a decimal.

Select the appropriate standard from the selection list STANDARD. SoundPLAN summarizes standards with the same vehicle types.

Activate DO NOT NORM, if the sum of all 24 values is not 100%, as for the table 3 of the RLS-90.

Copy hourly values

You can use the clipboard to paste hourly values from an external software (e.g. an Excel spreadsheet), or copy one element to another within the library.

Make sure the cursor is placed in the table and not in the section of the element name (the element name may not be highlighted) and press CTRL+C.
Select the items on the list that you want to copy. The item **COMPLETE GRID WITH HEADER** can only be used to copy data to an external program.

Then select the element where you want the values copied, (make sure the table is active) and press **CTRL+V**.

You can copy the definition of a complete element if you click right on the element name, copy it to the same library and give it a new name.

**Definition and Assignment of the Emission**

If the calculation is executed according to *Lden* another input window for the emission calculation is opened in the road properties. The level can be set for the three time ranges or calculated from the traffic volume and other parameters using the pocket calculator. The base values can originate from the road day histogram library or can be entered directly.

Five input types are available:

- **Road Day Histogram Library + ADT**
  - The distribution of the traffic volume over time originates from the road day histogram library, the average daily traffic (ADT) is entered manually.

  You can use this input type with data assigned from a road network. In this case the ADT comes from the network element, assigned in the tab index card "traffic". The percentage of the vehicle types are exactly the same as in the road day histogram library.

- **Road Day Histogram Library + ADT + HT**
  - The distribution of the traffic volume over time originates from the road day histogram library, the average daily traffic (ADT) and the percentage of heavy traffic is entered manually.
This input type can also be used together with data assigned from a road network. In this case the ADT and the portions of the vehicle types are taken from the network element, assigned in the tab index card traffic. The vehicle types of the road day histogram library are converted to the number of vehicles assigned in the network element, whereas the temporal distribution according to the road day histogram library is taken into account.

**Portion of the ADT manually**

The portions of the ADT are entered as factors and the heavy traffic portion is entered in per cent.

If a road type of the road day histogram library has been selected, the hourly distribution averaged to the time ranges and converted into factors.

**Vehicle/h from the industry day histogram library**

For industry and leisure noise investigations you can enter the traffic lanes of a parking lot, which has to be calculated according to the exact procedure of the Bavarian parking lot study. A day histogram from the industry day histogram library is assigned to each vehicle type. If you want to add elements to the industry day histogram library, click on the double arrow next to OPEN DAY HISTOGRAM LIBRARY.

**Vehicle/h manually**

Enter the vehicles per hour for each vehicle type and each time range.

The displayed levels for the time ranges day, evening and night are the average levels over the hours of the time range. For the input types where the road day histogram library is used, the emission stored per hour, so that you can select assessments with any assessment time range definition, e.g. the loudest 8 hours or the assessment time ranges day and night.

Enter the additional parameters for the calculation of the emission level in the fields of the tab index card SPEED, SURFACE, ETC.
Print libraries

You can print the element list of the selected library, as well as the detail data of the elements.

Open FILE -> PRINT and select whether you want to print the ELEMENT LIST or the ELEMENT DATA.

The element lists are a tabular output of all elements with the assigned values of the selected library. If you select element data, the selected element is printed with all details (charts, values, comments ...).

Print options

You can export the element lists to ASCII or copy them to the clipboard. Adjust font, text size and background color for the title row. Define the PAGE LAYOUT for the table output. The page layout is a central function in SoundPLAN, used for all printouts. Please read the section "Page Layout", page 216 in the chapter Result tables. The preview shows the content of the data but not the page layout.
7 Calculations

Run file and calculations

Open the calculation from the project manager. The user interface of the calculation core is a table where each of the calculations in a project should have their own line. This way you always have an overview of all calculations in the project and you can always re-run the data in case the model data changed. Each project must have one but can also have multiple run files. For very big projects it may be useful to structure the calculations in multiple run files, for small and medium sized projects it is advisable to host all calculations in the same file.

Each line in the run file is defining a calculation of its own, each calculation will have multiple receivers to be calculated. In the calculation definition you select the basic data to be calculated, select the function that should be run, define additional parameters for the calculation and request the type, amount and location of the results from the calculation. Calculation settings that were defined globally or for the project through the SoundPLAN Manager can be modified here to suite the need of a particular calculation run.

Run file

You see in one glimpse what type of calculations, what result file number and which geometry information was sent to the calculations and when the data was last edited and when the calculation was run last.

An additional benefit of the table type arrangement is that multiple calculations can be chained easily to be processed one after the other. This is especially helpful if you want to have multiple jobs done over night or on the weekend. An in depth log book informs you of warnings and error messages that happened during the calculation.
and also logs events that might have an influence on the calculation results. Security settings that define when the calculation will be aborted are user defined. This way you are always in charge of the calculation and the overseer of the quality assurance.

---

**Generate calculation runs and edit the properties**

When you open the calculation core for the first time, a run file with the name "noname.run" is opened and the table with the calculation definitions is opened. In the course of project work you will generate multiple more calculations, to request a new one click on the icon + on the navigation bar. To enable a calculation, the first column must contain the marker YES which you get by double clicking in the first column. Enter the name of the calculation in the table or open the calculation property dialog by double clicking on the column NAME or the column CALC TYPE or via right clicking on the line and selecting PROPERTIES. An empty line without definitions is deleted as soon as you move away from it.

Another handy possibility to create new calculations is to right click on an existing calculation to COPY the line and afterwards again with right clicking PASTE or PASTE IT IN A NEW ROW. The cursor jumps to the column RESULT, enter a result number here that has not been used by another calculation. The result number is used in identifying results from the calculation in Documentation, Graphics etc.

When you leave the run file, you are asked for the file name of the run file. For small and medium project it is sufficient to store all calculation runs in the same file, so you could conveniently name the file "all.run."

**Calculation run properties**

All calculations need certain parameters and settings. When you generate a new calculation run all parameters are set to the default conditions. These conditions are defined in SOUNDPLAN MANAGER/ OPTIONS/ SETTINGS/ GLOBAL SETTINGS OR PROJECT SETTINGS/ RUN COMMANDS. For every type of calculation you can customize the default settings at this location.

As long as the project does not have a run file stored, the definition table for all calculations is opened directly to set the properties of the first calculation. When you open the Calculation core the next time the run file dialog is opened where you need to confirm the name of the run file. Select the calculation run by double click on the fields NAME or CALC TYPE or open the properties via the menu EDIT -> RUN PROPERTIES.
Calculation properties

Under the tab **GENERAL** you enter the name of the calculation run, select the calculation type and the data to be processed and enter the number that will identify the results afterwards.

**CALCULATION ENABLED:** In the batch processing only calculation runs that have this box checked are processed. The checkmark corresponds with the „YES“ in the first column in the table. Batch calculations are triggered by clicking on the field.

To trigger a single calculation (the highlighted one) click on the button. The calculation does not need to be enabled and only the active calculation will be executed.

Please select a calculation type from the list of calc. types. Depending on the selected type of calculation the definition box will have a number of extra tabs to host the calculation type specific information:

**A: single point receivers sound (SPS) -> see page 196**

The Situations and Geo-File hosting the geometry must contain single point receivers. Click on the tab with the label “SPS” to open the definition box for single point receivers. Define which level of results you want to generate, **PLAIN RESULT TABLES** only create a list of receivers with the noise levels, **LEVEL CHARTS** will store the directional diagrams indicating from which direction the noise reaches the receiver, **DETAILED RESULT TABLES** stores much more data detailing the sources, average conditions and the transmission path. **PROTOCOL TABLES** will write a complete account for each partial calculation but will create a huge file and should be used only in cases where you want to see every detail. If the graphics are activated during the calculations, you can see the level charts in the size selected in the field **RADIUS** for the time of the day selected in **TIME SLICE**. If a calculation area is contained in the geometry only receivers inside the calculation area are calculated.
B: Grid Noise Map -> see page 198

The geometry must contain a calculation area and must have sufficient elevation information so that every spot in the calculation area has a defined elevation. If a rubber band is strung around all coordinates containing elevation information, the calculation area must completely fit inside. In the tab for the Grid Noise Map define the parameters for grid spacing, receiver height above the terrain and interpolation criteria for the acceleration of the calculation.

C: Façade Noise Map -> see page 203

In principle the Façade Noise Map is an automated single receiver calculation. The façades of the building that shall host receivers need to be specially marked in the Geo-Database. In the Façade Noise Map tab set the spacing of receivers for each façade is set. Receivers are calculated for all floors (up to 255.) For the Façade map most of the times only simple result tables are generated. If a calculation area is included in the geometry, only receivers inside the calculation area are calculated.

D: City Noise Map -> see page 206

The geometry must contain a calculation area and it must be have sufficient elevation information so that the elevation of every receiver can be interpolated between existing elevation points. The City Noise Map combines DGM (Digital Ground Model) calculations with single point receiver calculations. Especially in the cores of older cities where the roads are very narrow, this calculation procedure has distinct advantages over the Grid Noise Map. In this case the City Noise Map will use only use a fraction of the receivers the Grid Noise Map would use for the same quality of contours. Reflections on façades close to the receivers can be enabled or suppressed.

E: Wall Dimensioning -> see page 247

The calculation for Wall Dimensioning is a pre calculation for the read on line dimensioning of the wall or berm. Amongst the normal geometry there must be a Geo-File containing the wall which has been marked in the properties for the wall dimensioning. The settings for the calculations pertain to the wall element height and the maximum number of elements for the wall to be dimensioned. If the button IGNORE WALL OR BERM HEIGHTS IN DESIGN FILE is clicked, the heights of the wall in the wall design Geo-File will be ignored, otherwise the height iteration process starts with the wall of the already set height.

F: Cross-sectional Noise Map -> see page 202

The Cross-sectional Noise Map is a vertical Grid Noise Map. The Cross-section line is entered through the Geo-Database as a line receiver and must be present in one of the Geo-Files of the calculation. Around the Cross-section line enough elevation information must be present to assure that the program can define the terrain elevations along the cutting line. In the tab for the Cross-sectional Noise Map the maximal height to which the map shall be calculated and the grid spacing must be defined. Interpolations criteria must be set for the acceleration of the calculation.

G: Indoor Single Point Receivers, Grid Noise Map, Sound Propagation Curve - > see page 142
For the calculation of noise in industrial buildings several different calculation types are needed. The settings for the calculations are the same as for the noise propagation outside with the exception that the industrial hall has a flat bottom and therefore no DGM is needed for the calculation of the Grid Noise Map, neither is a calculation area needed. In addition there are some additional parameters for the indoor calculation to set the accuracy of the calculation.

**H: Hallout (In -> Out) -> see page 141**

From the simulated or set noise level inside the industrial hall and the transmission loss of walls and roof, this calculation determines the sound power of the building for the calculation of the environmental noise. Receivers for this indoor calculation are automatically generated one meter from the inside walls in the middle of all wall sections.

**I: Miskam and Miskam Screening -> see page 363**

In the Geo-Database the Miskam calculation area is entered and already contains the sequence of grid spacing and height sequencing of the stacked grids. In the calculation run definition the pollutants are selected and calculations grids and meteorology are defined.

**J: Elevation lines**

With this calculation type the elevation information from the geometry is triangulated and elevation lines are generated and stored as a Geo-File to be used in the Geo-Database or with any other module. The elevation difference between the elevation lines and the file number for the result need to be defined.

**K: Digital Ground Model DGM -> see page 88**

This calculation type triangulates all elevation coordinates contained in the Geo-Files and puts the result at the disposal of the Geo-Database and the Graphics. The main purpose of this calculation is to generate the triangulation for digitizing data form bitmaps in the Geo-Database.

**L: TA-Luft (Gauss-Model) single receivers and Grid Pollution Maps**

The settings required here are for the selection of the pollutant and the 3D-wheather statistics.

**M: Aircraft noise single receivers, Grid Maps and Contour lines -> see page 343**

In addition to the settings in the airport and operations definition the standard and some special parameters need to be defined here.

Under the tab **DESCRIPTION** you find an empty sheet where you can note your comments and information describing the calculation run. Filling out this description is especially helpful when the duration of the project is long and multiple people are working on the project. When the cursor is positioned on a calculation run and the line is highlighted, the comments are displayed at the bottom of the screen. This description will be stored with all result data so it helps very much to understand the meaning of the result files.
Copy a calculation run

To generate a new calculation run with the same settings as an existing run, the calculation runs can be copied. Right click on a calculation run to COPY it, then select a new calculation run by clicking on the + sign, move to the new empty line and PASTE the calculation run by right clicking and selecting the appropriate action. If you right click and select the option PASTE IN A NEW ROW, SoundPLAN will generate the new row for you and paste the copied content into it.

Hint: After copying calculation runs it is necessary to check all calculation parameter, they were not generated from the default settings but came from the calculation where they were copied from. If you select a different calculation type, the settings will be inserted with the default conditions.

Selection and Assignment of Situations and Geo-Files

Via the tab DATA assign the geometry data that shall be used in the calculations. In general this will be done with the situations created and stored in the Geo-Database. It is also possible to connect Geo-Files directly or even files from the DOS version or SoundPLAN. By clicking the double arrow in the box for the calculation data, you open the window for the file selection where the data are selected and assigned to the calculation run.

Selection of the geometry

The left and side shows the available files, the right side the files selected for the calculation run. The big selection window presents all files available for the file type that is selected above. If situations are selected, the box shoes all situations of the project, if Geo-Files are selected then all Geo-Files are presented. The files hooked into a calculation run can have different types, situations and single Geo-Files can be included and in addition to this mitigation files generated by the Expert System for Industrial Noise and GausBeam Script files that are the result of a calculation of complex meteorology (wind and temperature inversions) for industry noise.

When the Situations are the file type of choice, the contained Geo-Files and a pictogram of the Situation are displayed below the Situation listing. To include one or multiple Situations, mark them (for a single just click on it, for multiple ones use...
the Shift and Ctrl keys and click) and click on the icon or pull them across to the right with “Drag & Drop”.

In some cases it might be sensible to include singular Geo-Files in the calculation (for example Wall Dimensioning Geo-Files or to include a Geo-File with a calculation area in calculation run that was used for single point sound calculation and now is used to calculate a Grid Noise Map) Before selecting the files switch the file type to the „GeoFiles (*.geo)“.

In the same way files from the DOS version 4 can be activated in the calculation. To get the proper list of file types and check what files are available, check the click box “V4”.

If you want to exclude a Situation or Geo-File from the calculations, mark the files and either by clicking on the icon or with “Drag & Drop” transfer the files from the right side back into the left side.

File number of the results

All results of a calculation run contain the same unique number as part of the file name. This number was entered in the general tab of the calculation run definitions under the label NUMBER OF RESULT FILES. The result file number can have up to 4 digits and can only be used once to give the result files a unique identifier. In case you are assigning a number to the calculation run that is already in use in another calculation run, SoundPLAN will warn you. The result files have a fixed format and follow the naming convention as listed below. as part of their file name:

- RSPSxxxx.res Results of single receiver calculations
- RGLKxxxx.res Façade Noise Maps
- RRLKxxxx.res Grid Noise Maps
- RSLKxxxx.res City Noise Maps
- RWNDxxxx.res Wall Dimensioning files used by Wall Design
- RHTTxxxx.res Results from the Hallout Calculation
- RHRKxxxx.res Grid Noise Map inside a factory building
- RHPxxxxxx.res Single point sound inside a factory
- RSAKxxxx.res Results of the sound decay curve in the factory building
- RDGMxxx.res Digital Ground model
- RHYxxxx.res Elevation lines to be included as a Geo-File

Depending on the degree of detail you request for the storage of results, result tables, level charts and detail tables are stored using the same unique number as part of the file name (for example RPGDxxxx.* for level charts and RROAxxxx.* for the road emission table.) The Result Tables, Spreadsheets and the Graphics all can read the result database when the result files are opened. When you delete a calculation run entry from the table, result files are not deleted. If the same number as used by the
existing files is reused, a warning messages is dispatched indicating that results with the number already exist.

**Reconstruct the calculation run from the result file**

In case by accident you have deleted a calculation run entry and already have stored the run file, you can reconstruct the entry in the run file from the result files. Right click and select the menu **IMPORT RESULT FILE**. From the list of results select the one you want to reconstruct and click on the **OK** button.

**Logbook, Error messages and default settings**

The logbook keeps track of all actions that occur during a calculation run. For example which files are loaded, what is calculated and if there are warnings and error messages. The logbook is stored in each project under the name "Lastlog.rtf", if the file grows to a bigger size than 300 kB, the display in the logbook is emptied and the data stored under the name Logbk0.rtf. You do not have to wait for this to happen, you can manually empty the logbook or store it or print its content.

Calculations can produce errors! Most errors are caused by faulty data or missing parameters and attributes, some occur at special conditions for a particular geometry and some occur because SoundPLAN simply has made a mistake (unfortunately no program is completely free of bugs).

In general SoundPLAN distinguishes between warnings, exceptions and fatal errors. Warnings are logged with red italic writing, exceptions are printed in magenta and fatal errors are in bold red writing. In addition blue text is used to indicate that the user has aborted the calculation.

When **WARNINGS** are given, the calculations are continued as normal and for the most part the results are reliable. For example the warning message "Grid elevations could not be calculated for all receivers, x receivers were not calculated" means that the elevation data did not make it possible to securely interpolate the elevations for all receivers of a Grid Noise Map. A warning message "KΩ-Wall >=0.1, but no wall found in the vicinity of the source" – is hinting that a data entry error is present, either KΩ-Wall is set to the wrong value or a wall should be present but is not because it was deleted or is in a Geo-File that is no longer part of the situation that is assigned to the calculation. The examples show that you should always look into the logbook after a calculation, there might be warnings that something in the data was not correct and if this is the case corrections should be made in the Geo-Database.

**EXCEPTIONS** do not necessarily lead to an exit from the calculations, SoundPLAN can handle certain exceptions and still continue with the calculations. The number of possible exceptions is set in the calculation parameters. For example exceptions can occur resulting in one receiver not having been calculation but the rest of the Grid Noise Map would be calculated correctly. If exceptions occur, something unexpected happened in the calculation core and you should pack the project and send us the data along with the description so that we can research what happened and fix the problem. "Division by zero" for example is indicating that a value was zero but the program did not expect it to be, "Illegal access to memory" shows that the program tried to access a memory location that was never assigned. Problems
like these need to be fixed and the program authors do this, but in order to reproduce the error they need the data.

**ERROR** will immediately terminate the calculation. Errors can be have various roots but very often are caused by the geometry data. For example "Roads assigned to traffic light xxx could not be found" or "Building xxx, No. yyy has no attributes". Next to the error description you will find the object ID of the data object that is causing the problem. With this ID number you can search for the object in the Geo-Database. (Edit/Search Object opens the dialog for the object ID with OK the object will be zoomed to fill the screen.) Error messages are listed in the annex of the handbook.

**Run Settings**

In **OPTIONS -> RUN SETTINGS** define general pre-settings for all projects and all calculation runs.

Calculations can be finished even if problems have occurred. By default up to 10 exceptions are allowed. Please always look in the logbook if an exception has caused a receiver not to be calculated.

With Grid Noise Maps exceptions will mark the receiver that has not been calculated properly, the receivers with the exceptions can be processed later. Define how many grid points can be skipped until the program terminates.

**CANCEL BATCH RUN ON SINGLE RUN TERMINATION**: Determines if the entire batch run of multiple calculations shall be terminated if one of the runs is reporting unrecoverable errors.

**Hint**: As data entry errors often become visible and get noted when the geometry data are loaded into memory, it is good practice to load the data of all calculations before the entire batch is started. To do so position the cursor on the calculation run to be checked and click on the tab **GRAPHICS** and then look for errors under the tab
LOG-BOOK. Warnings and errors from loading the data are noted now and can be rectified in the Geo-Database if necessary.

DURATION OF WAITING LOOPS sets the time available to select between different options. In the batch run the calculation always goes to the next step, so if you need to intervene or have the data presented a different way, there is only a limited time until the automatic process continues.

Default Standards and Run Commands

The default settings (OPTIONS -> DEFAULT STANDARDS) define the standards to be used in a calculation and all the parameters for all run commands (OPTIONS -> RUN COMMANDS). The same settings can be edited as global settings and as settings valid only for the project that is currently open. If global settings are edited they will be effective only when a new project is generated, it has no influence on the projects that already exist.

Start or terminate a calculation run

With the symbols below the calculations are controlled:

These functions are also accessible via the menu CALCULATION or via the function keys listed in the menu.

With F7 a calculation run can be processed STEP BY STEP in a way that the program calculates a receiver and then pauses until you hit F7 to calculate the next receiver.

All calculations can be stopped and resumed at a later time. When you call the calculation the next time the following screen is displayed:

`Restart/Overwrite/Continue/Cancel a calculation run`
Select the option Restart/Overwrite to start the calculation from the beginning, continue to resume a calculation that had been interrupted and cancel to exit from the calculation. With the continue option the program resumes exactly where it was terminated, therefore this is a very handy way to quit the calculation, do some other work and then continue without having lost the calculation. Make the choice while the pause progression bar on the bottom of the box is active. The time for this bar is set in Options -> Run Settings -> Duration of Waiting Loops. If you set Continue if Possible in the calculation run properties, continue is preset as soon as a result file exists.

**Statistics**

After you started a calculation run, SoundPLAN displays status information about the calculation that is running.

<table>
<thead>
<tr>
<th>Statistics</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Coordinates</td>
<td></td>
</tr>
<tr>
<td>x[n] =</td>
<td>26130.09</td>
</tr>
<tr>
<td>y[n] =</td>
<td>26187.08</td>
</tr>
<tr>
<td>z[n] =</td>
<td>2851.12</td>
</tr>
<tr>
<td>Number of points</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>7567</td>
</tr>
<tr>
<td>Calculated</td>
<td>231</td>
</tr>
<tr>
<td>Interpolated</td>
<td>175</td>
</tr>
<tr>
<td>Calculation time about</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>00:36:52 [h.min]</td>
</tr>
<tr>
<td>So far</td>
<td>00:10:11 [h.min]</td>
</tr>
<tr>
<td>remaining</td>
<td>00:26:41 [h.min]</td>
</tr>
</tbody>
</table>

The statistics shows the coordinate of the receiver currently calculated, the number of total receivers and how many are already done. The calculation times are only estimates based on the time of the first receivers. The times can vary during the calculation, often with Grid Noise Maps SoundPLAN is under predicting at first, then over predicting slightly in the middle of a big area. Often the edges of the Grid Noise Map contain more interpolated coordinates than the average, thus the program thinks at first that the calculation is faster than it actually is. For Grid Noise Maps the timer is updated after each cell of 9 x 9 values, for all other calculations it is updated after each receiver.

**Calculation run-info**

The calculation run-info writes a protocol of all parameters relevant to the calculation, the files that were activated for the calculation and the version of the calculation program. This assures a complete documentation of the entire calculation run.

The calculation run-info is copied into each result table and can be printed from there as well.

**Distributed Computing**

Through the menu Calculation -> Start Distributed Computing SoundPLAN starts a calculation mode where the time consuming process of calculating many
receivers is distributed in a network of PCs. In order for this option to work, the calculation core of SoundPLAN must be installed on other PCs in a network with the TPC/IP protocol active. In order for SoundPLAN to find the other computers and see that the users have given the permission to use the resource, a communications kernel must be running on all participating PCs. This program is called the socket server and is started through the SoundPLAN Manager through the menu EXECUTE -> SOCKET SERVER. When the socket server is running the SoundPLAN icon is visible in the task bar.

After activating the Distributed Computing option, a box with all possible servers on the left will appear. PCs that shall participate in the SoundPLAN calculation need to be activated and then with the arrow to the right transferred to the list of PCs that are participating in the calculations. The DC client immediately is trying to establish communication with the servers that are in the field of the PCs participating in the calculation.

![Distributed Computing](image)

The communication between the server and the client is visible in the Status column where the C+R is showing communication and response has been established.

To start the calculation click on the field **START CALCULATION OF ALL RUNS MARKED WITH “YES”**. SoundPLAN will now pack the project and send it to all servers. After receiving the data the client will distribute the calculation tasks. For single receivers, Façade Noise Maps and City Noise Maps each server will receive one receiver at a time, calculate the noise levels and send the results back to the client. For Grid Noise Maps the client will send the server a filed of 9 x 9 receivers to do the calculations.

If the communication breaks down, a client is shut down or a server does not respond with result data, the client will eventually reassign the missing receivers to another server to make sure none of the receivers is left without calculations.

**Graphical presentation of geometry in calculations**

To graphically check the calculation results you can click on the tab **GRAPHICS** while the calculation is running. For single receivers, Façade Noise Maps and City Noise Maps the level chart is presented along with a table of the calculation results for each floor. For Grid Noise Map and Cross-sectional Noise Maps the results are presented as squares painted in accordance to a color scale. If you want to know
details on the single grid points, right click on the map and select the option **GRID POINT TYPE**.

Bright red squares are calculated receivers, dark red squares indicate interpolations, gray squares are indicating the square is completely inside a building, violet squares are indicating grid points where an exception occurred and green squares have not yet been calculated.

A print function is not planned for the graphics in the calculations; this is the domain of the Graphics modules themselves.

**Hint**: The graphical display increases the calculation time by as much as 20%!

*Display of level chart and the results from single point receivers, Façade Noise Maps and City Noise Map*
Even when the calculation is finished, the results are available in the calculation core. Click on the calculation run, activate the graphics by clicking on the Graphics tab. If the noise map has been calculated you can right click on the map area and select **LOAD GRID MAP**. Right click on a point on the map and get the information:

<table>
<thead>
<tr>
<th>X [m]</th>
<th>38077,00</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y [m]</td>
<td>29607,00</td>
</tr>
</tbody>
</table>

Grid point type

| Ground height [m] | 284,11 |

Day [dBA] | 61,06 |
Night [dBC] | 55,61 |

To present the entire map for a different time slot or to present the terrain elevations instead of the noise levels, activate the correct selection. If you want to change to display the terrain elevations, you probably need to correct the color scale. To change the colors, click on the **EDIT** button on the color scale.

For single point receivers and Facade Noise Maps the level charts can be called back on screen if the option **STORE LEVEL CHART** has been activated in the run parameters, if this option was not clicked only the noise levels are shown in tabular form.
Calculation settings for noise calculations

The default values to all calculation parameters is done in the SoundPLAN Manager under OPTIONS/SETTINGS/RUN COMMANDS.

For the ANGULAR INCREMENT 1° for the most part is a good compromise between calculation time and accuracy. For rough pre calculations and Grid Noise Maps it is possible to increase the search angle see the paragraph "Possibilities for the acceleration of Grid Noise Map calculations" on page 201.

For calculations "Strictly according to RLS-90" and "Strictly according to Schall 03" the angular increment is fixed to 1° and cannot be modified.

The definition of NUMBER OF REFLECTIONS and REFLECTION DEPTH can be found in the paragraph "Number of reflections and reflection depth" on page 383.

For calculations "Strictly according to RLS-90" only the first order reflection is evaluated, "Strictly according to Schall 03" calculates without reflections. When the NUMBER OF REFLECTIONS is set to a higher value, still only a single reflection will be calculated for road noise and no reflection for railway noise. All other objects (industrial, parking lots) present in the calculation will be calculated using the defined number of reflections.

During the calculation SoundPLAN searches for sources in a set distance around the receiver. The MAXIMAL SEARCH RADIUS (default setting is 5000 m) sets how far a source can be from the receiver and still contribute to the noise level at the receiver. This restriction is mostly effective for big noise mapping projects.

In general noise mapping and evaluations are based on the dB(A) filter. Any filter from linear to B, C and D can be set.
For standards that have provisions for **SIDE DIFFRACTION**, this feature can be activated or deactivated. Standards that do not “know” side diffraction will always work without it, regardless if the feature is activated or not. For further information about the side about the side diffraction see chapter "References", page xxx. As the calculation of the side diffraction is very computation intensive, this feature should be deactivated in a draft type calculation. **Caution:** Do not forget to re-enable this feature later on for the final calculation.

Railway noise has been assessed as being less annoying so there is a railway bonus that subtracts 5 dB to compensate for this difference.

### Calculation Types

#### Using a DGM for the calculation

The DGM can be utilized in noise calculations alternatively instead of elevation lines. If a Situation contains elevation lines they won't be loaded for the calculation. Break lines must still be part of the data. If a situation contains a DGM it will be automatically entered in the data selection list as a separate data type. If a DGM contained in the Situation shall not be used, it must be manually taken out of the file list.

**Important:** Be aware that all elevation lines in the situation are not loaded for the calculation. Make sure that all additional elevation information you defined (e.g. a cutting) is included in the data for the DGM calculation.

#### Single point receivers sound (SPS)

The receivers for the single point sound calculations are entered in the Geo-Database and if the reflection on the „own“ facade shall be ignored, they are assigned to the building. Click on the tab “SPS” Single Point Sound to set additional parameters:
In the top portion of the box select the size of the level chart as it would appear on screen. This also sets the scale of the viewport on screen during the calculations. The level chart is printed on screen for one of the time slots the assessment standard requires.

In the second section select the grade of detail for the calculation results. Different parts of the results can be opened in the Documentation, the Spreadsheet and the Graphics. See also the paragraph "File number of the results" on page 187, the file name of the individual tables are listed there.

**Simple result tables: (should always be activated)**

- Receiver list
- Road emission table (if roads are contained in the data)
- Railway emission table (if railways are in the data)
- Source table (if industrial sources are in the data)
- Day histogram of the noise level at the receiver
- Emission frequency table (if industrial sources are in the data)
- Emission day histograms (if industrial sources are in the data)
- Result table with frequencies (if industrial sources are in the data)

**Level Charts:**

- Level charts (for presentation in the calculation core and to include in the Graphics in a map)

**Detail-Result Tables:**

- Result tables of groups of sources
- Result table for mean propagation and partial noise levels.
- Result table of assessed noise level contributions (if industrial sources are in the data)
- Result tables for the Industry Expert Spreadsheet

**Protocol Tables**

- Protocol tables detailing the intermediate values for each standard. The protocol tables generate huge files and will slow down any calculation, therefore this option should be used only for selected receivers where every detail of the calculation needs to be checked. For answers that look implausible the protocol can be even used on a limited angular range to check the details in the section where the user has doubts.
Grid Noise Map Calculations

Grid Maps and the derived contour maps are the tools to visualize the noise at street level outside buildings and in nature. As the Grid Noise Map calculates reflections from all buildings, the levels can be up to 3 dB higher than Single Point Receivers Sound at the buildings. SPS receivers suppress reflections at the “own façade” (exception is CoRTN). Comparing SPS receivers and Grid Noise Map receivers is only possible if the SPS receiver is located in front of the building and is not attached to the building. The angular area must be set to contain all 360 degrees.

The Grid Noise Map generates a grid of receivers over the calculation area defined in the Geo-Database. The seed address for the grid depends on the grid spacing and is always set in a manner that adjacent grids would have the same pattern of grid points. For the middle of each grid cell the noise level is either calculated or interpolated from the receivers around it. One of the situations must contain a calculation area, often it may be a good choice to store the calculation area in a Geo-File of its own and directly select this GeoFile for the calculation.

If the geometry has been generated on the basis of a DGM, it is wise to use this DGM also for the calculation (click on USE DGM). The setting CALCULATE DGM first generates a DGM and then does the calculations. In contrast to the DGM calculation type the elevations contained in roads, railways and buildings are also used in the DGM calculation.

If you activate the graphics display during the calculations the result of the DGM calculation can be inspected, the terrain elevations are mapped according to a color scale for all grid points in the calculation area.

Display of the terrain elevations before the noise calculation

As a correct elevation model is paramount for the noise propagation calculation, the colored elevation plot helps pinpoint problems in the model before the calculation actually starts. Errors can only be fixed in the Geo-Database.
For the Grid Noise Map define the parameters for the grid generation and the interpolation under the Tab GRID NOISE MAP.

**CALCULATE NEW GRID NOISE MAP** is used to calculate a Grid Noise Map for the entire calculation area, continue a Grid Noise Map that is already partially calculated or recalculate the Grid Noise Map after the geometry was altered. **RECALCULATE GRID NOISE MAP** (See “Correct or recalculate a Grid Noise Map” on page 201) is used to recalculate a part of the noise map after a local correction to the date model has been made. The choice of **GRID SPACING** depends on considerations of accuracy, calculation time and memory/file size. In un-congested landscape a grid spacing of 20 to 50 meters is sufficient whereas in a city environment the spacing should be between 5 and 15 meters. The **RECEIVER HEIGHT ABOVE TERRAIN** sets the elevation of the receivers as the elevation interpolated from the DGM + the height entered. The default height above the terrain is defined through the options in the SoundPLAN Manager.

The parameter **MAX. NUMBER OF SUBSTITUTE RECEIVERS** defines how many receivers shall be used if the original grid middle is within a building. If multiple substitute receivers are used, the level is averaged between all results. Normally a single substitute receiver is sufficient. Grid Noise Maps with higher numbers of substitute receivers will consume much more calculation time in urban environment.

As the calculation of the DGM for big noise maps with megabytes of raw data may consume multiple hours, it is advisable to reuse the DGM for correction calculations or in case the DGM already has been established from another calculation. Check the click box **REUSE DGM NO.** to activate an already existing DGM. If **CALCULATE DGM** is checked and the Grid Noise Map is calculated, the DGM is stored with the same file number as the Grid Noise Map. The option **CONSTANT GROUND ELEVATION (0 M)** is used to execute a calculation at the base elevation 0 meters. For this case it is not necessary to define elevation lines around the calculation area.
Interpolation during the Grid Noise Map Calculation

The calculation of the Grid Noise Map is organized in blocks of 9 by 9 receivers. From the entire map a sub-grid of 81 receivers is read into memory, calculated and then stored. The Distributed Computing distributes those sub-grids to the participating servers. The 4 corners of the blocks and the middle receiver are always calculated. Other receivers of the block are interpolated if the following conditions are met:

- The corners of the block and the middle are within the calculation area,
- the level of the middle of the block is between the minimum and maximum found in the block,
- all corners and the middle do not exceed the maximum spread allowed for the block defined in the field MIN/MAX,
- the deviation for the interpolation of the block middle does not exceed the maximal DIFFERENCE.

If all criteria are satisfied, all receivers in the block not already calculated will be interpolated. If not, the block is subdivided into 4 blocks and the same procedure starts again until all receivers of the block are either calculated or interpolated.

Criteria for interpolation

There are 3 interpolation criteria:

MIN/MAX sets the maximal permissible level difference between the corners of a block.

SoundPLAN averages the values of opposite corners and compares the result to the calculated value. For the middle of the block there are 3 values to compare, one calculated one and 2 interpolated ones. If the difference between the calculated and the interpolated one is smaller than the value entered in the field DIFFERENCE the rest of the block is interpolated. The default setting of 0,15 dB is conservative. Higher values will accelerate the calculations as the interpolation is less likely to be suppressed, however the accuracy will be reduced with higher settings.
The **FIELD SIZE** defines the maximal size of blocks for the interpolation. Field size 1x1 entirely suppresses the interpolation of receivers. The following settings are possible:

- 1x1: no interpolation
- 3x3: interpolation block maximal with 9 receivers
- 5x5: interpolation block maximal with 25 receivers
- 9x9: interpolation block maximal with 81 receivers

**Possibilities for the acceleration of Grid Noise Map calculations**

Depending on the area, the topographical conditions and accuracy requirements, the calculation of the Grid Noise Map can be accelerated by the following means:

- Increase the angular increment of the search procedure (caution if RLS 90 strict is set as the standard, the angular increment is always 1 degree)
- Check and maximize the interpolation criteria for the accuracy desired
- Decrease the number of reflections
- Reduce the reflection depth
- Decrease the maximal search radius
- Set the number of substitute receivers to 1

**Correct or recalculate a Grid Noise Map**

If you only want to recalculate part of the calculation area because in a section of the map the base data have changed but the change will not affect the entire map, activate the option **GRID NOISE MAP RECALCULATION**. The partial calculation area (which needs to be entered as a calculation area and should be stored in a Geo-File of its own) needs to be completely within the original calculation area. The settings of grid spacing and height of the receivers above the ground are disabled for the correction calculations, these parameters are taken from the existing grid file. The calculation area in which all receivers are to be recalculated, needs to be defined in the Geo-Database and needs to be included in the calculation.

**Caution:** Please make sure that only one calculation area is activated for the calculation it should be the area for the recalculations and should be a Geo-File of its own.

The results of Grid Noise Maps are only documented in graphical form, not in the format of single receivers. However to check the calculation tables detailing the emission of the different noise types are generated:

- Road emission table (if roads are in the data)
- Railway emission table (if railways are in the data)
- Source table (if industrial sources are in the data)
- Emission day histograms (if industrial sources are in the data)
In the graphics the grid values and the contour lines can be exported in various file formats.

See „File number of the results“ on page 187, if you want to see the filenames for result files.

**Cross-sectional Noise Map**

For the Cross-sectional Noise Map a vertical noise map is generated along the Cross-section line entered in the Geo-Database as the line type receiver. The elevation supply along this line must be assured. It is impossible to extrapolate elevations in areas without sufficient elevation data.

**Settings for the Cross-sectional Noise Map**

With the **GRID SPACING** the spacing of the receivers is defined, the spacing is the same in height and along the Cross-sectional line. The spacing has big influence on the calculation time and the accuracy of the results. The **CALCULATION HEIGHT** determines the number if receivers in vertical direction relative to the receiver with the lowest elevation. Receivers are placed and calculated in an equidistant grid between the lowest terrain coordinate along the cross-sectional line to the top of the calculation area. The interpolation works analog to the interpolation in the normal horizontal Grid Noise Map.

**Cross-sectional Noise Map – graphical display during the calculation**

The **MAXIMALE DISTANCE OF SPOT HEIGHTS** is the distance at which spot heights can be used to set the elevation along the Cross-section line. Elevation lines
intersecting the Cross-section line do not need this parameter, it only influences the distance of spot heights to the Cross-sectional linen.

For Cross-sectional Noise Maps the same interpolation criteria apply as for the Grid Noise Map. Please read the paragraph "Interpolation during the Grid Noise Map Calculation" on page 200.

Grid Noise Maps and Cross-sectional Noise Maps are stored with the same file name. Check the result file number so that you are not by accident overwriting a Grid Noise Map or Cross-sectional Noise Map with the same file number.

The results of Cross-sectional Noise Maps are only documented in graphical form, not in the format of single receivers. However to check the calculation tables detailing the emission of the different noise types are generated:

- Road emission table (if roads are in the data)
- Railway emission table (if railways are in the data)
- Source table (if industrial sources are in the data)
- Emission day histograms (if industrial sources are in the data)

In the graphics the grid values and the contour lines can be exported in various file formats.

See „File number of the results“ on page 187, if you want to see the filenames for result files.

**Facade Noise Map Calculations**

The Façade Noise Map is featuring the graphical representation of an automated single point receiver calculation where the receivers are generated by the program for all facades enabled for the calculation. As the receivers are generated automatically this mapping module can be used for big calculation areas where detailed result documentations and spreadsheets are required.

In the Geo-Database the parameters of the elevation of the receiver and the usage of the receiver is directly defined with the building. For each building it is also possible to define which facade of the building shall be assessed and which one not. If a calculation area is included in the data, receivers for the Façade Noise Maps are only calculated in the area inside the calculation area, receivers on the outside are suppressed.

Facades of buildings connected to each other are recognized and skipped in the calculation. If one of the facades is higher than the other, the higher one will have receivers calculated only in the section that is above the adjacent building.

In the calculation core there are additional definitions for the Facade Noise Map available by clicking on the tab for the Facade Noise Map:
Parameter settings for the Facade Noise Map

In the top section define the size of the level chart that you will see on screen during the calculation. The size of the chart is in world coordinates and also defines the scale with which the basic geometry is plotted on screen. The level chart can be produced for any one of the time slots available in the selected assessment library.

**Hint**: For large calculations with big amounts of data it is advisable not to have the graphics active during the calculation, the screen presentation takes up to 20% of the calculation time.

For the automatic generation of receivers the following settings can be made:

With checking the click-box **ONE RECEIVER IN THE MIDDLE OF EACH FACADE** each facade will have one receiver in the middle. In addition you can request **TWO RECEIVERS AT THE END OF EACH FACADE** with a defined spacing from the corner. This might be a sensible addition when the building is very close to a congested road where a single receiver would not represent the noise levels on the facade correctly. With the third option you can request receivers to be spaced with an even spacing along the facade. **(RECEIVER WITH SPACING OF)**. If you want to have a 3D presentation of the Facade Noise Map, a close spacing (1 meter spacing) of the receivers is producing a nice presentation, however the calculation time will be by magnitudes longer than with only a single receiver per facade:
The **DISTANCE TO THE FACADE** defines how far in front of the facade the receivers shall be located. Some standards have specific requirements for this (CoRTN locates the receiver 1 meter in front). The default setting of this parameter should be declared in the Options of the SoundPLAN Manager, locally the parameter can always be adjusted to the requirement of the particular calculation run.

If you want to limit the reception direction of noise for the façade so that the noise from behind the building will not be evaluated for the receivers check the click box **LIMIT SEARCH ANGLE BY OWN FACADE (180°)**. The reflection on the “own” façade in any case is suppressed.

In the third section define what **RESULT TYPES** for table type and graphical presentation you want to generate. Normally the **SIMPLE RESULT TABLE** is sufficient for the Facade Noise Map.

See „File number of the results“ on page 187, if you want to see the filenames for result files.

The **simple result tables** generate the following documentation tables:

- Receiver table
- Road emission table (if roads are in the data)
- Railway emission table (if railways are in the data)
- Source table (if industrial sources are in the data)
- Receiver day history
- Emission day histograms (if industrial sources are in the data)
- Emission frequency table (if industrial sources are in the data)
- Receiver frequency table (if industrial sources are in the data)

**Level Charts:**

- Level charts (for the display in the calculation core, the Documentation detail table under "Details + Graphics" and in the Graphics)

  For Facade Noise Maps the level charts should be used only on smaller maps as this option will create vast amounts of data!

**Detail-Result tables:**

- Result table of groups
- Result table of the mean propagation conditions and partial noise levels
- Result tables of assessed partial noise levels (if industrial sources are in the data)
- Result tables for the module Expert System for Industry Noise
Calculation of the City Noise Map

The City Noise Map is a series of single point receiver calculations where the location of the receivers is determined by an iterative triangulation analog to the DGM. In contrast to the SPS calculation the City Noise Map only calculates receivers in one elevation that is calculated from the terrain elevation of the elevation DGM and the relative height of the wire-mesh above ground. City Noise Map offers the same accuracy as the Grid Noise Map but accomplishes this with less calculated receivers. The City Noise Map is not a module of its own, it is active when the license contains the modules for Grid Noise Map and Facade Noise Map. For the graphical results the wire mesh of the triangulation is used to interpolate the location of the noise contour lines. Contour lines then are drawn using color scales.

The City Noise Map achieves the better mapping quality by using more receivers where the noise levels are changing and having a coarser wire-mesh where the noise levels are only changing gradually. Furthermore receivers are located in fixed distances to source lines, barriers and buildings and thus the map avoids the singularities that occur in the Grid Noise Map by having some receivers extremely close to the source line, which in the Grid Noise Map creates “spots” along barriers and source lines.

![Triangulation in the City Noise Map](image)

The graphics above shows the different density of receivers in the free field and around buildings, barriers and the source lines.

 Receivers are generated along the following objects:
- Road edges, railway lines, industrial line sources
- Facades
- Noise protection walls and berms
- Back side of the plateau of berms
- Area usages
- Elevation break lines
In the first step the City Noise Map is setting receivers along the mandatory line elements of the table above. The position of the receivers is determined by following the line elements and placing receivers in the set \textit{RECEIVER SPACING}, the elevation of the receiver is calculated from an interpolation of the DGM and the \textit{HEIGHT ABOVE GROUND} parameter. After this initial placement the receivers are iteratively triangulated and if the triangles proved bigger than the receiver spacing around the original line elements and bigger than the receiver spacing * \textit{FREE FIELD FACTOR}, receivers are inserted in the middle of the triangles and the procedure starts anew until all placement criteria are met. The \textit{SEARCH RANGE} from which the receivers close to facade are receiving noise contributions can be set to \textit{DETERMINED BY THE FAÇADE} so that the calculation excludes the noise passing over the building. The switch \textit{SUPPRESS REFLECTION ON OWN FAÇADE} excludes reflections on buildings very close by and this delivers answers that then can directly be compared with the single point receiver sound calculations.

If the geometry data in the Geo-Database were generated on the basis of a DGM it is advisable to use the same elevation model for the City Noise Map (setting \textit{USE DGM}). The setting \textit{CALCULATE DGM} will generate the DGM firs before starting the receiver triangulation. In contrast to the direct DGM calculations the DGM invoked by City Noise Map will also use the elevations contained in roads, railway lines and buildings.

Receivers are generated as a table, furthermore additional tables are generated to check the emissions of the noise types contained in the calculation:

- Receiver table
- Road emission table (if roads are contained in the data)
• Railway emission table (if railways are in the data)
• Source table (if industrial sources are in the data)
• Emission day histogram table (if industrial sources are in the data)

Level Charts:
• Level charts for the display during the calculation, the detail table of the Documentation and the Graphics (to be used with caution, this option creates huge data files)

Detail tables:
• Partial noise levels

See as well the paragraph „File number of the results“ on page 187, if you want to familiarize yourself with the file names of results.
8 Result Tables (Documentation)

Overview

Single receiver calculations can be presented with extensive user formatted documentation. The settings in the run file table determine if SoundPLAN writes more or less extensive result files for the documentation module post processing. The documentation can be styled individually and the templates can be stored and reused in other calculations. A preview mode lets you view the table before printing it.

Simple stand alone tables and more complicated master/detail tables with more in depth results presentation in two interdependent tables can be generated.

The calculation log is attached to the documentation so all parameters and data files leading to the results can be traced. This is vital for quality control purposes.

Page layout, footers, headers, table layout and logo boxes can be defined as desired.

Result table preview on screen
Procedures

The calculation run parameters (before you start the calculation) define how detailed a documentation will be. Open the „Run Command Editor“ from the Calc. type column and set the hard disk settings in the „SPS“ index card. Choose from:

- only results
- intermediate and final results
- calculation protocol with all calculation steps
- graphical presentation of results (level chart, spectrum, day histogram)

After the calculation is done, call the documentation module from the SoundPLAN manager and select the file number of the result file. All results are stored in the same file.

Via a selection menu, define which table columns you want printed and assign a table format to each column.

Check if the table layout fits your requirements, if the printing is landscape or portrait and how the headers and footers are formatted.

Select the information to be included in the table by calling the table index card.

After formatting the table, use the preview to see how the finished table looks when printed. If you are satisfied, print the table from the preview mode. If not, return to the formatting stage and make changes.

Combination Tables (Master/Detail)

Principle sketch of combination table
The documentation presents two tables on screen. The top table contains index cards for the calculation log, receiver list and source list. The bottom table presents the details from the selection made in the top list. The bottom table can contain spectra, day histograms, level charts, partial level log, source day histogram and a record on the mean propagation parameters for each source.

Let us assume we have a results list and the following properties:

- receiver
- area usage
- noise limit day / night
- level day / night

Each receiver has additional data. For example:

- source name
- source type
- source size
- source sound power
- level contribution day / night

The tables are combined to form one table. The features of the main table are displayed in the comment lines, thus delivering a structured, readable document.

### Column Setup

The column setup must be defined for each type of list. Depending on the table, the following setup may vary, but in principle it remains the same for all table types and formats.
The left field shows all the available columns. Use the arrow keys to move within
the table. The column settings for the highlighted column can be viewed to the right.
The column layout can be defined individually for each column.

Headlines and column headers can be justified left, right or centered.

The [x] indicates that a column should be printed. You can move the x with a double
click or with the „visible“ click box in the properties. The title fields (title lines 1 an
d2 and units) define the column title and indicate if it should be printed. For
combination tables it may be advisable to disable a header „Floor“ when the line
already has „ground floor“ as a content. The headline can have one or two lines. The
unit of a numerical column can represent the third line. Specially for combination
tables, the units can be suppressed or be placed adjacent to the value itself. (See
below).

The fields for „display format“ and „rounding addition“ set the column format and
rounding of decimals.

For multiple story buildings, define if the building name shall be printed for each
floor or only once for the entire building.

The column width is set in [mm]. The field next to the column width shows the
remaining print width for the chosen layout and paper size. The numbers
automatically adjust to changes from landscape to portrait and to the margin size.
Positive numbers on the right side indicate the table still has some room. If the
number is negative, part of the table is outside the area that will be printed. Extra
space in the table is printed as a free column. Use the mouse to change the column
width.

Caution: On screen the table is not shown with the assigned text sizes. The ruler
above the text helps with the formatting. A print preview shows the exact formation
before the table is printed.

With the button reset all columns are set to their default sizes.

Rearranging columns

The sequence of columns can be changed. Click on the gray column header to be
moved and drag it with the left mouse button depressed to the new location. A black
vertical line will show the new location.

In column layout keep the left mouse button pressed on the line to be moved and
drag it to it’s new location.

Presentation of numerical Values in the Columns

The fields „Display“ and „Rounding“ define the layout of the column and how the
numerical values are rounded.

The display format of a table column can be configured individually. Along with
setting the number of digits after the decimal, you can place a text into the column.

0 acts as a place holder for digits. If string to be placed in this column
contains a digit in the place of the place holder, the digit will be
output, otherwise the „0“ will be used instead.
# acts as a placeholder for digits. If string to be placed in this column contains a digit in the place of the placeholder, the digit will be output, otherwise a blank will be used instead.

. Decimal. Which character is used in your table depends on the Windows country code set in your PC.

, Separator for thousand. When the field „Presentation“ contains one or multiple „,”, the thousand separator will be inserted in all groups of 3 digits left of the decimal. Which character is used depends on the country settings of Windows.

„Text“ Hyphenated characters are output as they are, they do not influence the formatting of the numerical string.

The position of the farthest left digit and the farthest right is setting the numerical format and thus determines the number of columns reserved in the output.

The numerical values are always rounded to the number of digits after the decimal delimiter. If your format does not contain any „0“ or „#“ behind the decimal the values will be rounded to integers.

When the number contains more digits then reserved, the additional characters will still be printed.

**Rounding** the numbers can be accomplished in many different ways. Coordinates will be rounded but noise levels should not be rounded the same way. As the noise scale is logarithmical, values beyond a set threshold should be rounded up. With the rounding addition you can influence the threshold. The rounding addition is added to the last digit shown after the decimal and the value is truncated after the last digit then. The value for the „rounding addition“ can between 0 and 9.999. This means that a value of „0“ will just truncate the value, a value of „5“ will cause the program to round the normal way and the „9.999“ will always round up to the next value.

The following table shows some examples for rounding additions between 0, 5 and 9.5.

<table>
<thead>
<tr>
<th>Rounding additions</th>
<th>0</th>
<th>5</th>
<th>9,5</th>
</tr>
</thead>
<tbody>
<tr>
<td>integer value</td>
<td>0</td>
<td>0,5</td>
<td>0,95</td>
</tr>
<tr>
<td>one digit behind decimal</td>
<td>0</td>
<td>0,05</td>
<td>0,095</td>
</tr>
<tr>
<td>two digits behind decimal</td>
<td>0</td>
<td>0,005</td>
<td>0,0095</td>
</tr>
</tbody>
</table>

Example:
The level 49.04 shall be truncated to 49 dB(A), but the level 49.05 should be rounded up to 50 dB(A). No digits behind the decimal are desired.

The rounding addition (RA) required is 9,5:

49.04 (+ RA 9,5 on first digit behind the decimal) = 49,999 => truncated to 49

49.05 (+ RA 9,5 on first digit behind the decimal) = 50,000 => truncated to 50
Legend

The legend text output in the legend section of the printed sheet can be assigned freely. Overwrite the given legend text with the new one.

Table Layout for Diagrams

For diagrams additional or modified parameters are needed:

Column layout for diagrams

The headlines will always printed with the diagrams, the second headline in the diagram section is used as the label to the diagram axis if activated in the index card table settings.

The field „column width“ sets the width of the column. The size of the diagram is automatically adjusted to keep the ratio of height and width constant. For the diagrams too you see the remaining printable width.

The field „diagram height“ sets the height for all diagrams placed in the same line. The proportions of the diagrams are maintained.

Table Settings

The Document layout is organized via format settings stored in a separate file with the extension .fms. Each table has a format file assigned. Format files can be stored globally in the GLOBDATA folder so that you only have to create a documentation layout once and can always use it with new projects. One format file for page size A4 portrait and one for A4 landscape are delivered. When creating a new documentation, a format file has to be assigned to that table. This file is copied to the project itself.
Table Settings

Page layout

In the table settings, the report title and two additional texts can be entered and placed in the headers or footers of the table. You can access the page layout directly from the table settings with the icon **PAGE LAYOUT**.
Page Layout

The layout configuration for the documentation is grouped in three sections:

- Page format
- Page layout
- Headers and footers

Page Format

In the page layout you define the print sheet size, print mode (landscape / portrait) and the border width. The page number of the first page of the print job can be set to generate a continuous document.

Several print sheet sizes are available. Additionally a custom size can be created if you need another size:

- A4 210 x 297 mm
- Ledger 17 x 11 in
- Legal 8 1/2 x 14 in
- Letter 8 1/2 x 11 in
- Letter Small 8 1/2 x 11
- Note 8 1/2 x 11 in
- Quarto 215 x 275 mm
- Statement 5 1/2 x 8 1/2
- Tabloid 11 x 17 in
Page Layout

In the page layout you define the character size for the column content, the color of the headers and the layout of page header and footer. Size and content of the header and footer are defined in the index card **Header and Footer text.** In the section **List header colors** you select your colors for the master and the detail table separately.

**Company logos** available as a bitmap can be inserted in the header as well as the footer. Click on the gray field to select the logo. The switch „visible“ toggles the printing of the logo. When you check the Logo justification button ("stretch"), the logo is fitted into the allocated space. The print preview however will decrease it’s speed because of it and therefore it the is advisable to select a logo of proper size.

The header and footer can be partitioned with vertical lines. Click of the selection box and define the distance of the box from the left and right border.
Headers and Footers

Headers and footers can be processed individually. Both parts have three partitions: Left, centered, right alignment. Even if the variables are shown as left aligned in the partition, you will see in the print preview that the texts in the left aligned partition are left aligned, in the centered partition centered and in the right aligned partition the texts are right aligned.

You can enter a text of your own which will be printed on every page. For the entry the following options are prepared for you and will automatically updated in case the information changes:

- Company name
- Consultants name
- Project name
- Project path
- File name of documentation
- Description of calculation run
- Description of documentation
- Page number
- Date
- Time
- Text 1 (individual text defined in the table settings)
- Text 2 (individual text defined in the table settings)

Click the cursor to the partition where the text should be displayed and select the report variable to be displayed from the bottom.
For each entry you can set the font, character type and character size. Highlight it and choose the desired settings.

The size of headers and footers is automatically adjusted to fit the column sizes, however the height of the line can be limited.

The Preview

The preview shows you the documentation on screen the way it will look printed later on. The preview can be accessed from the documentation main menu via or in the table layout with the button .

The functions of the icons are as follows:

Print Result table

With the icon send the print job to the printer. Select all pages or only a part of the result documentation. Depending on the print options in COLUMN SETUP -> TABLE SETTINGS, the legend is printed before the table, after the table or not. If needed, change the start number for the printout in PAGE LAYOUT -> PAGE FORMAT.
**Export of the Result table**

You can export the result table of your project as an ASCII or EXCEL file to be processed further in another program. Moreover you can export it as a WMF file. Every page of the result documentation is stored in a separate wmf file. The name of the files are named as "filenamxxx.wmf". xxx is a consecutive number. Open the preview click on the SAVE icon and select the desired format.

**Store and Load a Result table (QRP)**

A result table can be stored as a "Report File" and be reloaded later on. Please beware that this file will not automatically adjust to new calculation results if the calculation has been rerun with different data or parameters. The storage mechanism is meant mainly as a safeguard if you want to adjust the layout of the result table later without starting from the beginning again.

**New features in the Result Tables in SoundPLAN 6**

- The format file stores the assessment used for the calculation. If the assessment in the format file does not correspond to the assessment in the calculation (e.g. after recalculation), you will get a warning message in the Results Tables.
  
  Use "reset titles" to reinitialize the column headers from the assessment library.
  
  Then the new assessment is stored in the format file. If you don't use "reset titles", you will always get the warning message when you load the results.

- The Results Tables now allow to change or switch off the dB filter weighting in the spectrum tables (right mouse button). The selected setting is stored in the table format.

- The results tables no longer have to be closed if you start a calculation or work on a graphics sheet.

- The attenuation columns in the contribution tables can be stored and reused even if the calculation has been executed again. Click right SAVE ATTENUATION and LOAD ATTENUATION. Select RESET ATTENUATION to reset all attenuations to 0.
9 Spreadsheet

Overview

The difference between the result table and the Spreadsheet is that the result table provides detailed information on the results of one calculation run (e.g., frequency spectra, mean propagation ...) whereas the Spreadsheet can compare and compose results from several calculation runs. The Spreadsheet is a tool for enhanced documentation.

One of the main advantages of the Spreadsheet is possibility of creating formulas for specified columns which can be as complex as in a table calculation program such as 123 or Excel.

When starting the Spreadsheet, an empty table is opened. The data are selected from the calculation results. The delivered templates help you to create meaningful tables in a short time. Thus the concept is very flexible, many documentation tasks can be accomplished. For example the comparison of different variants of an investigation, the creation of complex formulas, definition of header blocks and so on).

**Hint:** The Spreadsheet is not only used for tabulated documentation of the calculation results but is also the background of the conflict table in the graphics.
Getting started with the Spreadsheet

After a calculation has been executed, the results of either a single point calculation or a Facade Noise Map calculation can be opened in the Expert result table.

**Expert result table**

The process to create and print an Expert table is:

- Open the Spreadsheet from the SoundPLAN Manager from the EXECUTE menu via the item DOCUMENTATION and then SPREADSHEET menu.
- Choose a new template or select a template from the selection list on the left hand side of the tool bar.
- Select the result file you want to process by clicking NEW from the FILE menu.
- Adjust the layout such as column width, text font and style.
- IMPORT results from other calculations in the existing table via the FILE menu and define the columns in which the results shall be imported.
- Create new value or text columns and enter a formula for example to show the level reduction or the levels exceeding the limits.
- Use the layout possibilities for example to display the values exceeding the limits in bold. Enter in the item CALCULATE AND MARK of the right mouse button menu x13>0; (mark all entries in this column >0) and click on the icon.
- Insert and format text rows to separate different sections in a table.
- Adjust the page layout.
- Print the table.
Components of the Spreadsheets

The Spreadsheets consists of these sections, which are defined in different menus:

The page layout which is defined in TABLE -> PAGE LAYOUT. The page layout is only visible in the preview of the page layout. While processing the Spreadsheet the page layout is not visible. The maximum width of the table to fit in the page and the page break are displayed as red dotted lines.

The column header shows the physical order of the columns. Some columns are nearly never displayed in the table (e.g. x, y, z), other columns might have been added later or you changed the position of a column in the table. Therefore the physical order is not a consecutive number. The formulae use the physical column number.

The table header contains the titles of the columns. In the table header cells can be combined to create easy to read headings. The header attributes can be edited when clicking on the COLUMN LAYOUT while the cursor is positioned in the header.

The table contents is created out of the data loaded to the table. The attributes can be edited when clicking on the COLUMN LAYOUT while the cursor is positioned in the table contents.

Change text size for the whole table

The text size and font for the table contents and the header can be changed in the TABLE LAYOUT of the TABLE SETUP. Once the settings have been made the text size can be shrunk or enlarged in the field text size. All texts are modified proportionally.

In addition to table contents and header, TEXT ROWS can be inserted. The text size and font of the text rows is defined in the section layout for standard text and title on the right hand side of the tool bar.

Select the template for the table from the selection list on the left of the symbol bar.
NEW TEMPLATE generates a table with predefined columns: receiver name, floor, direction, limit levels and level columns.

CURRENT TEMPLATE uses the columns and the layout of the currently opened table. When you start the Spreadsheet, the current template is the same as the new template.

You can store your own templates (here: statistics) for further use. User defined templates are stored in the folder GLOBDATA and are available for every new table and all projects.

Click FILE -> NEW and load the desired result file.

When you load the results of a facade noise map calculation the facade key is added to the receiver name. If you do not want to display the facade key, activate FILTER FACADE KEY in OPTIONS -> DOCUMENT SETTINGS. The document setting dialog is automatically displayed for new Spreadsheets.

Insert results and additional information

Insert results and additional information

For the documentation of the results of several calculation runs e.g. different noise sources or different states of investigation (analysis, forecast) you need to add columns to the existing table. Select FILE -> INSERT RESULTS AND ADDITIONAL INFORMATION and then ADD RESULT TABLE or ADD RESULT COLUMNS.
Add result columns

Additional results from another investigation state or another noise source can be inserted in new or existing columns in a table. If the coordinates of the receiver locations are the same as in the previous result file, the results are added in additional columns for the same receiver. Otherwise new receivers would be added at the end of the table.

Column selection for additional results

In the dialog box, all values that can be imported are shown. The additional results may either be inserted in an existing and formatted column or in a new one. The column numbers of the existing value columns are selected in the selection list SELECT LEVEL COL. Insert in new column means, that SoundPLAN adds new value columns and inserts the values.

Add result table

An additional results table can be added if the calculation has been done in several calculation runs. The rows are added at the end of the existing table. Select the result file desired from the open dialog box.

Add reference road or railway

A REFERENCE ROAD OR RAILROAD can be selected from a Situation in the Geo-Database to show the kilometer post in the table. It is necessary that the field reference line in the road or railroad properties is hooked.

Reference line is hooked in the properties
Add building information columns

You can enter additional information for the documentation and evaluation of the data using **ADD COLUMN WITH BUILDING INFORMATION**.

Filter for new tables in the Spreadsheet

Normally the Spreadsheet performs all calculations without truncating. Because of rounding the numbers if you display a column with only one or without decimal places it may be that differences have unexpected results depending on where in the process the results are rounded.

Activate the setting **CALCULATE WITH DISPLAYED DECIMAL VALUES** to get results consistent with the values displayed in the table.
Example with one digit after the decimal: \( 51,5 (51,541) - 51,5 (51,450) \) results in

setting is activated: 0,0

setting is not activated: 0,1

**DISPLAY ONLY THE SELECTED FLOOR** hides all lines from the result file except of the floor marked as decisive (in Geo-Database) in the definition of the receiver. If you want to display all floors select **TABLE -> SHOW HIDDEN ROWS**.

When receivers differ between two result files the option **UPDATE AND ADD DATA IN NEW COLUMNS ONLY FOR EXISTING RECEIVERS** assures that the program is not generating extra receiver lines for the second result file but rather amends only the ones already present.

If you have customized the names of the time slices in the table header, the program will reset the names to the settings in the assessment library when you store and subsequently reload the file, unless you deactivate the setting **SET NAME OF TIME SLICE IN TITLE**.

The facade marker is created automatically during the calculations and normally has no relevance for the user. In case you want to include this marker in the table, deactivate the setting **FILTER FACADE NOISE MAP MARKER**.

**DO NOT DISPLAY POINTS ON THE FACADE SMALLER THAN... [M]**, loads all receivers but only displays the receivers fitting the filter definition. Receivers blanked out are still included in the table statistics. This filter is used to prepare a Spreadsheet for the Graphics: Receivers at non-relevant facades (balconies, oriels..) shall not be part of the Spreadsheet but shall be loaded and displayed in the Graphics if the limit at the facade is violated. In contrast to this the option **LOAD ONLY RECEIVERS ON FACADES BIGGER THAN ... [M]** loads only the receivers on facades exceeding the criteria and thus the statistics will be only on the basis of these receivers. When you load a Spreadsheet into the Graphics and want to mark facades where the limit was violated, the first option will load and display all facades whereas the second will not, here only facades loaded into the spreadsheet will be displayed. The first two filters are mutually exclusive.

The last four options are used for special noise assessment procedures as are used in RAS-W (Germany), KNI (Switzerland) or the European Environmental Noise Ordinance (EU) where only certain receivers are processed. Only desired receivers are loaded the others are not included in the spreadsheet. **LOAD ONLY BUILDINGS WITH CONFLICTS** loads all receivers at a building as soon as at least one receiver at this building exceeds limit. **LOAD ONLY FLOORS WITH CONFLICTS** only loads the receivers on floors where the noise limit was violated. **LOAD ONLY THE RECEIVER WITH THE HIGHEST LEVEL ON EACH FACADE** loads only one receiver per façade and **LOAD ONLY THE RECEIVER WITH THE HIGHEST LEVEL PER BUILDING** loads all floors of the receiver with the highest level per building.

When you create a new table, the **DOCUMENT SETTINGS** are automatically displayed for checking and modification.
The table setup is accessed via the item **TABLE SETUP** from the **TABLE** menu or via the icon from the tool bar. The table setup displays the existing columns with its description, column width, visibility in the current table, the table layout including the text font and size and information on the table width.

Additionally the legend text is entered or changed here and formulas can be entered. The formula editor is one of the main advantages of the Spreadsheet which makes it as flexible as it is. The functions of the formula editor are described later on.

**Table Setup**

All available columns are displayed in the list. The X in the first column shows whether a column is visible in the current table or not. Double click with the left mouse button on the field in the appropriate row to change the mark.

The column number is the physical number of the column which is used by the formula interpreter. This field cannot be edited.

The column width can either be changed in the table itself when the cursor shape changes to a , or in the **TABLE SETUP** or the **COLUMN LAYOUT** if you want to enter the accurate number.

The column title is taken from the header entered in the table. This field cannot be edited.

The three record cards on the right hand side of the dialog box handle table header, table contents and table width definitions.

**Table definitions**
The font definition is the same for table header and table contents. Once the fonts and text sizes have been modified, the texts can be proportionally enlarged or shrunk via the text size field on the right hand of the tool bar. The text size displayed is the table contents text size.

The **ROW DISTANCE** is the height of each row in table contents or table header. **TEXT DISTANCE FROM CELL TOP** defines the position of the text in the row and is automatically adjusted to the row distance.

A background **COLOR** can only be defined for the table header.

The table width includes the options fit last column in page width which means that the last column of the table is enlarged or shrunk. See "Column width optimization tools" below. The edge lines of the table can be activated and defined here, too.

In the info box **TABLE WIDTH**, information on the maximum size which fits in the page width and the width of the selected columns is provided. If the table doesn't fit in the page width, either choose landscape in the page layout or shrink the column sizes. The maximum width of the table and the page length is also displayed in the table itself with a dotted red line.

**Column width optimization tools**

SoundPLAN offers tools to optimize the column width:

To adjust the column width to the longest entry in the column, select the button in the **COLUMN LAYOUT**.

To optimize the column widths for the whole table, i.e. to enlarge or shrink all columns so that they fit in the page width, choose **OPTIMIZE COLUMN WIDTHS** from the **TOOLS** menu.

To adjust the last column of the table to fit in the page width, choose **FIT LAST COLUMN IN PAGE WIDTH** from the **WIDTH** record card in the **TABLE SETUP**.

**Hint**: Be careful with combined cells in the header. The optimization tool cannot optimize combined cells. In this case SoundPLAN will optimize the cells in the table content.

**The Formula Editor**

In the Spreadsheets values and attributes can be calculated via formulas. The formulas are interpreted column wise. The result of a formula is written into a before created value or text column. The commands are more or less the same as in table calculation programs such as Excel or 123.

Before a column can be calculated, a formula has to be assigned. Create a value or text column, open the table setup and enter the formula in the appropriate field.
When entering a formula, the little hook marking RECALCULATE ALL becomes visible. With complex tables it is often better to deactivate the automatic calculation and to start the calculation afterwards in the table from the right mouse button menu on the column header via CALCULATE for the current column.

4 inserts a value column or select item INSERT VALUE COLUMN from the TABLE menu

T inserts a text column or select item INSERT TEXT COLUMN from the TABLE menu

Then go to the table setup and enter the formula in the appropriate field according to the instructions above.

Example:

In a new text column "yes" is to be entered if the acceptable noise level day or night is exceeded. (The limit is in column x7 (day) or x8 (night) and the level day / night is column x11/x12.)

IF x11 - x7 >0 OR x12 – x8 >0
    THEN "yes"
    ELSE ";

Formula Syntax

Important: The end of a formula has to be signed with a semicolon ;. The structure of the formulas is described using syntax charts. Please read these charts always from left to right. If branchings are used in the syntax chart, select the branch needed. If a branch leads back, it is marked with an arrow. When returned to the main branch, read further to the right. Such a construction is called a loop.

The instruction is such a loop (see chart below):

Enter a value in the main branch, e.g. 5, in the backwards branch an operator has to be entered, e.g. +. Back in the main branch a value is needed again, e.g. 4. The instruction therefore is: 5 + 4;

The terms operator and value are place holders for additional syntax charts, which can be further encapsulated by other place holders. In the description the key words are written in capital letters.

Instruction:

![Syntax Chart]

---

Table Setup

SoundPLAN Handbook
### Conditional Instruction:

```
IF instruction THEN conditional instruction ELSE instruction ;
```

### Table of the functions for the calculation in a formula

A column is defined by **XNo** (Column Number) in a formula. Multiple columns are divided by a comma, if two dots (..) are entered between the columns, all columns in this range are interpreted.

- **X1, X3**: The columns x1 and x3 are interpreted
- **X1..X3**: The columns x1, x2, x3 are interpreted

#### Operators

- **Arithmetic operators**: +, -, *, / (division), ^ (x^y power)
- **Relational operators**: <, <=, =, >=, >, <>
- **Boolean operators**: AND, OR

#### Instructors

IF, THEN, ELSE

#### Statistic functions

--- COUNT (Column Relation Value) ---

--- MIN (Column) ---

--- MAX (Column) ---

#### Text

- **Arithmetic Functions**
  - **ROUND**: ROUND (instruction[,decimal places])
    - Result is the rounded value (e.g. round(x10,1)
    - RLS90 rounded value according to RLS 90
    - SCHALL03 rounded value according to Schall 03
  - **TRUNC**: TRUNC (instruction[,decimal places])
    - Result is the truncated value
  - **SQR**: result is x^2
  - **SQRT**: result is \sqrt{x}
  - **EXP**: result is x^y
LN  result is the natural logarithm
LOG  result is the logarithm to the base 10
LogLEV  result is the logarithmic level
ELEV  result is the energetical level
Example: LogLEV(ELEV(x2)+ELEV (x3)); result is the summed up level
You can also use
LEVEL SUM (columns) or
LEVEL DIFF (columns)

ABS  result is the absolute of an value

Text functions
RIGHT, LEFT, MID  Function if only a part of a text shall be displayed
RIGHT (text, number of characters)
LEFT (text, number of characters)
MID (text, start position, number of characters)
Example:
RIGHT ("SoundPLAN 5.0",5) result Sound
MID ("SoundPLAN 5.0",6,4) result PLAN

TEXT  With relations and instructions, VALUE can also be a text. The text has to be marked by "". Text relations do not differ between normal letters and capital letters.
converts a value in a text, additionally the number of decimal places can be entered
TEXT (instruction[, decimal places])
Example: TEXT (x11-x9,1)

VALUE  converts a text in a value

SoundPLAN specific functions
KM  converts the km post calculated in the Geo-Database into km+meter (in GeoDB; 0,665 -> 0+665)

GV  Grid value: instead of x if the grid value shall be used (Assessment table)
CV  Conflict value: instead of x if the conflict value shall be used (Assessment table)
GRIDCOUNT  Counts the number of grid values (Assessment table)
CONFLICTCOUNT  Counts the number of conflict values (Assessment table)
CONFLICT VALUE
(instruction)
If the result of the instruction is <0, the result is 0 else the difference between level value and limit level. If the instruction includes a limit level column, the spreadsheet checks, if the limit level is 0 (not available). In this case, the result of the instruction is also 0.

<table>
<thead>
<tr>
<th>Level column (X19)</th>
<th>Limit column (X17)</th>
<th>Conflict value (x19-x17)</th>
</tr>
</thead>
<tbody>
<tr>
<td>60,3</td>
<td>59</td>
<td>1,3</td>
</tr>
<tr>
<td>58,7</td>
<td>59</td>
<td>0</td>
</tr>
<tr>
<td>60,3</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

CONFLICT
(instruction)
If the result of the instruction is <0, the result is 0 else 1 (Boolean value). If the instruction includes a limit level column, the spreadsheet checks, if the limit level is 0 (not available). In this case, the result of the instruction is also 0.

**Highlighting Cells Using Formulas**

In **TABLE -> TABLE SETTINGS** you can define a second formula for the cell layout, so the cell layout can be stored in the templates, and is still correct after a recalculation.

The key is:

CELL (Parameter, [Parameter,[Parameter …]])

The formula can determine the text color and the cell background color.

**Text Color and Text Style**

As parameters for the text layout, the following key words are available:

- BOLD, ITALIC, UNDERLINE
- RED
- GREEN
- BLUE
- BLACK
- WHITE
- YELLOW
- MAGENTA
- CYAN
- GRAY

The key words LIGHT or DARK can accompany the color names (except black and white), e.g. LIGHT RED.

Except for gray, full colors use the RGB values 255 and 0, light colors use 255 and 200, the dark colors use 200 and 0.
Example for red:

<table>
<thead>
<tr>
<th>Color parts</th>
<th>R(red)</th>
<th>G(reen)</th>
<th>B(lue)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>255</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Light red</td>
<td>255</td>
<td>200</td>
<td>200</td>
</tr>
<tr>
<td>Dark red</td>
<td>200</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

RGB values for gray:

<table>
<thead>
<tr>
<th>Color parts</th>
<th>R(red)</th>
<th>G(reen)</th>
<th>B(lue)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Dark gray</td>
<td>100</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td>Gray</td>
<td>150</td>
<td>150</td>
<td>150</td>
</tr>
<tr>
<td>Light Gray</td>
<td>200</td>
<td>200</td>
<td>200</td>
</tr>
<tr>
<td>White</td>
<td>255</td>
<td>255</td>
<td>255</td>
</tr>
</tbody>
</table>

If these color shades are not sufficient, you can enter RGB values in the formula with the command text color:

TF (r,g,b)

However, SoundPLAN doesn't save the RGB values, but the color numbers from the SoundPLAN color palette. The command TF replaces the entered RGB values with the closest color from the color palette.

**Cell Color**

The cell background color is defined according to the text color definition. Because SoundPLAN needs to know that you want to define the cell color and not the text color, you must enter the command ZF for the cell color definition.

The syntax is ZF=LIGHT RED for color constants or ZF(r,g,b) when defining RGB values.

**Example - Formula for Cell Layout**

If CONFLICT (X19-X17)
   then CELL (ZF=light red, bold)
   else CELL (gray);

If a conflict occurs, the cell background is light red and the text is bold. Because the text color doesn't change, the definition of the text color is taken from the column layout. Without a conflict, the text color is gray.

As often only the cells with conflict should be changed, the ELSE branch can be omitted.

Instead of

If CONFLICT (X19-X17)
   then CELL (ZF=light red, bold)
   else CELL ()

If CONFLICT (X19-X17)
   then CELL (ZF=light red, bold)
Update results

The Spreadsheet recognizes changes in the results (i.e. that the date of the results file is newer), if you executed a calculation again. When you start the Spreadsheet, you are asked whether you want to update the results.

During working in the Spreadsheet, you can update the results via the menu FILE -> UPDATE RESULTS and FILE -> REBUILD RESULTS.

REBUILD RESULTS completely builds the table, executes the filters in OPTIONS -> DOCUMENT SETTINGS, adds new receivers and removes receivers no longer in the data. Cell layout, text rows and manual changes are lost. The Spreadsheet will inform you about the number of added and removed receivers.

UPDATE RESULTS updates only the results already included in the table. No receivers are added or removed, but cell layout, table structure and text rows are kept.

You can define the cell layout via a formula, to keep the formatting when you rebuild the results. See "Highlighting Cells Using Formulas" on page 233.

Design Spreadsheet tables

There are a lot of possibilities to design the Spreadsheet tables.

- Format single cells, for example to highlight level exceeding
- Combine cells in the table header
- Make tables easier to read using the table structure
- Use the 3 section layouts for the formatting of text

Column layout

The column layout can be accessed either via the right mouse button menu from the column header or via the item COLUMN LAYOUT from the TABLE menu. The column layout is always valid for all column marked or the current column in which the cursor is positioned. If the cursor is positioned in the table header, the column layout enters the header layout; if it is positioned in the table contents, the layout for the table contents is opened.
Column layout in the Spreadsheets

Column settings

The background color of the columns can only be set in the table header. In the table contents this field is disabled. The column width can be set numerically. Via the button the column width is assigned to the longest entry in each column.

Value settings

Enter the number of decimal places and the round mode. The round mode has several rounding options:

Round mode

The round mode MATHEMATICAL rounds according to the mathematics standards on the specified decimal places:

1 decimal place: 0,3499 -> 0,3 0,3500 -> 0,4
2 decimal places: 0,3499 -> 0,35 0,3500 -> 0,35

The round result depends on the numbers of decimal places defined in the field DECIMAL PLACES.

The round mode DOWN (TRUNCATE) cuts down the value to the specified decimal places:

1 decimal place: 0,3499 -> 0,3 0,3500 -> 0,3

The round mode UP (TRUNCATE+1) cuts down the value to the specified decimal places and adds 1 on the last decimal place:

1 decimal place: 0,3499 -> (0,3 + 0,1) = 0,4 0,3500-> (0,3 + 0,1) = 0,4
Text settings and line setting

Define text style settings bold, italic and underlined, text color and the alignment of the text in a column for the complete column.

In addition to text settings for complete columns, the text style can be changed for marked cells to bold and/or italic without entering the column layout if the option MARK COMPLETE ROWS from the OPTIONS menu is disabled (no hook in front of the option).

Single cells can be marked by either clicking Ctrl+ left mouse button or by using the function CALCULATE AND MARK in the right mouse button menu from the column header.

Calculate and mark

With this function for example all cells in which the acceptable noise limit has been exceeded can be marked automatically to be displayed in bold.

Apart from the text style settings the alignment and the text color an output mode to display texts only if they are different to the previous text can be set:

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Jemica Road 26</td>
<td>1</td>
<td>NW</td>
<td>64.0</td>
<td>5.4</td>
<td>66.7</td>
<td>46.1</td>
<td>56.9</td>
<td>46.6</td>
<td>6.0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>NW</td>
<td>64.0</td>
<td>5.4</td>
<td>66.7</td>
<td>46.1</td>
<td>56.9</td>
<td>46.6</td>
<td>6.0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jemica Road 37</td>
<td>1</td>
<td>NW</td>
<td>59.0</td>
<td>40.0</td>
<td>57.4</td>
<td>40.0</td>
<td>57.4</td>
<td>40.0</td>
<td>57.4</td>
<td>40.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>NW</td>
<td>59.0</td>
<td>40.0</td>
<td>57.4</td>
<td>40.0</td>
<td>57.4</td>
<td>40.0</td>
<td>57.4</td>
<td>40.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jemica Road 33</td>
<td>1</td>
<td>NW</td>
<td>59.0</td>
<td>40.0</td>
<td>57.4</td>
<td>40.0</td>
<td>57.4</td>
<td>40.0</td>
<td>57.4</td>
<td>40.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>NW</td>
<td>59.0</td>
<td>40.0</td>
<td>57.4</td>
<td>40.0</td>
<td>57.4</td>
<td>40.0</td>
<td>57.4</td>
<td>40.0</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Only texts different to the previous text are displayed.

To get a clear output, SoundPLAN can eliminate texts that are the same as in the row before. This can be defined for each column you want. In this example all repeated texts are only displayed once.

Enable this function with a click in the field DO NOT SHOW TEXT IF SAME AS PREVIOUS TEXT. If more then the text in one column should not be shown, it is necessary to define a reference column to which the column text refers. Click on the field USE REFERENCE COLUMN and enter the column number from the column header.

E.g. the area usage is always the same but it should be displayed with every receiver location. Click in the column area usage on the field DO NOT SHOW TEXT IF SAME
AS PREVIOUS TEXT, activate USE REFERENCE COLUMN and enter the column number of the receiver name (in the example column No. 7).

Moreover the blocks can be separated by lines. Click on the field SHOW LINE BETWEEN DIFFERENT TEXTS and define the line width and the color.

**Text distance and edge lines**

The TEXT DISTANCE defines the distance from the left and right edge of the cell. This can be used if for example the level values shall be displayed right aligned but with a specified distance from the right edge of the cell.

The EDGE LINES define for each edge line separately whether the edge lines should be displayed, and if yes in which line width and color.

**Right mouse button menu in the column header**

Click on a column header with the right mouse button to open this menu.

The Column layout can be entered here or with TABLE -> LAYOUT -> TITLE COLUMN or DATA COLUMN.

The CONTENTS item shows the contents of the appropriate column which can be a formula or an information on the result.

The item CALCULATE calculates the formula of the selected column. With complex tables it is often more suitable to calculate just the current column then to calculate all after closing the table setup.

Single cells can be highlighted by either clicking Ctrl+ left mouse button or by using the function CALCULATE AND HIGHLIGHT in the right mouse button menu from the column header.
Calculate and highlight

With this function for example all cells in which the acceptable noise limit has been exceeded can be marked automatically to be displayed in bold.

The item **MARK** marks the current column to modify the layout.

A table can be sorted ascending or descending with reference to the current column when selecting the item **SORT** from the right mouse button menu.

### Section Layout

The section layout is used to define the title, body text and block layout of text rows or structured tables in the table. The layout of the table columns is modified in the column layout or in the table setup. Changes in the font, letter type and size, line spacing and section spacing can also be reviewed. The text rows or structured tables can be assigned a top and bottom line and a background color. The items in the section layout are self-explaining.
Structured Tables

The structured table shows selected columns as a header row and exclude them from the table. Thereby the table becomes easy to read and smaller. As an example, the receiver name, the area usage and the limits should be displayed in the header line.

<table>
<thead>
<tr>
<th>Floor</th>
<th>km post</th>
<th>Lr Analysis Day in dB(A)</th>
<th>Lr Analysis Night in dB(A)</th>
<th>Lr Prognosis Day in dB(A)</th>
<th>Lr Prognosis Night in dB(A)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jamaica Road 26</td>
<td>Usage</td>
<td>Limit day/night</td>
<td>64</td>
<td>554 dB(A)</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>0+734</td>
<td>58.29</td>
<td>46.10</td>
<td>56.8</td>
<td>46.6</td>
</tr>
<tr>
<td>2</td>
<td>0+734</td>
<td>50.20</td>
<td>47.90</td>
<td>50.7</td>
<td>48.5</td>
</tr>
<tr>
<td>Jamaica Road 27</td>
<td>Usage WA</td>
<td>Limit day/night</td>
<td>59</td>
<td>450 dB(A)</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>0+752</td>
<td>67.63</td>
<td>57.42</td>
<td>68.1</td>
<td>57.9</td>
</tr>
<tr>
<td>Jamaica Road 30</td>
<td>Usage</td>
<td>Limit day/night</td>
<td>64</td>
<td>554 dB(A)</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>0+734</td>
<td>51.65</td>
<td>41.34</td>
<td>52.3</td>
<td>42.0</td>
</tr>
<tr>
<td>2</td>
<td>0+734</td>
<td>52.62</td>
<td>42.50</td>
<td>53.5</td>
<td>43.1</td>
</tr>
<tr>
<td>3</td>
<td>0+734</td>
<td>60.56</td>
<td>50.29</td>
<td>61.1</td>
<td>50.9</td>
</tr>
<tr>
<td>Jamaica Road 31</td>
<td>Usage WA</td>
<td>Limit day/night</td>
<td>59</td>
<td>450 dB(A)</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>0+753</td>
<td>67.56</td>
<td>57.25</td>
<td>68.1</td>
<td>57.9</td>
</tr>
<tr>
<td>2</td>
<td>0+753</td>
<td>67.53</td>
<td>57.32</td>
<td>68.1</td>
<td>57.3</td>
</tr>
</tbody>
</table>

Example of block definitions in the Spreadsheet

Mark the columns in the table that should be displayed in the header row by selecting them via the mouse.

Choose STRUCTURED TABLE from the TABLE menu, the dialog box might look like that:

Block definition – not modified
The first column is the COLUMN number in the table. X and Y position show the position of the text and / or value in the header row. It is automatically taken from the column width. TEXT BEFORE and TEXT AFTER are taken from the column header in the table. FONT describes the selected section layout.

Now the block definition can be modified:

E.g. in the header row it is not necessary to show the text "receiver name", and the noise limits which are unmodified displayed as

Limit day  64 dB(A) Limit night  54 dB(A)

perhaps shall be displayed as

Limit day / night  64 / 54 dB(A)

Furthermore the receiver shall be displayed in a bigger text size and bold. It is a little bit tricky to adjust the x position. The default width in the header row is column width of this column in the table. Click OK to return to the table and change the x position until it fits in the header row. The x position of the following items in the header row is adjusted automatically if the appropriate field in the dialog box is hooked. The y position has only to be modified if different text sizes are used in the header row or if the header is displayed in more than one row.

The modified dialog box might look as follows:

![Reference Row Definition](image)

_Block definition - modified_

The result of the modification can be seen in the example above.

There are three section layouts that are modified in the table itself and assigned to the column in the structured table dialog.

If more then the text in one column should not be shown, it is necessary to define a reference column to which the column text refers to. Select the column number from the column header in the field REFERENCE COLUMN.

If the field ALLOW PAGE BREAK IN BLOCK is disabled, only whole blocks are printed on one page. With long blocks it might be suitable to allow the page break in the block.

To delete a defined structured table definition choose DELETE STRUCTURED TABLE from the TABLE menu. The columns that had been displayed in the header row have to be made visible manually in the TABLE SETUP.
**Hint:** Once a structured table has been defined, this definition can be stored as a template so that the definition is available for other projects and tables.

---

**Table statistics**

The table statistics now can be placed at the beginning or at the end (default) of the table. Activate the box **INSERT STATISTICS ON TOP** at the bottom of the definition mask table statistics.

**Definition of a statistics in TABLE -> TABLE STATISTICS -> DEFINE**

<table>
<thead>
<tr>
<th>Obj. No.</th>
<th>Filter</th>
<th>Blocked</th>
<th>Compress</th>
<th>M1-(\Delta)</th>
<th>Limit Level Day</th>
<th>Limit Level Night</th>
<th>Provisions Day</th>
<th>Provisions Night</th>
<th>Time range limit const.</th>
<th>Facade length</th>
<th>Facade length crossing the limit day</th>
<th>Costs</th>
<th>Costs noise protection measure (18244,0) Euro</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>yes</td>
<td>no</td>
<td>1.5</td>
<td>0.06</td>
<td>0.06</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>1.0</td>
<td>0.0</td>
<td>0.0</td>
<td>18244,0</td>
</tr>
</tbody>
</table>

| Maximum levels/day/night: 18244,0 (Euro) |

**Effect in the Spreadsheet**

---

**Page Layout**

The preview of the page layout within the Spreadsheet is only visible if you click on Preview in the page layout. The table itself is printed in the way you see it on the screen. Please read the description on page 216.
10 Wall Design

Overview

Calculating and optimizing the dimensions of noise protection walls is a time consuming task. Designing the wall for one receiver is manageable if the source is just one line. Usually the permitted height is selected and the barrier length needed to shield the receiver to the proper noise level must be determined. Otherwise, you can specify the length of a noise screen and calculate the screen height needed to reach the proper noise level.

Dimensioning a noise screen for a single receiver

The task of optimizing becomes complicated when more than one receiver must be protected.

In most cases you would begin dimensioning the noise screen for each one of the receivers, superimpose the screens, and check how much the noise control target was exceeded. You would then modify the screen by hand to optimize it at certain locations. Real optimization by hand (even with the help of a computer) is impossible!
Optimizing a noise screen by hand for multiple receivers

Optimizing a noise screen means finding the screen with the smallest surface area shielding the receivers to the desired level. A second optimization is a minimization of costs. SoundPLAN provides these options plus even more.

The optimal noise screen might be the least expensive solution, but it may also be the least aesthetic. The structure of noise protection walls should fit into the landscape. Beginning with the minimal solution, you can modify the noise screen design while keeping the noise control objective.

SoundPLAN can optimize complicated areas with multiple sources (road, rail, industry) and receivers in areas having different requirements (residential or industrial).

Wall Design's Internal Organization

In order to better understand Wall Design's capabilities, examine the completed calculations. The following picture shows an example of a road with a parallel noise barrier which is to be dimensioned for one receiver.
SoundPLAN's search rays (triangles sent with a constant angular spacing) intersect the barrier and the roads when scanning. The geometry for every cut is organized according to distance from the receiver as seen in the flow chart following. Wall Design's goal is to calculate the screening influence for every intersection with the noise barrier and record the differences.

After the search ray intersects the screen element, the influence of a 0.0 screen is calculated. A defined increment is used to increase the height of the noise barrier a specified number of iterative steps. The element height and the number of elements are defined in the calculation properties.

Flow chart of optimizing calculations

Completely calculation the noise in one ray allows the influence of ground attenuation and screening to be evaluated and used later to optimize the noise barrier.

As more than one search ray may pass over an element of the noise barrier, the values stored in the matrix must have different energies than the zero height barrier. When all contributions that passed over a single barrier section have been evaluated, the "noise footprint" of this barrier element for the receiver being calculated has been recorded. SoundPLAN stores all energetic reductions in a matrix that is up to 20 elements high for every receiver and as wide as the total wall elements.
Wall design loads this matrix and searches for the barrier elements yielding the highest reduction of sound energy per surface (or per cost). The barrier selection uses an iterative process.

### Selecting the barrier elements

As documented in the flow chart, receivers are included in the barrier selection process only if their noise level exceeds the set limit. For all improperly shielded receivers, SoundPLAN searches for the element resulting in the highest reduction of noise energy (stored in the matrix) for all receivers. During this search SoundPLAN examines the next element to be added and evaluates the usage of the next 2-3+ elements.

If the base of the noise screen was not intersected with the search ray, the first element has no protecting value. Only elements high enough to intercept the line of sight provides a positive reduction of noise per area. In this case the highest attenuation per square meter requires many more elements than just those breaking the line of sight.

### Selection sequence

<table>
<thead>
<tr>
<th>Selection sequence</th>
<th>End shape of the noise screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
</tbody>
</table>
The noise reduction per square meter of wall surface (or wall surface * specific cost) is the main goal for selecting barrier elements. The element's efficiency can be seen in the diagram.

<table>
<thead>
<tr>
<th>dB(A)</th>
</tr>
</thead>
<tbody>
<tr>
<td>74</td>
</tr>
<tr>
<td>72</td>
</tr>
<tr>
<td>70</td>
</tr>
<tr>
<td>68</td>
</tr>
<tr>
<td>66</td>
</tr>
<tr>
<td>64</td>
</tr>
<tr>
<td>62</td>
</tr>
<tr>
<td>60</td>
</tr>
<tr>
<td>58</td>
</tr>
<tr>
<td>56</td>
</tr>
<tr>
<td>54</td>
</tr>
</tbody>
</table>

1 2

surface area in 1000 * [m²]

Noise level reduction and increase of wall size

As seen in the diagram, increasing the wall size beyond 2000 m² does not decrease the noise levels at a justifiable rate. Even if SoundPLAN manages to reach the set noise levels, the cost to performance ratio becomes increasingly worse. The decision maker must decide how much sound the noise screen shall shield and at which point passive measures (improved windows) are the more cost-effective solution.

For clarity, the cost-performance diagram was shown only for one receiver. In a real situation, the diagram would contain many more lines, and for each receiver a characteristic cost to performance line.

Wall Design Performance

Wall Design can perform accurately only if all the parts are present. Before the optimization can be run, several steps need to be completed.

1. Define the wall's position as a regular screen in the Geo-Database. Copying and moving the coordinates sideways defines the position of the major road or rail, or the screen can be digitized. The wall height can be ignored because Wall Design will determine this. It is advisable to extend the potential wall beyond both sides of the perpendicular position of the receivers. If the walls are not needed, Wall Design will ignore them, and if they are necessary, they will be included in the pre-calculation. The wall elements should not be longer than 10% of the distance between the source line and the receiver. The wall has to be entered in separate Geo-File, otherwise the wall cannot be pre-calculated.
2. Wall Design can optimize a noise control wall for minimum surface area or for minimum cost. Minimizing the cost requires price information for the noise control wall. SoundPLAN offers a cost matrix which you must configure to local conditions. Costs can be defined for walls and berms and can consist of land acquisition, foundation and building costs for different wall heights. Planting costs for berms are a separate factor. When digitizing the wall base line, different wall elements may have different cost. One part could be concrete, another part could have translucent material and yet another part could be constructed of lumber.

3. A calculation run is necessary for Wall Design to obtain all information about the efficiency of wall sections. SoundPLAN dimensions only one wall per calculation although other berms and walls may be present in the calculation. Sources can be from road, railway and industry. The wall base line is marked with a little hook in the field **OPTIMIZATION** in the properties of the walls and berms in the Geo-Database. It has to be stored in a separate Geo-File.

4. Use Wall Design for on line dimensioning and optimization of the noise screen. The noise screen element heights are dimensioned using the calculated data. The following tools are available:

- Automatic calculation of the shortest wall height or the least cost. The selection can be all at once or step by step.
- Definition of the minimum and maximum element heights so the all can aesthetically fit into the landscape. It might be advisable to complete a second automatic dimensioning for the wall elements that don't have defined heights.
- View the dimensional noise screen as a graphic in the top view and as a 2D projection.
- Generation of a cost performance diagram. This is part of the procedure for deciding when to stop dimensioning the wall if it does not meet the objective. The selected wall can be transferred to the selection matrix for further studies.
- Printing the cost performance diagram with the protocol table, including all wall sections, costs and achievable attenuation at the receivers.
- Transfer of the wall to the Geo-Database as a normal screen for later use (calculation of noise maps, etc.)

---

**Using Wall Design**

Define the position of the wall base line in a separate Geo-File in the Geo-Database. Activate the field **OPTIMIZATION** in the properties of the wall or berm and specify the properties of the wall.
Activate the field optimization in the wall or berm properties

The sections of the wall base line should not be too wide. Depending on the geometry situation and the distance of the receivers from the source, the size of the sections can be different. The following table shows empirical values:

<table>
<thead>
<tr>
<th>City Type</th>
<th>Section Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inner cities</td>
<td>5 to 10 meters</td>
</tr>
<tr>
<td>Outside cities</td>
<td>20 to 40 meters</td>
</tr>
<tr>
<td>Highways</td>
<td>up to 100 meters</td>
</tr>
</tbody>
</table>

Use the GeoTool **DIVIDE SECTIONS** to divide the wall base line into several sections. The elevation information will be interpolated.

In the next step the wall base line has to be pre calculated in the Calculation Kernel to obtain all information about the efficiency of wall sections.

Open **CALCULATION** from the SoundPLAN Manager. Add a calculation run to the already existing or create a new run file. For details see also Chapter "Calculations".

You can use Wall Design for single receivers as well as for Facade Noise Maps.

Enter a run name, select the run type Wall Design from the selection list and select the data needed.

**Run properties**

Do not forget the number for the result file. Check the pre settings in the dialogues Settings and Standards and look at the Wall Design properties:
Wall Design properties

The default settings for the height of each element is 0.5 meters and for the maximum number of elements used for the iteration it is 20 elements.

These default settings can be modified according to your needs.

Activate the field **IGNORE WALL/BERM HEIGHTS IN DESIGN GEO-FILE** if the wall that should be optimized has been assigned an object height in the Geo-File. On the other hand the object height of a finished noise barrier can be taken into account if a cost estimation should be done.

Make sure that the calculation is enabled (yes in the first column of the run file) and start the calculation via **EXECUTE**.

After the calculation run has been finished successfully, open Wall Design from the SoundPLAN Manager via the menu **EXECUTE**, the item **TOOLS** and then **WALL DESIGN**.

Load the result of a designed (pre-calculated) screen file in the **OPEN** window.

The Wall Design window will be displayed on the screen:

**Wall Design window**

On the left hand side information on the calculation run, the receivers, the wall segments and on the history of iteration are displayed in four sections. On top of the window, information on the surface, length and costs are shown, additionally the
user can select whether the optimization of the wall should be done on the surface optimum or on the cost minimum and what time slice should be taken into account.

Wall design uses the SoundPLAN Graphics. The object types OPTIONS -> OBJECT TYPES control the objects representation and particularly the representation whether or not receivers exceed the limits.

The lower part of the graphic displays the site map, and the upper part the front elevation. Right click to change the DISPLAY TYPE (site map, front elevation, 3D) as well as the DRAW TYPE (wire frame, hidden lines or areas).

![Diagram of Wall Design](image)

Depending on the display type, further functions are available via the right mouse button.

Additional options:

- **OPTIONS -> SHOW ONLY BUILDINGS WITH RECEIVERS** removes buildings without assigned receivers from the graphics.

- It is possible to enter a stretch factor for the front elevation.

- To speed up the optimization, the building process of the wall is no longer displayed (OPTIONS -> DISPLAY WALL BUILDING PROCESS).

In the Wall Design graphics the screen can be zoomed to the current receiver location or the current wall element, depending on the current table on the left hand side. Set CENTER AUTOMATICALLY to refresh the screen section while going through the receiver or wall element list.
**Starting the optimization**

The optimization is started by clicking on [ ] or via the item **RUN <F9>** from the **OPTIMIZATION** menu. The wall is gradually built until all receivers keep the limits or the number of wall elements is not sufficient to keep the target levels. In this case the following error message is displayed

![Wall Design Error Message]

and still some of the receivers are displayed in red.

A step by step iteration with constant observation of the selection of the wall elements can be done by clicking [ ] or via item **SINGLE STEP <F7>** from the **OPTIMIZATION** menu. If you choose the step by step approach, you can interrupt the building of the wall at any time with [ ].

**Receiver locations**

This section gives detailed information on the receivers. If a reference axis of a road or railway has been defined in the road or railway properties of the Geo-Database, the kilometer post is shown for the exact location of a receiver. The next columns display the receiver height above ground, the number of floors, the decisive floor and the area usage.

The **TARGET LEVEL** is the level that should be kept after the optimization. If the area usage has been defined for the receivers in the Geo-Database and an assessment library has been selected in the calculation run the target level is taken from the limits in the assessment library. If not, a target level can be set in Wall Design for all receivers by either using **<F4>** or selecting the item **SET TARGET LEVELS** from the **RECEIVER** menu otherwise the target level is 0, and can never be kept. Aside from setting the target levels for all receivers, the levels for single receivers can be modified in the table.

When starting Wall Design, a **YES** is placed in the first column for all the receivers, which means that all the receivers are included in the optimization. Use **<F2>** or the item **SELECT FOR OPTIMIZATION** from the **RECEIVER** menu. Sometimes it is suitable to exclude a receivers from the optimization after the first calculation, e.g. if the limit cannot be kept and therefore passive measures (improved windows) have to be designed.
Wall Design

Wall segments

<table>
<thead>
<tr>
<th>No.</th>
<th>Ch.</th>
<th>Length</th>
<th>Height</th>
<th>Wall elements</th>
<th>Wall height</th>
<th>Length</th>
<th>Cost [€]</th>
<th>Cost [k]</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.024</td>
<td>441.37</td>
<td>0</td>
<td>0</td>
<td>0.00</td>
<td>19.82</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>0.026</td>
<td>441.37</td>
<td>0</td>
<td>2</td>
<td>0.00</td>
<td>31.95</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>0.028</td>
<td>441.37</td>
<td>0</td>
<td>2</td>
<td>0.00</td>
<td>18.22</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>0.030</td>
<td>441.37</td>
<td>0</td>
<td>2</td>
<td>0.00</td>
<td>22.49</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>5</td>
<td>0.032</td>
<td>441.37</td>
<td>0</td>
<td>2</td>
<td>0.00</td>
<td>18.14</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>6</td>
<td>0.034</td>
<td>441.37</td>
<td>0</td>
<td>2</td>
<td>0.00</td>
<td>28.15</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>7</td>
<td>0.036</td>
<td>441.37</td>
<td>0</td>
<td>2</td>
<td>0.00</td>
<td>28.16</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>8</td>
<td>0.038</td>
<td>441.37</td>
<td>0</td>
<td>2</td>
<td>0.00</td>
<td>31.94</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>9</td>
<td>0.040</td>
<td>441.37</td>
<td>0</td>
<td>2</td>
<td>0.00</td>
<td>25.86</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>0.042</td>
<td>441.37</td>
<td>0</td>
<td>2</td>
<td>0.00</td>
<td>33.87</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>11</td>
<td>0.044</td>
<td>441.37</td>
<td>0</td>
<td>2</td>
<td>0.00</td>
<td>32.99</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>12</td>
<td>0.046</td>
<td>441.37</td>
<td>0</td>
<td>2</td>
<td>0.00</td>
<td>28.10</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>13</td>
<td>0.050</td>
<td>441.37</td>
<td>0</td>
<td>2</td>
<td>0.00</td>
<td>38.13</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>14</td>
<td>0.052</td>
<td>441.37</td>
<td>0</td>
<td>2</td>
<td>0.00</td>
<td>22.16</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>15</td>
<td>0.054</td>
<td>441.37</td>
<td>0</td>
<td>2</td>
<td>0.00</td>
<td>26.22</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>16</td>
<td>0.055</td>
<td>441.37</td>
<td>0</td>
<td>2</td>
<td>0.00</td>
<td>13.71</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>17</td>
<td>0.057</td>
<td>441.37</td>
<td>0</td>
<td>2</td>
<td>0.00</td>
<td>14.75</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>18</td>
<td>0.059</td>
<td>441.37</td>
<td>0</td>
<td>2</td>
<td>0.00</td>
<td>14.22</td>
<td>10</td>
<td>0</td>
</tr>
</tbody>
</table>

Section Wall segments

For information this section shows the assigned km post and the base height of the wall.

Wall height, length and costs can only be added after the first optimization. When optimizing a wall, often a minimum or maximum height is predefined by the planning authorities. Those default heights can be entered via the items SET MINIMUM HEIGHTS or SET MAXIMUM HEIGHTS from the WALL menu.

**Hint:** The maximum number of wall elements cannot be higher than defined in the Wall Design properties in the calculation run.

After the first calculation the wall might look like that:

![Wall with gaps after the first optimization](image)

Some segments of the wall do not need to be built to keep the limits. Therefore minimum and maximum heights (number of elements) can be set in the table itself. Modify the number of elements in the columns MIN and MAX but not in the column ELEMENTS, this column should be calculated.

Please do not forget to optimize again after modifying minimum or maximum heights!
Optimization History

If the objective of dimensioning the noise screen to the set noise limits can not be met, or if Wall Design requires an excessive amount of wall surface, the situation can be analyzed using the cost to performance diagram.

The diagram shape is a representation of the Fresnel diagrams with attenuation and extra path length. If the noise screen is lengthened, the benefits per surface area decrease. This is also visible in the wall size to noise level diagrams. Wall Design, however, uses elements in the perpendicular position and elements along a stretch of receivers, the height is increased and the elements chosen shield the noise from the sides.

The diagram can be plotted in different modes:

The x-axis can map the surface area or the total cost, while the y-axis can map the absolute noise levels over the area of the noise screen (actual level), the noise reduction (level difference to the start level) or the levels exceeding the limits (level difference to the target level).

[diagram]

are used to move in the diagram to view every state of the wall - the wall elements built are displayed in the graphics, costs, length, surface area and so on are displayed in the table.

Each move to the right begins the next iterative selection. goes to the first iterative step, goes to the previous step to the next step and to the last step.

Minimizing Costs

If the objective in Wall Design is to minimize the cost, SoundPLAN needs the cost definitions.
Cost table in Wall Design

The cost table is divided into costs applying to berms and costs applying to walls. The costs for berms are rough estimates because the volume and area are calculated with a simple model rather than with a digital ground model.

**Calculations of berm parameters**

- **Foot print**: Defines the cost per area that the wall or berm developer needs to acquire.
- **Volume**: Defines the cost per volume for berms. The material must be transported, compacted, etc. Sometimes there is a demand to deposit excavation material and the charges to dump that location allow the entry of a negative cost.
- **Surface area**: Defines planting costs for the berm.
- **Base**: Start up costs and foundation costs.
- **Height < 1 m**: Cost of the wall if the wall height is less than 1 meter.
- **Height 1-3 m**: Cost of the wall if the wall height is between 1 and 3 meters.
- **Height 3-5 m**: Cost of the wall if the wall height is between 3 and 5 meters.
- **Height > 5 m**: Cost of the wall if the wall is higher than 5 meters.

**Storing the Wall**

After the optimization of the wall or berm has been finished, it can be stored in the Geo-Database for further calculations and for the display in the Graphics.
**Dialog box for storing the designed wall in the Geo-Database**

Enter a new Situation or select an existing one with [ ] . The wall can be stored in a new Geo-File or in an existing one but it is suitable not to overwrite the original wall base line.

**Model restrictions of Wall Design**

Wall Design is set up to iterate the height of a noise protection wall. Every model has certain restrictions, and Wall Design is no exception. There are 3 restrictions in Wall Design:

- If a search ray finds more than one wall section to be optimized, only the wall element closest to the receiver is iterated, and the second intersection of the wall will be set to a height of zero.

- Wall Design calculates only the screening effect and the influence on the ground effect. It does not calculate the influence of the reflection on the other side of the road. If this is important, calculate and optimize the wall for the side where the screening is important and then transfer the coordinates to another wall object type on the other side.

- The optimization is exact for vertical walls. A post calculation will deviate from the Wall Design results only if there were multiple intersections between the search ray and the screen. (This may happen when reflections are on the other side of the road.)

- The optimization is not exact for berms. During the calculation, SoundPLAN intersects a wall element. Inside the calculation, the wall element increases in height. For a vertical wall, the coordinates of the top remain the same. For berms, the top moves away from the road. Eventually the cut of slanting intersections will get out of scope from the element originally intersected. If all wall elements have the same height, the reduction will be accounted for the wrong element, which leads to a systematic error.
After optimizing a berm, it is mandatory to check the results with an extra calculation run!

Intersections of search ray with moved top of the barrier

Optimizing problem with berms

In the picture, the first 5 iterations of the berms generate an intersection within the element credited for the final reductions. The next 8 iterative steps extrapolate where the wrong element is credited. The last iterations move the screen beyond the position of the building and no extra screening is found. In normal cases, the barrier is not as flat as in the example, but optimizing the barrier over the building does not make sense either. The problem of crediting the wrong element with a reduction is still serious and needs to be observed.
11 Graphics

Overview

The geometry data and calculation results are compiled with the graphics elements north arrow, scale bar, legends, scale and text boxes to create a complete, professional looking graphics plot. The plot can be printed to scale on any Windows compatible printer or plotter. All plot elements are stored in the „sheet“ and are accessible any time for modification or use in other plots. The screen view is an exact copy of the final print.

SoundPLAN graphics enables you to generate „templates“ and store them. After you have made your personalized standard layout for all sizes and applications, the templates can be used for any new project to generate plots efficiently and quickly.

A „sheet“ is a complete graphics which is stored in the actual project with the lists of files used in the graphics.

A „template“ is a complete graphics without the list of data files. The templates are stored under the path „GLOBDATA“ under the SoundPLAN 6 installation.

The following sketch shows the interdependence of the elements and from where the elements come.
SoundPLAN supplies a global color palette which is copied into each sheet. Modifications carried out in the local (sheet dependent) copy do not influence the global palette.

SoundPLAN supplies predefined object definitions for each object type. A copy of the global object definitions is transferred to the project. Each plan has a copy of the objects included in it. Modifying the object definitions in one instance only modifies the particular copy and does not modify other copies.

The geometry files opened for the plan set the object types used in the plan and therefore influence the legend and scale.

The selection of the geometry viewport defines the north arrow, scale and scale bar.

Situations and selected calculation results are assigned to the plan with the file selection and are written into the file list stored with the plan.

This sketch will help you to become familiar with the expressions used to define the properties of the graphics elements:
As you can see, the graphics on screen consists out of several elements. These elements have properties, such as edge lines, frames, sizes. A sheet has only properties but no content definitions. The properties are the same for all elements except the map, because the frame definition of the map has more parameters.

The content depends on the element itself.

**General Editing Functions**

This section is very important because later chapters use the functions described below, but do not explain them again.

The SoundPLAN graphics concept should assist you in efficiently editing your project data. As you will have developed your own company graphics standards and layout ideas, SoundPLAN helps you generate these ideas as templates and stores them. The templates are filled with specific data. Perhaps you always want A 0 plans to have the legend and north arrow at the bottom right so the plan description is visible even when the map is folded. Maybe you want to print the coordinate cross in the plan frame and the folding tics (not yet implemented) on the frame. Other choices for an A 3 plan for a consultation document would be a 2 cm wide border for holes for insertion in the document. Other standards might involve a standard company scale to which noise levels would be mapped.

You set these basic parameters one time, and SoundPLAN offers procedures to generate the templates as a template for use in future graphics.

It is wise to generate templates for different sheet sizes and requirements and store them globally. The best way to accomplish this is to develop a plot and store it as a
template. The data files are then extracted from the plot and the template is stored with the SoundPLAN global data. For future plots, you can load the template again and fill it with new data, set your viewport new and customize legends and text boxes.

**Tip:** If you want to group legends, scale, north arrow and a text box into a single block, leave extra space for the north arrow and the legend. If the view angle is changed, the north arrow may consume more space and legends may be amended by new object types depending on the data loaded into the plot.

**Color Pallet**

SoundPLAN supplies a global color pallet which you can extend and customize. The pallet contains 240 colors organized in 15 x 16 color cells. The colors are defined as RGB values.

\[
\text{RGB} = \text{Red-Green-Blue} - \text{components as values ranging from 0 to 255.}
\]

The global pallet, COLORS.SGC, located in the GLOBDATA folder, is loaded at start time of the graphics. As the pallet is also stored in the sheet, the local pallet is loaded when opening an existing sheet. When you open the color selector from the parameter menu, you also open the pallet stored with the sheet.

![Color Pallet Image]

The color pallet

To modify the global color pallet, go to OPTIONS -> PRESETTINGS and open the global color pallet in the branch "global -> graphics".

"Print" sends the color pallet to the printer or plotter. Depending on the devices and the windows drivers, the printed colors may deviate from the screen colors. In order to print plots with your desired colors, print the pallet, and if needed, customize the colors delivered with SoundPLAN.

**Hint:** Some printers allow you to calibrate the colors as they should appear on the print, to the colors on screen. Please read the chapter in your printer handbook.

**Defining New Colors**

To define a new color or modify an existing one, click on the color field to be customized and open it for editing with the arrow to the right. The color and the corresponding RGB values are shown in the middle of the edit box. To customize the color, press the small arrows to gradually change the red-, green-, and blue components. If you know the RGB value, simply enter the numerical value. Color
changes are shown on screen immediately. However, colors may be different on the plotter.

When the desired color appears in the color box, press the left arrow to return it to the color definition pallet.

**Defining a color pallet with interpolated colors**

Use the pocket calculator to define a color pallet with interpolated colors, example interpolated colors between white and dark blue. Click on the color field white and then →. Place the cursor to the first field of a completely black row and click ←. Select a color field with a dark blue and click → again. Place the cursor on the last field of this row and click ←. Now click on the pocket calculator: The RGB values of the colors are interpolated between white and dark blue.

**Base Settings**

Access the default settings for the drawing sheet, boxes, scales and printer via the **base settings** in the „Parameter“ menu. The **base settings** definitions are stored globally, so they will be applied for all projects.

**Base Settings for Sheets**

In order to create a standard layout for use in your office, all sheets should have a basic, uniform layout. SoundPLAN stores sheets without the content as global templates which can be applied to new sheets when needed. When using a template, you only need to fill the map with contents via the file selection menu and customize legends and scales. Select a name for the template and specify if it should become the standard.

Alternatively, you can select a sheet according to size in the „A“ row of sizes or a user selected format. When „insert map“ is set, an empty map of maximum size is generated.
**Base Settings for Boxes**

Click on the color field and select a color from the palette to define the default background fill color for the boxes.

Box frames have a default setting with a 0.2 mm line. Modify the default setting here.

Boxes can be drawn with shadows. If you always want this feature, enable the display checkbox and select the box color and width at the bottom right side.

Customize the default settings to the most often selected settings. You can always modify individual maps in the box settings of each map later on.

**Base Settings for Scales**

The scale uses a color string of 16 colors from the palette. Define which color shall be used for the first Scale element. See section "Edit the colored scale" on page 295.
For noise calculations, intervals are generally organized with ascending values. If the default setting for the scale should not be ascending; deactivate this field.

**Options**

![Options window]

*Options of plan processing*

For visual editing of plans and boxes with the mouse, define if shadows, box frames, box frame lines and plan frames should be zoomed with the element when increasing / decreasing the size of an element. The text is zoomed automatically.

For lines and box lines you can define a minimum width in order to keep the lines on the plotter when decreasing the size of an element.

**Object Types File**

The object setup defines how data is drawn on screen and on the plotter, and sets the format of the legend text. Objects can be feed data or graphics generated data. The object setup also controls the appearance of grids, contour lines and facade noise maps.

A global copy of the object setup is located in the SoundPLAN GLOBDATA path. As soon as you start a new project, a local copy of the global object types is copied to the project, and another copy is stored with each plan you create. You can edit the global object types in the settings in the SoundPLAN Manager, see Global and Project Settings.

This enables you to modify the default settings that will be used for new projects in the future. When generating a new plan, the object types for all objects contained in the plan will be copied into the plan. Modifications restricted to a single plan can be made in the object setup of the plan.

Some object types require certain SoundPLAN modules. They can be omitted if the specific module is not present or they can have a different appearance. For example, the object setup will not contain the objects of point, line and area sources if your license does not include the Industry Noise module.

The project dependent object setup is available with the menu „object types“ in the parameter menu. To edit the plans object setup, select the object setup from the pop
up menu which appears when the right mouse button is pressed when the plan is activated.

The object types are structured hierarchically in a tree view at the left of the screen.

An object type might be further structured. The Graphics considered different parts of one object, such as the emission line and the road band of a road or the berm top and the slope of a noise berm as independent object types. Now all these parts are sub-object of the appropriate object type.

The structure of the object types corresponds to the structure in the Geo-Database, so it will be much easier to find an object type.

Layout and 3D-layout are now part of the tab index cards Cartography and and 3D-graphics or are included in the base settings, as for buildings.

The menu SETTINGS includes parameters for the site map, the cross section and the 3D-graphics (previously only accessible in PROCESS PLAN CONTENT). Not all the settings can be defined here (e.g. the animation track for the 3D-graphics).

**Output sequence**

Following is a description of one evident advantage of the new concept, using the object type road as an example:

Up to version 5.6 SoundPLAN divided a road into the objects road band, emission line, bridge and bridge screen when the geometry was loaded. All these object types were independent, and were painted according to the normal output sequence. According to the defined output sequence SoundPLAN first painted all road bands, then all bridges and bridge screens and then all emission lines. If roads crossed, SoundPLAN drew the emission line of the bottom road over the bridge. In SoundPLAN 6, each road is drawn with all its sub-objects, so only the loading sequence is relevant. The input sequence of the data in a Situation or the order of the Geo-Files determines the output sequence in the Graphics.
**Layout Settings**

The object type layout is shown on the right side. Depending on the modules included in your license, you see the tab index cards Base settings - Cartography - 3D-Graphics.

The base settings are equivalent to the settings in the object table in 5.6. The tab index card cartography is equivalent to the layout settings that have been located under the symbol button "Layout".

Use the tab index card 3D-Graphics to select if the object should be displayed in the 3D-Graphics. Objects without elevation (e.g. general lines) can be omitted from the output in the 3D-Graphics, but shown in the site map.

**Reference Scale**

The objects in the object file are drawn to a world coordinate scale. The reference scale establishes the base for converting sheet coordinates to world coordinates. If the reference scale equals the plan scale, objects are printed the size assigned in the object setup. If the scales deviate, the objects size increases or decreases according to the ratio of factors. If the reference scale is smaller than the plan scale, the objects size is smaller. If the reference scale is larger, the objects size is larger.

**Area Fill and Hatch Patterns**

Users without the Cartography module open the fill pattern selection from the layout field. Select the desired fill pattern and click OK.

For mitigation (buildings and foliage) and usage areas, select from 14 hatch patterns, flood fill or unfilled. A specialized fill selection is offered for buildings.

In the Geo-Database you can select from 18 predefined and 7 user definable usage areas. Customize the fills in the object types of the Graphics.

**Result Object Types**

The result object types also are hierarchically structured. Let us look at the object type grid noise map to explain the subdivision in main and part object types. The part objects are "main interval", "middle interval" and "additional interval".

Use the main object type to define the display grids or noise contours. If you select noise contours, specify if they should be displayed with or without Bezier. This setting is part of the main object type, because it does not make sense to display the main interval without Bezier and the additional intervals with Bezier. However, the appearance of each of the interval lines, e.g. line width or line type is defined with the respective interval line type.

**Grid Maps**

For Grid Maps and Cross Section Maps the following layout settings are available:
Grid / contour line settings

If you want to display the grid instead of the contour lines, deactivate the check box SHOW in the contour line section and activate the check box SHOW in the grid section. For the grid output, there is an option to use an additional control to interpolate the grid colors in the color scale. The result is noise maps with continuous color variations.

For check reasons it is sometimes useful to view the values of the grid. You can either go to EDIT CONTENTS of the plan and open EDIT -> DATA -> RRLKXXXX.GM -> EDIT GRID VALUES to check (and modify) single grid values or activate the check box VALUE AS TEXT in the map object types. Define font and point size of the text and the number of decimals.

Values of the Grid Points as text
Because the calculation area is not a contour line you can define the drawing, color and line width of the **edge line** independently.

**Filter value** defines the band width where extra intermediate points are removed in order to smooth the contour line. The filter band width is defined as a ratio between grid spacing and filter value. As the filter band width is defined as a fraction of the grid spacing, a grid space becomes the upper boundary. Set the filter value in the box. SoundPLAN calculates the filter band width.

---

**Band width and result of filtering**

The **Bezier type** defines the interpolation of the contour line between the grid points. Choose how the contour lines are calculated, and how they are including the exact points in the line. Lines can be drawn with straight lines or with a Bezier interpolation. For Bezier lines, the lines can be smoothed further by not forcing the line to be routed exactly through the interpolated base points.
Description of Bezier line

To attain the contour line from the calculation grid, SoundPLAN first calculates base points between adjacent grid points. The „straight line“ contour line simply connects the base points with straight lines. The „exact Bezier“ calculates a smooth line through the base points. For strong changes in direction, this contour line would contain bigger errors than the smooth contour lines that are not forced through the base points.

Settings for main interval, middle interval and additional intervals

The three types of intervals enable you to set the colored scale intervals to the divisions defined in the scale and to create middle lines and a user defined number of additional lines for each interval. Main interval, middle interval and additional intervals can be defined separately.

When Fill contour areas is activated, the areas between the contour lines are filled with the color determined for this interval in the scale. „Line layout“ defines if the contour line is plotted and with which color and line width. Users with Cartography can define the line type (solid, dashed, dotted ...) in the tab index card Cartography.
Facade Noise Map

There are various options for presenting receivers in a Facade Noise Map. The default setting is for the receivers to be plotted as a hexagon filled to a color scale. Receivers exceeding the noise limits are plotted with a black frame around the hexagon.

The results can also be shown as **texts** in the symbol. Select the text you want to display from the selection list.

The interval number shows a number in roman figures, that can be shown in the scale, too.

The RLS 90 has specified rounding definitions. In order to make documentation and graphics comparable, the results of a facade noise map can be rounded according to RLS 90.

If the check box **USE SCALE COLOR** is checked, colors are mapped according to the colored scale. Set **FILL BUILDINGS WITH SCALE COLOR** if you want to fill the buildings with the highest level at the building.

If you want to write the noise levels on the map, mark the box „show value as text.“ If you do this, it may be advisable to mark the receiver with a uniform color, which is triggered with the settings for the facade points.
Define the appearance of facade points, conflict facade points, free field points and conflict free field points in the appropriate branch. In the default setting a black frame is placed around all receivers exceeding the noise limits. Set the line width to 0 if you don't want it.

Conflict point with a black frame, facade points without conflict without frame and buildings filled with the highest level at the building

Font, size and number of decimal digits can be adjusted to your requirements.

**Cartography - Creating user defined object types**

SoundPLAN 5.x could only create the object types "point", "line", "area" and "text", now you can **DUPLICATED** every geometry object. Click on the desired object type in the tree view (e.g. road) and select duplicate object type. This creates another road with all part objects.

All part objects can be adapted to your needs, so you can display different road types differently. This was not possible in previous versions because SoundPLAN assigned the standard object types to the data and ignored graphics object types assigned in the Geo-Database.
Settings in the object types

Settings for Site Maps

The width of lines and size of texts are zoomed with the plan. Define a minimum line width and a minimum text in the object setup box.

For plotting texts you define if texts are truncated at the border of the plot or if texts that would not be completely visible should be excluded from the drawing. Texts can be printed on top of the drawing or in the area below. Texts can be free of any elements (total clipping) or free from only the fill patterns (clipping only lines and patterns). Caution: When text clipping is enabled, the output on screen is considerably slower. Therefore this should be enabled only for plotting on paper.

Settings for Cross Sections

The relief height is the vertical height of the ground. Normally the relief height is calculated automatically out of the geometric data. But depending on the topography and the grid space, it might be possible that the first row of grid points is lower than the ground. In this case please adjust the relief height.

If your cross section calculation comprises point objects the maximum point distance from the cross section defines in what distance in[m] from the cross sections these point objects shall be displayed.

The scale factor height changes the scale factor for the elevations.
**Settings for 3D**

![Settings for 3D](image)

**Settings for cross section**

**Zoom Plan**

SoundPLAN graphics allow free and almost limitless zooms, and includes the possibility to zoom an element to the maximum size within the screen. The graphics viewport itself is set within the editing of the plan.

The magnifying glass is used to mark an area to be zoomed. Click on the symbol and move the cursor to the left top position of your desired window and pull to the bottom right position with the left mouse button depressed. The selected window is magnified when releasing the mouse button.

To revert to the total view, click the symbol „total sheet.“

This symbol enlarges an element to fill the screen. Click on the symbol, move the cursor to the element to be enlarged and click on that element with the left mouse button.

**Working with Elements**

SoundPLAN graphics are built in a modular way. The elements are sheet and plan north arrow, legend, scale, scale bar and text boxes. Each element has specific properties. The plan is a special element containing „hooks“ for the situations and result data files, the model geometry, grid maps, etc.. Object type administration,
north arrow and scale bar are anchored directly in the „plan“. A sheet only has properties but no contents.

**Parent - Child Relationship of elements**

Elements can be included within each other. If an element is created within another element, both elements have a parent-child relationship. When the parent element is moved, the child (and children of the child...) is moved with the parent. Child elements can only be moved within the parent element.

If elements are aligned at the parent element they can not be moved at all. Please read section "Aligning elements" on page 278.

Only the active element can be moved in the graphics (shown with the typical windows eight dots on the frame). If the plan is active, the plan content and properties can be edited. If a text box is open, its content and properties can be edited.

**Activate Elements**

When an element is active, the cursor changes shape to a cross ✉, symbolizing that the element can be moved. Then only the parent element or an element in the same hierarchical position can be activated automatically. If you want to activate a child element you must first reset the cursor to an arrow. To do so, click on the arrow at the upper right screen border. Via **keyboard** elements can be activated by using the **space bar** and thereby activating one element after another.

**Process Elements**

To process element properties or content, click on the element with the left mouse button or press the space bar. Press the right mouse button or <Return> (process content) or <Ctrl-Return> (process properties) to access the processing functions.

The boxes containing the controls for editing content or properties need to be closed after editing.

When grid and contour maps are loaded, or hatch patterns are used in the geometry, redrawing can take a lot of time.

![Refresh all](image)

In order to limit the time, SoundPLAN graphics offer a control to select when the screen should be updated (redraw completely, redraw geometry and patterns, redraw only the simple geometry or redraw nothing). If you choose "no refresh" the background of the plan remains empty until you press the symbol "Refresh" to redraw the whole plan or until you change the setting in the control bar to "Refresh all".

The icon „refresh“ always redraws the complete screen regardless what the redraw selection control indicates.

**Delete Elements**

To delete an element, click on the element to activate it and press the key <Del>.  

SoundPLAN Handbook  Working with Elements
Create Elements

SoundPLAN automatically creates legends and scales from the file selections menu. To generate new elements (i.e. text boxes), click on the symbol button or request the topic from the sub menu „create“ in the „element“ menu.

Create North Arrow

Clicking the mouse on the appropriate symbol button causes the cursor to change to a north arrow. Click on the symbol and then click twice on the plan where you want the north arrow to be located.

Create a Scale Bar

Click on the appropriate symbol button and the cursor changes into a mini scale bar. Move the cursor to the desired location and click left again.

Enlarge, Shrink and Move Elements

When an element is activated all 4 corners and the middle of each side is marked with a small square. Moving any of these squares changes the box size. Placing the cursor inside the element and dragging it moves the box to a new location.

Moving

When an element is the cursor changes to a four sided white arrow. Press the left mouse button and drag the element to the new position.
Hint: Click on the element twice. The first click activates the element. When you press again you can move the element.

Zoom up and down

When you move the cursor to one of the four corners of the element, the cursor changes to a double arrow. Now you can zoom the element up or down. With the left mouse button pressed you can zoom the element and its content up and down proportionately. If you press the <Ctrl> key along with the mouse button, the element is zoomed proportionately but not the content. To change the element without keeping the proportions, press the shift key while moving the mouse.

Left mouse button content will be zoomed proportionately

<Ctrl> + left mouse button zooms the box but not the content

<shift> + left mouse button resizes height and width but leaves content

Element Properties

Sheet and plan are special elements whose properties are controlled individually.

"Sheet properties" on page 280

"Plan properties" on page 285

The properties of some of the other elements (text boxes, scales, legend and scale bar) are identical and are therefore not explained separately. As all elements are boxes with controlled contents, the properties in general are named „box properties.“ The properties definition is divided into 3 index cards: box layout; box name, position and size; and box frame definitions.

Layout

![Box properties - layout](image_url)
The layout defines the box background color, the line properties and the shadow. The background color can be inherited from the parent box. This feature is very useful when multiple children are placed in the parent box. The box background color can be marked as translucent or assigned directly to the box. Click on the field "fill color" and select a new color. As soon as you leave the properties dialog the new colors will be incorporated in your drawing.

The border lines can be defined in width and color and the lines can be suppressed and reactivated. Line width is in [mm].

Boxes can have shadows on the bottom and right side. If you want shadows, click on the selection box and set the color and shadow depth.

The default settings you defined in the base settings of the box "Base Settings for Boxes" on page 264 are preset automatically.

**Name, Size and Position**

![Box properties - name, position and size](image)

Each element can be assigned a *name*. The name of a new element consists of the element type and element number. The element number automatically increases if the same type of element already exists.

**Aligning elements**

An element can be aligned with the parent element. For example, if a text box should be positioned as the title at the top of the parent box, in this case the plan, only the height of the text box can be controlled by adjusting the lower frame line. All other dimensions are inherited from the parent. The text box cannot be moved anymore. If the width of the entire plan would be changed, the width of the child box would automatically adjust. The possibility of aligning children to parents is especially interesting for hierarchically stacked children.
The following possibilities for alignment are available:

Box alignment to the parent

The child element can also completely fill the parent element, in which case the parent box will no longer be visible and can only be used to move the child.

It may be worthwhile to again state some information about activating boxes.

When a parent element is activated, the child box cannot be activated directly. The child can only be moved with the parent. If you want to move the child within the parent while the parent is active, click on the arrow in the frame to reset the cursor and then activate the child or press ESC or the space bar until the child becomes the active element.

The sequence of alignment operations is important when aligning. The first child is aligned to the total width of the box, the next child is aligned to the parent plus the first sibling and so on. Doing this ensures boxes do not overlap.

The box position is described as the top left corner in relation to the parent box in [mm], and the size of the box in [mm]. Aside from being informative, this enables you to adjust the box to the millimeter.

Entering Elements In a Parent Box

„Cut“ and „copy“ allow you to insert existing boxes into a parent box at any time. The inserted boxes are moved, enlarged and shrunk with the parent.

Activate the box and click on the scissors symbol. Activate the box where the cut box is to be inserted and click on „insert.“
Frame

Frame properties defines the frame. Each individual side or all sides can be set. The magnitude of increase for changing the frame can also be set. All sizes are in [mm].

Caution: When increasing the frame size but not the box size, the text may no longer fit the box and may be clipped.

The Sheet

When SoundPLAN graphics is opened or when a new sheet in the graphics is created, a blank sheet and plan is presented. The sheet is the canvas for your plan. The sheet sizes are taken from the BASE SETTINGS of the PARAMETER menu. You can only modify the properties contained in the layout and in the sizes.

Sheet Properties

In order to process the sheet properties it is important to deactivate all elements which might act as children elements for the sheet. To do this, press <ESC> or click on the arrow at the right side of the top frame. As soon as no other element is active, the sheet is active. Clicking the right mouse button opens the sheet properties for editing. An alternative method, if the plan completely fills the sheet, is to select "Properties" from the "Element" menu.
### Layout

[Image of the Layout window]

**Sheet properties - layout**

Layout defines the frame lines, the sheet background color, and if the sheet should have folding ticks on the frame when plotted (not yet implemented).

All lines can be customized together or separately. They can be assigned a color and thickness and their drawing can be toggled.

### Name and Size

[Image of the Name and Size window]

**Sheet properties - name and size**

Each element (therefore sheets) can be given a name. The sheet name is the description for storing the sheet.
Width and height in [mm] defines the size. You can assign your own values or select from the A type format sequence (A0 = 1 square meter; each higher A number folds the sheet in half). There is also a portrait and landscape orientation selection.

In **PARAMETER -> BASE SETTINGS** (see "Base Settings" on page 263 ) a sheet size can be selected which will be used for creating the new sheet.

---

**The Plan**

Not only the properties and the content of a plan are relevant for creating a plan. You also need the file selection and the layout of the object types. A plan may contain geometry data and / or calculation results, moreover further elements such as scale, legend, text boxes etc..

First the plan will be filled with data via the file selection manager. Then questions concerning legend and specific settings for the results data have to be answered. After that you will see the plan on the screen. Define the geometric viewport in the "process plan content" menu first, afterwards you may individually adjust the display of the object types and the results data in the object setup of the plan (press the right mouse button when the plan is active and choose "object types" from the popup menu.) The next step would be to create text boxes for the plan heading, scale bar, north arrow etc.. Afterwards the boxes have to be positioned on the plan perhaps by grouping them in a parent box. If the plan on the screen meets your requirements, you can print the sheet. Now the creation steps will be explained in detail.

**File Selection Manager**

Each new sheet is empty and needs to be completed. The file selection allows you to select the plan content from the basic geometry prepared in the Geo-Database and the calculation results from the calculation core.

Press the right mouse button when the plan is active and select the topic **file selection manager** from the popup menu.
The file selection compiles the files from which the plan will be made. Select a single or multiple situation to represent the geometry. In the left box, click on a situation and then click on the arrow in the middle, between the editing fields to activate the situation in the plan. SoundPLAN generates a new legend from the object types found in the situations. If you later amend the list of objects, SoundPLAN will ask whether or not you would like to extend the legend.

The field „recalculate format“ will also be activated. You can decide to keep the old viewport or calculate a new one from the data contained in the amended situation. This box is inactive by default. When loading a template and filling it with data it is absolutely necessary to recalculate the format, because otherwise you would not see the data on the screen.

After selecting the geometry, select the calculation results by activating an entry in the list and then including it in the drawing using the arrow at the right. Difference Maps for Grid Maps, City Noise Maps and Facade Noise Maps are selected via grid operations, triangle operations or facade map operations, see section File Operations on page 286.

Press OK to return to the graphical on screen editing.

Selection of Parameters for the Grid Noise Map

Grid noise maps are calculated for more than one time slot, so you must define which time slot and which scale you want to use for your drawing. The number of time slots may depend on the calculation and assessment standard used in the calculation.

Special controls for grid noise maps

You may select an existing scale, edit the scale right now pressing the double arrow or use the automatically created scale and customize it afterwards using the edit
scale command. Editing the scales is described in the section "The Colored Scale" on page 294. Press OK to return to the graphics screen.

**Selecting Parameters for Facade Noise Maps**

Select Facade Noise Map

Select the assessment time (day, night..) and which floor the receivers shall be drawn. You can plot a specific floor, a loudest noise level on a facade or the highest receiver of the building. Then select the assessment, the default setting is the assessment selected in the run properties.

If you want to put more emphasis on the conflicts (receivers exceeding the limits), two options are possible. You can opt to show only receivers that produce a conflict or you can choose different symbols to mark conflicts. The magnitude of excess can be controlled in the box „show conflict from.” The value 0.0 causes all receivers exceeding the limit to be mapped as a conflict. The value 3.0 causes all receivers exceeding 3.0 dB to be marked.

With the module Cartography, you can mark facades where the limit is exceeded (default setting is a read line). Select, whether you want to load the information for the selected time slice or for all time slices.

You may select an existing scale, edit the scale right now clicking the double arrow or use the automatically created scale and customize it afterwards using the edit scale command. Editing the scales is described in the section "The Colored Scale" on page 294. Press OK to return to the graphics screen.
**Select Grid Cross Section Maps**

Choose the file in the file selection manager and add the appropriate situation. The Cross Section Map will be displayed on the screen.

![Cross Sectional Map on the screen](image)

The numbers on the y-scale show the height in meters and the numbers on the x-scale show the length of the map, the beginning of the cross section is always 0.

You can change the settings for the height scale factor, the height of the relief and the maximum distance of point objects included in the cross section in the "Edit Map" menu.

**Level charts**

To display the level chart in the Graphics, make sure that the level charts are stored during the calculation (set the check box level charts in the calculation core).

![Level chart in the graphics](image)
File Operations

File operations contains numerous possibilities for combining maps such as difference maps, addition of noise maps linear or logarithmically or addition of a constant to the map.

Select GRID OPERATIONS, FACADE NOISE MAP OPERATIONS or TRIANGLE OPERATIONS form the FILE SELECTION MANAGER and press the double arrow to select the operations.

Entry box for grid file operations

For some calculation result types the graphics offers file operations to do arithmetic between result files. The file operations are offered for 3 different file types that you can find as file types in the file selection manager as well:

- Facade Noise Map operations
- Triangulated map-operations (City Noise Map, Measurement point lists)
- Grid Map operations

For FACADE, TRIANGLE AND GRID-MAPS the following selection of operations is available:

- add
- subtract (difference maps)
- add levels of a map
- subtract levels of maps
- select the smallest value in the map
- select the highest value in the map
In addition you can add constants to the map either as a regular constant or energetically as the background noise level.

For **GRID AIR POLLUTION MAPS** select from the following operations:

- add
- subtract (difference maps)
- add with a nomogram
- subtract with a nomogram

In addition you can add a constant directly or via a nomogram.

All file operations share the same operation principle: You first select the base file(s) and then the second operand and the operation or the constant to be added to the base file. Using more than one base or operand file is only possible for grid operations.

Internally SoundPLAN generates a formula from your selection, with the same format you find in the Spreadsheet. The formula is stored with the file selection and thus when you have recalcualted one or both of the noise maps and open the sheet in the Graphics, the file operation will automatically do the operations requested.

In spite of the shared procedures there are some special considerations worth noting for each of the 3 base file types.

**Grid Operations**

You can combine grid files of different grid resolutions.

In the base files the grid file with the highest resolution (smallest grid spacing) is selected and the total area of all maps is defined. The coarse grid map is then converted into a finer grid with the new grid points derived by linear interpolation. For grid points in the area covered by multiple grid maps you can select how the new grid values should be defined:

- use the value of the file loaded last in the list (this used to be the only option)
- generate the mean value between all available values
- use the highest value
- use the lowest value
- energetically add the values

The grid defined by the base file or base files now becomes the basis of the file operations, meaning that even if one of the operand files has a finer grid it will not change the grid any more. Secondly the operations are only carried out for grid points present in the base map. If the second operand has additional grid points, they will be ignored.

The results of the grid operations can be stored as a new grid map. The file names are RROPxxxx.GM, where xxxx is a four digit number that has to be different from the numbers of the calculated maps. The number of time slices and the names of the slots are defined by the first file in the list of base files.
When you want to store the new file derived from the file operations, you need to select an file number. The box managing the storage operations shows the numbers already in use on the right hand side. The first number available for the new file is the default selection and can be replaced with any free number. Afterwards customize the file description and select the time slice for the resulting grid values.

If you want to store additional time slices in the same new grid map the file operations must be generated separately for each time slice. Now select the existing file. Select if the file shall be rewritten or the result of the new grid operation shall be pasted in another time slice of the existing file. Select the time slice where the results shall be stored.

The file description cannot be altered here any more. The grid size has to be the same for all time slices.
Grid operations with City Noise Maps and measurement data files

City Noise Maps and measurement data files can be used as the second operand in the grid operations. For the individual grid points in the grid file the values are interpolated on the basis of the triangulation of City Noise Maps or measurement maps.

To represent the City Noise Map sensibly in the grid map it is paramount to select a relative fine grid spacing. Therefore the program offers the possibility to select a finer grid spacing than the base file would offer.

Facade Noise Map Operations

The receivers in both files should be identical, otherwise it takes long to execute the operation. The facade points should be calculated for the same buildings with the same calculation settings for spacing etc..

You can select the time slice for the base file and the operand so that it is possible to manipulate results calculated for different transmission and assessment regulations.

After leaving the file selection menu select the floor to be presented in the map. SoundPLAN carries out the operation for all floors but only displays a single one of them. When you select the operation „subtract“ and select the display to be the „highest value“, not the highest values of a point in the two files will be subtracted but the values of the respective floors. The highest value of a point after the operation is displayed.

Triangle Map Operations

Triangle operations can be carried out either with City Noise Maps or with measurement data files. If the City Noise Map is the base file the second operand may be another City Noise Map or a measurement file to determine the background noise level for the City Noise Map. If the base file is a measurement file, the second file can only be of the type measurement file.

If a City Noise Map is the base file, the calculation area in the base file will determine the area of validity of the resulting map. This means that the calculation areas do not have to be identical, but the base area cannot be extended. As the calculation area is not reduced, difference maps only make sense if the calculation area for both calculations were the same (this is the same as for Grid Noise Maps).

As measurement data files do not contain a calculation area, you need to define if the operation shall be carried out for the entire area inside the hull around the measurement points or only for the area shared by both files.

The structure of base and operand files should be identical meaning that for City Noise Maps the same time slice definitions and for the measurement file the same column definition should be shared by both operands. The operation is carried out for all columns if the column type is value or level column, and at the same position in both files. SoundPLAN only checks if the columns are compatible, it does not check if the results make sense.
**Processing of files with differing receiver locations**

If base file and second operand are of the same file type, meaning they are either City Noise Maps or measurement value files, SoundPLAN will proceed using the following three steps:

- First the point list of both files is amended. The values for new receivers are interpolated.

- In the next step a copy of the base file is generated and then the operation is carried out for all value and level columns. If the column definition is not identical (for example column 7 is a value column in one operand but of a different type in the other operand) no operation is carried out and the value and type of the base file is copied into the result file.

- In the last Step SoundPLAN re-triangulates the new file for the City Noise Map by paying special attention to the calculation area, for the measurement file calculating a new hull.

If the base file is a City Noise Map and the second operand is a measurement receiver list, steps 1 and 3 are omitted. Instead of this the program will make linear interpolations in the list of triangle generated from the measurement receiver list to calculate the value from the measurement point list for each of the receivers in the City Noise Map.

In the next step select the column to be displayed. As the last step you have the option to store the new receiver list with the triangulation.

For City Noise Maps the new file name is RTOPxxxx.CNM, xxxx is the file number that in not yet used for a calculation run. For measurement value files the file name is RTOPxxxx.PLI, the triangle file belonging to this file has the extension TRX.

**Things to pay attention to in the City Noise Map**

When the receivers in both files are amended and derived by linear interpolation, the basic geometry is not considered. Roads, buildings and noise barriers influence the triangulation in the main calculation, the derived amended calculation may not reflect this fact and thus may allow receivers to triangulate across these elements.

For the results this has no relevance but for further processing the noise map it will have grave influence:

If you want to create a conflict map from a City Noise Map it may happen that triangles are intersecting with the boundaries of the usage area and cannot be accounted for correctly for the area.

**Plan Properties**

In addition to the above description, in the plan properties, index card "name, size and position you can mark if element boxes should be aligned with the inner frame of the plan. This selection is the default setting and wise, if you have chosen a double frame for the plan (see below "frame properties").

The frame properties of a plan differ from the frame properties of the other elements.
Frame Properties

The plan has a specialized frame properties menu:

Plan frame properties

The plan can be framed with a **double frame** which can contain the coordinate cross. The plan content is moved inward the size of the double frame. The default frame setting is 10 mm but you can set it to any size in the „width” field. The frame can remain white or be filled with color. If only the outer frame line is desired, set the width to zero.

**Inner frame lines** can be activated / deactivated separately. The inner frame line thickness is always twice as big as the outer line. To change colors, open the pallet and select new colors.

SoundPLAN predetermines the **distance of the coordinate grid** but this can be adjusted in „grid spacing.” The measurement is used for spacing the grid marks and the coordinate text in the double frame.

The **grid crosses** in the plan can be toggled. „Connect“ connects the grid crosses with fine lines. The crosses are ignored. The frame „width“ and „color“ customizes the frame.

**Hint:** When the frame crosses are enabled but are not visible on screen, the cause may be a too large grid spacing.

The **coordinate text** in the double frame can be activated / deactivated and the letter size and color can be selected.
Process Plan Content

Editing the plan consists of selecting viewport (the coordinate for the middle of the plan), rotation and scale factors. You can set these definitions with the mouse or with a numerical value.

SoundPLAN calculates the middle coordinates and the scale factor automatically. The program attempts to scale all data so the entire content is plotted with as little empty space as possible. Initially the plan is oriented with north pointing up on the plan. The plan scale is shown in the status line.

Geometry Parameter

Usually you want to plot the plan in a set scaling factor. Open the geometry parameters with the symbol or from „edit manually“ in the „Geometry Viewport“ menu and set the numerical values for scale and rotation. The coordinate around which the plan is rotated can be set. All settings can be used with other plots.

Changing the Viewport

Aside from the numerical settings, the viewport (visible part of the plan in world coordinates) can be attained graphically by moving and zooming the plot to the size desired. The easiest way to do this is to first establish an overview of the entire data. For a total view, press the overview symbol (see below). A black frame indicates the viewport which would be plotted.
The zoom functions are defined differently:

- The magnifying glass enlarges an area as usual.
- The sheet view button opens a complete view of your plans frame and its content.
- This draws the viewport of the visible part of the plan (the section which will be plotted).

To graphically change the viewport, press the symbol „change viewport“ or select „edit visually“ from the „Geometry Viewport“ menu and then make the frame the desired size. Pressing the button again activates the new coordinates as the plan measurements.

Now you can move the viewport, zoom up and down and rotate it. A keystroke combination is needed to use the functions. Each actions changes the cursor shape.

- To move, press the left mouse button.
- To zoom up and down, press shift and the left mouse button and move the mouse up and down.
- To rotate, press <Ctrl> and the left mouse button.
The controls for **move, zoom and rotate** can also be activated via the **right mouse button** or via the „Geometry Viewport“ menu. The functions are only active when the mode „process geometry viewport“ is active.

**Caution:** Press the symbol button „Change View“ again to close the changes and make them permanent.

**Show Child Boxes**

Within „Edit Plan Content“ you can display all child boxes for your plan (text boxes, legends, scales and scale bar). These functions enable you to accurately position the view of your plan. The child boxes themselves cannot be moved or processed at this level. To do this you must close „Edit Plan Content.“

**Cross Section Parameters**

A user defined geometric cross section can be displayed on the screen and plotted. Use the item „**cross section**“ and then „**new**“ from the **VIEW** menu. Draw the line of the cross section with the cursor.

When processing a Grid Cross Section Map it is not possible to enter a new cross section, but you can toggle between the depiction of the cross section and the site plan and change the settings for the cross section.

**The Colored Scale**

When you load results of a grid calculation in the graphics, SoundPLAN generates a new scale with an even interval spacing ranging from the minimum to the maximum value found in the grid. If you are using an existing form with a scale, the automatic is deactivated and the form’s scale is used. The scale is stored with the plan.
Edit the colored scale

To edit and enhance the scale you can define two section layouts for headlines and body text. To open the text layout, press the symbol „Section layout.“ (See "Section Layout" on page 239 for the description).

**Hint:** The numerical values in the scale are set as body text. The symbols for inserting or deleting text and data lines assist with customizing the scale. The headline can be modified and extra headlines can be generated. Text lines can be incorporated in the scale, too. This feature could be used for example for highlighting the interval from which the noise limit is exceeded.

When generating headlines, <Return> opens a new line and <Ctrl-Return> creates a new section. Only one section layout can be active within a single section.

The lines of data are configured as a table. The symbol is used to insert new data lines into the scale. The column width is modified in the table heading by pressing the left mouse button and pulling it in the appropriate direction.

"Adapt box to contents" sizes the box to fit exactly around the content. This may lead to changes in the position of child boxes attached to the sides. If resetting is too much a bother, don’t click „adapt box“ again which would make the changes permanent. If the content is bigger than the frame, the part outside the box will be clipped.

**Colored scale types**

For different display options in the Graphics you can select different colored scale types.
The Grid Noise Map is a good example: If you fill the contour lines with the scale color, the color represents an interval, e.g. between 55 and 60 dB(A). In case you deactivate the color fill and set the contour lines themselves to be colored according to the scale, the color represents an exact value.

The scale type defines on the one hand, whether the color refers to an interval (the first 8 scale types) or to an exact value.

On the other hand the scale type defines, whether the lower or upper value of an interval is represented by the color and the columns and order to be displayed. If you don't like the suggested order or text, you can activate the description and then change the text. If the description is activated, you cannot use the auto scaling and cannot insert or delete scale rows. Therefore it is advisable to activate the description not until the scale type and the needed intervals meet your requirements. If you need to change something in the scale, deactivate the DESCRIPTION COLUMN.

The description is no longer restricted to 40 characters. It can now be as long as you need and may consist of several lines. (Therefore Graphics sheets with version 6.1 colored scales can only be opened in older versions, if the sheet is stored as SoundPLAN 6.0 sheet).

It is possible to hide the lowest interval if you don't want to display values smaller e.g. 50 dB(A). Areas with values of the hidden interval are not colored. For Facade Noise Maps you can define in the object types, whether the facade points of this interval shall not be displayed or displayed in the color defined in the object types.
If you use the lowest interval, you can transform this "open" interval to a closed interval. This can be used for conflict maps, where you always got e.g. $<=3$ up to now. If you close the interval the display is $0 < \text{color} <= 3$.

Please observe, that the scale type is only the representation of the colored scale and has no influence on the output of the results. Only the switch "use lowest interval" has an effect on the result.

**Automatic Scaling**

Automatic scaling creates scales of up to 16 intervals.

Automatic scaling is used to define the number and magnitude of the intervals one color represents. "Ascending" sets the scale in ascending values with the first interval small and succeeding intervals increasing in value. "Descending" has descending values with the first interval representing the biggest value.

Define the scale units (the scale can represent other properties than dB) and the number of digits behind the decimal.

The SoundPLAN color palette is used for the color selection. Each line has 16 color boxes so you can install predefined color successions for the scales in each of the lines. One scale is predefined in SoundPLAN. In the "parameter" menu topic "colors" you can define your own scale color sequences.

To assist you with the color scale, SoundPLAN can set the colors to begin with a selected color ("from color"). When "set" is deactivated, your entries will not be overwritten and additional intervals will not be assigned a color. "Ascending" determines if the pallet colors will be used to the left or to the right of the selected position.

If less than 16 intervals are entered, SoundPLAN interpolates intermediate colors. For manual editing it makes sense to generate all 16 intervals. Edit the ones you need and then delete the extra intervals.

**Manual Scale Customization**

The easiest way to create your own scale is to generate an automatic scale and customize it.
The scale does not have to have constant interval sizes. You can set the left scale position and the right side will adjust automatically. In this way scales can show more than just noise levels. For example, you could use green colors for noise levels below the target level, yellow tones between the target value and the noise limit, and red and purple tones to point out the noise limit violations in dB steps. The scale can be set to 5 dB intervals for low noise levels and decrease the range for high values.

To modify individual scale colors, click on the color field and select a new color from the pallet.

**Interval Numbers and Und Description Columns**

The interval numbers of a facade noise map can be shown in the color field of the scale. Please enable the switch "numbering". The figures will be displayed in roman figures.

The switch “description column“ adds a text column to the table to enter further information on the scale (only Cartography).

**Colored Scale layout**

Use the Symbol SCALE LAYOUT for further settings:

- the row height, that cannot be smaller than the text height.
- the height (or thickness for contour lines) of the color square.
- the left and right distance to the column edge.
- the color and line width for the border of the color square, if desired.
The Legend

SoundPLAN generates the object legend from the information stored in the object setup.

Only object types and section headlines with the activation mark in column 3 will be used. The legend is generated automatically and consists of the enabled section headlines and object types. The legend sequence is the same as the object setup sequence.

The legend contains the object type symbol and the legend text. The symbol presentation depends on the settings in the object setup. If the color of the object is changed in the object setup, the color in the legend also changes.

Editing the Legend

The legend can have two section layouts for headline and body text. To open the layout, press „section layout“ and then customize the layout. (See „Section Layout“ on page 239 for the description).

Hint: Legend texts are printed as body texts.

Use the symbol buttons insert and delete text lines for modifying and inserting headlines and texts. When inserting headlines, <Return> causes a line feed and <Ctrl-Return> generates a new section. An individual layout can be assigned within each section.

As the data lines are tables, the column sizes can be adjusted.

„Adapt box to contents“ sizes the box to fit exactly around the content. This may lead to changes in the position of child boxes attached to the sides. If resetting is too much a bother, don’t click „adapt box“ again which would make the changes permanent. If the content is bigger than the frame, the part outside the box will be clipped.
Text Boxes

Text boxes should be used to host multi-line descriptions or to act as parent elements for other elements. See "Aligning elements" on page 278.

Editing Text Boxes

After creating and sizing the text box, press „edit content“ with the right mouse button or double click with the left mouse button to open the text editor to write and format your text. Use the symbols at the top to insert and delete lines. The line feed is not automated like in a word processor. You are responsible for line feeds, etc. <Return> inserts a line feed and <Ctrl-Return> requests a new section. Each section can contain its own section layout.

„Adapt box to contents“ sizes the box to fit exactly around the content. This may lead to changes in the position of child boxes attached to the sides. If resetting is too much a bother, don’t click „adapt box“ again which would make the changes permanent. If the content is bigger than the frame, the part outside the box will be clipped.

Section Layout

The section layout is used to define the title and body text layout. Changes in the font, letter type and size, line spacing and sections can also be reviewed.
Editing the North Arrow

The north arrow is automatically positioned in the visible part of the plot. Click on the arrow to move it to a new position or size it up and down.

The north arrow can be modified manually. Click on the right mouse button and select "north arrow properties" from the popup menu.

![North Arrow Properties](image)

You will see "Name", "Size" and "Position" as described in the section "Name, Size and Position" on page 278 of the element properties.

Color, line width and rotation of the north arrow can additionally be defined. The north arrow normally will be rotated automatically in dependence of the geometric viewport. The manual rotation is only necessary if the map you have used for digitizing has not been in the north direction.

The Scale Bar

The scale bar is automatically generated from the geometry view. You control the scale bar design and if the scale is only a numerical value or associated with a scale bar.

![Defining the scale bar](image)
The scale text font, size, type, and color and the scale bar can be set individually. If you do not like to have the text „1:“ for the scale value, please delete it. The distance between the scale text and bar and between the text on the bar and the bar itself can be set.

Define the scale bar units in [m] or [km] and the number of subdivisions and length. The first part is drawn in two colors if „half the first section“ is activated. For additional design, set the bar width, the subdivision colors and the frame line.

„Adapt box to contents“ sizes the box to fit exactly around the content. This may lead to changes in the position of child boxes attached to the sides. If resetting is too much a bother, don’t click „adapt box“ again which would make the changes permanent. If the content is bigger than the frame, the part outside the box will be clipped.

---

### Printing

To print your plot, SoundPLAN accesses Windows typical print routines.

The plot is device independent while editing your data. After activating „print“ in the file menu or pressing the print symbol select a printer or plotter. The default setting for the printer is the printer you have entered in "parameters -> presettings -> program -> branch system". Select a printer and set the desired controls.

SoundPLAN asks for the printers active drawing area. The printable area, especially for single sheet feeders, will be smaller than the paper size. If your plot exceeds the maximum printable area, SoundPLAN issues a message:

![Message if the plot exceeds the maximum size.](image)

There are several possibilities of action. The switch "Fit sheet in paper size" will adjust the sheet and map size to the displayed values. The scale will be preserved. If you want the scale to be adapted, too, click on the switch "Adapt scale". Press Execute to start the action. After that you have three options. Print the plot immediately, go back to the printer menu to change the paper size for example or cancel the printing process to look at the changes SoundPLAN has made.

The options "print", "back" and "cancel" can be chosen without executing "fit in paper size" or "adapt scale". Perhaps the plot is only a test plot and you don't mind if the frame of the map is not printed, then press "print". A reason for "back" could be that you have just forgotten to change the paper size of the printer.
Sheet Size Settings For HP DesignJet With Roll Medium

The HP DesignJet plotter driver has a flaw requiring some attention. If the paper size is set to an A0 roll and the plot is to be made to A4, the plotter still restricts the size to less than A4. To overcome this, define the plot as „oversized A4.“ This setting allows you to define the plot size exactly in [mm]. In case the oversize is not listed, activate „other sizes“ and change „oversize“ to „on."

Further Graphics Features with Cartography

There are several display methods available, which are not yet described in detail.

- The procedure is the same for all output types and already described:
- Select the output type you want to use from selection list in the FILE SELECTION MANAGER and load the data

Go to the object types and select the branch for the result object types.

Contour line texts

The texts can be edited in the EDIT CONTENTS of the map. Select DATA -> RRLKxxxx.GM -> EDIT CONTOUR TEXTS from the EDIT menu. The settings for the contour line texts are defined in the OBJECT TYPES -> GRID MAP -> INTERVAL settings.
Level tables

Tabular result representation in the Graphics

Tabular result definition in the object types
Geometry bitmaps

Bitmaps that have been used in the Geo-Database for digitizing (i.e. reference points have been defined) can be displayed in the Graphics, too.

![Geometry bitmaps in the Graphics]

Solutions when the printer doesn't print geometry bitmaps

- **PARAMETERS -> OPTIONS -> "bitmaps" tab index card: set the check mark USE MAP VIEWPORT AS CLIP REGION**

- **MAP OBJECT TYPES -> branch external data -> geometry bitmap: use "additive" not "transparent" (with transparent the bitmap is 4 times in the memory!)**

- **Try it with the ALTERNATIVE PRINT ROUTINE FOR BITMAPS (Parameters -> presetstings, branch program -> System)**

- **Depending on the printer driver (e.g. DesignJet) use the option "print preparation in the computer" - takes longer but could help if the printer has not enough memory.**

- **Use "print to file" and copy the print file to the printer with 'copy/b "filename.prn" "printer name"’ in the MS-DOS mode or write it to a batch file.**
Display text attributes

Text attributes that can be displayed in the Graphics are shown in the file selection manager. By double clicking on the text attribute or on the little arrow the texts will be generated and included in the plan. The following attributes can be displayed:

- Receiver number and -name
- Road and railway kilometer markings, if the road or railway was defined as reference axis in the Geo-Database.
- Wall height for noise protection walls is displayed at places where the wall height changes.
- Reference kilometer referencing the beginning, end and changes in height of a noise protection wall to the kilometer markings on the road or railway.
- Indoor receiver numbers and names
- Photo point number

The layout of the text attributes is controlled through the object setup under the tab Cartography. The preview picture shows how changes in parameters will affect the display of the attribute text.
When object types are duplicated in order to distinguish between an existing and a planned noise protection wall, the text attributes for these duplicated objects are also duplicates enabling the texts to be included in the planned wall but not in the existing wall. As there are two different text attributes they both need to be loaded with the data in the file selection menu.

The text attributes cannot be moved in the Graphics.

**Spreadsheet in Graphics**

The complete Spreadsheet or parts of it can be included in the Graphics in a Spreadsheet box.

<table>
<thead>
<tr>
<th>Obj No</th>
<th>Fld</th>
<th>Dir</th>
<th>Limit Day in dBA</th>
<th>Analysis Day in dBA</th>
<th>Prognosis Day</th>
<th>Time range</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>N</td>
<td>50</td>
<td>67</td>
<td>62</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>N</td>
<td>55</td>
<td>66</td>
<td>60</td>
<td>0</td>
</tr>
</tbody>
</table>

**New table box**  First pull open a spreadsheet box and then click on it to **EDIT THE CONTENT**. Here the "file open" dialogue will open up. With the file filter select the table type, select from the options "Level table", "Measurement table" or "Area table".
After this selection an additional dialogue opens up were the top part expects the file name and the click boxes for „Select“ and „Edit“ operations. You can select another spreadsheet, or edit the selected spreadsheet.

The middle part of the box defines if the entire table shall be included in the drawing or only part of it. You can use any Value as integer column as a filter. For level tables the object number (to for example only generate the table part representing a specific building) and the house ID are predefined value as integer columns. You can also use own value as integer columns (TABLE -> ADD COLUMNS -> VALUE AS INTEGER).

The filter column can be suppressed in the box even if it was active in the Spreadsheet, likewise a filter column can be temporarily activated even if it is suppressed in the Spreadsheet.

Lines selected with the filter function do not have to be adjacent lines in the Spreadsheet. If a Structure beginning line is preceding a displayed line, it too will show up in the Spreadsheet box of the drawing.

---

**Short description of the 3D-Graphics**

The 3D-Graphics is divided into two parts: 3D-Graphics model data check and 3D-Graphics animation. The 3D model data check displays all data as used for the calculation (no intersection with the ground). Further objects (trees, roofs, ...) and improved display is supported with 3D-Graphics animation. Moreover an existing road or railroad can be used to drive through the area to view the situation from the point of view of a pedestrian or car driver.

Any map can be displayed in 3D. Double click on the map (contents of the map) and choose 3D-MODEL from the VIEW menu.

**What is displayed in the 3D-Graphics?**

**Module 3D-Graphics model data check:**
the modal data, which are used in the calculation, i.e.

Road and railroad as well as the emissions lines and the intersection addition
Parking lots
Point, line and area sources
Buildings without roofs
Noise screens (walls and embankments)
Attenuation areas
Elevation lines
Spot heights
Receivers for all calculated floors

General points

**Hint:** Die model data are displayed as used in the calculation. i.e. buildings and attenuation areas are not used for the calculation of the DGM.

The **triangles** of the **Digital Ground Model** (DGM). The road edges are used for the calculation of the DGM and the triangles on the road surface are excluded.

**Grid Noise Maps:** In the 3D-Graphics the height of the grid values is taken out of the grid map (not laid on the ground). In the object type grid map you can choose, whether the calculated height over ground the ground height should be used. In case you chose ground height, there is the possibility of adjusting the display height of the grid map (e.g. if the roads are not displayed correctly).

**Facade Noise Maps:** The level values for each floor are displayed. In the register card 3D of the object type facade noise map settings for the creation of the facade points can be made. If a very small distance between the facade points is defined in the calculation, the facade points are shown as a level band at the facades.

**Additionally for the Module 3D-Animation:**

- **Trees:** 3 tree types are delivered. Conifer tree, deciduous tree and bush
- **3D point settings.** (The module model data check displays all data in the normal mode)
- **Extended display of walls** (thickness of the wall and the wall points as posts)
- **Roofs** (not yet implemented)

**Settings in the 3D parameters:**

- Display perspective or orthogonal
- Rotate or tilt light with world
- Background color
- Hidden Line: Line color black or object color, settings for line width and area fill color
- OpenGL parameters: There are some graphics cards that have problems with the clip plane. If the 3D display on the screen is not satisfactory, change the value for the **NEAREST CLIP PLANE** to 5 or 10 m.
Settings in the 3D Options:

- show map frame
- show coordinate axis

How and where to work with the 3D Graphics

Double click on the map ("Edit map") and select VIEW -> 3D MODEL.

Within the 3D Graphics, you are working with OpenGL. As OpenGL cannot use a printer, the displayed 3D map is written into a bitmap and stored as an extra file called "sheet name.bmp".

When leaving "Edit map" and the 3D Model is selected, the bitmap is created, OpenGL is deactivated and the sheet includes the created bitmap.

For a satisfactory 3D-Graphics sheet print out, the settings for the bitmap (i.e. resolution, color depth ...) can be adapted within "Edit map" 3D -> BITMAP.

The different display and move possibilities

- Scene
- Light
- Viewport
- View (only 3D-Animation)

Each of the display possibilities offers different move possibilities. For scene, light and viewport, the movements refer to the coordinate origin. The coordinate axis are displayed and can be disabled as well as the map frame in 3D -> Options. Both, map frame and coordinate axis are not taken into account for the bitmap creation. You can move the world, the light and the coordinate origin (center of the map).

The move speed is controlled with the slide control at the right hand side of the screen.

Operation of the moves:

Use the right mouse menu to toggle between the different possibilities (the right mouse menu changes depending on the display mode) or use the following key and mouse combinations:

- Keep left mouse key pressed and move the mouse: Move world or center of the map
- additional keys:
  - Shift: Change distance to the world center (zoom)
  - Ctrl: Rotate world or light
  - Alt: Tilt world or light

You can also use only the keys from the keyboard:

- Arrow keys: Move world or center of the map
• Ctrl+ Arrow keys: Rotate and tilt world
• Page up / down: Change distance to the world center (zoom)

If you change to the view mode, the world center of the scene becomes the position of the eye, the direction to the depth of the screen is the line of vision. If the left mouse key is pressed, "walk around" is activated.

• move the mouse forward and backward (arrow keys up / down): move forward or backward
• move the mouse left / right (arrow keys left / right): Turn to the left or right

Further actions are available via the right mouse button.

Another interesting action is "look around":

• move the mouse forward and backward (Ctrl+ arrow keys up / down): The view goes up or down
• move the mouse left / right (Ctrl+ arrow keys left / right): The view turns to the left or right

View settings

Additional settings for the view mode are available via 3D -> VIEW SETTINGS. Define which data shall be used for the automatic elevation calculation (only possible if the corresponding data are loaded). Furthermore you can define the height of the eye above ground and whether the view shall be straight on or whether it shall follow the inclination of the ground. The distance between the eye position and the second point, which is necessary for the calculation of the inclination can be entered.

In the last section, you can define, whether the viewer can walk through buildings (which can be very confusing).

Hint: Both, the automatic elevation calculation and the blocking of buildings, is time consuming and makes movements slower.

View from Receiver locations (only 3D-Animation)

View points are automatically created if receiver locations are included in the loaded Situations and Geofiles with the line of vision vertical to the façade (only single point receivers). If a receiver is selected from the selection list, the view mode and the action "look around" are activated.

Additional Options for 3D-Animation

Trees

Three tree types are delivered with the object types: Deciduous tree, conifer tree and bush. Trees are entered as general point in the Geodatabase. Z1 is the ground elevation and Z2 is the height of the tree itself (sorry, the input of the height will be improved, the way it is done at the moment is just temporary). Afterwards you have
to assign the graphics object type: Select the "trees" and use EDIT -> GRAPHICS
OBJECT TYPE and select the desired tree type from the list. Make sure that the point
is the active object type. Save the Situation. The shape of the trees can be adapted in
the object types, opening the 3D layout of the tree object type with the appropriate
symbol.

Walls
In addition of the wall itself, the posts can be displayed. The posts are the object
coordinates of the wall. Change the settings in the 3D layout of the wall object type
with the appropriate symbol.

3D Point Layout
There are several view types for points in the 3D-Graphics (also for the receivers of
a Façade Noise Map):
"Normal", Rotation body, cylinder or tree.
Enter the point size in meter.

View types
Normal: The symbol can be displayed in the xy plane
The symbol is tilt to the xz plane and rotated around z according to the given
number of rotations.
The areas in the xy and xz plane can be shaded. (All other display types always use
the shades).
Rotation body: The symbol is rotated around the y axis.
Cylinder: clear
Tree: The line of the symbol in the y axis is interpreted as the trunk, the areas are
interpreted as tree top, and rotated around the trunk. They can be displayed as areas
or as body.
Changes in colors or point sizes are immediately visible. All other changes only
become visible after OpenGL has recalculated the scene. Click the Refresh button!
With cartography, you can add your own object types, therefore also additional tree
types are possible.

The Animation
The animation can be executed online or by creating a AVI file, which can be played
with any Multimedia Player available. (Attention: The AVI files can become very,
very large. Reduce the color depth of the bitmap (3D -> BITMAP) and / or make it
smaller (in the CREATE AVI dialogue.)
Open 3D -> ANIMATION OPTIONS and select a road or railroad entered in the
Geodatabase. After that click the green arrow to run the online animation, the red
square to stop it, and the two yellow bars to pause it. Once the animation is paused,
you can use the slide control to move to a desired position.
To create an AVI file, click the red circle, and enter the file name (without path) and check the size of the AVI file. If it becomes too large, make the bitmap smaller. The AVI file is stored in the project folder. Afterwards, you can use the external program "AVICompress.EXE" delivered with SoundPLAN or any other compress software to reduce the size.

### Measurement data

#### Import of measurement data

In order not to display all .txt files that are included in the SoundPLAN project data, the measurement files to be imported have to be renamed to the extension:

- PTX (Point data)
- ATX (Polar data; a for angle)

The file type in the Graphics file manager is "Measurement data". When the measurement data are taken into the map, a dialog will open to define the table structure of the ASCII file:

The ASCII file may not contain text rows.

The title rows must contain the column headers. Enter the number of title rows (it may also be 0).

In the column section, all columns are displayed. Mark one column after the other and assign the meaning of the column to the column number. Use the button [>>] to automatically assign the column number or enter it manually. If the column number is 0, this column will not be imported.

**Point data:**

Define at least the columns "x position" and "first value". If the column number of "last value" < "first value" only the column "first value" will be imported.

**Polar Data:**

The coordinates of the center can be entered. Define the orientation of the angles (mathematical positive or not) and the position of 0°. SoundPLAN understands 0° as the positive x axis (east). If the 0° angle differs, enter the angle difference, e.g. if 0 degree in your data is north and the angle is defined as mathematical positive, enter 90° as angle offset, if it is mathematical negative, the offset would be –90°.

Define at least the columns "angle position", "distance position" and "first value". If the column number of "last value" < "first value" only the column "first value" will be imported.

**Target file:**

SoundPLAN automatically creates two files with the name of the imported file and different extensions:

- The file *.PLI contains the point list, the file *.TRI contains the triangulation file.
Display

The layout of the measurement points is controlled in the object types, via the object type DGM / Data:

Just as for grid maps, contour lines can be created, and / or the measurement values can be displayed via a symbol with or without the scale color, and / or the measurement value can be displayed as text.

To check the data, the edges of the triangles can be displayed (button triangle in the DGM / Data object type)

File operations

File operation can be executed with PLI files, moreover PLI files can be operator files for grid noise maps.

Two or more PLI files:

An additional checkbox defines, whether the measurement data of the PLI files should be combined or if only the overlapping area should be used. E.g. if you want to figure out the maximum level, you could combine two or more areas: within the overlapping area the maximum level is displayed, in the other areas you will see the original level. This checkbox doesn’t make sense for difference maps!

Grid Noise Maps combined with PLI files:

In order to get sensible results, the edges of the measurement points should be completely within the calculation area of the grid noise map. This is not necessary, if the levels should be added energetically, in this case the results are sensible even if the calculation area is smaller.
12 Expert System for Industrial Noise

Getting Started with the Industry Expert System

The Expert System for Industrial Noise is an analysis tool to develop noise control concepts for industrial complexes that often have very many individual sources and for each source may have different spectra, time histograms and solutions. As this program module has multiple windows it is possible to view different aspects of the same facility at the same time from different angles. With sort functions it is possible to very quickly figure out which are the problem receivers and to locate the main sources causing the problems and to simulate noise control options to see which combination of noise control measures has the best ratio of cost to performance.

In the following chapter read a short synopsis about the generation of noise control with the module Expert System for Industrial Noise. The functions used are described in detail in the next section:

- In the Calculation Core a noise calculation must be already carried out with detailed results stored before the Expert System for Industrial Noise is of any use.

- Open the module for the Expert System from the SoundPLAN Manager

- With FILE -> NEW read all result files from the single receiver calculation (with detailed results enabled at the calculation) into the Expert System. (FILE -> OPENS an already prepared and stored noise control concept.)

- Initially the screen contains 3 windows: The top two windows, the receiver list and the source contribution list are always visible. In the third window you can select different views to your data by clicking on different tabs. For the receiver list you can select different time slots (EDIT -> TIME SLOTS, in brackets the assessment standard used in the calculation is visible) and change the sort criteria. (EDIT -> SORT RECEIVERS ACCORDING TO). For the source contribution select if individual sources, groups or both shall be displayed (right click -> VIEW SOURCES).

- With the right mouse button additional detail windows can be generated or closed.
• In the additional detail windows select the content via the tabs on top of each window:

Top view or 3D-view show all sources and receivers highlighting the receiver marked in the receiver list (active receiver) in the top left window and highlighting the source marked in the source list (active source) in the top right hand window.

Day histogram of the noise level at the receiver
Day histogram of the sources
Day histogram of source contributions to the receiver

Sound pressure spectrum at the receiver
Spectrum of the source
Spectrum of the source contribution

Sorted source contribution diagram (lowest contributions on the right edge of the diagram with each contribution sorted so the magnitude is rising to the left)

List of noise control measures
Ranking of the noise control measures
Noise control cost/performance diagram

• The layout of the diagrams (diagram type, colors, title of the axis) can be customized via OPTIONS -> DIAGRAM SETTINGS or via a right click on the diagram.

• To generate a noise control concept, noise control options are assigned to the sources in the noise control measures list: left click on a source in the source list (top right hand window) to put the focus on a particular source and right click in the noise control measure list (or enter it via MEASURES -> ADD MEASURES FOR "NAME OF SOURCE") to add a new noise control measure for the highlighted source. It is possible to define multiple measures for each source. The noise control measure is either inserted from the noise control measures library when the measure is defined as a level difference over frequency or directly if the measure is a single figure reduction of noise levels. By right clicking on the noise control measure list and selecting the option GENERATE NEW LIBRARY ELEMENTMENT you open the library to generate a new frequency dependant noise control measure (difference and cost).

• Generate noise control measures in the noise control measure library: Enter the element name and under the tab VALUES difference spectrum and under the tab CHARACTERISTICS assign the costs to the measure.

• Single figure broad band reductions in noise levels can be directly assigned to the measure list in the Expert System without using the library. From the entry selection use the OWN VALUES (SINGLE VALUE) and enter the values in the fields MITIGATION and COST. Overwrite the text in the selection list.

• Each source can be assigned multiple noise control measures. The measures are either alternative or additive (see index).

• Multiple sources in the source list can be jointly activated and assigned a joint noise control measure from the library or single value mitigation.
• By right clicking on the source list and selecting the option VIEW -> SOURCES AND GROUPS you can assign a group of sources the same noise control measure.

• Optimizing: In the noise control measure list each measure needs to be set to one of the following options in the column “Active”: Yes, No or Opti. YES means that the mitigation will be used in any case and the influence of noise control measure will be accounted for the particular source and all receivers. NO likewise means that the measure will not be used for noise control of the source and OPTI allows the program to evaluate if it has a beneficial ratio of price to performance and will use it if this is the case and not if there are no sufficient benefits or the measure is not needed to attain the goal. With the setting for OPTI the influence of the noise control measure is not accounted right away, this is done by triggering the menu option MEASURES -> OPTIMIZATION. The program then polls all combinations and ranks the source modification measures according to the ration of price to performance and uses all measures until the noise control goal is met. If you want all new measures to have the default setting to optimize it, click on the menu option OPTIONS -> ADD MESURES AS „OPTI“. By activating multiple measures at the same time (shift click) the status for multiple measures can be changes simultaneously.

• With the column INDEX you can define how multiple measures for the same source are handled. For example there are the options of silencer A or silencer B for the same source. Both options are used as alternatives to each other, therefore the index for one measure needs to be different from the index of the other option. If the index number would be the same both measures could be used at the same time.

• After running the optimization you can manually fine tune the noise control concept. The measures recommended by the program are printed in the noise control measure list on a white background; measures not needed are printed on a gray background. Under the tab labeled „Attenuation“ select the left side tab „Attenuation/cost plot“ to see from which source modification on the relationship of cost/benefit becomes unproductive. On the diagram click on the source modification position from where on all further modifications should not be used any more. In the table under the tab “Measure range” you can check the results of this limitation but can also change the status of individual entries into “Yes” or “No”. After this setting you can redo the optimization under the constraints given.

• The noise attenuation concept now needs to be stored and is available to be included in any calculation run involving industrial noise sources. To include the attenuation concept in a calculation open the calculation run and select the mitigation file in the section with the label DATA as the file type EXPERT INDUSTRY ATTENUATION FILES (*.ATN). If the purpose of the calculation is to generate feed data for the documentation, the results can be directly stored back into the result database by using the Expert’s menu with the option FILE -> SAVE TO RESULT NO. XXX.

• With FILE -> PRINT you can print a table of the MEASURES USED, the RECEIVER LIST or the details of the CURRENT RECEIVER. The header and footers of the pages are customized in the section PAGE LAYOUT of the print menu.
Before the Expert System can be opened, the data first must be generated in the Calculation Core. Start a **single point sound** calculation with the **detail result tables** in the tab **SPS** enabled. This setting will store the intermediate and final results needed by the Expert System.

**Relationship of the individual graphics and tables amongst each other.**

The graphics show that the result data can be assembled in various forms and formats. Depending of project size, scope and advancement of the study it may be advisable to rearrange the detail windows depicting different content. The typical steps in the Expert System are:

- Check input data (sources, receivers, geometry)
- Gain an overview over which sources have a prominent influence upon the receivers.
- Generate the concept of noise control measures
- Post process the optimized noise control measures

The tables of the receiver list and the source list are always visible. Under **preview -> switch alignment** the alignment of source and receiver list can be toggled from side by side to sequential. Detail windows, which you can request by right clicking on a table or diagram (but not on graphics), you can place in the same row or in separate rows below each other.

Receivers by default are sorted by the magnitude of the excess of noise ($E_{w/a\ A}$). With **edit -> sort receivers by** the sort criteria can be changed.
Sort criteria:

Point number (number of the receiver)
Name
Lr w/o A (Assessed noise level without noise control measures)
E w/o A  (Excess of the noise limit without noise control)
Lr w A (Assessed noise level with noise control measures)
E w A (Excess with noise control measures)
Attenuation  (Magnitude of the noise control measure)

Source contributions are always ranked in accordance to their contribution at the receiver highlighted in the receiver list.

If groups have been assigned to the sources it is possible not only to assign attenuations to individual sources but also to the group itself. Switch the display in the source contribution list in PREVIEW (or via right clicking):

Sources
Groups and sources
Groups

In additional detail windows select different views to the data for a selected receiver or source.

Detail window

You can add multiple detail windows side by side or below each other. On any window (except the 3D or top view graphics, where you need to click on the tabs ) right click on the window and then ADD DETAIL WINDOW. In the following dialog select where the new window shall be inserted.

When no longer needed close the additional windows again by right clicking and selecting REMOVE DETAIL WINDOW.

"Splitter"  
You can modify the width of the detail windows and the height of the rows by positioning the cursor on the border between the windows and as soon as the cursor changes the shape to move the border to its new position.

Graphics window

You can display the geometry data in a top view as a frontal projection or as a 3D projection. To switch between the display modes right click on the graphics picture and in the select the VIEW TYPE. If the view type is “front view” or “3D map” there
is an additional choice to define the **DRAW TYPE** with the choices “Wire frame”, “Hidden line” and “Hidden surface”. The graphics settings and selection of the movements (move, zoom, rotate, move height) are also controlled via right clicking on the picture and selecting the menu choices, the movements are invoked by moving the mouse while holding down the left mouse button.

In the graphics the selected receiver and the selected source are highlighted. Colors, sizes and line thicknesses are controlled from the menu point **OPTIONS-> OBJECT TYPES**.

**Day histogram**

In the diagram type for the day histogram there are 3 tabs on the left side of the diagram allowing the display to switch between the day histogram at the receiver (receiver) or to view the day histogram of the sound power (source) or the contributions at the receiver.
Spectrum

With the 3 tabs on the left side of the spectrum diagram you can select the view to represent the spectral information at the receiver caused by all sources (receiver) or the sound power spectrum of the highlighted source (source) or the contribution of the highlighted sources at the receiver.

Contribution Level Sum

For a quick overview of potential noise control measures the diagram with the progressive addition of the sources is very helpful.

The vertical blue line depicts the noise limit for the selected time slot. The diagram is generated by ranking the source contributions and from the right hand side of the diagram starting with the lowest contribution to the source. As the source contributions are ranked each additional source is added to the left of all smaller contributions the new data point in the diagram is always representing all contributions from the new source contribution on. The diagram shows how much the level is raising if the new source is being considered. In this display it is quickly
visible that noise control must start with controlling the sources above the noise limit and sources that are very close to it. If the diagram is very flat the noise at the receiver is caused by many independent sources, if the rise is steep, only a few sources are responsible. The red line represents the situation without and the green with noise control measures in place.

For the tab index cards Measures and Attenuations see „Preparation of a noise control concept“ on page 324

On any of the charts you can right click and select the option COPY CHART TO CLIPBOARD to copy the diagram into other software packages such as WORD.

Diagram properties

The properties of the diagrams can be set individually for each of the diagram types, the program can display different content in different formats and configurations. It makes sense to display multiple sources in the source contributions but in the attenuation diagram it is wise to only view it for a receiver at the time for the selected receiver only.

The diagram properties are opened by right clicking on the diagram to be edited and selecting the option CHART PROPERTIES. Another access is via the options menu and the selection of chart properties there.

All settings under the tab GENERAL are valid for all diagram types. Here the text fonts for the diagram header, legends, axis title and axis labels are set. To set the parameters click on the button boxes and configure them. In addition you can set the colors for the background of the normal diagrams and the background, bottom and sides for the 3D diagrams.

Up to 10 elements can be displayed in the diagrams (10 sound power spectra, day histograms at 10 receiver locations ...) therefore there are 10 boxes where you can
individual select the colors from the SoundPLAN palette. The color and thickness of the border line for the selected time slot is set on this control box. The content and appearance of the diagrams is set individually for each diagram type.

**Navigation keys**

In the second tab the diagram properties for each individual diagram is set. To navigate from diagram type to diagram type use the navigation buttons in the lower left hand of the diagram properties box.

![Diagram properties for individual diagrams](image)

The diagram-properties for each diagram is split into 3 sections: Title and scale, Elements and Style.

Under the tab **TITLE AND SCALE** find the diagram headers and the titles of the axis. The **Y-AXIS** can either be scaled automatically according to the data or if the box „automatic“ is not clicked be scaled according to the **MINIMUM** and **MAXIMUM** values to be user defined.

Specialties for some diagrams: For the **CONTRIBUTION PLOT** you can define for the **X-AXIS** if you want to display all sources or only the N loudest sources. As the sources are sorted according to their contribution at the receiver the degree of detail will increase when the number of sources is limited.

Under the tab **ELEMENTS**: The **NUMBER OF SERIES** indicates how many sources or receivers are displayed in the chart as a line, bar or 3D graph. Up to 10 series can be displayed at the same time. For noise level contribution charts the level sum without and with noise control are always displayed on the same chart therefore the selection of the number of series is not available for this diagram type.

The lower part of the tab **ELEMENTS** configures the appearance of the element names and the general layout of the legend.

Select the element name from the following possibilities:

**NO ELEMENT NAMES** – The element names are not displayed in the diagram.
ELEMENT NAME IN TITLE AS LIST – The element names are printed on the diagram as a table

ELEMENT NAME IN ONE TITLE ROW – All element names are all placed in the title row

ELEMENT NAMES IN LEGEND – Places the element names into the legend. To recognize the elements color coding is used. For this option additional settings are for the placement of the legend, background color, frames and shadows.

For the STYLE of the diagrams the following chart styles are to your disposal:

- Bar diagram
- Line diagram
- Line diagram with steps
- Area diagram
- Area diagram with steps

All diagram types can be drawn as regular 2D diagrams or as 3D-diagrams.

The LINE THICKNESS is only valid for line diagrams relevant: For 2D-diagrams the parameter LINEN THICKNESS sets the thickness of the element line, for 3D-diagrams this parameter controls the thickness of the border line.

In addition you can specially highlight the data points with the SHOW POINTS option (not available for bar graphs).

Preparation of a noise control concept

First all data is analyzed using the tables and diagrams and the noise control potential of prominent sources at critical receivers is evaluated.

Before you start with the noise control concept in the Expert System, define the noise mitigation potential inside the factory buildings by evaluating absorptive material at the ceilings, design needed noise control walls and evaluate the timing of the sources and check if sources can be shifted from the costly night time into daytime. After all these factors are exploited rerun the calculation.

In the Expert System the first step is to assign noise control measures and costs to the sources with sufficient control potential. The optimization itself can only rank the noise control measures to find which combination will control the noise for the lowest price possible.

Optionally you can set the program in OPTIONS -> DO OPTIMIZATION WITHOUT COSTS to only evaluate the noise control potential without taking the cost into account.

Noise control measures can be set to a status as YES -> use this measure or NO -> do not use this measure or OPTI -> to leave it up to the optimization to choose if the noise control benefits are greater than the costs.

Often the exact costs connected to a noise control measure are not known at this stage. If this is the case it is possible to substitute the cost with a point system where
low costs are set to 1, middle costs are associated with 5 and high costs are represented by the figure 20. A noise control calculation with these figures will not yield the total costs but nonetheless will show the tendency in the optimization.

**Assign noise mitigations**

In the detail window select the tab measures. In the level contribution table select a group or source that shall be assigned a noise control measure (the source will be highlighted with a white background) and add a noise control measure in the table of measures by right clicking or by invoking the process through the menu MEASURES. The sub menu allows to **ADD A MEASURE TO SOURCE “XXX”**.

---

### Add a measure for a single source or group

The field with the header „name“ shows „Own entry (single value)“. If you want to work with broad band values without using the noise attenuation library, you can type the name of the measure here and enter the magnitude of the attenuation in the next field and the cost of the measure in the last one.

---

### Attenuations from the library

Open the library from the menu with **EDIT -> LIBRARY** or in the detail window „measures“ by right clicking and selecting -> **NEW LIBRARY ELEMENT**. You can find the details of how to work with the library in the chapter Library. Check the system library if there are elements that fit your needs; if there are elements already in the system library, copy them to the project lib. The attenuations are given in octaves, the costs are added under the tab characteristics in the top most left position:

---

### Entry of the cost in the attenuation library

Pick the measure in the Expert system in the window measure from the lib list.

---

### Assign multiple sources to the same noise control measure

Mark multiple sources or groups with the mouse or by using the shift + arrow keys. The selected sources or groups are showing on a white background when marked.
By right clicking in the detail window “Measures” select the option ADD MEASURE TO SOURCES: NR. – NR.. In the following window the measure are predefined.

![Define measure window]

Predefine measures assigned to multiple sources

Enter the dialog if you want to have the same measures for multiple sources or skip this phase by clicking on the OK button. If you skip the definitions here you still can assign the measure manually or select the library elements.

The Optimization

With the optimization routines the noise control concept can be optimized even if the measures are not beneficial for all the receivers. The program will select the most suitable combination of noise control measures.

The Optimization Algorithm: In the first step the program looks for the receiver with the highest violation of the noise limit. In the next step the program evaluates for all sources modifications the ratio of cost to benefit (if the option -> opti is active for the measure) to find the best ratio of cost to performance (or just the attenuation if the optimization was run disregarding the cost). After the noise control measure was selected the noise level of the source is subtracted from the noise level of all receivers. If the noise levels at one or multiple receivers is still above the limit, the optimization procedure is carried out again. The optimization only stops if all receivers are below the limit or no further unused noise control measure is available.

When you want to carry out the optimization the measures need to have the status "OPTI". Select OPTIONS -> ADD MEASURES AS „OPTI“ so that you do not need to modify the status manually.
In this case the measures and costs are not accounted for immediately but only in the process of the optimization. The difference due to noise control measures is accounted for in the noise level at the receiver and at the contribution table. If there are measures that have been determined to be undertaken in any case, it may be beneficial to switch the status from „OPTI“ to „YES“.

**Meaning of the status of "Active"**

In the noise control Measure list the source modifications assigned to sources can have any of 3 states in the column „Active“: Yes, Opti and No. **YES** means that the measure will be used in any case, the measure is instantly accounted for in the contribution list etc.. If **OPTI** is selected, the differences are not accounted for until the **OPTIMIZATION** has determined that the measure has a beneficial ratio of cost to performance. With **NO** the measure will not be used at all (this only becomes relevant when the optimization has been run and certain measures that the program might select shall be blocked from being used).

If measures have been entered with the status "Yes" and shall be modified later on into "Opti", mark the column with the shift and arrow keys and change the status of the last entry by clicking on the field and selecting the option for „opti“.

<table>
<thead>
<tr>
<th>Graphics</th>
<th>Time histogram</th>
<th>Spectrum</th>
</tr>
</thead>
<tbody>
<tr>
<td>No.</td>
<td>Active</td>
<td>Index</td>
</tr>
<tr>
<td>1</td>
<td>Yes</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>Opti</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>Yes</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>Yes</td>
<td>0</td>
</tr>
</tbody>
</table>

Change the status of multiple measures simultaneously

**Limitation of the optimization algorithm:** The algorithm used in the optimization is non recursive. When the most suitable measure was found (example: Measure A, 5 dB attenuation, $1000 cost), it is added to the measure list. If the noise limit is violated at one or multiple receivers, the next measure (example: Measure B, 15 dB attenuation, $4000 cost) is requested and entered in the measure list. The ratio of cost to benefit for the measure 2 is worse than for measure 1. If measure 2 alone would have been sufficient, the program would not realize, the optimization is not recursive and does not reevaluate that measure 1 is obsolete. If multiple receivers and multiple sources with multiple modifications are in the optimization, it is not very likely that the outcome would be different from a recursive procedure.

**Mutually exclusive measures**

Each noise source can be assigned multiple noise control measures that can be either in addition to each other or exclude each other. The „Index“ column is defining the status of noise control measures for the same source.
Meaning of „Index“: For a source only measures having the same index can be used simultaneously, measures with different index numbers are mutually exclusive. Exception: Index 0 can be combined with and other index.

**Alternative measures:** If you have multiple different fan types to choose from you ultimately want to have only one selected, so the measures are mutually exclusive. Fan A can have the index 1, fan B the index 2... If the optimization finds fan B to have the best ratio of cost to performance all other fans are discarded. If a silencer is considered for any of the fans the index should be set to 0 to be compatible with any of the measures.

**Additive Measures:** Noise control measures that can be used in addition to each other share the same index number. Example: The noise control for a piece of equipment can comprised of multiple independent measures (swap bearings, reduce RPM, building an enclosure around the machine).

**Measures that are connected** must be defined as one measure. A silencer that only fit one of the new fans must be defined as a combination package, if it fits multiple source modifications it could be split and the index should be 0 then.

In order to have the measure used in the optimization the status must be set to Opti. Select **MEASURES -> OPTIMIZATION** to start the optimization run. After the Optimization calculation click on the tab **Attenuation** (if needed add a new detail window).

**Attenuation-/cost diagram and ranking of the measures**

Under the tab **Attenuation** click on the left side tab “Attenuation plot” to view the attenuation / cost diagram. The vertical line shows to which noise control measure the noise control options need to be considered. Under the tab “Measure range” the list of measures are ranked according to the effectiveness of the source modification and the cost of it. Measures with a gray background are not needed.
After the optimization measures not used because of index number conflicts are displayed with cursive text.

<table>
<thead>
<tr>
<th>No.</th>
<th>Active</th>
<th>Index</th>
<th>Group/Source name</th>
<th>Measures</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Opti</td>
<td>1</td>
<td>Loud Speaker 1 (Beer Garden)</td>
<td>Own entry</td>
</tr>
<tr>
<td>2</td>
<td>Opti</td>
<td>2</td>
<td>Loud Speaker 1 (Beer Garden)</td>
<td>Own entry</td>
</tr>
</tbody>
</table>

The optimization is a tool, the decision which measure to use however is yours. Therefore the optimization status is not switched after the optimization. You can change the status of individual source modifications by hand from opti to “Yes” or “No”. Sometimes you run the optimization for one time slot, determine what source modifications are required there, set these to “Yes” and then run the optimization for another time slot with some measures already predetermined and others open for further optimization.

### Print and reuse the noise control concept

For the documentation of the noise control concept you can print the following tables:

- Receiver list
- List of used noise control measures
- Contribution of the sources at selected receivers

Select the table of your choice after invoking the menu FILE -> PRINT. In the preview review the layout of the table. The normal SoundPLAN page format is used, with PAGE LAYOUT in the print menu customize the layout of your printout. Details about the page layout can be found in the chapter about the result tables.

By right clicking on one of the detail windows you also can select the option COPY USED MEASURES TO CLIPBOARD to move your data into other programs and format the printout there

**Hint:** Only measures containing the „yes“ status are printed and moved to the clipboard, measures containing „opti“ or „no“ are ignored.

### Using the noise control concept in additional calculations

Save the noise control concept via FILE -> SAVE or SAVE AS as an attenuation file (xxx.atn). By including this file in the list of files of a calculation run, the attenuations of the noise control concept are included in the calculation.

Enter the attenuation file in the calculation run properties in addition to the situations and geo files. To include the attenuation file click on the >> in the „data“ entry field and select the attenuation file from the list of attenuation files. With the > key you include the attenuation file (*.atn) in the list of files assigned to the current calculation run.
The results can be processed as usual, the Documentation, Spreadsheet and Graphics always will show the noise levels as defined in the Geo-Database reduced by the attenuations defined in the noise control concept of the Expert System for Industrial Noise.

**Store the noise control concept into existing result tables for documentation and graphics**

With the menu FILE -> SAVE TO RESULTX NO. XXX the noise control concept is directly stored back into the result files. When the result files are opened in the documentation the selected source modifications are accounted for.

**Caution:** A new calculation run will overwrite the results in the result files, so if the noise control concept shall be accounted for it must be added to the calculation as a *.atn file!
13 Aircraft Noise

General

The SoundPLAN module Aircraft Noise enables the calculation of noise levels in the vicinity of airports. The setup and calculations are based upon the German standards „Anleitung zur Berechnung von Lärmschutzbereichen nach dem Gesetz zum Schutz gegen Fluglärm“ (AzB) from 1975 and 1984 as well as the „Datenerfassungssystem“ (DES). The standards are were developed under the guidance of the German Federal Ministry of Interior (Bundesminister des Inneren).

The ÖAL 24 calculates according to the AzB, however in curve sections an adjustment according to "ECAC Doc 29" is considered. "ECAC Doc 29" is in principle, built on the calculation algorithms of the AzB, but ground attenuation and emission characteristics are calculated according to „ICAO CIRCULAR 205-AN/1/25:1988“. As before, only "calm wind conditions" are considered.

With the specification of the operations data for the various assessment time slots (day/night), the energy equivalent noise level $L_{eq}$ according to AzB, the assessed noise level $L_{rFl}$ according to DIN 45 643 or the „Noise and Number Index“ NNI (Great Britain) can be computed (NNI is still in the implementation phase).

**Hint:** Elevation lines, buildings and other obstacles are ignored in the propagation model of the AzB. Topographical information is only used for the Digital Ground Model (DGM) in order to establish the elevation of the receivers in the Grid Noise Map. For the calculations the airport elevation is always the reference.

Procedures

At present the access to the data entry to the aircraft noise module is through the SoundPLAN Manager **ADDITIONAL TOOLS -> AIRCRAFT NOISE DEFINITION**. Here you can enter the airport with all related data (runways, aircraft classes, routes and operations data). These data can be combined at will with other SoundPLAN data types and Geo-files (receivers, calculation areas ...) to be used in the Calculation Core and the Graphics. Table type results you will find like normal in the Documentation.

In order to ease the start up with this module the “official” example project supplied by German Umwelt Bundesamt (German EPD) is included on the CD.
Aircraft Noise – Data Entry

In the main start-up screen you can define the airport geometry and the available runways for start and landing. Via the buttons on the right hand side you have access to the definition sheets for routes, aircraft classes and operations data. All sheets are designed to resemble the data entry of the DES, all identifiers, abbreviations and indices are used strictly as defined in the AzB and DES.

Aircraft Noise – Data Entry

Airport

The top part of the main data entry screen is used to define the airport. Each airport has one airport reference point (P_{rp}). All local references (runways..) are in relationship to this reference point. The locations name and placement is user definable, the coordinates are at the moment confined to the coordinates R=>X and H=>Y. The global referencing with degrees, minutes, seconds of longitude and latitude is planned but not finished.

Airport Definitions

The airport elevation is only used for the Documentation and the presentation in the Graphics. The AzB in general defines the receiver elevation as the elevation of the airport itself. The last section of the flight path ends with leaving the airport radius. According to AzB and the Airfield Noise Regulations the airport radius is set to 20.000 meters. In the Graphics this radius is displayed but so far it is not applied in the Calculations.
Runways for Start- and Landing

Each airport can contain any number (greater than zero) of runways. Each runway has 2 approach and departure directions.

The runway reference point (Pb) is defined by the distance (X,Y) to the airport reference point Pfp. For each of the directions of start and landing the orientation is defined by taking the magnetic heading of the runway and dividing the number by ten. Additional entries such as the overall length of the runway (no influence to the calculations) and the distance of the starting point and the threshold from the runway reference point Pb can be taken from the DES or are measured on the runway chart. In case the start point—as seen in start direction—is behind the runway reference point, the distances need to be entered as a negative number.

Density-1- and Line-up area according to AzB

The density-1-area (linear digression of the aircraft from 100% to 0%) according to the AzB is defined as a length of 1500 meters. For short runways this could exceed the length of the runway, therefore it needs to shortened to suit the situation. The value to be entered here represents the distance of the threshold from the runway reference point.
**Hint:** If you at a later stage delete runways, the references to the flight path will be unreferenced, therefore in order to make the data consistent again, a new runway needs to be assigned to the path.

### Approach- and Departure Flight Paths

**Flight Paths**

For the entry of the flight path first select the path type, the tables will adapt according to the selected path type. A switch at a later stage may result in the loss of data (operations). The following path types are available:

<table>
<thead>
<tr>
<th>Path Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.2.4: Takeoff path for helicopter</td>
</tr>
<tr>
<td>2.2.5: Takeoff path for propeller/jet aircrafts</td>
</tr>
<tr>
<td>2.2.6: Takeoff path for helicopter</td>
</tr>
<tr>
<td>2.2.7: Landing path for propeller/jet aircrafts</td>
</tr>
<tr>
<td>2.2.8: Landing path for helicopter</td>
</tr>
<tr>
<td>2.2.9: Pattern flight for helicopter</td>
</tr>
<tr>
<td>2.2.10: DES-MEL takeoff</td>
</tr>
<tr>
<td>2.2.11: DES-MEL landing</td>
</tr>
</tbody>
</table>

**Selection of Flight Path Type**

After the selection of the path type you can define the track. The name is free definable but “speaking” names are sensible. In the next field you can select one of the available runways. Starting and landing always is lined up with the runway direction, a runway direction of 180° (from North to South) will cause approaches and departures to be from north to south.

In general the definition of the flight path is done section by section. The first section starts with the reference point for the runway P_{rb}. For the departure the description is following the flight path, for the landing the description is in reverse order. Additional sections of the flight path are always starting at the end of the previous section. Each section is either described in column 1 was a straight section or in the columns 2..4 as an arc. Changes in direction are entered with the columns 2 left/right, 3 Change in heading in degrees and 4 radius of the curve. The columns 5 and 6 define a corridor width distributing the flight tracks evenly over an area. 5 is the corridor width at the beginning of the section, 6 represents the end of the section. For military flights the height at each of the sections can be defined in column 7. This entry will override the elevation data as they normally are defined via the aircraft class.
**Path Description for Fixed Wing**

For approaches and pattern flights the glide path must be defined. In case this is not known, the path can be assumed (according to AzB) to a L/D of 1:20. In addition to the glide path the begin and end of the line up area needs to be defined. The DES references the begin and end of the line up area to the runway reference point. From these data the linear increase of the aircraft from 0% to 100% are calculated. For pattern flights and departures this line up area is omitted.

**Data Entry for Departure and Approach Flight Paths**

The Entry of the flight altitude the airport for departure and approach is only relevant for certain aircraft classes. For pattern flights the altitude is limited to the maximal elevation in the pattern (pattern altitude).

**Flight Track for Helicopters**

**Data Entry Screen for Helicopter Flight Paths**
The track description for rotary wing aircraft is the same as for fixed wing. The helicopter landing point \( P_H \) according to DES is defined as follows: The nearest runway is superimposed with a new coordinate system. The X coordinate is in the path direction, the Y coordinate of the system is rotated by 90° to the left.

Coordinate Entry for Helicopters

The definition of the helicopter touch down area is defined in the DES. For future versions of this program a free definitions directly in world coordinates in reference to the airport coordinate system is planned.

Aside from this the data fields should be self explanatory. In doubt look into the AzB for reference.

**Aircraft Classes Library**

The aircraft classes library has the same structure as all the other libraries (system, global, project). The library contains the tabs "properties", "AzB-Profiles" and "comments". If you open an older project, where the classes were not yet handled in the library, the old classes are automatically written in the project library as soon as you open the Aircraft Noise Definition the first time. Old classes can also imported from another project to the library.

The common aircraft classes published in AzB are installed in SoundPLAN already and can therefore be used in each project without re-configuring this definition. In order to keep your project manageable all unused classes should be deleted. When
entering new classes please keep in mind that the change of aircraft classes may result in changes in the data fields. In case data are already present, it is possible that these will get lost when the class is changed.

**Z,V,H - Table**

With the Z,V,H-table the flight altitude of the aircraft class is described. Analog to AzB not only numerical values but also certain characters are allowed as input („X“, „-“, „h“ and „tgw“). When the elevation column has the character „h“ entered, the altitude of the flight path (over airport elevation) will be computed from the path. With the entry „X“ the altitude will be computed according to a formula (see entry of the aircraft class). For the entry „tgw“ the tangent of the glide path w is calculated, the parameter itself is to be entered in the cell „dH/ds“.

**On, Rn - Table**

The On,Rn table contains the emission spectrum (octave band) of an aircraft class for a set reference distance s0 and the direction factor Rn, which in a simplified fashion simulates the directivity of the aircraft. From these octave bands the tables of the AzB are derived that are the basis of the propagation calculations. To generate the tables press PROPAGATION LOSS TABLE.
Generate Table Sheets according to AzB

Intermediate values for other distances will be derived by linear interpolation using the logarithmic distance \( \lg(s) \). With the parameter “Limit Row No” you set the maximal distance for which the aircraft noise is considered relevant. For greater distances the emissions of the aircraft class is set to zero.

Aircraft Traffic Data

The aircraft traffic data tables describe the various modes of operations (variants).
The system always opens the traffic data for the selected table. For each path all possible aircraft type groups are displayed. The data entry calls for the number of aircraft flying in the 6 most active months of the year for this particular group on this path (variant). For day and night there 2 columns each. In order to assign the quiet time penalties for night time according to DIN 45 643, the number of aircraft must be entered separately for day and night. The first column (day takes the number of flights between 07 and 19 hours. In the column „day/rest period“ the sum of flights in the quiet time from 06 to 07 hours and 19 to 22 hours is to be entered. The night column takes the number of flights between 22 and 06 hours for the night time. The last column (only used for DIN 45 643) the number of flights in the loudest hour of the night can be entered. For the calculation according to DIN the assessment level for the night time (from column3) will be set to the loudest hour at night time if this level exceeds the average of the night by more than 4 dB.

For calculations according to the AzB or AzB-L the number of flights for day is the sum of columns 1 and 2. Therefore it is sufficient to enter the data into either one of the columns. The column 4 with the max at night is ignored for the AzB.

For the actual table you can view the paths of your aircraft classes by pressing on the button GRAPHICS.

Used Flight Paths (here all paths)  Used Flight Paths (here departure 8Ab)

**Import of Aircraft Traffic Data**

You can define the import parameters, so that an automatic link is possible.

Select the time range of the import data in the field TIME FACTOR. Write the name of the column header in the import file into the text field TRACK HEADER. You can
combine the track name with the track description via the field **TRACK ENCODING**.
The setting "track+text+runway" creates e.g. a track description "ALS2G-33" instead of "ALS2G", if only "track" is selected. Write the name of the runway header in the import file into the text field **RUNWAY HEADER**. The aircraft traffic data can only be imported, if the created track description corresponds to a track name in the DES. Tracks that couldn't be assigned during the import are displayed in a separate window. **IMPORTANT:** When you import traffic data the existing traffic data in the current table are deleted and exchanged with the imported data. If track descriptions are identical they are summed up for the respective track.

The automatic allocation of the column header for aircraft groups and time slices is defined by **GROUP TIME ENCODING**. The spelling of time slices have to match with the column headers in the mask "2.3. Flight Traffic Data". **IMPORTANT:** The identification follows the group names and not the name of the class! For groups with more than one take-off class all traffic will be summed up to one class. For the automatic assignment you have to define a unique group for each take-off payload. You can check and change the assignment groups/time slices in the import dialogue.

If data for one track is not in rows rather in columns, then you can transform your whole data e.g. in EXCEL with "insert content" according to "transponate".

Push **IMPORT** to start the Excel import definition. Please see the description for the import in chapter libraries-> Import.

When using **AUTOMATIC LINK**, the program tries to create all necessary connections according to your import settings. The spelling has to match with the column header of the import data (big or small caps are ignored).

If it doesn't work, you can define manual links.
The pick list shows all (group) \( \times \) (time slice) combinations not yet linked to a column. The creation of the pick list is defined in the import settings.

HINT: Within „Define link“ you can see how the column header has to be spelled for an automatic link.

**Air Traffic Calculator**

The air traffic calculator is for exchange of traffic between tracks, exchange between time slices (evening <-> night) or for roughly estimations (table "today" \( \times \) 1.5 = table "2010"). In a text box at the bottom of the calculator all used operations are listed. The calculator is capable of the 4 basic operations of arithmetic, selected cleaning (NULL) of traffic and exchanging traffic \( \text{EX} \). The operations are possible for selected tables, tracks, groups and time slices. All operations can be undone. On big screens it's possible to view at the calculator and the traffic data at once, to recognize the impact of an operation.

Examples:

On the whole table all traffic for night period was typed to the evening column. If only on one track, then select just this track for exchange.

Replace values on a track with values from other tables:
a) Clear all traffic on track:

With that settings you would produce nonsense. You only delete the cleared the evening column. For a correct procedure you have to set the box for the time slice to **ALL TIMES**. For the actual viewed track the clearing operation is performed by the button **CLEAR TRACKS**.

b) Add track:

In the lower part of the above picture you can see, that the operation was already performed. The listed operations can be undone. The data will be set to the condition before the operation. Manual entries after the operation will also be reset.

c) Add multiple tracks:

Open the selection list for multiple tracks (tables, groups or time slices) with a double click on the appropriate list box.

The selected tracks of the second operand will be summed up and added to the first operand. In this example the result is stored on the track of the first operand. It can also be another track. The selection of every other track is possible.
Aircraft Noise in the Geo-Database

The flight paths and the various reference points for the airport, runways thresholds and start points are all contained in the Geo-File. The file name (for example $FLS0000.GEO) and the description should not be modified as otherwise the references to the operations data will get lost. Otherwise the Geo-file is treated the same way as all the other Geo-Files, it is to be included in the Situation along with the calculation area and other data.

Situation Manager of the Geo Database

After loading the geometry of the airport and the reference points are displayed as general line and point objects. At the moment the objects can be still be moved in the Geo-Database, this however will not have any influence upon the calculations. In the future these objects will be treated as fixed place objects and will not be open for editing.

Aircraft Noise in the Calculation

In the Calculation you can select between the “Aircraft Noise Grid Map” and the “Aircraft Noise Single Point Sound”. After selecting one of these options the index card for Aircraft Noise is included.

Selection Calculation Standard

Here you can select the calculation parameters and the type of documentation (simple or detail). At present you can choose between 4 calculation standards: Strict accordance with AzB, AzB (free), AzB-L (revision from 1997) and DIN 45643 strict
or according to DIN 45643 (free). With open the extended parameter set. For some of the standards these are fixed and cannot be.

**Calculation Parameters Aircraft Noise**

The parameters are the decay parameter (halving parameter q) to be set to 3 or 4, the factor for the signal duration $t_{10}$ (1 or 0.5), the limit level (user discretion) and the table limit in accordance to (AzB, AzB-L, free or none). The table limits themselves are contained in the definition of the aircraft classes and will be executed accordingly.

**The Aircraft Noise Result Documentation**

Depending on the setting in the calculation core you will generate different results for the Documentation.

**Settings relevant for the Documentation**

The Calculation Run Information is generated for each run regardless of the other settings. For “Plain Result Tables” the program generates a list of the receivers and the assessed noise levels as well as a list of the flight paths with the aircraft numbers (this has no print function at present). If the “Detail Result Tables” are requested, detailed results of paths and their sections will be generated for the $A_{ijk}$-Table.

**Example, $A_{ijk}$-Table**

<table>
<thead>
<tr>
<th>$A_{ijk}$-Table all paths</th>
<th>22</th>
</tr>
</thead>
</table>

---

Aircraft Noise – Data Entry SoundPLAN Handbook
Graphical Printouts of Aircraft Noise Calculations

In the Graphics as usual you can display the results along with the line graphics of the flight paths.

![Diagram of Aircraft Noise Calculations](image)

Used Flight Paths (here for all paths)

New features for Aircraft Noise in SoundPLAN 6

- Use **settings** (in earlier versions graphics settings) to hide the display of the influence radius in Geo-Database and Graphics.

- **Definition of the flight traffic data:** It is possible to change the size of the window to show as many flight classes as possible without scrolling. The name of the Geo-File is now written in front of the name of the tables, for example, "SFLS0003-semicolon". It is only possible to change the description, not the number of the Geo-File.
• The elements of the Austrian standard are now available in the flight classes library.

• For the documentation of the input data, two new switches are available in the data sheet 'traffic data'. ONLY TAB. creates a text file with the traffic data of the current table. TOTAL provides a complete documentation of all input data of the airport (airport, runways, tracks, classes and traffic data). The text files are stored in the project folder under the name „Docu_FTSFL$0003.txt“ (only tab.) and „Documentation$FL$0003.txt“ (total), for example to import them to Excel.

• There are two new calculation standards in the calculation kernel "ÖAL 24" and "ECAC Doc 29". The "ÖAL 24" calculates according to the AzB, however in curve sections an adjustment according to "ECAC Doc 29" is considered. "ECAC Doc 29" is in principle, built on the calculation algorithms of the AzB, but ground attenuation and emission characteristics are calculated according to „ICAO CIRCULAR 205-AN/1/25:1988". For calculations according to ECAC you can choose between the wind situations "moderate wind" and "calm downwind" Up to now the wind situation was always "moderate wind".

• Nine results (10 for DIN 45643) are now stored for grid map calculations. These include the assessed level for the whole day as well as the un-assessed level and the maximum level for each of the four time ranges. The maximum level is the mean value over the maximum levels of the part corridors. The part corridors are assessed using the normal spreading function. The next version will also show the absolute peak level of a part corridor. Hint: if the number above threshold (NAT) is calculated instead of the levels, always the maximum levels of the part corridors are taken into account.

• For single point calculations, the levels for the different time ranges are calculated un-assessed as well as assessed according to the selected standard.

• For single point aircraft noise calculations a protocol file containing all airport data is created. It is displayed in the Results tables.

• CONTOUR MAP aircraft noise is now available as a new entry in the Graphics file selection manager.
14 Air Pollution MISKAM

Introduction

The prediction of the expected pollution loads due to traffic sources is becoming more and more vital in congested city environment as the threshold for the permitted pollution load is becoming lower and lower.

There is virtually no planning measure in city and regional planning where the questions of air pollution (peak and average values) could be ignored. Measurements play a vital roll in the assessment of the air pollution situation, however because of the tremendous costs involved the scope of the measurements is limited both in the time and regional scope. Secondly the measurements can only cover existing conditions, variants of the plan cannot be evaluated.

For some time improvements in the numerical methods are adding prognostic capabilities to the standard measurement approach. In the past sophisticated numerical models could only be run on big mainframes but with the recent improvement of PC performance they now can be run on standard PC. In light of this it is not understandable that at large the government bodies are still only demanding answers from inferior Gauss models (TA-Luft) that ignore the influence of terrain and buildings.

The MISKAM – calculation core

The model MISKAM (Mikroskaliges Klima- und Ausbreitungsmodell/ micro scale climate and propagation model) by the virtue of the mathematical description of the atmospheric physics is probably the most advanced model of its type. It was developed at the Institut für Physik der Atmosphäre der Universität Mainz (Institute for the Physics of the atmosphere of the University of Mainz) (previously called Institute for Meteorology). This institute for more than 10 years has worked on research concerning regional and local climate and propagation models. Aside from the generation and further development of MISKAM the focus at the moment is on the regional climate model KLIMM (Climate-Model Mainz). KLIMM is conceived for modeling questions of regional climate and air hygiene with area sizes measuring 5 to 50 km.

The tasks MISKAM was designed for are micro scale solving propagation models of few 100 meters in size. As MISKAM is modeling the physical processes it is perfectly suited to model small scale tasks in road construction and city planning.
Here the direct influence of the terrain and buildings is of big influence to the dispersion and transport of the pollutants.

MISKAM is a three-dimensional non-hydrostatic flow and dispersion model for local prognosis of wind distribution and pollutant concentration in areas ranging from roads to city districts. Originally the model was generated for micro-climate questions (Eichhorn, 1989), due to user requests it was later extended to cover the dispersion of car traffic pollutants on standard PC. MISKAM permits the explicit treatment of buildings in the form of rectangle cubes (3-D-Raster), so that the flow around buildings can be modeled realistically. In addition the authors attempted to create a model which straightforward applied the physics thus was able to model the dispersion with minimal use of empirical-diagnostics relationships.

MISKAM is built on the complete 3-dimensional motion equations for the simulation of the wind field and the advection-diffusion-equations for the dispersion of density neutral substances.

MISKAM Background Material

The microscale climate and pollutant dispersion model MISKAM is a complex physical model for small scale simulation of air pollutants. The model was developed at the Institute for the Physics of the Atmosphere of the German University of Mainz. The model was chosen by the German engineering association VDI as the only model fulfilling the VDI 3782/8 "Ausbreitungsberechnung für Kfz-Emissionen" (Dispersion simulation for car exhaust). Additional information are included in a translation of the description of the program author Dr. J. Eichhorn.

As the physics and executable code for MISKAM was developed by Dr. J. Eichhorn, it is advisable to directly contact Dr. Eichhorn at the University of Mainz for questions regarding the scientific content and support of the model. For questions regarding the data preparation and the graphics please contact your local SoundPLAN dealer or Braunstein + Berndt directly.

The following brochure introduces the numerical hydraulic- and dispersion model MISKAM. This advanced prognosis model can become an important tool in an ecologically oriented city planning, because it can simulate the air hygienical consequences of city planning measures before they are realized and be used in the selection of the optimal solution. Because of it's physically advanced modeling, the program can be used in a big variety of problems.

Motivation

The prognosis of traffic induced immissions is gaining importance. Today hardly any planning measure in city or traffic infrastructure planning can be undertaken without studying it's effect on the pollution load imposed upon the citizen (mean or peak concentrations). The assessment of air pollutants plays an important role and the tremendous costs of measuring programs force the planners to use simulations.

For some years the development of numerical simulation programs has been fostered as an accompanying measure to measurement programs. The tremendous developments in the computer hardware sector now allow the use of numerical
simulation models on a PC platform, that a few years ago were confined to the big university mainframes. In this light it is astonishing that government requirements are still only demanding the use of Gauss models (TA-Luft, MLuS) although their weaknesses are known. The VDI 3782 will change this trend and will lead to the use of complex models that simulate the conditions of complex terrain and in congested environment.

The model MISKAM from the included physical description offers the most advanced procedures amongst a number of similar calculation models. It was developed by the Institute of the Physics of the Atmosphere (sometimes known by it's old name Institute for Meteorology) of the University of Mainz. This Institute has been developing regional and local climate and dispersion models. Aside the continued development for this model the current focus is the regional climate model "KLIMM" (Climate Model Mainz). KLIMM will be focused for the simulation of regional climate conditions and air hygienical questions for a scope ranging from 5 to 50 km.

The scope of MISKAM is limited to small pollutant simulations where the size of the study measures in the range of a couple hundred meters. This qualifies MISKAM specially for simulations of small scale effects of city traffic infrastructure planning.

MISKAM is a 3 dimensional non-hydrostatic wind flow and dispersion model for the small scale prognosis of wind conditions and the concentrations of air pollutants in the vicinity of buildings and along roads. Originally it was developed for the assessment of micro climate problems, it's range was extended to enable the prognosis of air pollution concentrations along roads. Additionally, sedimentation and dry deposition of pollutants may be taken into account.

![Simulated air flow around a building](image)

Pic. 8-6: Simulated air flow around a building

Flow around a u-shaped building, horizontal wind field at a height on 2m. Inflow velocity is 5 m/s at a height of 10m. The building height is 28 m. The thick line corresponds to the circulation zone from wind tunnel experiment.
MISKAM Background Material SoundPLAN Handbook

Pic. 8-7: Air flow in the 3rd dimension

Pic. 8-8: Pollutant concentrations of above example

Distribution of a polluting gas from a point source at the center of the backyard. Normalized mass concentration (10^{-3} \text{m}^{-2}), the thick line indicates the 10^{-3} \text{m}^{-2} contour line as obtained from the wind tunnel experiment.

MISKAM allows the explicit processing of buildings in the form of rectangular block structures so that the effects of the air flow around buildings can be modeled realistically. MISKAM makes the attempt to simulate all effects from the physical causes on without the use of empirical corrections. MISKAM is based on the 3 dimensional kinematical equations for the solution of the hydraulic model and on the advection-diffusion-equation of density neutral substances. The flow model is the first step in solving the pollution questions, the dispersion constitutes the second part of it.

In the following overview an insight of the physical and numerical concepts of MISKAM is given.

**Physics of the Model**

To obtain realistic concentration distributions within complex building structures, care must be given to properly simulate the three-dimensional wind field. Therefore, the complete Eulerian equations of motion are adopted. Buoyancy effects, however, are neglected as well as the Coriolis force, which for the limited model sizes is of less importance. The set of dynamic equations reads

\[
\frac{\partial u_i}{\partial t} + \frac{\partial u_i u_j}{\partial x_j} = -\frac{1}{\rho} \frac{\partial p}{\partial x_i} + \frac{\partial}{\partial x_j} \left[ \kappa_i \left( \frac{\partial u_i}{\partial x_j} + \frac{\partial u_j}{\partial x_i} \right) \right] - \frac{\partial H}{\partial x_i} \]

\[
\frac{\partial H}{\partial x_i} = 0
\]
Pollutant transport is modeled by solving a transport equation for arbitrary mass concentrations

$$\frac{\partial c}{\partial t} + \nabla \cdot (\mathbf{v} c) = \frac{\partial}{\partial x} \left( K_m \frac{\partial c}{\partial x} \right) - Q_c,$$

where $Q_c$ denotes the sum of sinks, i.e. deposition at the ground, and sources of the mass concentration $c$.

The turbulent exchange coefficients are computed from a $k$-$\varepsilon$ model. Once the prognosis equations for the turbulent kinetic energy $k$ and for the dissipation rate $\varepsilon$ are solved,

$$\frac{\partial k}{\partial t} + \nabla \cdot (\mathbf{v} k) = \frac{\partial}{\partial x} \left( K_m \frac{\partial k}{\partial x} \right) = P_m + P_h - \varepsilon,$$

$$\frac{\partial \varepsilon}{\partial t} + \nabla \cdot (\mathbf{v} \varepsilon) = \frac{\partial}{\partial x} \left( K_m \frac{\partial \varepsilon}{\partial x} \right) + c_1 \frac{\varepsilon}{k} (P_m - P_h) - c_2 \frac{\varepsilon^2}{k},$$

are solved, $K_m$ is computed from

$$K_m = c_{\mu} \frac{k^2}{\varepsilon}.$$

For simplicity, $K_m = 1.35 K_m$ is assumed. Values for the empirical constants $c_{\mu}$, $c_1$, $c_2$ and $s$ are taken from Paterson and Apelt (1989). At the surface, exchange coefficients are calculated from the external Monin-Obukhov laws as specified by Clarke (1970).

The solution of the velocity field is carried out by using the well-known procedure described by Patrinos and Kistler (1977) who introduce an auxiliary velocity field which is free from dynamic pressure disturbance. The final velocity field is obtained by iteratively solving a Poisson equation for the pressure disturbance and substituting the results into the preliminary wind field.

Special care has been taken to simulate flow separation at building edges which has been a minor defect of earlier model versions. The method adopted in the present study is due to Paterson and Apelt and uses a zero longitudinal velocity at the upper front of the buildings. All other grid points near solid surfaces are treated as usual.

The prognostic equations are solved on an arbitrary scalable Cartesian grid. Upstream discretisation is used for the advection terms. In order to reduce numerical diffusion, however, the advection scheme proposed by Smolarkiewicz and Grabowski (1989) may be applied. The diffusion equations are solved by use of a standard ADI procedure. Finally, a SOR method is used to solve the Poisson equation. This method is known to be reliable but slow in comparison to newer techniques. Nevertheless, SOR has been selected because of its remarkably lower memory requirements thus enabling MISKAM to run on standard personal computers.

**Wind Tunnel Simulations**

A variety of wind tunnel experiments have been carried out by Klein et al. (1994) to obtain a data base for the validation of microscale models. A comparison of five different models, including MISKAM, as applied to the wind tunnel data was subject to a study by Röckle and Richter (1995).
Since MISKAM has been improved in various parts, several of these simulations have been repeated by the author. The following figures show results for the flow and pollutant transport around a U-shaped building. In Picture 8-6, the horizontal wind field in the lowest grid level is shown. A well-pronounced pair of lee-eddies is noticed as well as the reattachment of the flow about 50 m downstream of the building. This gives a recirculation zone extending roughly two times the building height. The wind tunnel measurements by Klein et al. imply a slightly larger recirculation zone.

Pollutant dispersal has been simulated for an arbitrary gas released from a point source located at ground level outside the backyard, at the centre of the backyard and above the building’s roof. Picture 8-8 shows a vertical cross-section of the normalized mass concentration $cU/Q$ where $U$ is the inflow velocity at height 10 m, $Q$ is the emission rate and $c$ the mass concentration with the source located at the centre of the yard. The simulation corresponds to the wind field shown in Figure 8-7. The dotted line represents the 10' $m$ contour line as obtained from the wind tunnel experiments showing an almost exact agreement of model result and measurement.

**Measurements of Traffic Induced Immissions**

Wind tunnel and model studies of pollutant dispersal have also been carried out for more complex building configurations representing parts of a large chemical plant at Ludwigshafen (F.R.G.). Details are given in the report by Röckle and Richter (1995). The present study will give an impression of MISKAM’s performance for a highly structured build-up by applying the model to an inner city roadway at Frankfurt. Model results will be compared to immission data that have been collected during a one-week measuring program carried out by the Centre of Environmental Research at the University of Frankfurt in conjunction with Lahmeyer International, Frankfurt.

A vertical profile of four equally spaced measuring points was taken as well as two additional ground level measurements, one near the entrance of a building facing the roadway, the other at the rear side of the building row, representing the undisturbed background conditions. The measuring site was located at the west side of the road. Since westerly winds were prevailing throughout the measuring period, highest immission concentrations had to be expected at the ground level data points. Therefore, the lowest point of the vertical profile was used as reference point. During peak hours (6.30 to 9.30 a.m., 3.30 to 7.30 p.m.), each of the measuring points was attached every 5 minutes. For the remaining time, an alternating scheme of 30 minutes measurements of the vertical profile and measurements at the reference point was used.

To obtain realistic emission rates as input for the numerical simulations, emission factors for different types of vehicles have been taken from a recent study (PROGNOS, 1993). Traffic data (number of vehicles per hour, fraction of different car types etc.) have been estimated from a traffic census carried out for one day of the measuring period.
Model Results

Preliminary results of MISKAM - computations of the immission distributions as compared to the measured data will be presented below. The simulations were carried out for Dec 8, 1994, covering the peak hours from 6 a.m. to 10 a.m. Picture 8-9 shows the time averaged mass concentrations for NO\(^2\) at the lowest grid level (1.5 m).

Computed NO\(^2\) concentrations (mg/m\(^3\)) at a height of 1.5 m at Eschenheimer Landstraße, Frankfurt Germany. Averaged values for Dec 8, 1994, 6 a.m. Open dots denote locations of ground measuring points, the solid dot denotes the location of the vertical profile.

As expected, maximum values are found at the lee-side of the roadway. A more homogeneous structure of the immission distribution results in those parts of the model domain where the flow field is less influenced by the building structure.

Since the model runs for the complete measuring period are not yet finished, only preliminary findings can be drawn concerning the quality of the model simulations. A first examination of simulated and observed concentrations for the period evaluated in Picture 8-9 shows a moderate overestimation of the observed mean values at ground level by roughly 15 %, while model results for the upper points of the vertical profile are lower than the corresponding observations. This discrepancy may be removed by properly specifying the thermal stratification as input for the numerical simulations.

To obtain a comprehensive impression of MISKAM’s quality, an evaluation of the complete experimental data set is required. Furthermore, model sensitivity to external parameters (thermal stratification, roughness of underlying surfaces etc.) must be examined comprehensively. Present results, however, indicate that MISKAM is a well-designed tool for practical planning purposes. This has also been concluded from validation experiments which have been carried out by other...
authors. For example, Bächlin et al. (1995), has tested various microscale models, including MISKAM, by simulating annual average concentrations of exhaust gases near an inner city road in Hanover / Germany. There has been a one-year series of measurements for the corresponding site which has been carried out by the German control organization TÜV. A comparison of observed and simulated mean values gives deviations of approximately 10% for the MISKAM simulations which agrees well with the results of the present study.

**Model Numerics**

The equations are discontinuous in their location, they are solved exactly for grid points of a Cartesian coordinate system. The grid mesh can be generated with different grid spacing in X and Y, and the Z-axis can be either equally spaced or the layers of the system can be individually placed.

---

**MISKAM and MISKAM-SCREENING under SoundPLAN**

MISKAM and MISKAM screening are both the same piece of software; MISKAM represents the full version and MISKAM Screening a “simplified” version that has several options disabled.

The differences are not rooted in the calculation procedures but rather in the declaration of the meteorology (wind statistics) and a reduced result processing for the MISKAM Screening.

**Assessment of the Emission**

The MISKAM program kernel implemented in SoundPLAN can only calculate the dispersion of emissions. The emission rates of vehicles and stationary sources must be defined by the user in [kg/hour]. In the past SoundPLAN offered an interface to the handbook for emission factors published by the German EPD. The EPD made it clear that it would violate their copyright to embed the emission factors directly into SoundPLAN. At the moment we are looking for an alternative source for the emission. However the emission factors very much depend on the local fleet, the engine size and the proportion of vehicles equipped with catalytic converters. Because of the local nature of the emission values the calculation of the emission rates needs to be established locally.

**Wind roses, weather statistics, processing results**

In **MISKAM SCREENING** the meteorology is defined and classified in 6 main wind directions (0°, 60°, 120°...) and their occurrence in percent of the time. The results are limited to the mean and the maximal concentrations (approximation of the 98%-percentile).

The full version (**MISKAM Complete**) in addition to the capabilities of limited version **MISKAM SCREENING** can calculate with any number of user definable
meteorological situations and can deliver more detailed analysis of the results of individual meteorological situations (pollution concentration, surface deposition and wind fields). These results can be presented in cartographically enhanced maps.

To ease the compilation of the wind statistics, the developers are working on tools to classify the 3D weather statistics.

Theory and Praxis

The 23 amendment to the German environmental law (23. Bausch) and the latest European guidelines in accordance with common measurement praxis define the 98th percentile as threshold values. They define for each reference time slots the percentage of cases permitted to exceed the pollution concentration threshold.

For a calculation in accordance to the German TA Luft (Technische Anleitung Luft/Technical Guidelines Air) this procedure seems suitable as it can handle a big number of meteorological cases. In regards to the emissions which can show distinctive day histograms, the TA-Luft itself can be sufficient.

Even for the more exact procedures of MISKAM the percentile assessment is only feasible with diminished accuracy. First of all the wind statistics that can be handled with acceptable simulation time on a PC requires the class size to be rough enough so that the size of individual classes are exceeding the 2% probability (>> 98 %-value).

Secondly as a general praxis the prognosticated pollutant emission is generated from the average daily traffic, which like TA-Luft and MISKAM does not detail the fluctuations over the day in a day histogram. In rush hour the traffic flow is about 2.4 times the daily average. In order to offer some help in this situation, the program supplies the answers of the mean value and the max value reflecting the ratio of the average and peak flow. The max value covers the permissible 2 % excess of the 98 percentile well enough so that the results are always on the safe side.

Obviously given enough calculation time and input data, the program can simulate the exceeding frequency of thresholds or can pinpoint the threshold of smell. For a fine enough resolution of the weather statistics (24 to 36 situations) a super fast computer system is mandatory as well as some patience. Often it is more sensible to simulate critical single situations and correlate their time resolution.

The calculation model: What MISKAM can do

From the point of view of the consultant the possibility of using a validated numerical model to obtain safe estimates of the expected pollution concentrations is promising. For once expensive measuring campaigns can be reduced and on the other hand the consistent coverage of an area is preferable to the point type results of measurements while exceeding the accuracy and scope demanded by law.

As long as the numerical model has a suitable user interface and facilities, a PC based model seems to offer a fast replacement of the complex procedures involving measurements, calculations and meteorological know how.
As is already apparent from the wording of the last paragraph, such a view contains many dangers. If a computer model is taking over too much of the work of a consultant, the effect can be that the consultant loses the critical eye for the results and accepts the results of the simulation without the necessary scrutiny. Because of this it is of great importance to be aware of the limitations of the model. This is reason for the next section.

MISKAM is suited for:

- Calculation of quasi-stationary wind fields in the vicinity of isolated buildings or in the range of structured settlements. Here it is noted that the structure of the settlement is only simulated with the finite resolution of the grid representing the buildings. The terrain is assumed as a plane, the elevations of all objects on this plans is adjusted automatically in accordance. By permitting 3D input data the same data as for a noise simulation can be reused.

- Simulation of the dispersion of the plume of density neutral non reactive substances in precalculated wind and turbulence fields from given source distribution.

- Assessment of the temporary mean values and percentiles from a collective for given wind fields.

- Comparison of mean and maximum values with text and threshold values.

For the calculation of the wind fields the effects of terrain and roughness length can be taken into consideration. The assignment of the roughness length to individual grid cells at the moment is only possible as a constant for the entire model. In the future areas of equal roughness length will be permitted (specially for big scale simulation).

Wind direction and speed statistics are obtained by superimposing singular results. The weighting in part can be changed at a later stage.

A further parameter relevant for the flow is the thermal layering. For the entire model the laps rate is constant and is entered as the vertical gradient of the potential temperature. The influence of the layering is given in a reduction of the turbulent exchange for stable layering as well as an intensification for labile conditions.

Aside from the source distribution the effect of sedimentation and deposition are used to simulation of the pollutant dispersion, so that an estimate of non density neutral substances is possible. Both processes are controlled by assigning characteristic constant vertical velocities to substances.

The speed of sedimentation is superimposed to the vertical wind velocity in the advection calculation. In addition the deposition speed determines which proportion of the transported substances are deposited on ground and buildings and thus are removed from the atmospheric transport mechanism. Both speeds shall be understood as pollutant specific constants and need to be entered by the user in an appropriate manner.
What MISKAM cannot do...

... but how SoundPLAN can support you in your effort.

The processing capabilities listed in the last paragraph make MISKAM a versatile tool in city planning and road and infrastructure developments.

With all tools built into MISKAM it needs to be understood that it cannot be regarded as a black box but rather a tool that requires considerable amount of thought and work. Uncritical acceptance of the results shall be avoided.

The following tasks of the numerical simulation are not carried out by MISKAM automatically but are supported by SoundPLAN:

- Generation of a discrete grid optimally fitted to the calculation area (3D-grid). The definitions and specially the fitting of the grid to the topographical and building situation is a task demanding the understanding of the consultant. Specially in the cases where the exact representation of the buildings is not possible. 
  *In SoundPLAN only the grid spacing is required, the buildings and sources are fitted to this raster structure. Checking the results visually is supported by the program.*

- Terrain elevations are not supported, where the terrain is mandatory (at a steep slope of a hill) the terrain can be approximated by buildings. Local wind components in reality triggered by the thermal effects of the slopes cannot be simulated on the PC successfully. The wind effects near slopes however can be incorporated into the model by including them into the wind statistics that drive the wind field generation. This way the pollution concentration near slopes can be approximated.

- The positioning of sources and the definition of the source is a task for the user. Here it needs to be observed that the sources need to be incorporated into the 3D-grid and that they not necessarily are placed at the elevations defined in the SoundPLAN Geodatabase.
  *The placement of SoundPLAN-Objects in the 3-D-grid is automated by SoundPLAN.*

- MISKAM does not supply any emission rates. The emission rates are part of the modeling expertise of the model user who needs to explicitly define the define all grid cells containing sources.
  *Here as well SoundPLAN automates the transfer of the sources to the grid representation. For road traffic the emission is taken from the properties of the road object. The selection of pollutants is confined to the pollutants mentioned in the German MLUS. Additional pollutants for industrial sources can be defined via the pollution library. The research of the pollutant characteristics like depositions speed and sedimentation speed lays in the hands of the user.*

Hints to the calculation of the emissions from traffic sources: The program HBEFA can be obtained from Infras, Mühlemattstraße 45, CH-3007 Bern. For the simplified calculation of the emission the TÜV Automotive GmbH, Kaiserstraße 100, 52134 Herzogenrath, is offering an alternative Access-Datenbase Mobilev. Here as well the copyright resides with the UBA (German Environmental Protection Agency)
The superposition of wind statistics used in multiple MISKAM runs needs to be accomplished by superimposing the weighted results of the individual calculation runs.

Here SoundPLAN is helping by evaluating the different SoundPLAN Meteorology files created by you.

Finally it remains the responsibility of the user to define sensible fields of receivers and interpret the results in a correct manner.

Aside the requirements mentioned in the last paragraph, MISKAM users need to accept additional imposed by limitations of the model itself. Following is a list of modeling aspects that so far must be left to future:

- Thermodynamic processes (energy transfer between different media) involving the heat exchange between the earth surface, walls and roofs of buildings and the air as well as thermal expansion and evaporation with its cooling cannot be handled by the model as the memory requirements and the calculation time would surpass the capabilities of the PC.

- MISKAM does not regard any of the chemical processes happening in the atmosphere. Of special regards for traffic induced pollutants would be the conversion of NO\(_x\) to NO\(_2\), for which the empirical relations are known. The model did not incorporate the equations because the accuracy would be questionable and it is possible to deduce the concentration from the concentrations of the base components.

  SoundPLAN is using the Romberg-Function for the NO\(_2\)-conversion rate from NO\(_x\).

Modeling the plume dispersion without regarding the thermodynamic is certainly reducing the usability and accuracy of the model because for certain situations these effects can have a big influence (for example street canyons with asymmetric exposure to the sun). In the average concentrations for an entire year these effects will hardly be identifiable so that one of the most pronounced usages of the model is not restricted by it.

For the calculations of rows of meteorological scenarios the thermal effects can be ignored as well as the studies most likely are undertaken for critical air hygiene situations (worst case scenarios). For the near ground concentrations the most prominent thermal influence, the layering is incorporated in the calculation of the turbulent diffusion coefficients.

This listing insinuates that the scope of MISKAM is very narrow. In praxis the spectrum however covers almost all air hygienic aspects needed such as the annual average, percentiles and peak. To accomplish these tasks MISKAM requires the competent and careful cooperation of the consultant. If all considerations are met, MISKAM delivers results that are reliable and trustworthy.

Additional information regarding the MISKAM model can be found in the VDI – guideline 3782 sheet 8 (green print). In this VDI paper MISKAM is recommended for air hygienic assessments.
MISKAM project flow under SoundPLAN

Working MISKAM within SoundPLAN for the most part is self explanatory once you have mastered the first steps with help of these short instructions.

Object Types for MISKAM in the Geo-Database

As a SoundPLAN new user please familiarize yourself first with the basic functions and procedures of the Geo-Database. After having understood the structures and gained the first experience with the Geo-Database, please proceed here.

MISKAM and MISKAM-SCREENING make use of three different object types: calculation area (grid/raster definition), roads (emission) and buildings (flow obstacles). The full version MISKAM in addition to these objects can handle the type MISKAM point pollution source (emission of pollutants) for the definition of point type emissions of any pollutant. In the future MISKAM will be retrofit with line and area emitters. In addition both MISKAM and MISKAM Screening will receive an object for the local definition of terrain roughness (vegetation, undifferentiated buildings etc.).

Calculation area MISKAM

(MISKAM and MISKAM-SCREENING) The MISKAM calculation area defines how the simulation area is split into three dimensional grid cells. The entire simulation area is comprised of the inner equidistant grid for which results are generated and the outside area which is automatically added by SoundPLAN to cope with the transient effects at the edges of the calculation area (in the Geo-database displayed as a frame). The calculation grid always is rectangular and therefore can be hinged to a single coordinate (on screen the lower left corner of the area). Properties automatically requested after entering the calculation area finish the definition.
**Explanations of the property screen: tab GRID:**

Definition of the grid spacing for the inner area for which results shall be generated

- **No:** number of grid cells in x or y-direction
- **Dist:** size of grid cells
- **Length:** (passive, cannot be edited) size of calculation area derived dist from No and dist in x/y-direction

Definition of grid cell size for the expanded area which is needed for the calculation but does not yield visible results. (transient area size)

- **No:** number of additional grid cell rows / columns (recommended: 5-10)
- **Factor:** the width/height of the additional cells can be scaled with increasing distance from the central area without compromising the accuracy of the calculations. This way the transient area can be enlarged without consuming too much memory. The parameter can be varied between 1.0 and 1.99 with the data entry only geared for the digits after the decimal.

**Rotation of the calculation area**

- **Rotation:** angle measured against the clock (mathematically positive) 0° is to the right = positive x axis.

**Explanations for the property screen: tab Layer:**

Definition of the vertical component of the grid (layers)

- **Layers:** number of layers in the grid (= number in the 3rd dimension)
- **Height:** can be selected equidistant for all layers and then be corrected once the checkbox “equidistant” is deactivated. This is wise so that the top of the calculation grid is in the undisturbed flow. The entry is always representing the top of each layer relative to the terrain.

![MISKAM calculation area Properties](image)
What needs to be considered when building the model?

For the building configuration the following specifications need to be met:

- The height of the highest building after converting it into the raster shall not exceed 30% of the total height of the model (set the numbers of layers and the succession of heights accordingly).

- Inside the expanded calculation area the outermost 3 rows and columns need to have an identical setting of the obstacles. The horizontal grid resolution in this area must be constant as well. In doubts an obstacle free border is preferable to a border where buildings are cut. In order to automate the transition of SoundPLAN noise data, this procedure is incorporated automatically.

- To make sure that sensitive single point receivers are out of the transient area, they should be located at least 10 rows/columns away from the border (here again the expanded area counts).

- Grid cells containing sources are not suited for as reference receivers for the comparison to the pollution limit. If possible the grid spacing should be reduced.

- For the calculation pollutant concentrations in prominent street canyons, the street canyon should at least contain 6 grid cells across, preferably even more. Assessing entire residential areas often cannot be performed with such a resolution, it would exceed the memory of the PC. In this case it is sensible to first calculate a rough screening calculation and then pick the critical areas to perform a calculation with increased resolution. For certain evaluations of traffic scenarios the rough resolution might even be sufficient to pinpoint the differences of planning variations.

If only a single street canyon is in the simulation, it is preferable to rotate the grid so that the street is parallel to the rows or cells of the grid.

In the area that is used to map the emissions the grid size shall be small in comparison to the size of the buildings, in the expanded area the relationship does not matter this much as this area is only added in order to keep the transient area out of the visible range. Buildings can be modeled with a resolution as low as ±1 m, complex buildings and roof structures can be simulated by generating complex interwoven buildings. As the buildings are only used to “fill” 3D grid cells, multiple buildings at the same location is not a problem as it can be in the acoustics calculations.

In the non displaying expanded area the buildings need to be digitized with an accuracy of ±20%. In this area it is not needed either to simulate the different forms of roofs, buildings can be digitized as blocks where the height is a compromise between the drain and the ridge.

For a rough screening calculation as is the domain of MISKAM Screening, the grid cell size can be much bigger, thus a much larger area can be simulated. If critical pollution loads are discovered in some part of the screened area, a closer look with higher resolution can pinpoint this area in a second stage.
Object type Road

(MISKAM and MISKAM-SCREENING) You can use the same roads that you may have already generated for the acoustical calculation. The property declaration for the roads contains a tab for the definitions of the road exhaust components. Here you can define the pollutants per km of road per day in kg. The pollutants for the calculation are CO, HC, C6H6, NOx, Pb, SO2, PM.

Aside from the pollutants the dimensions of the road must be defined in the tab PROFILES. The emissions are dispersed by MISKAM over the entire road width.

Find more information on the road properties on page 117.

Object type Buildings

(MISKAM and MISKAM-SCREENING) In general you can reuse the same buildings here as were used for the noise calculations. For the refinement of the geometry it may be wise to open the situation manager and generate a copy of the geo-file from the noise calculations so that specific roof forms can be generated by stacking multiple buildings on the same spot. The data entry of this object type is described in the handbook. Of all object properties only the height of the building is used.

MISKAM-Source

The MISKAM-source is only available in the complete version of MISKAM. At the moment this object is only supplying point pollution sources, future extensions to cover line and area sources are planned.
The library has facilities to enter pollutants or pollutant cocktails that might be used in this or future projects. For the definition of the pollutants the name, abbreviated name and the parameters for the sedimentation speed and deposition speed (for particles and aerosols) need to be entered here. In the left part of the property tab select the component from the library and enter the amount of pollutants in mg/second.

Evaluation criteria such as concentration limits and the threshold for odor will be incorporated into the library in the future.

At present the assessment parameters get incorporated into the selection of scales colors when the data are selected for plotting. Green colors for example can be chosen to depict uncritical concentrations and yellow and red for critical areas.

Pollutants not found in the library can be entered after opening the library with the double arrow on the bottom of the screen.

For each source the height of the emission above the plane needs to be defined in the box Chimney extra height. The thermodynamic extra rise of the plume must be included in this figure.

**MISKAM in the Calculation Core**

After you have familiarized yourself with the principles of the run file, you can generate a new run file and start with the definitions for the calculation. Please observe that the result file numbers shall be unique numbers used only once in a project. A MISKAM calculation No. 1 otherwise would destroy the databases of the acoustical calculation No.1.
Calculation definition for MISKAM-SCREENING

In the Run File open the properties and click on the tab General. Here select the Calculation type MISKAM Screening.

In the **tab MISKAM Screening** select the pollutants that shall be evaluated in the calculation all pollutants that were assigned to the roads are available.

Now enter the parameter for the stability of the atmosphere with the vertical temperature gradient in degrees Kelvin per 100 meters. The vertical temperature gradient often called the laps rate shows the cooling in the layered atmosphere caused at large by the changes in pressure with increased altitude. (gas law \( p_1*T_1 = p_2*T_2 \)) As the screening version always attempts to be on the safe side, the setting for the laps rate of 0 degrees will be a stable layering which is associated with high pollution concentrations.

In the next section the wind statistics need to be defined. In MISKAM Screening 6 different wind directions can be weighted with their contributions. The columns for velocity and the wind measurement height are automatically applied to all wind directions. When the worst case situation is evaluated for the wind speed, this will produce results of sufficient accuracy for the screening procedure.

Finally the **tab Description** should be used to describe the calculation intention and the parameters that were assigned.
Calculation definition in MISKAM

In the run file open the properties and select the MISKAM option in the General tab.

The tab settings contains 3 groups. The first one is for pollutant selection. Here you select the pollutants that should be simulated. Only pollutants that are used in the project can be activated, however it may happen that an error message appears indicating that a certain (or more than one) pollutant is not present in the calculation. This may be caused by the pollution source laying outside the scope of the calculation grid. Only pollution sources inside the frame of the expanded area will deliver input into the calculation.

After the pollutant selection 3 Emission parameters are requested. The portion of partial emission and the forecast year at the moment are deactivated as they are in reference to the Handbook for emission factors for road traffic, which is not implemented at this point of time (there are licenses questions with the German EPA)

The factor for the hour with the heaviest traffic is an adjustment factor between the average hourly traffic based on the 24 hours of the day to the peak traffic at rush hour. This factor in general is 2.4 of the average. The peak hour has 10% of the daily traffic. If no more detailed data are available, please use this value. The peak hour adjustment is used in the calculation of the 98 percentile.

In the box Met-File select a wind statistic. This statistics must be user generated from the data obtained from the nearest weather station. The double arrow leads to the library where multiple weather statistics can be generated and stored.
For each weather situation please enter the measurement height of the reference station, wind direction, wind speed and the vertical temperature gradient in °K.

In the next step the MISKAM specific parameters must be defined in the tab MISKAM.

Here 3 boxes are awaiting your input, defining the terrain roughness used in the simulation, a propagation iteration parameter and what data shall be stored for each calculation.

The box for the roughness at the moment is passive, so far MISKAM can only handle a homogenous roughness. The roughness in general is used to approximate the turbulent influence of obstacles on the terrain that is not incorporated explicitly in the calculation. Vehicles, shrubs and trees are all contributing to the roughness. The preset 10 cm is the average value found in an urban street canyon.
For each entry set in the wind statistics MISKAM is going to perform a simulation of its own with a wind field and concentration grid maps. If only the final results are desired, the check boxes for wind fields and immission are not needed, they would invoke the program to store all intermediate results which can be used in a more detailed analysis later on. The influence on the amount of data can be tremendous as is shown in the attached table for the following parameters: 20 calculation layers, a meteorology file with 36 cases and 6 pollutants:

<table>
<thead>
<tr>
<th>Displayable wind fields</th>
<th>Wind field results: [off] Immission results pollutants: [off]</th>
<th>Wind field results: [on] Immission results pollutants: [on]</th>
<th>Wind field results: [off] Immission results pollutants: [on]</th>
<th>Wind field results: [on] Immission results pollutants: [on]</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>20 layer x 36 cases = 720 scenarios</td>
<td>-</td>
<td>720 scenarios</td>
<td>Wind field</td>
</tr>
<tr>
<td>Displayable maps for the pollutant concentrations</td>
<td>-</td>
<td>6 pollutants x 720 wind fields = 4320 scenarios of concentrations</td>
<td>4320 scenarios of concentrations</td>
<td></td>
</tr>
<tr>
<td>Possible mean value maps generated for pollutant concentration</td>
<td>6 pollutants x 20 layers = 120 scenarios mean concentration</td>
<td>-</td>
<td>120 scenarios mean concentration</td>
<td></td>
</tr>
<tr>
<td>Possible maximum value maps generated for pollutant concentration</td>
<td>6 pollutants x 20 layers = 120 scenarios for maximum concentrations</td>
<td>-</td>
<td>120 scenarios for maximum concentrations</td>
<td></td>
</tr>
<tr>
<td>Total:</td>
<td>240 possible maps for 100 x 100 grid cells: 2,400,000 values stored</td>
<td>720 + 240 = 960 possible maps for 100 x 100 grid cells: 9,600,000 single results stored</td>
<td>4320 + 240 = 4560 possible maps for 100 x 100 grid cells: 45,600,000 single results stored</td>
<td>4320 + 720 + 240 = 5280 possible maps for 100 x 100 grid cells: 52,800,000 single results stored</td>
</tr>
</tbody>
</table>

This example shows that you should activate single detail results only for selected calculations as the project otherwise would grow to a size that is not manageable any more.

Last not least there is a comment tab for the description of what was simulated. Next it would be wise to store the calculation settings and open the Graphics Tab of the complete calculation run.

**Hint:** If you want to delete all files of a MISKAM calculation at a time, go to the module Result Tables, select the desired result in **FILE -> OPEN** and press the key **DEL**.
Graphics tab index card in the run file

The graphics tab shows the model data as they will be used in the MISKAM calculation. As soon as the calculation starts the grid mesh generated by MISKAM is displayed. Source representation and the buildings can at least be controlled in the plane.

When you start the calculation the cursor is displayed as the hour glass indicating that the system is busy. Nonetheless you still can move between the run file, log book and graphics.

MISKAM in the Graphics

Please familiarize yourself first with the general procedures of the Graphics. The handbook explains the details.

MISKAM-results can only be displayed graphically. Here each of the calculation layers can be displayed in all variants as a Grid map, as number, color grid or contour line map. For the display of each wind field for each meteorological situation a wind vector can be displayed for each cell.

In the graphics module you can select at data loading time to display the "wind field map MISKAM" or the „Concentration map MISKAM“.

To display a wind field you need to select the meteorological scenario and the layer. Additional data for presentation can be loaded at users discretion.

Hint: In MISKAM-SCREENING wind fields cannot be displayed as the single scenarios are not stored. If the check box “Wind fields” is not marked no wind fields can be presented.

For the pollution concentration presentation the selection is more plentiful:

Select the pollutant and select either mean value, maximum value, meteorology case or odor.

Hint: In MISKAM-SCREENING the selections “meteorology case” and “odor” are not available. When no single situation for the pollution concentration was stored, meteorological case and odor are void.

Under the keyword „odor“ the presentation of the excess frequency of a threshold value is prepared. The threshold value is requested in the same box. According to this procedure for each of the grid cells the program checks how many of the calculated scenarios lead to an excess to the threshold value. Instead of the odor threshold you can enter the percentile threshold and receive the results of how often this threshold has been violated. The generation of a suitable color scale (for example for the P98: values > 2% -> red color otherwise green) depicts the excess of the threshold very clearly.
15 Technical Acoustics in SoundPLAN

Overview

An acoustics or noise consultation project includes modeling, calculations, concepts for improving the noise situation, documentation and assessments, the investigation report and the graphical presentation.

The modeling, calculations and assessments are based on norms and standards defined in ISO and other standards reports. In the normal text you will find many references to calculation methods, most of which are derived from use of the German standards for road, rail and industry. Notes are included if a standard deviates from general practice. How a particular standard defines a specific detail is written in specialized chapters.

In the modeling section, you will convert a real life situation into an abstract model which SoundPLAN will use to automatically process the data and calculate noise levels. The type of calculation depends on the specific consulting task you want to perform.

Types of Receivers

The different map types need different receiver types plus additional specifications. In general, the calculations are the same for all map types. The Grid Noise Map has some special requirements for calculations close to buildings. Calculations in buildings are suppressed. All calculations scan the geometry for 360 degrees and include reflections of all buildings.

The Facade Noise Map, City Noise Map and the single point calculation are the same in its algorithms. For single point calculations the user gives in the receivers and assigns them to the building. For the calculation of a Facade Noise Map the receiver locations are automatically calculated. SoundPLAN disables the reflections at the own facade. For City Noise Maps, the receiver locations are defined automatically during a triangulation process.
4 Types of Receivers

- Single point receiver
  - Top view
  - Angle of incidence

Facade noise map with several floors

- Top view
- Side view
- Distance
- 2 floor
- 1 floor
- Ground floor

Grid points for a defined elevation above the terrain

Grid points in a defined vertical cross section

Different types of receivers

Physical Descriptors of Noise

The units for noise measurement are dB(A). The descriptor in brackets (A) indicates the noise level is corrected to suit the human ear which is not linear like a sound level meter but is frequency dependent. Most of the time dB(A) refers to the $L_{eq}$, the energy equivalent noise level. In some cases (UK road noise), the descriptor is the $L_{10}$ which is the noise level exceeded 10% of the time. In the literature for the assessment of noise events, the statistical descriptors $L_5$ and $L_{95}$ are also known. The maximum noise level, $L_{max}$, is also a descriptor used in some standards (Rail noise Scandinavia).

Noise levels like the $L_{max}$ and the $L_{10}$ are difficult to obtain from a calculation if no special provisions are made for them. The $L_{max}$ for train noise, for example, describes the maximum noise level from the loudest train. It is obvious that on a 2 track rail line there is a chance that two trains meet somewhere. In this case, 2 trains would cause an increase of 3 dB. As these levels are statistical descriptors, the nature of two trains in practice is not relevant.

From Levels to Rating Noise

Often the pure noise level a piece of machinery creates in a factory is not as important as the rated noise. The first part of the assessment is the adjustment of the machine's operating time per hour or events per hour (i.e. a press). The $L_{eq}$ is adjusted to the operating time.
Along with the calculation of noise levels for 24 hours, different time penalties need to be considered. In most places, the noise limits at night are 10 dB less than during the day. Some places have penalty factors for morning and evening hours. SoundPLAN processes the hourly $L_{eq}$ and then rates them in accordance to the required descriptors.

Descriptors for noise rating (or noise assessment) can be the $L_{eq}$ for day and night, or the loudest hour at night, the SEL, the NEF or others. SoundPLAN is delivered with several noise assessment standards. The definitions can include multiple time slots and penalty times. The noise assessment standard of choice needs to be selected.

### Modeling the Real World

Noise measurements have been performed for many years and still need to be used to assess the sound power of machines. For anything to be measured, the object must be present. For a simulation, a physical phenomena has been abstracted to a mathematical model which can be applied to imaginary situations.

If the simulation shows the noise levels are unacceptably high, the proposed solutions can be tested by changing the model and studying the results. Models are usually not a complete description of the reality as only the main aspects are described. This is true of acoustic simulations as well. The atmospheric aspects are included only in a very rudimentary form.

As models are not a complete description of the real world, the models need to be constructed as carefully as possible and calibrated with measurements.

### Physics Versus Standards

One would assume that the principles of physics are the same world wide. The principles might be the same, but the interpretation of acoustical phenomena is not the same! The physical laws of acoustics were studied at different times in different countries. The equations derived from these studies were written into standards which everyone should follow. The initial developments began at a time when the engineer's tools consisted of slide rules and nomograms rather than computers. This demanded some acoustic aspects to be simplified as much as possible.

SoundPLAN is a standards based application guaranteed to fulfill standards to within 0.2 dB or less. SoundPLAN's representation of the physics will be as good as the standard selected.

### Calculating Principles

This section in the handbook is written for the SoundPLAN user who is not completely familiar with acoustics. Some explanations will seem obvious to the expert, but there are some hints concerning how SoundPLAN interprets propagation details.

As noise maps are created from single point calculations, it is very important to describe the noise level calculation process for single receivers. All sources are
independent and can be calculated separately. Results of all source contributions can be added to the immission level using the formula:

$$L_{i,\text{sum}} = 10 \times \log \left( \sum \left(10^{L_i / 10}\right) \right)$$

The single source contribution can be described by

$$L_i = L_w - C_1 - C_2 \ldots C_n$$

with $L_i = \text{immission level at the receiver}$

$L_w = \text{sound power (or equivalent)}$

$C_1, C_n = \text{coefficients describing different propagation aspects}$

The sound level at a receiver is derived from the sound power and the propagation. The propagation coefficients are spreading, air absorption, screening, ground effect and reflection.

**Source Emission**

Noise can be emitted from various sources, most of which you can calculate with SoundPLAN. Sources include roads, railroads, airports, point, line and area sources inside and outside buildings. All sources have their own definition for emission data and other descriptions. For road, railroad and aircraft noise, SoundPLAN contains a source model calculating the sound power or a derived value from the traffic data. Industry noise requires use of measured data. The emission data defines the next section of geometric data.

The source type determines the source geometry entry. A point source needs only one coordinate. A line source is defined with at least 2 points. If more than 2 points are chained together, SoundPLAN assumes there is a continuous poly line. An area source requires at least 3 coordinates. As long as the area is defined as one plain, SoundPLAN can accept any number of coordinates for the area source. If the source is not on one plain, you need to divide it into smaller source polygons with each polygon on a plain. If area sources contain more than 3 coordinates, SoundPLAN separates them into a series of triangles at loading time.

The second limitation for line and area sources is that the condition within the source needs to be uniform. If there is a change in traffic volume or speed, there is also a change in noise emission and thus a new source definition is necessary.

Roads, railroads and industry sources are only definitions of noise emission. If the road is on an embankment, the embankment may act as a shield for other sources.

**Spreading**

The sound power definition is based on the energy distributed over a sphere with a surface area of one square meter. As the distance from the source increases, the surface of the area of the sphere also increases. With the rule $\text{Area} = 4 \times \pi \times R^2$ the spreading of a sphere at any distance from the source is set to: $10 \times \log \left( R_0 / (4 \times \pi \times R^2) \right)$. In most cases, the distance $R_0$ and $4 \times \pi$ are substituted with 11 dB and the square of the distance is taken in front of the equation. The division in the log is replaced with a multiplication by -1 so the resulting formula is $-11 -20 \times \log (R)$. 
Spreading

\[ \Delta L_{\text{Distance}} = -11 - 20 \times \log(\text{distance}) \] only applies for point sources and only if the propagation is uniform over the whole sphere. The law of spreading is different for line sources and area sources.

Geometrical spreading

\[ 6 \, \text{dB} / \text{doubling distance} \]

Spreading for a point source

When the line of a line source is much longer than the distance from the receiver to the line source, the spreading is calculated from the line and increases only in 2 dimensions. With increasing the distance the characteristics of the propagation gets closer to a point source.
Spreading for a line source

A receiver inside the area source will receive a constant noise level. Outside the area source, increased distance slowly changes the characteristics to be more like that of a point source.

Spreading of an area source

All industry noise standards evaluate spreading with $20 \log_{10}(\text{distance}) + 11$ dB. The calculation methods for railroad and road tend to calculate the spreading with a formula derived from experimental data. As air absorption usually is not included, the term spreading accounts for it. Details concerning spreading for the different standards can be seen in the sections on standards formulas.
Air Absorption

Air, like any other medium, does not permit sound waves to propagate without loss. The losses depend on the frequency, temperature, relative humidity and air pressure. As far as the calculation standards are concerned, when air absorption is not implicitly calculated in the spreading, there are three different methods used to evaluate air absorption:

<table>
<thead>
<tr>
<th>Standard for air absorption</th>
<th>Date the standard was issued</th>
<th>Calculation method preferring the air absorption method</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANSI 126</td>
<td>1978</td>
<td>Nordic General Prediction Method for Industrial Plants</td>
</tr>
<tr>
<td>ISO 3891</td>
<td></td>
<td>VDI 2714 / 2720 ÖAL 28</td>
</tr>
<tr>
<td>ISO 9613 Part 1</td>
<td></td>
<td>ISO 9613 Part 2</td>
</tr>
</tbody>
</table>

ISO 9613 is the most recent and most flexible standard. The values are calculated from formulas derived from the relaxation curves of nitrogen and oxygen. Temperature, moisture, frequency and pressure are input parameters for the calculation. ISO 3891 is partly from tables and partly interpolated with a formula. ANSI 126 is only available in table form. The accuracy of one method compared to another is unknown. However, as ISO 9613 has the latest publishing date, it is probably the most accurate method.

SoundPLAN allows you to choose the method you want for the standards with air absorption by selecting the appropriate setting. If no other conditions are defined, SoundPLAN will use the following default conditions:

<table>
<thead>
<tr>
<th>Acoustical Standard</th>
<th>Temperature</th>
<th>Relative Humidity</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Prediction Method for Industrial Plants</td>
<td>15 degrees Celsius</td>
<td>70 percent</td>
</tr>
<tr>
<td>VDI 2714 / 2720 ÖAL 28 / 30</td>
<td>10 degrees Celsius</td>
<td>70 percent</td>
</tr>
<tr>
<td>ISO 9613</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Concawe</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

When sources are associated with an octave band, all frequencies higher than 1999 Hz result in the lowest third octave value of the band used for the frequency. As the ANSI 126 is only given in table form prepared for octave bands, the values are inserted directly.
**Air absorption**

**Screening**

Screening occurs when a sound wave is diffracted around an edge. Screening can be around horizontal and vertical edges, but the default assessment in SoundPLAN is only over an obstacle. In the industry standards, the horizontal screening can be activated by activating the appropriate field. The function evaluating the screening is given the parameters of frequency and extra path length.

The principle of the extra path length

![Diagram of screening principle](image)

**Screening over a single obstacle**

The extra path length is the extra distance the sound has to travel over the obstacle. (distance source to screen) + (distance screen to receiver) - (distance source to receiver). For bigger distances, the extra path length leads to an overestimation of the screening effect. This is due to the atmosphere. As the air pressure decreases with increasing altitude, the atmosphere itself is bending the sound waves back to the ground. This means that the sound is traveling on a curved path and not in a straight line. For bigger distances, the extra path length for the curved path is much smaller than linear connections from source to receiver via the screen would allow.
How a standard interprets the physics determines how the effect is managed. Details are listed with the standards.

The screening effect itself is best described with the Fresnel number theory. However, many standards use formulas derived from measurements that do not allow direct comparison to the theory.

In SoundPLAN, diffracting effects can be found from screens, elevation files and reflecting objects.

In normal operations, SoundPLAN evaluates the diffraction over a screen. Diffraction around obstacles is only processed if the calculation standard has made provisions for it and if you have told SoundPLAN to calculate the side diffraction. (For big noise maps, this option would greatly increase calculation time and produce minimal changes in the results.) Screens are active even when the height of a screen is set to zero.

Elevation lines have a very similar function, but there are some changes. Elevation lines act as screens only when they produce a positive extra path length, whereas screens for most standards cause a screening loss even if the line of sight is not interrupted. Screens, in contrast, have no direct influence on the ground effect. (In the Nordic Methods there is an indirect influence). Most standards regard the average height of the line of sight above the terrain as the measure for their ground effect. In the next section this is also the case.

Screening and ground effect

a) Ground effect without screening is present. The average height above ground increases from floor to floor.
b) The screen shields the ground floor, and the rest is ground attenuation. The screen for the 4th floor is irrelevant. The result is identical to situation 'a'.

c) There is screening for the ground floor. The result is the same as in situation 'b'. For the 4th floor, the average elevation is raised causing the ground effect to be different than situation 'a'.

When you prepare a noise calculation, remember that the models calculate the sum of many different contributions. When a single contribution is slightly inaccurate, the overall result won't change drastically. Today's survey methods allow the civil engineer to manage coordinates that are minute in difference and very close together. You do not need to feed data with very fine resolution into the model. If you abstract the model, which eliminates a lot of small details, the average remains the same. The models need to be abstracted to increase speed without sacrificing too much accuracy.

Use Elevation lines for  
Describing terrain features, small mounds and hills  
modeling the landscape  
Defining cut and fill situations for road and railway

Use Screens for  
Walls and screens that do not raise the average contours. Tops of  
Buildings

Recommendation: As elevation lines are evaluated for screening and ground effect, it is recommended to generate the basic model of the terrain with elevation lines. If you intend to design and optimize noise screens afterwards, you can always copy the coordinates from the elevation line file into the screen file.

Horizontal Screening / Side Diffraction

As mentioned above, a sound wave is not only traveling over an obstacle but also around it. SoundPLAN only processes the side diffraction for standards that have explicit provisions for the side diffraction. As the calculation time with side
diffraction is often twice the time without it, you must tell SoundPLAN to calculate the side diffraction.

**Horizontal Diffraction**

![Diagram of horizontal diffraction](image)

**Principle of side diffraction**

SoundPLAN calculates the path around buildings and screens for the side diffraction. Only objects directly connected from source to receiver are evaluated. The side diffraction is evaluated by placing a rubber band around the obstacles that are found between source and receiver.

The following sketches show the range of operation of the algorithms used. Buildings are only evaluated if they are dissected by the direct connection source to receiver.

**Side diffraction for buildings**

![Sketches of side diffraction](image)
Side diffraction differences elevation line versus screen

(a) Only the building with the receiver attached is evaluated for the side diffraction. When the "rubber band" stretches over the second building, it is not found.

(b) If you want the annexed building to be part of the path evaluation, you must connect the two buildings.

(c) The screen between the buildings is processed and the "rubber band" placed around it.

(d) The line between the buildings was defined as an elevation line which causes SoundPLAN to ignore it. Only screens and reflecting objects (buildings) are evaluated for the side diffraction.

SoundPLAN only regards the side diffraction for the direct interaction of source and receiver. For reflected noise, only the direct, vertical diffraction is evaluated.

**Ground Effect, \( K_{\omega} \), Directivity**

A sound wave traveling across the ground interacts with the ground. The wave is reflected and absorbed and interferences between the direct wave and the reflected wave can occur. The diversity of answers concerning the ground effect is greater than any other aspect. Some standards (all German standards) disregard the ground absorption coefficient and handle propagation over a field the same way as over a lake. The ground effect only depends on the distance from source to receiver and the average height of the line of sight above the ground.

The other extreme is found in the Nordic General Prediction Method for Industrial Plants, where the ground effect is split into source, middle and receiver dependent effects for the ground reflection and absorption.

The interaction of screening and ground absorption is another area where big differences are found in the standards.

Another controversial issue between the industrial standards is an effect that the Nordic standards associate with the ground effect, and VDI 2714 / 2720 and ISO 9613 declare as an addition of constants to the spreading. The “Spreading” for a point source was defined on page 372. If the source is close above a reflective surface, the propagation is not spherical, but a half sphere. The VDI school states that all energy is reflected on the hard ground thus doubling the sound levels for the rest (addition of 3 dB). If the source is located on a wall, the propagation is a...
quarter sphere, doubling the noise level for the rest of the propagation again by adding 3 dB(A).

The addition, which can be 0 dB for a point source high in the air or 3 dB closer to the ground, increases by another 3 dB if the source is located close to a wall. The addition is labeled $K_\Omega$ in the VDI standards.

The Nordic standards have implicitly included the $K_\Omega$ with an adjustment for the ground absorption in the formulas for the ground effect. Therefore, the addition of $K_{\Omega, \text{ground}}$ in the Nordic industrial standards would be incorrect! The $K_{\Omega, \text{wall}}$ is correct if one assumes that the wall itself is the source or that the absorption of the wall can be neglected. If the $K_\Omega$ method for the walls is not used, the directivity needs to take its place.

$K_{\Omega}$

In the written standards, the corrections $K_\Omega$ are listed with the settings 0, 3, 6, 9 dB(A) for the different cases intermediate values must be based on the assessment of the engineer. Engineering judgment is required to assess if these cases really apply. $K_{\Omega} = 0$ is set for the smoke stack high in the air, but how high it needs to be before the value becomes 3 dB(A) is not defined.

<table>
<thead>
<tr>
<th>$K_{\Omega}$ in VDI 2714</th>
<th>$K_{\Omega}$ in Nordic Method</th>
<th>Applicable for the case</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 dB(A)</td>
<td>0 dB(A)</td>
<td>Spheric Propagation</td>
</tr>
<tr>
<td>+3 dB(A)</td>
<td>0 dB(A)</td>
<td>Example: Smoke stack</td>
</tr>
<tr>
<td>+6 dB(A)</td>
<td>+3 dB(A)</td>
<td>Propagation into a half sphere</td>
</tr>
<tr>
<td>+6 dB(A)</td>
<td>+3 dB(A)</td>
<td>Example: Forklifter driving on hard surface</td>
</tr>
<tr>
<td>+9 dB(A)</td>
<td>+6 dB(A)</td>
<td>Propagation into a quarter sphere</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: The outside walls of a factory building</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Propagation into an eighth of a sphere</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: A fan in a corner</td>
</tr>
</tbody>
</table>

As there are differences between the VDI and the Nordic methods in the application of $K_{\Omega}$ in relationship to the ground, SoundPLAN has split the entry into one value for $K_{\Omega, \text{ground}}$ for the ground and another one for $K_{\Omega, \text{wall}}$ for the walls.

Upon loading sources and buildings, SoundPLAN checks if the settings for $K_{\Omega}$ are feasible. If $K_{\Omega, \text{ground}}$ is zero and no directivity was used and the source is found at the outside walls of a building, a warning message is issued.
Reflection

Most objects reflect sound. The main principle of reflection is:

\[ \text{Angle of Incident} = \text{Angle of Reflection} \]

For the reflection, the angles of incident and reflection must be observed both in the floor plan and in the third dimension.

The angles are not the only criterion to qualify a wall for a reflection. The size of an object must be at least as big as half the wavelength, otherwise the sound wave is absorbed. This restriction applies also for two dimensions. A sound wave hitting the wall with an angle \( \alpha > 85 \) degrees will also not be reflected.

If a wall qualifies for the reflection, remember that there is a loss associated with the reflection. The wall is absorbing part of the sound energy. The absorption is a material characteristic, so the user must enter it in SoundPLAN. The absorption of a surface is usually highly frequency dependent. Therefore industry noise calculations can perform the reflection calculation with an absorption spectrum.

All calculation standards offer different interpretations for the conditions needed for a reflection to occur. Explanations are included in the descriptions of the particular standard.

Normal traffic noise which is only calculated for a center frequency, does not require the absorption to be specified in frequency spectra. In this case SoundPLAN requires the entry of the reflection losses in dB.
<table>
<thead>
<tr>
<th>Absorption Coefficient</th>
<th>Reflection losses in dB(A)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0.1</td>
<td>-0.5</td>
</tr>
<tr>
<td>0.2</td>
<td>-1</td>
</tr>
<tr>
<td>0.3</td>
<td>-1.6</td>
</tr>
<tr>
<td>0.4</td>
<td>-2.2</td>
</tr>
<tr>
<td>0.5</td>
<td>-3</td>
</tr>
<tr>
<td>0.6</td>
<td>-4</td>
</tr>
<tr>
<td>0.7</td>
<td>-5.2</td>
</tr>
<tr>
<td>0.8</td>
<td>-7</td>
</tr>
<tr>
<td>0.9</td>
<td>-10</td>
</tr>
<tr>
<td>1.0</td>
<td>-100</td>
</tr>
</tbody>
</table>

**Number of reflections and reflection depth**

Two parameters are relevant for the reflection calculation. One is the number of reflections, the other is the reflection depth. The number of reflections depicts how many reflections of a search ray are permitted until the operation is stopped. The reflection depth defines the number of potential reflecting surfaces that the search ray may pass over so that reflections ray can still be found.

Please look at the two examples to clarify these two parameters:

**Volume Type Absorption**

A sound wave passing through a group of obstacles will be partly absorbed. It is not important if the obstacles are forests, residential buildings or the pipes of a refinery. The bigger the distance the sound travels in the "volume" type absorption, the higher the losses.

As the sound over longer distances is not transmitted in the line of sight but in a curved path, only the stretches of the propagation leading through the area can attenuate the sound. SoundPLAN assumes the arc connecting source and receiver to
have a radius of 5500 meters. It uses a polygon with the maximum distance between coordinates as 50 meters to approximate the arc.

If a hard obstacle is found in the propagation path, the arc connects the top most points of the obstacle so the lines don’t cut through it. Only the part of the path cutting into the defined absorption area will be accounted for in the attenuation. The attenuation equals:

\[ \text{Losses} = \text{Distance through area} \times \text{attenuation per meter} \]

The attenuation per meter is entered in the Geo-Database.

Most standards put a ceiling on the maximum value of attenuation. Details are listed in the individual module descriptions.

---

**Volume absorption with ray passing over a building**

---

**Volume absorption with congested area**

---

**Volume absorption through vegetation (forest)**
The Search Angle Method

SoundPLAN uses a sector method. Starting from the receiver, search "rays" scan the geometry for sources, reflections, screens and geometry modifying the ground attenuation. The scanning rays use a constant increment angle of 1 degree (default setting), but you may choose any increment. The finer the increments, the more accurate and slower the calculations. The engineer must consider the trade-off of speed versus accuracy for the particular calculation.

Studying the definition more closely shows a search triangle is a more accurate description than a search ray. As one search triangle adjoins another, the search triangles cover the entire ground around the receiver, whereas a set of rays would miss the components between rays. When SoundPLAN finds a source in the search direction, it automatically calculates the part of the source contained in the search triangle and processes that partial source. Area sources and industrial line sources remain areas and lines for all calculations. Line sources from road and rail are abstracted to point sources and treated like point sources in the calculation. Details of the source search for the industrial models are contained in the chapter for industry noise.

Principle of search triangle method

The sketch explains the following principles:

a) The noise contributions hitting the receiver from different directions are drawn to scale with the receiver at the center. From the length of the arrows, you can measure the noise contributed from the direction the ray is pointing. During a calculation, this can be made visible on screen with scaling rings incrementally 10 dB each.

b) Point sources are automatically accounted for in the sector where they are found. The calculation was performed with the geometry exactly between the source and the receiver, unlike line sources where the line is in the middle of the triangle.
c) Line sources are automatically divided into segments fitting inside the search triangles.

d) Line sources leading away from the receiver are divided so that the condition
\[ L < 0.5 \times \text{distance} \]
with \[ L = \text{Length of source segment} \]
\[ S = \text{Distance source to receiver} \]

e) Area sources are clipped with the search triangle before performing the noise calculations. The corners of the clipped area sources are further checked for propagation differences. If the corners deviate more than a definable limit, the resulting area source is partitioned further until the differences are negligible.

In calculating the noise for a single receiver, SoundPLAN treats every search ray the same way. Therefore all components can be explained with one sample ray. The following drawing shows road and industrial sources. The receiver is shielded with a noise screen. An elevation line is also part of the model.

Floor plan of model

The search found and marked the section of road and all industry sources which are within the search triangle. The noise screen is only found in the intersection of the middle of the search triangle with the object. After the direct input of noise is calculated, SoundPLAN calculations mirrors the position of the receiver and looks from there for reflected noise. The intersection through the model generated a 2 dimensional cross-section.
The cross-section through the model is represented in the calculation core as a list of objects found. The list is organized according to the distance from the receiver.

The calculation inside SoundPLAN is split into a search and an acoustics calculation part. First, all objects loaded in the calculation are cut and the intersections are entered in the object list. The second step processes the acoustics starting at the receiver and searching for the next source in the list. When a source is found, the noise contribution for the receiver is calculated. These calculations evaluate spreading, air absorption, screening, ground effect, reflection and volume type absorption. The contributions of the sources found in the search triangle are added for the cumulative noise level.
16 Principles and Standards

Overview

SoundPLAN is a multi purpose and multi standard application. SoundPLAN offers solutions for most countries that require calculations be performed in accordance with a set standard. Calculations can be performed with different types of sources. Road, railroad and industry sources can be calculated in one run.

The exception to the rule is a road calculated in accordance to the UK standards CoRTN. The results for this standard are the L10 for 1 and 18 hours and cannot be calculated together with the Leq from other sources. SoundPLAN will issue a warning message if it found an illegal combination in the RUN File.

The time slots day, night and 'special' are computed for all calculations. If the railroad method from Scandinavia is activated, SoundPLAN needs the third time slot to calculate the maximum noise level from the train. Therefore the third time slot for any other source is disabled. For calculation reasons concerning finding the maximum noise level, the scanning angle increment is then fixed to one degree.

Road Noise

Standards for road noise are implemented for many countries. If your country is not listed in our materials or web site, it does not mean that you cannot use SoundPLAN. It is likely there is no national standard, in which case the standard used needs to be decided with the agency issuing the order for the noise study.

If a standard is modified, SoundPLAN will be revised as soon as the modified standard's text is published.

All these standards calculate noise emitted from road traffic as a broad band noise. No differentiation is made to accommodate for the different spectra of tire noise versus engine, transmission and exhaust noise. Trucks and passenger cars use the same frequency which is also not modified by speed.

Philosophy of Modeling

All standards share the basic setup. All models are split into a source and a propagation model which are separate from one another.
The emission noise level (also called basic noise level) is calculated from the traffic parameters for a certain reference distance. The sound power is not used as a noise description. The reference distance, however, varies from standard to standard. 10, 12.5, 15 and 25 meters are used in the standards. This means that the emission level cannot be compared between different standards!

The propagation also has differences in almost all components. The biggest difference is the philosophy concerning how a section of road is managed.

One school from the measurement practice stated that the noise level from a road decays with distance. The distance effect from a road is used to describe the entire road. If only a section of the road is to be calculated, the level from the section is described by deducting $10 \log_{10}(\text{segment angle} / \text{180})$ from the level the whole road would cause.

**Angle method for road section**

Another school states that a section of road is to be treated as a point source. All energy emitted from a section is concentrated in one point and propagated from there to the receiver. Certain conditions of uniformity and length of the section must be observed. The propagation does not require the perpendicular distance from source to receiver. The influence of a section depends on $10 \log_{10}(\text{length of road section})$ and a formula describing the spreading from the point source.

**Point source method for road sections**

The angular method may seem obvious as a method derived from hand measurements and calculations. It has a number of negative impacts. The biggest problem is if the receiver is positioned in the extended source line. In this case, the...
perpendicular distance and the angular difference between beginning and end angle become zero, leading to a mathematical disaster.

SoundPLAN solves the problem by rotating the road section around its middle until the intersecting angle is at least 5 degrees.

Another problem is the requirement of calculating the perpendicular distance. This process adds an extra step to the calculations, increasing the calculation time and possibly causing accuracy problems. If the receiver is positioned on the same elevation as the road section, one would expect the perpendicular distance to depend only on the coordinates $x$ and $y$. This is true only if the road section is flat. If not, the third dimension will increase the perpendicular distance, adding an error to the calculations.

**RLS 90 / DIN 18005**

The German government issued the RLS 90 as the successor for the RLS 81. The DIN 18005 for road noise is almost identical to the RLS 81. As RLS 90 has replaced RLS 81, this description will ignore the DIN 18005.

The RLS 90 guideline establishes specific technical standards and measurement procedures for the prediction and abatement of road and parking lot noise. The RLS 90 specifications rate (rating level) the sound level at the receiver location for the day (6:00 AM to 10:00 PM) and night (10:00 PM to 6:00 AM) time ranges for the evaluation of the resulting sound impact.

The RLS 90 uses the point source method with spreading, ground attenuation, screening and reflection. The standard consists of two separate models. The source model uses the traffic data and results in the reference noise level at 25 meters distance from the road at 4 meters above the ground. This noise level is called LME (Level Mean Emission) in SoundPLAN, but is referred to as the L25 (for reference distance 25 meters). The propagation model has the mean emission for day and night as an input and the noise levels at the receiver for day and night as the result.

**The Source Level LME**

The following data is required for calculating the source level:

- Vehicle data (number of vehicles per hour, % of heavy vehicles)
- Speed for cars and trucks
- Road surface adjustments
- Road gradients
- Multiple reflection addition

The source level $L_{m,E}$ is calculated by:

$$L_{m,E} = L_{m}(25,\text{basic}) + C_{\text{Speed}} + C_{\text{RoadSurface}} + C_{\text{Gradient}} + C_{\text{Ref}}$$
The $L_{m,\text{25,basic}}$ is the standardized level for the following conditions:

Speed 100 km/h for cars and 80 km/h for trucks
Road surface non-grooved asphalt
Gradient $< 5\%$
Free field propagation

$L_{m,\text{25,basic}} = 37.3 + 10 \log ( M * ( 1 + 0.082 * P ) )$

with

$M = \text{Mean hourly traffic volume (vehicles per hour). Average daily traffic (ADT)}$
$P = \text{Percentages of trucks exceeding 2.8 tons}$

**Speed correction $C_{\text{Speed}}$**

$= L_{\text{car}} - 37.3 + 10 \log \left( \frac{100 + (10^{0.1C} * P)}{100 + 8.23 * P} \right)$

$L_{\text{car}} = 27.8 + 10 \log \left( 1 + \left( 0.02 * V_{\text{car}} \right)^3 \right)$

$L_{\text{truck}} = 23.1 + 12.5 \log ( V_{\text{car}} )$

$C = L_{\text{truck}} - L_{\text{car}}$

$V_{\text{car}} = \text{Speed of cars (min. 30 km/h max. 130 km/h)}$

$V_{\text{truck}} = \text{Speed of trucks (min. 30 km/h max. 80 km/h)}$

**Road surface addition**

$C_{\text{RoadSurface}} = \text{additions and subtractions according to the table 4 of RLS}$

**Road gradient addition**

$C_{\text{Gradient}} = \text{addition for road gradients}$

$0 \text{ dB(A)}$ for gradients less than $5\%$

$0.6 \times |g| - 3$ for gradients $> 5\%$ with $g=$gradient of road

**Multiple reflection addition**

$C_{\text{Ref}} = \text{Correction for multiple reflections between retaining walls}$

$C_{\text{Ref}} = 4 * (\text{wall height}) / (\text{distance between retaining walls})$

$C_{\text{Ref}} < 3.2 \text{ dB}$ for hard surfaces

$C_{\text{Ref}} = 2 * (\text{wall height}) / (\text{distance between retaining walls})$

$C_{\text{Ref}} < 1.6 \text{ dB}$ for absorbent walls

**The Propagation**

The sound level at the receiver location is derived from the sound levels of all road sources. All contributions of sectional calculations greater than 0 dB are added energetically for the noise level. In addition to the calculated noise levels, an addition of 1, 2 or 3 dB may be added to the contributions of a road if the receiver...
was found 100, 70 or 40 meters from a traffic light. The closer the distance, the bigger the addition to compensate for breaking and accelerating.

In the search triangle method, a section of road within the search triangle is calculated as a separate source. The source is located 0.5 meters above the road surface. The level contribution is calculated with the formulas:

\[ L_m = L_{\text{Mean Emission}} + C_{\text{Section length}} + C_{\text{Spreading}} + C_{\text{Ground absorption}} + C_{\text{screening}} \]

**Correction of section length**

\[ C_{\text{Section length}} = 10 \times \log(\text{length of section within the search triangle}) \]

**Spreading and Air absorption**

Spreading and air absorption combine to one formula depending on the distance:

\[ C_{\text{Spreading}} = 11.2 - 20 \times \log(\text{distance}) - \text{distance} / 200 \]

Distance = distance from middle of the section to the receiver

**Ground attenuation and meteorological absorption**

\[ C_{\text{Ground absorption}} = \left( \frac{\text{av. height}}{\text{distance}} \right) \times \left( 34 + \frac{600}{\text{distance}} \right) - 4.8 < 0 \]

av height is the average height of the line of sight above the terrain

When there is screening, the ground absorption is not evaluated.

The RLS 90 ignores the ground impedance (absorption coefficient)!

The shaded area between the line of sight and the ground is averaged for the ground attenuation.

**Average height of the propagation above the ground**
Screening

\[ C_{\text{Screening}} = 10 \times \log \left( 3 + 80 \times \text{Extra path length} \times C_{\text{eq}} \right) \]

**Extra path length** = \( A + B + D - \text{(direct distance)} \)

Screening is only evaluated in the shadow zone. Obstacles not interfering with the line of sight are disregarded.

---

**Extra path length**

Model with 7 potential screens

---

Selection of the screens used to determine the extra path length

First iterative step finding the biggest extra path length

---

**First iteration**
The selection of screens included in the calculation of the extra path length follows an iterative procedure. In the first order between source and receiver the screen resulting in the extra path length is found. Then the process is repeated with each half until the 'rubber bands' stretched over the screens do not find any more screens increasing the extra path length.

**Meteorological Correction**

\[ C_{\text{met}} = \exp \left\{ -\frac{1}{2000} \sqrt{\frac{A \times B \times \text{direct distance}}{2 \times \text{extra path length}}} \right\} \]

If there is multiple screening, the distance between the outer screens for the \( C_{\text{met}} \) calculations is added to the bigger distance of A and B. The meteorological correction factor assumes that noise is traveling on a curved path from source to receiver. As the atmosphere density decreases with increasing altitude, noise is bent back to the ground. Inversions and downwind situations increase this effect. The VDI 2714 sets the radius of the arc to 5500 meters.

**Reflections**

SoundPLAN calculates single and multiple reflections by finding the mirror receiver and looking for sources from the mirror receiver through the point where the last wall was intercepted.

**Segmentation Constraints**

Road sections require special attention if the extended source line would lead through the receiver. When the length of a segment to be calculated is longer than
the distance from the middle of the segment to the receiver, the source line needs to be divided in the middle. SoundPLAN does this in an iterative process.

**Deviations from RLS-90**

No deviations were necessary in the implementation of the standard.

**A calculation in strict accordance to RLS-90**

When the „strict accordance“ box is checked, settings preferred by the German Road Administration are activated:

Only single reflections are computed and the search angle is set to 1 degree.

---

### Calculation of Road Traffic Noise (CoRTN)

Calculation of Road Traffic Noise (CoRTN) was issued as a means to standardize the assessment of entitlements under the "Noise Insulation Regulations." SoundPLAN is based upon the 1988 version. The noise levels to be calculated are the statistical descriptors \( L_{10} \) for the loudest hour and an average \( L_{10} \) for an 18 hour period. The following description of the standard does not attempt to be a complete description. We recommend you obtain a copy from HMSO if you use CoRTN.

**The Reference and Basic Noise Levels**

CoRTN requires noise levels to be calculated one meter in front of the facade. Reflections of the own facade are not calculated. A facade correction of 2.5 dB is added to the final result of the calculation.

The calculation consists of a source model and a propagation calculation. The reference distance of the source model is 10 meters from the nearest edge of the carriage way. Unless the carriage ways are separated by more than 5 meters and when the outer edges of the carriage ways are differing by less than one meter, the road is assessed as one source line 3.5 meters from the nearest curb. The source is 0.5 meters above the road surface.

\[
\text{reference level} = \text{basic noise level} + \text{speed correction} + \text{heavy vehicle adjustments} + \text{corrections for gradients}
\]

The influence of different types of pavement are not part of the official method.

**The basic noise level** for the hourly \( L_{10} \) is calculated:

\[
L_{10} = 42.2 + 10 \log_{10} q \quad \text{dB(A)}
\]

For the 18 hour \( L_{18} \) it is:

\[
L_{18} (18 \text{ - hour}) = 29.1 + 10 \log_{10} Q \quad \text{dB(A)}
\]
with q the number of passenger cars for the hourly and Q the number of cars for the 18 hour period. The assumed speed is 75 km/h and no trucks.

Speed correction:
"Corrections are made for the speed of vehicles, the percent of heavy vehicles and gradients."

Correction = 33 * \( \log_{10} ( V + 40 + 500 / V ) \) + 10 * \( \log_{10} ( 1 + 5p / V ) \) - 68.8 dB(A)

Speed correction and \( \Delta V \)

The traffic speed V is already adjusted for the situation by the "Change in mean traffic speed \( \Delta V \) in terms of the percentage of heavy vehicles p and the gradient G (percent)."

\[ \Delta V = [ 0.73 + ( 2.3 + 1.15 * p / 100 ) * p / 100 ] * G \text{ km/h} \]

Correction for mean traffic speed V and percentage of heavy vehicles p:
with the definition \( p = 100* f / q \) or \( 100* F/Q \)
"Correction for gradient G" is set as Correction = 0.3 G dB(A)

For low traffic volume and short distances to the source line there is a correction of the basic noise level.

\[ K = -16.6 \log(D) * \text{sqr}(\log(C)) \]

with \( D = 30 / d' \) \( d' \)=shortest slant distance
\( C= \text{traffic volume}(1h) / 200 \) or \( \text{traffic volume}(18h) / 4000 \)

The Propagation

Noise levels are calculated as additions to the reference noise level (corrected basic noise level)

\[ L_{10} = \text{reference level} - \text{distance correction} \ C_d - \text{ground attenuation} \ C_s - \text{view angle correction} \ C_v - \text{screening} \ C_s + \text{reflection correction} \ C_r \]

Distance Correction

\[ C_d = -10* \log(d'/13.5) \]

where \( d' \)=shortest slant distance from effective source position. (taken in the perpendicular position) valid for \( d>4.0 \) meters
Ground Attenuation

For \( 0.75 < H < (d+5)/6 \) \( C_g = 5.2 * I * \log(6*H-1.5)/(d+3.5) \)
For \( H < 0.75 \) \( C_g = 5.2 * I * \log(3/(d+3.5)) \)
For \( H > (d+5)/6 \) \( C_g = 0 \)

<table>
<thead>
<tr>
<th>% of absorbent ground</th>
<th>value for I</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 10</td>
<td>0</td>
</tr>
<tr>
<td>-29</td>
<td>0.25</td>
</tr>
<tr>
<td>-19</td>
<td>0.5</td>
</tr>
<tr>
<td>-29</td>
<td>0.75</td>
</tr>
<tr>
<td>&gt; 90</td>
<td>1</td>
</tr>
</tbody>
</table>

View angle Correction

\( C_v = 10 \log(\text{View angle} / 180) \)

Correction for Screening

The screening is split into illuminated and shadow zones. The insertion loss is evaluated with a polynomial,

\[
C_s = A_0 + A_1 * x + A_2 * x^2 + ... + A_n * x^n
\]

with the coefficients: \( X = \log_{10}(\delta) \), with \( \delta \) being the extra path length.

<table>
<thead>
<tr>
<th>Coefficients</th>
<th>Shadow zone</th>
<th>Illuminated zone</th>
</tr>
</thead>
<tbody>
<tr>
<td>A0</td>
<td>-15.4</td>
<td>0</td>
</tr>
<tr>
<td>A1</td>
<td>-8.26</td>
<td>0.109</td>
</tr>
<tr>
<td>A2</td>
<td>-2.787</td>
<td>-0.815</td>
</tr>
<tr>
<td>A3</td>
<td>-0.831</td>
<td>0.479</td>
</tr>
<tr>
<td>A4</td>
<td>-0.198</td>
<td>0.3284</td>
</tr>
<tr>
<td>A5</td>
<td>0.1539</td>
<td>0.04385</td>
</tr>
<tr>
<td>A6</td>
<td>0.12248</td>
<td></td>
</tr>
<tr>
<td>A7</td>
<td>0.02175</td>
<td></td>
</tr>
</tbody>
</table>

The range of validity for the potential barrier correction is defined as follows:

**Shadow zone**  **Illuminated zone**

For \( x < -3 \) \( C_s = -5.0 \)  For \( x < -4 \) \( C_s = -5.0 \)
For \( x < 1.2 \) \( C_s = -30.0 \)  For \( x > 0 \) \( C_s = 0 \)

Multiple Screening

Multiple screening is evaluated for the most and the second most effective screen.
\[ C_{\text{combined}} = -10 \times \log \left( \frac{1}{10} \times \frac{1}{10} \times \frac{1}{10} \right) \]

\[ J = \sqrt{\sqrt{\frac{M}{d+3.5}}} \] with M the distance of the screens

**Reflection Correction**

\[ C_r = 1.5 \left( \frac{\text{sum of reflected angles}}{\text{sum of total angle}} \right) \]

Only the first reflection is evaluated!

**Concepts of Screening, Ground Attenuation and Reflection**

All calculations for spreading, ground effect and screening are based on the perpendicular distances from receiver to the road.

This means that the ground effect of a road leading away from the receiver is zero. The formulas state the validity of the formulas for distances \( \geq 4 \) meters.

The screening is also evaluated during the projection of data in the perpendicular position. This leads to greater than expected screening losses for shallow angles between the road and the search ray.

**Projection of screen geometry to the perpendicular position**

**Projection of geometry**

Example:

**Effect of projecting the screening geometry onto the perpendicular position**
Assuming the distance to a section of road is 1000 meters and the distance from source to screen equals 200 meters for a screen 5 meters above the road, the extra path length would equal 0.079 meters. If the perpendicular distance to the road is only 25 meters, the projection yields an extra path length of 2.686 meters. This leads to systematic errors. In the normal mode, SoundPLAN leaves this problem untouched.

The reflection is another chapter in need for special explanations.

CoRTN does not calculate the reflected images to evaluate the reflections, but adds a constant to the results. The drawing in the CoRTN handbook best explains the situation:

![Diagram of Reflection Correction](image)

**Reflection correction** = \(+1.5 (A/A^*)\) in dB(A)

where \(A = A_1 + A_2 + A_3 + A_4\)

and \(A^* = \) Total segment angle

**Reflections in CoRTN**

If the opposite side of the road is completely reflective, the maximum correction due to reflections can be 1.5 dB. The absorption coefficient of the reflecting object is not evaluated.

**CoRTN states that reflections can only occur from the opposite facades. It is difficult for SoundPLAN to evaluate the term 'opposite facade.'** SoundPLAN accounts only reflected noise passing over the road where it was emitted.
Reflections at the own building

Reflections that did not pass over the road once are not accounted. The same applies for reflections into side roads.

Deviations from CoRTN

CoRTN requires every step to be rounded to the next 0.1 dB(A). SoundPLAN does not do this. The whole calculations are performed with double precision numbers with no rounding except for final results.

Ground attenuation  => calculation with the actual distances
Screening  => calculation without a projection for the perpendicular position
Reflection  => ray tracing with a selection of number of reflections  SoundPLAN shall evaluate

Statens Planverk 48

Statens Planverk 48 is the joint Nordic Prediction Method for Road Traffic Noise. It was revised in 1989, and the 1992 English translation was used for the implementation of the rules.

The Equations of Statens Planverk 48

The standard separates the emission model from the propagation using a basic noise level with a distance of 10 meters as the interface. The method calls for a sectional calculation method with the spreading calculated in the perpendicular positions and segments adjusted in accordance to their angular size.

The following section is taken directly from the paper:

"The contribution to the $L_{Aeq}$ from each section is calculated and all contributions are added. Each contribution is calculated according to Equation (4)."
\[ L_{\text{Aeq}} = L_{\text{Aeq}}(10\text{m}) + \Delta L_V + \Delta L_N + \Delta L_A + \Delta L_{AV} + \Delta L_{MS} + \Delta L_{O} + \Delta L_F \]  

(4)

Indices in Equation (4) means corrections for:

\begin{itemize}
  \item \( V \) = speed
  \item \( N \) = number of vehicles
  \item \( TF \) = fraction of heavy vehicles
  \item \( AV \) = distance (spreading)
  \item \( MS \) = ground and screening
  \item \( O \) = other factors (view angle, road gradient, reflections, etc...)
  \item \( F \) = facade sound insulation
\end{itemize}

**Basic Situation**

\[ L_{\text{Aeq}} (10\text{m}) = 68\text{ dB} \]

when

\[ N = 24000 \text{ vehicles per 34 hours and} \]
\[ V = 50 \text{ km/h} \]
\[ a = 10 \text{ m (distance from centre of vehicle path)} \]
\[ h_m = 1.5 \text{ m (receiver height) straight, horizontal, infinite road with normal asphalt, freely flowing traffic (but also applicable in city traffic).} \]

**Speed**

\begin{itemize}
  \item If \( V \geq 50 \text{ km/h} \) \( \Delta L_V = 30 \log (V/50) \)
  \item If \( V < 50 \text{ km/h} \) \( \Delta L_V = 0 \)
\end{itemize}

**Traffic Intensity**

\[ \Delta L_N = 10 \log (N/24000) \]

**Heavy Vehicles**

\[ \Delta L_{TF} = 10 \log \left[ \frac{100-p+500*p/v}{100} \right] \text{ for } 50 \geq v \geq 90 \text{ km/h} \]
\[ \text{LTF} = 10 \left[ \frac{100-p+50/9*(90/v)^3*p}{100} \right] \text{ for } v>90 \text{ km/h} \]
\[ p = \% \text{ heavy vehicles} \]
\[ v = \text{speed [km/h]} \]

**Road Gradient**

\[ \Delta L_{\Sigma} = 2*\Gamma/100 + 3*\Gamma/100 + 2*\gamma(1+\pi) \]
\[ G = \text{road gradient [%}] \]
\[ p = \% \text{ heavy vehicles} \]
**Distance (Geometrical Spreading)**

\[ \Delta L_{AV} = -10 \cdot \lg \left( \sqrt{\frac{a^2 + (h_m + h_b - 0.5)^2}{10}} \right) \]

- \( a \) = distance to road centre line
- \( h_m \) = receiver height
- \( h_b \) = road surface height

**Ground Effect and Screening**

The concepts of ground effect and screening are difficult to understand from the formulas, so these concepts will be explained in words and shown with drawings.

The vehicle noise on the road passes across the ground. Depending on the geometry, the sound is reflected and absorbed. The ground impedance and screening further influence these effects.

The reflection plane is the central concept for noise propagating from a road. A limited number of planes which reflect the noise are used to approximate the ground between source and receiver. From these, the major reflection plane is to be used for the remaining calculations.

---

**Linearizing the terrain for a reflection plane**

The picture shows the linearized reflection plane. The noise control wall has an effective height \( H_e \) above the reflection plane. For the noise reflected on the ground, the height \( H_v \) of the noise control wall above the reflection plane is the main characteristic.

---

**Reflection plane with road on a fill**
When the road is on an embankment higher than 1.5 meters above the reflection plane, the edge of the road functions as the diffraction edge. When SoundPLAN discovers this, it automatically places an elevation line at the road edge and handles the case as a screened case.

![Reflection plane](image)

When the road is in a cutting, the road actually may be underneath the reflection plane. The effective height of the screen is the perpendicular distance from the line of sight to the edge of the cutting. As the cutting is dependent on the site geometry, the user must enter the edge.

The sketches show that screening and ground effect are related. The standard says the following concerning screening and ground effect:

**Case A:** No screening occurs and the road surface is less than 1.5 m above ground

**Case B:** Other cases are treated as screened cases. This includes roads in cuttings and roads on embankments of more than 1.5 m.

The non screened case locates the reflection plane and calculates the ground reflection according to the site geometry and the absorption coefficient on the ground. Only two states are differentiated - acoustically hard and porous. SoundPLAN averages the ground absorption coefficient between source and receiver and then determines if the case is soft or hard (hard < 0.5; soft > 0.5).

For the screened case, soft versus hard is determined for both sides of the screen, leading to 4 possible routes.

The formulas for ground effect are highly complex and require a number of cases to be treated separately. As the formulas do not directly assist understanding a model situation, they are omitted in this text.

**The Reflection Plane**

The major problem in the ground effect is defining the linearized reflection plane. An engineer would automatically decide correctly for a manual calculation. Algorithms must be used for an automatic calculation.

All coordinates marking ground elevation points (elevation lines, roads, buildings) are separated into a maximum of 5 sections from source to receiver. If more coordinates are found within a section, a substitute line will be calculated with the methods of linear regression.

A second step evaluates which of these is the major reflection plane.
**Other corrections**

**View angle correction** for a road section of the angular size $\alpha$.

$$\Delta L_\alpha = 10 \log \left( \frac{\alpha}{180} \right)$$

Small distances

$\Delta L_{K,a}$ = formula for very small distances from road to receiver

**Reflections** are calculated with the normal SoundPLAN method of calculating the mirror receiver and searching for new roads from that position.

**Multiple screening** is considered for two screens or for thick screens. The steepest tangent from source and receiver to the screens is selected for the first order of barrier calculations. From the highest point, a line is drawn parallel to the ground until it intersects with the other tangent. The distance of the two tangent points is used for the screen thickness. The formulas evaluate the multiple screen addition with formulas using the distances and the tangent angles.

**Deviations from Statens Planverk 48**

The standard was implemented in its entirety. Adjustments to the formulas were made for the selection of the reflection plane, as the standard assumes the plane is known.

The facade insulation chapter was omitted in the calculations. Similar assessments are possible in the Documentation.

---

**Federal Highway Model (FHWA)**

The FHWA model is one of the oldest models for calculating noise impact from road sources. The December 1978 version was used as the reference for the SoundPLAN implementation. The model calculates the contributions from cars, medium and heavy trucks separately.

**The Equations of FHWA**

The method is best described with a direct quote from the model:

"The FHWA Highway Traffic Noise Prediction Model (hereafter referred to as the FHWA model), like several other prediction models, arrives at a predicted noise level through a series of adjustments to a reference sound level. In the FHWA model, the reference level is the energy mean emission level. Adjustments are then made to the reference mean emission level to account for traffic flows, for varying distances from the roadway, for finite length roadways, and for shielding. All of those variables are related by the following equation:"
\[ L_{eq}(h)_i = (L_0)_{ei} + 10 \times \log \left( \frac{N_i \pi D_0}{S_i T} \right) \text{ traffic flow adjustment} + 10 \times \log \left( \frac{D_0}{D} \right)^{1+\alpha} \text{ distance adjustment} + 10 \times \log \left( \frac{\Psi_{\alpha}(\Phi_1, \Phi_2)}{\pi} \right) \text{ finite roadway adjustment} + \Delta_S \text{ shielding adjustment} \]

where

- \( L_{eq}(h)_i \) is the hourly equivalent sound level of the \( i \)th class of vehicles
- \((L_0)_{ei}\) is the reference energy mean emission level of the \( i \)th class of vehicles
- \( N_i \) is the number of vehicles in the \( i \)th class passing a specified point during some specified time period (1 hour)
- \( D \) is the perpendicular distance, in meters, from the center line of the traffic lane to the observer.
- \( D_0 \) is the reference distance at which the emission levels are measured. In the FHWA model, \( D_0 \) is 15 meters. \( D_0 \) is a special case of \( D \).
- \( S_i \) is the average speed to the \( i \)th class of vehicles and is measured in kilometers per hour (km/h)
- \( T \) is the time period over which the equivalent sound level is computed (1 hour).
- \( \alpha \) is a site parameter whose values depend upon site conditions
- \( \Psi \) is a symbol representing a function used for segment adjustments, i.e., an adjustment for finite length roadways.
- \( \Delta_S \) is the attenuation, in dB, provided by some type of shielding such as barriers, rows of houses, densely wooded areas, etc.

Noise levels are to be calculated separately for 3 classes of vehicles - cars, medium trucks and heavy trucks. The calculations are kept separate in SoundPLAN because the height of the source lines above the road surface is different for each vehicle class (medium trucks have only 2 axles and the weight is between 4,500 kg and 12,000 kg).

<table>
<thead>
<tr>
<th>Vehicle type</th>
<th>Formula for the reference mean emission</th>
<th>Height of the source above the road surface</th>
</tr>
</thead>
<tbody>
<tr>
<td>Passenger cars</td>
<td>( 38.1 \times \log(S) - 2.4 )</td>
<td>0 m</td>
</tr>
<tr>
<td>Medium trucks</td>
<td>( 33.9 \times \log(S) + 16.4 )</td>
<td>0.7 m</td>
</tr>
<tr>
<td>Heavy trucks</td>
<td>( 24.6 \times \log(S) + 38.5 )</td>
<td>2.44 m</td>
</tr>
</tbody>
</table>

Distance Adjustment to the Reference Levels

The distance adjustment connects the ground effect with the spreading. This connection of two effects is based on measurements showing different drop off rates for hard versus soft sites.

\[ 10 \times \log \left( \frac{D_0}{D} \right)^{1+\alpha} \]
The major concern is the assessment of the site (absorption) factor \( \alpha \). When the ground is hard, all of the energy is reflected. When the ground is soft, the FHWA model assumes 50% absorption.

When SoundPLAN detects a road source and evaluates the ground absorption coefficient between road and receiver, it averages all intermediate sections and then limits the absorption coefficient to a maximum of 0.5. Setting criteria for section of drop-off rate per doubling of distance:

<table>
<thead>
<tr>
<th>Situation</th>
<th>Drop-Off-Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>All situations in which the source or the receiver are located 3 meters above the ground or whenever the line-of-sight averages more than 3 meters above the ground</td>
<td>3 dB(A) ( (\text{Alpha} = 0) )</td>
</tr>
<tr>
<td>All situations involving propagation over the top of a barrier 3 meters or more in height</td>
<td>3 dB(A) ( (\text{Alpha} = 0) )</td>
</tr>
<tr>
<td>Where the height of the line-of-sight is less than 3 meters and there is a clear (unobstructed) view of the highway, the ground is hard and there are no intervening structures</td>
<td>3 dB(A) ( (\text{Alpha} = 0) )</td>
</tr>
<tr>
<td>Where the height of the line-of-sight is less than 3 meters and the view of the roadway is interrupted by isolated buildings, clumps of bushes, scattered trees, or the intervening ground is soft or covered with vegetation.</td>
<td>4.5 dB(A) ( (\text{Alpha} = 0.5) )</td>
</tr>
</tbody>
</table>

Finite Length Roadway Adjustments to the Reference Levels

The finite length of a roadway is defined via a difference in angles from one side to the other \( \rightarrow \) see "Philosophy of Modeling" on page 389. The equations for hard sites are the same as described above,

\[
10 \cdot \log \left( \frac{\Psi_\alpha(\Phi_1, \Phi_2)}{\pi} \right) = 10 \cdot \log \left( \frac{\Delta \Phi_o}{180^\circ} \right)
\]

For soft sites or any \( \text{Alpha} \) between 0 and 0.5 the procedures are far more complicated! The FHWA standard text uses nomograms for the evaluation, which is not a solution for a computer. They are not even useful for checking the accuracy of the calculations as the angles SoundPLAN uses are beyond the scope of the diagrams.

For calculations of the soft site, the FHWA model specifies an integral to be solved with the Simpson's approximation:

\[
\Psi_\alpha(\Phi_1, \Phi_2) = (10 \cdot \log (\text{Integral} (\sqrt{\cos(\Phi)} \, d\Phi)) - 10 \cdot \log(\pi)
\]

The integration is to be performed from the angular beginning to the end. Implied in the angle method is the increasing distance with shallow angles.
The perpendicular position is defined as the zero angle. The integration for $\Psi_0(\Phi_1,\Phi_2)$ is performed from the beginning angle to the ending angle. The beginning angle in this case is a negative number and the ending angle a positive one.

**The Shielding Adjustments to the Reference Levels**

The screening is based on the extra path length see "Screening" on page 376. Note that the extra path length for all classes of vehicles is different. (The sources are set for cars 0 meters, medium trucks 0.7 meters and heavy trucks 2.44 meters above the road surface). It is based upon the Fresnel number theory stating:

$$N_0 = 2(\delta_0 / \lambda)$$

With $\delta_0$ as the extra path length and $\lambda$ as the wave length for 550 Hz.

The step from the Fresnel number to the reduction in noise levels requires the solution of integrals, one for the illuminated area and one if the receiver is in the shadow zone.

**Traps and Solutions**

**Warning**: This selection table which sets criteria for the drop-off rate has created some confusion. If the propagation from a road is passing over a soft site with a height of the line of sight less than 3 meters, the coefficient Alpha is 0.5. If a berm is 200 meters distance from the road and the berm is high enough for the average height to exceed the 3 meter mark, suddenly there is a drastic increase of noise levels. In some cases the increase can be seen even in the shielded part on the back side of the berm!

This is an expression of a modeling inconsistency included in the FHWA model. As SoundPLAN follows the standards text, this problem is also included.

**Deviations from FHWA**

For screening, the FHWA model sets a ceiling for the screening loss to 20 dB for walls and 23 dB for berms. As in SoundPLAN, diffracting edges can be from elevation line files, buildings and screens, this differentiation is too close. SoundPLAN evaluates the screening and if more than one screening edge is active, SoundPLAN treats it like a berm in the FHWA model.
Railway Noise

Railroad noise is a very common noise source. As train stations are historically built in city centers, or cities grew around the stations, trains travel through very congested areas. SoundPLAN has implemented different train noise models:

- SCHALL-03 (D)
- Transrapid (D)
- DIN 18005 (D) with emission calculation railway
- Calculation of Rail Noise CRN 99 (GB)
- Ö-Norm S 5011 (A)
- RMR 2002 (NL/EU)
- SEMIBEL (CH)
- Nordic Prediction Method for Train Noise NMT 98 (Skandinavia)
- Nordic Rail Prediction Method Kilde Report 130 (Skandinavia)
- Japan Narrow Gauge Railways (Japan)

All models attempt to calculate the $L_{eq}$ from trains. The Nordic model calculates the maximum noise level $L_{max}$ in addition to the $L_{eq}$. The Austrian model uses the same procedures for the train noise as for the industry noise model, with calculations performed on an octave band sound power.

Input for the four models is also different. The Nordic standard states that all trains are basically the same in their emission, length, and speed. The German model connects the emission to the percentage of disk brakes of the train and a train type specific addition to the emission level. The British model uses a list of engines and cars to compile a train. The addition to a basic noise level in the first order depends on the number of wheels. The Austrian model is radically different. It has provisions for entering the $L_w$ in speed dependent octave bands. The $L_w$ for a particular train is interpolated according to the train speed.

The train results are as different as the input and the calculation procedures. All models calculate the $L_{eq}$ at a receiver location. The Nordic method also yields the $L_{max}$. All standards except the German Schall 03 result in the measurable noise level. The Schall 03 results in a rated noise level. A German train company survey led to a 5 dB train bonus. The train bonus assumes a train produces the same annoyance as a road if the train has a 5 dB higher noise level than the road.

**Principles of Emission**

All train models calculate the emission noise level (basic noise level or reference noise level) from the train speed, length and number. As there is usually more than one train to be evaluated, the emission noise level requires its own data entry and calculation spreadsheet. The emission calculation is handled separately in the Geo-Database. After entering a train track, a reference to the emission level file is evaluated in a control line.
The German Federal Railroad (Deutsche Bundesbahn) developed the Schall 03. The SoundPLAN implementation is based on the 1990 edition. The calculated sound levels are $L_{eq}$ for the day (6:00 to 22:00) and night (22:00 to 6:00). A bonus of 5 dB(A) is subtracted from the final result of the calculation.

**The Emission Noise Level Schall 03**

The procedure for calculating the noise level at a receiver is divided into two sections. The emission level is calculated from the traffic data for a reference distance of 25 meters. The propagation assesses the noise level at the receiver under the influence of the site geometry and the reference noise level.

Trains of a similar type, speed and disk brake percentages are added to determine the emission level of this particular class of trains. The emission levels of all groups of trains are added energetically to form the comprehensive emission level for day and night.

The Emission Level $L_{m,E}$ is calculated with the formula:

$$L_{m,E} = 10 \cdot \log \left( \sum 10 \left( 0.1 \left( 51 + DFz + DD + DL + DV \right) + DTt + DBr + DLC + D_{ra} \right) \right)$$

- 51 dB is the basic noise level of one train.
- $DFz$, $DD$, $DL$ and $DS$ are additions applying to the particular train.
- $DFz$ Adjustment to the type of train / car
- $DD$ Adjustment for % of disk brakes
- $DL$ Adjustment for train speed
- $DS$ Adjustment for train length

$DTt$, $DBr$, $DLC$ and $D_{ra}$ are additions applying to the train track.
- $DTt$ Adjustment for track type
- $DBr$ Adjustment for bridges
- $DLC$ Adjustment for level crossings
- $D_{ra}$ Adjustments for small radius

$DFz$ is declared as an addition to the basic noise level of 51 dB and is stated by the German Railway for all type of rolling stock. The general definition of the railway company is setting the values to:
This figure needs calibration for trains you enter in the list. The easiest method is to measure the train at a not too complex site with a low ambient noise level and then make a calculation model for the situation. The difference between the measured value and the simulated one is the value to be added as a calibration.

$D_\text{D}$ adjusts the noise level in accordance of the percentages disk brakes.

$D_\text{D} = 10 \times \log \left( 5 - 0.04 \times P \right)$ \hspace{1cm} \text{with $P = \%$ of disk brakes.}$

$D_\text{L}$ accounts for the length of the train with

$D_\text{L} = 10 \times \log \left( 0.01 \times \text{Length of train} \right)$

$D_\text{S}$ adjusts the noise levels to the speed of the train with

$D_\text{S} = 20 \times \log \left( 0.01 \times V \right)$ \hspace{1cm} \text{with $V$ = speed in [km/h]}$

There are categories of adjustments $D_\text{Tt}$ for the different track types.

<table>
<thead>
<tr>
<th>Type of track</th>
<th>$D_\text{Tt}$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track body with grassplot - (street car)</td>
<td>-2</td>
</tr>
<tr>
<td>Ballast bed with concrete ties under special surveilance</td>
<td>0</td>
</tr>
<tr>
<td>Ballast bed with wooden ties</td>
<td>0</td>
</tr>
<tr>
<td>Ballast bed with concrete ties normal maintenance</td>
<td>2</td>
</tr>
<tr>
<td>Slab track and tracks for street cars set in roads</td>
<td>5</td>
</tr>
</tbody>
</table>

$D_\text{Br}$ adjusts the emission for noisy bridges. The effect should be measured for existing bridges. For predictive purposes, an addition of $D_\text{Br} = 3 \text{ dB(A)}$ should be applied.

$D_\text{LC}$ can be used to adjust the emission for a higher noise level at level crossings. The standard recommends $D_\text{LC} = 5 \text{ dB(A)}$.

$D_\text{Ra}$ The effect of the squeaking noises found at tight turns can be assessed with the table:

<table>
<thead>
<tr>
<th>Radius of curve</th>
<th>$D_\text{Ra}$</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 300 meters</td>
<td>8</td>
</tr>
<tr>
<td>From 300 meters to 500 meters</td>
<td>3</td>
</tr>
<tr>
<td>&gt; 500 meters</td>
<td>0</td>
</tr>
</tbody>
</table>
The Propagation from a Railway line according to Schall 03

The calculation of the noise impact requires the track to be divided into sections. The noise emission is positioned in the middle of each section at the height of the railhead.

The formulas used in the propagation are:

\[ L_{r,k} = L_{m,E,k} + 19.2 + 10 \cdot \log a_k + D_{l,k} + D_{s,k} + D_{BMA,k} + D_{Korr,k} + \text{Bonus} \]

- \( L_{r,k} \) is the noise level at the receiver caused by a single section of rail k.
- \( L_{m,E,k} \) is the emission level assigned to the rail section.
- \( L_k \) is the length of a section of rail found within the search triangle.
- \( D_{l,k} \) is the directivity of the source (see drawing following next paragraph).
- \( D_{l,k} = 10 \cdot \log \left( 0.22 + 1.27 \cdot \sin^2 \delta \right) \)
  with \( \delta \) as the angle of the ray and the railroad track.
- \( D_{s,k} \) is the spreading with
  \( D_{s,k} = 10 \cdot \log \left( \frac{1}{2 \pi \cdot (\text{distance source to receiver})^2} \right) \)
- \( D_{l,k} \) is the air absorption
  \( D_{l} = -\left( \frac{\text{distance source to receiver}}{200} \right) \)
- \( D_{BMA,k} \) is the influence of ground and meteorological attenuation.
  \( D_{BMA} = \frac{a_h \cdot l_s}{\text{Dist} S} \cdot \frac{34 + 600}{\text{Dist} S} - 4.8 < 0 \)
  \( \text{Dist} S \) is the distance source to receiver.
- \( a_{h_l_s} \) is the average height of the line of sight in the integration of the distance between the line of sight and the ground divided by the distance source to receiver.
- \( D_{Korr,k} \) is the influence of screens and reflective surfaces.
Screening

Screening is evaluated for an extra path length > zero and for screens in the illuminated area with an extra path length > -0.033 meters. The positive extra path length is evaluated from the input files reflection, screening and elevation line, the illuminated area is only derived from screens and reflection files (buildings). The selection method for the screen is identical with the description for the road noise according to the RLS 90.

The insertion loss of a noise screen is calculated with:

$$D_{e,k} = - ( 10 + \log ( 3 + 60 \times \text{extra path length} \times K_{w,k}) + D_{bm,k}) < 0$$

The meteorological correction $K_w$ equals

$$K_w = 10^X$$

with

$$X = \left( \frac{-1}{2.3 \times 2000} \right) \times \sqrt{\frac{A \times B \times \text{direct distance}}{2 \times \text{extra path length}}}$$

$A = \text{distance from source to screen}$

$B = \text{distance from screen to receiver}$

For the illuminated area the factor $K_w$ is set to 1.

If there is screening from more than one screen, the distance between the screens is added to the smaller of the distances $A$ or $B$ for calculating $K_w$.

Please note that ground effect is added in the formula and that the result of the whole procedure shall be a negative number. This means that the screening effect is zero if it is smaller than the ground effect!
Calculation in strict accordance to Schall 03“

When the „strict accordance“ box is checked, settings preferred by the German Railway Administration are activated:

No reflections are computed and the search angle is set to 1 degree and the railway bonus of 5 dB(A) is set.

Traps and Solutions

The Schall 03 normally does not regard reflections. If buildings are included in the calculation run, the diffraction over the building is evaluated but not the reflections. As reflections do occur, the standards should not be interpreted literally.

ÖAL 30

The ÖAL 30 is unique in three ways. First, it is the only standard for railroad noise that uses octave bands to describe noise emission and propagation. Second, it allows the user a method to calibrate the model for any rail bound vehicles. Third, it uses an established standard for the propagation. The ÖAL 30 is based on the ÖAL 28 which is identical to the Nordic "General Prediction Method for Industrial Plants." As it is identical, please use the description of the Nordic Industry standard for the propagation of railways in accordance to ÖAL 30.

The Equations of the Standard

Railway noise calculations based on the ÖAL 30 require two separate steps. The first is a calculation of the source level \( L_w \) based on the measured noise data from several passes of trains. The Austrian standard ÖNORM S 5024 specifies rules for measuring the \( L_w \) from trains. As the measurement from trains is not part of SoundPLAN, the content is not further detailed.

The sound power per meter of train track is the energetic addition of the sound powers of all trains adjusted by the duration of the noise event. As the sound power of trains is speed dependent, many measurements at different speeds are needed to be able to interpolate the sound power for a particular speed. The emission calculation for trains performs this task from a list of preset and user adjustable sound powers for different speeds.

The sound pressure \( L_i \) at the receiver is the energetic sum of the contributions of all angles SoundPLAN scanned. The propagation is calculated according to the rules of the ÖAL 28 or the Nordic General Prediction Method for Industrial Plants. The propagation is described in the chapter “General Prediction Method” on page 431. An addition to the ÖAL 28 is the directivity associated with the train.

\[
L_i = L_w - 11 + 10 \log(\text{section length}) + 20 \log(1/\text{distance})
\]

- 11 interface sound power to 1 meter dist
+ 10*log(section length)  adjustment to finite section length
+ 20*log(1/distance) spreading
+ 10*log(0.15+0.85*sqr(S)/sqr(R)) directivity of train (see below)
+ air absorption
+ ground absorption
+ screening

The directivity of a train depends on the two-dimensional perpendicular distance \( S \) and the three-dimensional distance \( R \).

\[ \text{Directivity of train} \]

**NOTE:** For the purpose of calculating spreading and screening, the source is located on the railhead closest to the receiver. For the evaluation of the ground effect, the location is 0.3 meters above this point.

**Deviations from the Standard**

The critical part of this standard is the evaluation of the ground effect. The source height above the reflection plane is of major importance. SoundPLAN uses the elevation of the terrain next to the train track labeled "elev. terrain" as a first order adjustment. The elevation SoundPLAN uses might be completely different. The ground between source and receiver must be approximated by a limited number of reflecting planes. From these, the major planes are chosen as the reflection planes for the remaining calculations.
Calculation of Railway Traffic Noise (CoRN)

The paper describing noise propagation from railroads was published in 1993 and became a standard in 1995. The 1995 version is the basis for the SoundPLAN implementation. In contrast to the Calculation of Road Traffic Noise, the railway model describes the noise levels at the receiver as $L_{eq}$ rather than $L_{10}$. As $L_{eq}$ and $L_{10}$ cannot be used in one calculation, this is a major problem for comprehensive noise studies involving road and rail.

Noise levels are to be assessed 1 meter in front of the facade. SoundPLAN positions the receiver in that location if the receiver was found to be within the reflex tolerance and if the beginning and ending angles correspond with the orientation of the facade.

The calculation separates the equations describing the emission of the train in terms of the SEL and the propagation. The emission "Reference Noise Level" is assessed from a table of basic configurations and equations adjusting for train length and speed. The distance the basic noise level is calculated is set to 25 meters, which also differs from the distance used in CoRTN. At the end of the calculation, the SEL is converted to the $L_{eq}$ by subtracting 43.3 dB for the 6 hour and 48.1 dB for the 18 hour $L_{eq}$.

The Reference Noise Level CoRN

The emission reference level for a single vehicle is the sum of the BASELINE SEL + vehicle type adjustments + track type adjustments. The energetic sum of all single vehicle SELs is used as the reference level in the calculations. (correction $10\log(N)$ with N=total number of vehicles).

The BASELINE SEL for the rolling railway vehicles is calculated with:

$SEL = 31.2 + 20 \log(V)$  \( V = \text{speed in km/h} \)

For Diesel engines under full power the formula is:

$SEL = 112.6 - 10 \log(V)$  \( V = \text{speed in km/h} \)

A table of additions and subtractions to the Baseline SEL is provided in the standard. As the values are visible in the emission calculation of Calculation of Railway Traffic Noise, they are not repeated here.

The adjustments to different track conditions and types are listed in the following table.
### Type / Description

<table>
<thead>
<tr>
<th>Type / Description</th>
<th>Correction Factor dB(A)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continuously Welded Rail (CWR) Concrete Sleepers + Ballast Beds</td>
<td>0</td>
</tr>
<tr>
<td>Continuously Welded Rail (CWR) Timber Sleepers + Ballast Beds</td>
<td>0</td>
</tr>
<tr>
<td>Jointed Track (60' lengths)</td>
<td>2.5</td>
</tr>
<tr>
<td>Slab Tracks</td>
<td>2</td>
</tr>
<tr>
<td>Concrete Bridges and Viaducts with Parapets</td>
<td>1</td>
</tr>
<tr>
<td>Steel Bridges: with Parapets</td>
<td>4</td>
</tr>
<tr>
<td>Steel Bridges: Box Girder with Rails fitted directly to Girder + orthotropic Slab.</td>
<td>9</td>
</tr>
</tbody>
</table>

As the propagation is different for engines under full power than for normal vehicles, SoundPLAN calculates a separate reference level for the engines and for the rest of the vehicles. The location for the emission from engines is 4 meters above the nearest rail. For all others it is the position of the nearest rail.

### The Propagation of CoRN

SoundPLAN calculates the Leq and adds the levels Log10 for each segment of the rail line. For each section the level results from:

\[
Leq = \text{Reference Level} \quad \text{See above} \\
- 10\log(d/25) \\
+ 10 \log(\pi \theta/180 - \cos(2\alpha) \sin(\theta) - 5) \\
- 0.008*d + 0.2 \\
- 0.6*I*(6-H)*\log(d/25) \quad \text{For } 1.0<H<0.6 \\
- 3*I*\log10(d/25) \quad \text{For } H>1.0 \\
+0 \quad \text{For } H>6.0 \\
\]

Ground absorption as a function of the perpendicular horizontal distance and the average height between source and receiver. I is the absorption coefficient of the ground between source and receiver.
**Screening**

The extra path length is calculated in the geometry projection onto the perpendicular position. The extra path length in the shadow zone is calculated from the data types screens, elevation lines and reflecting objects. Only reflecting objects and screens are used in the illuminated zone. In the shadow zone, barriers distinguish between absorptive and reflective barriers (reflections between the train and the barrier).

There are three sets of formulas with the extra path length (delta) as entry data:

**ILLUMINATED ZONE:**

\[
\text{screening} = \begin{cases} 
0 & \text{for } \delta < -0.5 \\
0.55 - 1.85 \times \log(10^{\exp(-3 - \delta)}) & \text{for } -0.5 \leq \delta < 0 \text{ m}
\end{cases}
\]

**SHADOW ZONE:**

**Reflective Barrier**

\[
\text{screening} = \begin{cases} 
-15.4 & \text{for } \delta > 2.5 \text{ m} \\
-5 \times \log(10 + 470 \times \delta) & \text{for } 0 \leq \delta < 2.5 \text{ m}
\end{cases}
\]

**Absorptive Barrier**

\[
\text{screening} = \begin{cases} 
-19.8 & \text{for } \delta > 2.5 \text{ m} \\
-2.17 + 0.868 \times \delta - 9.4 \times \log(2 + 50 \times \delta) & \text{for } 0 < \delta < 2.5
\end{cases}
\]

Reflections are evaluated the same way as in CoRTN (see "Concepts of Screening, Ground Attenuation and Reflection" on page 399).

**Traps and Solutions**

Deviations from the physically correct way will occur with the projection of the geometry to the perpendicular position. See chapter "Calculation of Road Traffic Noise (CoRTN)" on page 396 for details.

**Deviations from the English Railway Traffic Calculation**

When the angle between the rail and the search ray becomes smaller than 5 degrees, the section of rail is "rotated" so that this minimum angle remains.

The formulas set the minimum perpendicular distance between the track and the receiver to 10 meters. Even if SoundPLAN discovers a receiver less than that distance from the track after rotating the section, the formulas are applied with the distance of 10 meters.
Nordic Rail Prediction Method

The Nordic Rail Traffic Noise Prediction Method was prepared in 1984 for the Nordic Council of Ministers Noise Group, NBG. It applies for all countries in Scandinavia. There are small changes in some formulas. The SoundPLAN implementation is based on extra definitions of the developers of the standard, DELTA of Lyngby, Denmark.

The Nordic Method is the only method known to require the Leq and the Lmax from trains. SoundPLAN follows the rules of the Lmax calculations but does not assume the Lmax occurs in the perpendicular position. SoundPLAN calculates the Lmax in complex terrain and with assessment of reflections.

The Reference Noise Level - Nordic Rail Prediction

The reference noise level describes the emission from all trains during a 24 hour period. The reference level is valid for a train on infinitely long, straight track with continuously welded rails.

The reference noise level for the Leq calculations is:

\[ L = 50 + 10 \times \log \left( \frac{l_{24}}{1000} \right) - 10 \times \log \left( \frac{a}{100} \right) + 23.5 \times \log \left( \frac{V}{80} \right) \]

- \( L \): Reference noise level of the 24 hour Leq level in dB(A) (= 50 dB(A) at 100m with 1000 m of cumulative train length within 24 hours).
- \( a \): perpendicular distance from the track center line to the prediction position in meters.
- \( l_{24} \): total train length of all passing trains in a typical 24 hour period, in meters.
- \( V \): speed of the train in kilometers.

The emission for the Lmax noise level is described as:

\[ L = 10 \times \log \left( 10^{\Delta L_{1}/10} + 10^{\Delta L_{2}/10} \right) \]

- \( \Delta L_{1} \): maximum noise level caused by the railroad cars
- \( \Delta L_{2} \): maximum noise level caused by the engine

\[ \Delta L_{1} = 92 - 10 \times \log \left( \frac{a}{10} \right) + 10 \times \log(\tan(\frac{l_{1}}{2 \times a}) / 1.37) + 30.5 \times \log \left( \frac{V}{80} \right) \]

\[ \Delta L_{2} = 50 - 20 \times \log \left( \frac{a}{10} \right) + \left( 44 - 100 / \sqrt{l_{t}} \right) \times \left( \frac{3}{\sqrt{a}} \right) + 30.5 \times \log \left( \frac{V}{80} \right) \]

- \( l_{1} \): length of the train causing the Lmax
- \( V \): speed of the train (if train is slower than 80 km/h, the speed correction is zero.)
The Propagation - Nordic Rail Prediction Method

The noise level at the receiver for a single segment of rail is composed of the reference noise level and a distance adjustment, angular size, ground absorption and screening.

\[
L_i = L_{\text{reference}} + 10 \log \left( \frac{\alpha}{180} \right)
\]

view angle adjustment

\[
- 12 \log \left( \frac{d}{1 + d/10} \right) + 3 \log (h) + 7.76
\]

ground absorption for the \(L_{eq}\) calculation

\[
d = \text{distance from source to receiver}
\]

\[
h = \text{average height of the line of sight above the ground}
\]

\[
- 12 \log \left( \frac{a}{1 + a/10} \right) + 3 \log (h) + 7.76
\]

ground absorption for the \(L_{\text{max}}\) calculation

\[
a = \text{perpendicular distance from track to receiver}
\]

(SoundPLAN deviates and uses the formulas for the \(L_{eq}\))

\[
- 10 \log (a_s) - 10 \log \left( \frac{e + 1}{4 \left( a_s + 1 \right)} \right) \frac{1}{1 + e/3} - 7.5
\]

screening with

\[
e = \text{extra path length}
\]

\[
a_s = \text{the perpendicular distance from the screen to the track center. If the screen has high absorption paneling on the rail side the value } a_s = 15 \text{ should be used. If the perpendicular distance between the rail and the screen is exceeding 15 meters, the value is set to 15 meters.}
\]

Calculations for the Maximum Noise Level – Nordic Rail Prediction Method

SoundPLAN calculates the noise levels for the \(L_{\text{max}}\) the same way as for the \(L_{eq}\). For every degree of angle (the Nordic rail method angular increment is fixed to 1 degree), a search ray is sent from the receiver scanning for track and terrain geometry. The calculation for the \(L_{eq}\) is performed the same way as for all other standards. The \(L_{\text{max}}\) results are written in a special matrix for later evaluation.
Calculations for the maximum noise level

In the drawing, it is apparent that the maximum noise level cannot be expected in a position symmetrical to the perpendicular position to the track. The calculation sends ray after ray to scan the entire track. For every angle (one sample is displayed in the drawing), SoundPLAN writes the following values into the matrix:

- A contains the length of the track segment found in the search ray.
- B contains the maximum noise level for a hypothetical engine in the middle of the segment.
- C contains the maximum noise level caused by the railroad cars of this search triangle.
- D contains the reflected components of the noise this section generated.

After the initial calculation, SoundPLAN searches the matrix for the maximum noise level. As there are 360 search rays, there are 360 potential locations for the engine. The cars can be either in front or behind the engine. As the railroad track is not wound around the receiver, the possible 720 cases in practice are reduced by half. SoundPLAN finds the maximum noise level by adding the values from C and D beginning at the engine position and continuing until the integration of the train length in section A is bigger than the total length of the train. The last element is then interpolated.

The maximum noise level calculated for all potential engine locations is the maximum noise level for a single track. If there is more than one track, the same procedure is repeated for all tracks. The maximum from all track files is the maximum noise level found at the receiver location.

This procedure is very calculation intensive, yet is the only possible way to find the maximum noise level in complex geometry.
Deviations from Nordic Rail Prediction Method

The limitation of the formulas to distances from the track of less than 300 meters is not included in the model.

In some copies of the standard text there is a limitation of the extra path length (e) to 2 meters. As this is not part of the Danish version, it was omitted in the implementation.

The cross-reference between the screen and the ground effect shows differences.

The SoundPLAN implementation:

\[ \Delta L_s \] is not rounded to integer numbers. There are three groups for \( \Delta L_{\text{ground}} \) for

- \( \Delta L_s \geq -4 \) full ground effect
- \(-10 \leq \Delta L_s < -4 \) half the ground effect
- \(-10 > \Delta L_s \) no ground effect

SoundPLAN offers more detailed calculations than the Leq for a 24 hour period. All calculations are created for the time periods day (06:00-22:00) and night (22:00-06:00).

Industry Noise

The SoundPLAN parameter menu offers six different choices for calculations of frequency dependent industry noise. Three of the choices do not require much explanation. The ÖAL 28 is identical with the Nordic General Prediction Method for Industrial Plants, the ISO 9613 is identical with the VDI 2714 / VDI 2720 and the Hong Kong Construction Noise regulation is identical to the ISO 9613, but ignores the air absorption and ground attenuation.

The remaining three choices have similar definitions for the physical parameters of the sound power and the spreading. There are differences in concepts and formula for all other steps defining the propagation.

There are even differences in scope. The Nordic and the ISO methods are set for any distances from source to receiver. The CONCAWE method was designed for the oil Industry and was meant for the propagation over long distances across flat terrain (water or land). This method cannot be used for distances less than 100 meters as the formulas for ground effect and meteorological effect are not valid.

Acoustical Schools (ISO / Nordic / CONCAWE)

The Nordic method and the CONCAWE method assume all calculations are based on octave bands. For major components, SoundPLAN must branch into one of the eight octaves to perform calculations. The ISO method does not supply different formulas for different frequency and can therefore be used for any frequency.

The CONCAWE method is especially suited for assessments where prevailing winds and meteorological conditions do not fit normal conditions as in the other
standards. CONCAWE is the only standard that allows the meteorological influence to be assessed.

The Nordic method has a strong point in the explicit interaction of the ground effect. As the Nordic method is the only one available for accurate frequency dependent calculations of the ground effect, it is included in the appendix of the VDI 2714 and ISO 9613.

The ISO and VDI methods have their particular merits in calculation speed. They are magnitudes faster than the Nordic or the CONCAWE calculations, making their use for noise maps of a whole city advantageous.

**Spreading / K\text{omega} / Ground Effect**

In the ISO 9613, the spatial directivity of the source is unique. It belongs to the characteristic of the source regardless if it transmits the sound energy into the full, half or quarter sphere. This separates the ground effect from the ground reflection and it is only described as a ground absorption. The formula for ground absorption depends on the average height of the line of sight above the ground, and the ground impedance is completely ignored. In the Nordic method, the spatial directivity is not included in the method. The interaction with the ground is included in the ground effect.

SoundPLAN has separated the spatial directivity $K_{\text{omega}}$ from the ISO standard into a directivity for the ground which must be observed in the ISO and set to zero in the Nordic method. The Nordic method uses directivity to manage the second part of the spatial directivity (sources attached to buildings). Possible conflicts and resulting error messages are explained later.

**From Area and Line to Point Sources**

Noise sources can have many different shapes. For modeling, they are abstracted to three different types - point, line and area sources. All calculations manage point sources, and all description use the distance from source to receiver as a main parameter. Part of the abstraction process in the calculation converts area and line sources into one or multiple point sources. During this process, the following questions need answers:

- What size of source can a single point source represent?
- How can larger sources be divided into smaller pieces?
- Where is the substitute point source located?
- How is the height of the point source above the ground defined for the ground effect?

For a line source, the same rules apply as documented for road sources. For line vertical sources, the law of length versus distance applies as well. Line sources will be separated into segments when the length of the source is longer than the distance from receiver to the middle of the source.
Area sources are administered very differently. When an area source consisting of more than 3 coordinates is loaded for calculations, it is divided into triangles. This enables SoundPLAN to adapt the source to any shape. Even areas placed on top of other areas (i.e. windows and doors on a building) can be properly managed this way.

The algorithms used to separate a source into a set of triangles are documented in the next pictures:

**Desintegrating an area source into a set of triangles**

**Complex area source**

A list of coordinates defines the area source, the ground elevation at every coordinate, information on sound power and operations data. Regardless of how the sound power was entered, the loading procedure recalculates it for the sound power per square meter.

**Triangulating an area source**
The area source is divided into 12 separate triangles sharing the same source definitions. The list of triangles describes only 12 sets of references to the polygon points of the original source. No extra coordinates are necessary.

If one of the new triangles is completely within the search triangle, the area size is multiplied by the sound power per square meter and assigned to the center of gravity of the triangle for the calculation of the propagation.

If the source triangle does not completely fit into the search triangle, the part of the source triangle inside the search triangle is cut and managed as a source polygon of its own. For all points belonging to the new source polygon, the height of the terrain is calculated from the original triangle's ground elevation. The new polygon usually is not a triangle any more, as more coordinates are inserted due to the cutting. All values are computed for these new coordinates (X, Y, Z, ground elevation).

**Cutting a source triangle**

The distance from the middle of the polygon to the receiver was smaller than the biggest distance found within the triangle. The triangle had to be cut into two separate source polygons. The polygons are managed separately for the remainder of the calculations.

The remaining question is if one point source can represent the new polygon. The last constraint is the requirement for the source to find uniform propagation conditions. A point source can only represent a line or area source if the ground attenuation and the screening of the point source is representative for the whole source.

The criteria for uniformity is user definable in SoundPLAN. For all coordinates of the source polygon, the ground attenuation and screening are assessed and compared to the value which was set in the parameters to the maximum permitted difference between the values. If there are differences between the coordinates exceeding the
maximum, the source is divided in the middle between the minimum and maximum value. This procedure is recursively repeated until the differences within the source are below the set maximum value or the maximum number of iterations is reached. The maximum number is also user definable.

Division of a source
In the above picture, the building radiates the noise. Upon loading, the original source rectangle was separated into two triangles. During the calculation process part of the source was within the search triangle (ray). As there are two original triangles, after the cutting there are two source polygons. Further investigation indicated that the noise screen did not shield the top of the triangle which is above the line of sight. As the bottom of the polygon is shielded, the maximum difference within the source is exceeded, resulting in further recursive disintegration.

Aside from the direct shielding, the influence of side diffraction and ground effect can cause the source polygon to have a tension too big to be evaluated as one point source.

Cross References between Sources and Buildings
If a source is attached to a building or if the building itself is the source, several points need to be observed in order to avoid possible problems. The source coordinates of a building can be transferred directly from a building (not yet implemented). In this case, the coordinates of the source are exactly in the plane loaded for the buildings. For point sources marking an opening in the wall, the coordinates will be either slightly inside or outside the building. For all cases, the treatment is the same. A receiver with clear sight to the source needs to evaluate the direct input and oppress any possible reflection or screening effects from the building.
Possible reflections if the source is in front of the building

Source in front of a building

Possible screening over the top of the building if the source is inside the building

Possible screening from a source inside a building

For the above situation, the search procedure must find and evaluate two screens.

Sources on the other side of the building

In order to satisfy the rules mentioned in the last three pictures, it is apparent that a direct link must be established between the source and the building. All sources are checked at loading time to see if they are within a certain distance from a building.
If a source is found within the defined and is not higher than the top of the reflection wall, a reference between the source and the reflector is established. The source is then moved to a location 10 mm in front of the reflecting facade. This enables the search procedure to correctly evaluate the screening from the back side while ensuring there is no screening on the visible side. The own facade reflection is directly disabled. However, noise bouncing off the opposite facade can be reflected again on the own facade.

The direct link is also used to check the correctness of $K_{\text{OMEGA}}$ and directivity. If a source is attached to a building and there is no directivity associated with the source and there is no $K_{\text{OMEGA}}$ defined, a warning message is written to the LOG File.

### VDI 2714, VDI 2720 or ISO 9613

The ISO 9613 Part 2 and the German VDI 2714 / VDI 2720 are identical. The concept of the standards dates as far back as 1976. The current version of the VDI 2714 is dated 1988 and is still called a draft. It includes all aspects of the propagation of a frequency dependent industrial source except for screening, which has its own standard, the VDI 2720 which is dated 1991. The ISO 9613 includes both parts and was approved in 1992. In the following materials, the standard is abbreviated as ISO 9613.

ISO 9613 is a general purpose standard for outdoor noise propagation. The main emphasis was to create an easy to use, reliable standard where all formulas produced results with smooth curves. (Remember that nobody had a PC in 1976).

### The Equations of VDI 2714/2720, ISO 9613

The sound pressure at the receiver $L_{eq}$ is the sum of all contributing frequencies. The sound pressure for a single frequency is calculated by:

$$ L_s = [ L_w + D_i + K_\Omega ] - [ D_s + \sum D ] $$

with:
- $L_s$ sound pressure for a single frequency
- $L_w$ sound power
- $D_i$ directivity of the source
- $K_s$ spherical model
- $D_s$ spreading
- $\sum D$ different contributing factors
  - air absorption
  - ground absorption and meteorological effects
  - volume type absorption
  - screening
- $K_\Omega$ is defined by the spatial angle $\Omega$ with
K₀ = 10 * lg ( 4 * π / Ω ) dB(A)

The spreading "Spreading" on page 372 of a point source is set to:
Dₛ = 20 * log ( dist. source, receiver ) + 11 dB(A)  See "Spreading" on page 372.

The air absorption is evaluated in accordance to the ISO 9613 or ISO 1913 part 1 or ANSI 126. See "Air Absorption" on page 375.

The ground and meteorological attenuation (D₉₀₉ₐ) depends on the average height of the line of sight above the terrain (Hₘ₀) and the distance from source to receiver (Sₘ). The ground impedance is ignored.

\[ D₉₀₉ₐ = [ 4.8 - 2 * Hₘ₀ / Sₘ * ( 17 + 300 / Sₘ ) ] dB > 0 dB \quad \text{See "Ground Effect, Komega - Directivity" on page 380.} \]

Calculating the average height of the line of sight above the ground

The “Volume Type Absorption” is detailed on page 383.

The principle of screening is explained in "Screening" on page 376. The formulas define an insertion loss which is the combination of screening, volume absorption (foliage, buildings) and the ground attenuation. If the ground attenuation is bigger than the screening, the effect of the screening is zero dB. If the screening effect is bigger than the ground absorption, the ground absorption is ignored.

The screening is calculated with the formulas:

\[ D_z = 10 * \log ( C_1 + C_2 / \lambda * C_3 * Z * K_w ) dB \]

- \( \lambda \): wavelength of the sound
- \( Z \): extra path length
- \( C_1 \): constant
- \( C_2 \): factor 20 for normal calculations, 40 for calculations using the ground reflection explicitly
- \( C_3 \): factor = 1 for single screen
- \( \text{factor} = ( 1 + (5*\lambda/e)^2 ) / ( 1/3 + (5*\lambda/e)^2 ) \)
- \( \text{for multiple screens with e=distance between the screens} \)
- \( K_w \): correction factor for meteorological influences

\[ K_w = \exp ( -\sqrt{ A_q * A_a * S_m / 2 * Z } ) \]
\( A_s \) distance source to screen
\( A_a \) distance screen to receiver
\( S_m \) distance source to receiver

The directivity of the source is explained in detail along with the data entry for sources in chapter 3 „Industrial sources“.

All other corrections such as inversions and wind are listed in the standard, but no quantifying formulas are provided.

---

### Definitions for VDI 2714 / 2720 / ISO 9613

For the calculations in accordance with the VDI 2714 / 2720 / ISO 9613 the following settings can be selected:

Calculation of the air absorption accordance with ISO 3891 or ISO 9613 or ANSI 126 or calculate without air absorption. When the air absorption is set to ISO 3891 or ANSI 126 only the values of the standard in regards to pressure, temperature and relative moisture are available. If the ISO 9613 is selected, all intermediate values are calculated from the relaxation curves for these elements.

Area sources at loading time are triangulated, at calculation time SoundPLAN subdivides the triangles if the dimensions of the source are too big (compared to the distance of the equivalent point source). The resulting polygons are intersected with the search triangle and ground effect and screening are assessed to see if the source is homogenous. If not the source will be subdivided further. In the field diameter of source to distance the automatic subdivision can be controlled.

If the relationship diameter to distance would be evaluated strictly, a receiver located within the source would subdivide the source forever. To handle this case you can control the minimum distance at which the subdivision should be undertaken. All sources located closer will be processed without further disintegration.

The number of iterative steps taken and the maximum tolerable spread of ground effect can be controlled to customize the calculation core to your application.
General Prediction Method

Report 32 from the Lydteknisk Laboratorium (now DELTA ACOUSTIC and VIBRATION) is titled "Environmental Noise from Industrial Plants. General Prediction Method." It is referred to as General Prediction Method in SoundPLAN. All Scandinavian countries involved in the Nordforsk project are working in accordance to this document.

The Austrian Acoustical Society (Österreichischer Arbeitsring für Lärmbekämpfung) translated the report into German under the report number ÖAL 28. It is binding in all of Scandinavia and Austria.

The calculations can be performed on the basis of 1/1 or 1/3 octaves. However, as the equations are given only in 1/1 octaves, the recommendation is to use 1/1 octaves. For calculations with single frequencies, the equations will revert to one of the 8 octaves for the ground effect.

Concepts and Equations (Gen. Pred. Method, ÖAL 28)

The noise level at the receiver for a single frequency is calculated with the equation:

\[ L(f) = L_w + \text{directivity} + \text{divergence} + \text{air absorption} + \text{screening} + \text{ground effect} - \text{volume type absorption} \]

- **directivity** directional influence of the source radiating the noise unevenly (horizontal and vertical)
- **divergence** spreading with \(-10 \log(R^2) + 11 \text{ dB} \)
- **air absorption** The General Prediction Method prefers ANSI 126, the ÖAL 28 prefers the ISO 3891. Calculations according to ISO 9613 are also possible. See section "Air Absorption" on page 375.
- **screening** single and multiple obstacle with horizontal and vertical screening
- **ground effect** ground absorption and reflection
- **volume type absorption** (in plant scattering, attenuation due to foliage, buildings etc.)

**Directivity**

Source directivity is described in chapter 4 „Directivity libraryand chapter 3 „industrial sources“ concerning input of the directivity.

**Divergence**

\[ DL_d = -10 \log (4 \pi R^2) \]

\[ DL_d = -20 \log (R) - 11 \]

The reflection on the ground, which in some standards is added to the source ( \(+3 \text{ dB (A)}\) ), is calculated as part of the ground effect and may not be used in conjunction with the General Prediction Method.
Screening

Industry noise is implemented with single screening and procedures concerning when and how to calculate double screening. There is no limitation concerning double screening in the standards text. In a note from the developers of the standard, this limitation is temporarily defined as: The distance between the two screens needs to be larger than 0.25*dist (source to receiver).

To qualify as a screen, the horizontal dimensions perpendicular to the line between source and receiver should be greater than one wavelength. Screening is evaluated for both the illuminated and the shadow zone (positive and negative extra path length). The extra path length is calculated with regard to the curve of the transmission path due to the refraction in the atmosphere. The effect of the refraction is \( \Delta h = \frac{D1 \times D2}{16 \times (D1 + D2)} \).

In the picture, the refraction raised the intersection between the screen and the line of sight by \( \Delta h \) from position K to position Q. The extra path length is calculated \( (source - T) + (T - receiver) - (source - Q) - (Q - receiver) \). The effective screen height \( h_e \) is the distance between Q and T. As the screening reduces the ground effect, the source and receiver height \( H_i \) and \( H_s \) are measured from the increased height position rather than the ground.

The screening evaluates the Fresnel Numbers over and around the obstacle. The calculation of the extra path length for the side diffraction is completed as explained in Chapter 6.2.2.4.

\[
\Delta L_S = 10 \times C_h \times \log \left[ \frac{1}{(20N_v + 3)} + \frac{1}{(20N_l + 3)} + \frac{1}{(20N_r + 3)} \right]
\]

- \( C_h \): screen size correction
- \( N_v \): Fresnel number for the bending over the screen
- \( N_l \): Fresnel number for the screening around the object to the left
- \( N_r \): Fresnel number for the screening around the object to the right
**Ground effect**

The ground effect assumes there is a source, middle and receiver component for which frequency dependent procedures calculate the ground effect. The main parameters are the source height \((H_s)\) and the receiver height \((H_i)\) above the reflection plane and the ground absorption coefficient.

![Diagram showing source, middle, and receiver zones with distances](image)

**Calculation of \(H_s\) and \(H_i\), the heights above the reflection plane**

In the first order, \(H_s\) and \(H_i\) are fixed at the data entry level. For the receiver, the program assumes a 2 meter default value for single receivers, or 2.8 meters for the lowest of a multi story receiver calculation. When the receiver is attached to a building, the ground is fixed at the bottom of the reflecting wall. If the user wants to deviate from the default conditions or the automatic calculation, a control line establishes the height of the receiver above the reflection plane. The user must implement ground elevation for the source.

These are the first order measures to establish the values for \(H_i\) and \(H_s\). Unfortunately, this is not a solution for all cases. When a source is close to the edge of a roof, the values for \(H_s\) may be different in all directions! Additional problems occur if we assume the ground is not flat. For these cases, SoundPLAN calculates the source and receiver heights using statistics. A regression analysis beginning at the source evaluates the best fit for an assumed reflection plane. The same procedure also occurs at the receiver. The calculation proceeds as follows:
In the propagation direction from source to receiver, spot heights are calculated assuming the ground is flat between the points. Data is derived from elevation lines, screens and other objects containing elevation information.

Using these spot heights, the program searches for “nearly” flat sections within the given profile. Using a regression analysis, the program reduces the number of flat sections to a maximum of 5.

SoundPLAN calculates Hi, Hs and the possible extension 30*Hi, Hs for all possible sections. Selecting the section with the best fit for Hi,Hs and distances Di,Ds produces the correct Hi and Hs. With this procedure, SoundPLAN automatically reproduces calculations f in Appendix E of the General Prediction Method.

The formulas for the ground effect are:

<table>
<thead>
<tr>
<th>Frequency in Hz</th>
<th>Ground effect for source and receiver part in dB</th>
<th>Ground effect for the middle part in dB</th>
</tr>
</thead>
<tbody>
<tr>
<td>63</td>
<td>1.5 - G * a(h)</td>
<td>3*m</td>
</tr>
<tr>
<td>125</td>
<td>1.5 - G * b(h)</td>
<td></td>
</tr>
<tr>
<td>250</td>
<td>1.5 - G * c(h)</td>
<td></td>
</tr>
<tr>
<td>500</td>
<td>1.5 - G * d(h)</td>
<td>3 * m (1 - G)</td>
</tr>
<tr>
<td>1000</td>
<td>1.5 * (1 - G)</td>
<td></td>
</tr>
<tr>
<td>2000</td>
<td>1.5 * (1 - G)</td>
<td></td>
</tr>
<tr>
<td>4000</td>
<td>1.5 * (1 - G)</td>
<td></td>
</tr>
<tr>
<td>8000</td>
<td>1.5 * (1 - G)</td>
<td></td>
</tr>
</tbody>
</table>

\[
a(h) = 1.5 + 3.0 \exp^{-0.12 \times (h-5)} \times (1-\exp^{-d/50}) + 5.7\exp^{-0.69 \times d} \times (1-\exp^{-2.8 \times 10^{-6} \times d^2}) \\
b(h) = 1.5 + 8.6 \exp^{-0.09 \times d} \times (1-\exp^{-d/30}) \\
c(h) = 1.5 + 14 \exp^{-0.46 \times d} \times (1-\exp^{-d/50}) \\
d(h) = 1.5 + 5.0 \exp^{-0.9 \times d} \times (1-\exp^{-d/50}) \\
m = 0 \quad \text{for} \ d \leq 30 \times (h_i + h_j) \\
m = 1 - \frac{30 \times (h_i + h_j)}{d} \quad \text{for} \ d > 30 \times (h_i + h_j)
\]

**Influence of Screening upon the Ground Effect**

Calculation of the ground effect is dependent upon the parameters Hs and Hi for source and receiver components of the propagation. When screening occurs, the ground effect needs to be decreased. Raising the source / receiver height above the reflection plane using the formula Hs = Hs + He * (1 - dss/d) accomplishes this. Only evaluate this when Hs is less then 5 meters, causing a break in the model (SoundPLAN has omitted this limitation). The length of Ds and Di is calculated with the “physical” source height. The values Ds and Di are used for calculating the values of G for the source and receiver and for the assessment if a middle section is present.

All objects found in the direct propagation path are evaluated, and objects below the plain from source to receiver are excluded from the side diffraction. As the General Prediction Method confines screening to the two most effective screens, there is a deviation from the recommended procedures. In the General Prediction Method, the
effective screen height is calculated for every pair of normal and side diffractions. Here, the side diffraction is evaluated in the conventional way for the most and second most effective screens.

**Influence of the Side Diffraction upon Ground Effect**

A grid noise map calculated for a large power plant indicated problems created within the standard. Section 4.7 states that $h_{s,i}$ is to be lifted when $h_{s,i} < 5\text{m}$ and significant screening occurs. For consistency reasons and with consent from standards developer, this condition $<5$ was removed. The "significant screening" can also create problems. In the evaluated case, the obstacle was the machine house of a big power plant and the source was not attached to the building. As it turned out, the noise behind the building was greater than in the free field. The analysis showed the reason to be that the $H_e$ was very high and the extra path length around the building was very small on one side. SoundPLAN calculates the free field conditions and compares them to the screened case with the shift in the ground effect. It then verifies there is no increase due to the lifting of source and receiver.

**Multiple Screening**

A single screen is limited in the screening to a 20 dB reduction. For multiple screening, SoundPLAN assumes the top of screen one as an imaginary source and if the limitations of the distance from screen to screen is observed, it calculates the value for the second screen. The overall screening can then amount to 40 dB. It is important to switch the screen positions and calculate first for one position and then reverse and calculate the second combination of screens. Choose the combination with the highest attenuation. SoundPLAN deviates from the given procedures in Step b of Appendix C. The side diffraction of a single screen is not evaluated. For long screens, the result is identical with the test questions, but for short screens there is a deviation in results.

**Reflections**

For Reflections, the restrictions concerning the angle of incident and the sizes are implemented. The restriction stating the reflection should be taking place a wavelength from the edge of the reflector was not implemented. Cylindrical objects are not part of the model as they need to be simulated in segments.

**Deviations from General Prediction Method, ÖAL28**

With the permission of the organization developing the standard, the following positions were modified:

When significant screening occurs, the ground attenuation is changed. The source and receiver height used in the ground attenuation are to be changed when $H_{source}$ or $H_{receiver}$ are less than 5 meters. As a receiver 4.99 meters above the ground would be lifted to a higher position than a receiver set at 5.01, the limitation was omitted.

If there is a high value for screening over an obstacle (effective height of screen many meters) but source and receiver are in a position where the horizontal diffraction is carrying the noise around the building, the increase of source and
receiver height will cause an increase of noise levels behind the building. SoundPLAN compares the two effects and makes sure that no increase of noise levels will occur.

The selection process for the $H_{source}$ and $H_{receiver}$ in complex terrain is not detailed in the standard. With the statistical formulas (linear regression), SoundPLAN partitions the distance from source to receiver into 5 sections and then selects which has the best fit. (There are no procedures for this in the standard).

For double screening, there must be a certain distance between two screens to count as two individual screens. (This distance is not specified in the standard.) The developers of the standard set the distance between the screens to 0.2 * distance from source to receiver. SoundPLAN has implemented this.

**CONCAWE**

The CONCAWE methods is a research paper especially designed for the requirements of large facilities. It was published in 1981 under the title, "The propagation of noise from petroleum and petrochemical complexes to neighboring communities." This method is the only one dealing explicitly with the influence of wind and the stability of the atmosphere.

**The Equations of the Standard (CONCAWE)**

The sound pressure at the receiver is described with:

$$L_p = L_w + D - \Sigma K$$

$L_w$ sound power

$D$ directivity of the source

$\Sigma K$ correction factors $K_1..K_7$

$$K_1 = 10 \times \log (4 \times \pi \times d^2)$$  See chapter 6.2.2.2 for details.

$$K_2 = \text{air absorption}$$  See chapter 6.2.2.3 for details.

The air absorption is evaluated in accordance to ISO 9613 or ISO 1913 part 1 or ANSI 126 or the ISO3891.

$K_3$ = ground attenuation set to -3 dB for hard surfaces

The following equations apply for propagation over soft surfaces:

$$K_{3,63 \text{ Hz}} = 33.4 -35.04 (\log d) + 19.159 (\log d)^2 - 0.3508 (\log d)^3$$

$$K_{3,125 \text{ Hz}} = 8.96 - 35.8 (\log d) + 20.4 (\log d)^2 - 2.85 (\log d)^3$$

$$K_{3,250 \text{ Hz}} = -64.2 + 48.6 (\log d) - 9.53 (\log d)^2 + 0.634 (\log d)^3$$

$$K_{3,500 \text{ Hz}} = -74.9 + 82.23 (\log d) - 26.921 (\log d)^2 + 2.9258 (\log d)^3$$

$$K_{3,1k \text{ Hz}} = -100.1 + 104.68 (\log d) - 34.693 (\log d)^2 + 3.8068 (\log d)^3$$

$$K_{3,2k \text{ Hz}} = -7.0 + 3.5 (\log d)$$

$$K_{3,4k \text{ Hz}} = -16.9 + 6.7 (\log d)$$

$d$ = distance from source to receiver
If the propagation is over both hard and soft ground, only the soft ground is used for distance d.

\( K_4 \) = correction due to refractions by wind and temperature gradients.

The basis of this correction is the meteorological category of the atmosphere which is assessed in accordance with Pasquill and Turner:

<table>
<thead>
<tr>
<th>Meteorological Category</th>
<th>A, B</th>
<th>C, D, E</th>
<th>F, G</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>V &lt; -3.0</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td>-3 &lt; V &lt; -0.5</td>
<td>V &lt; -3.0</td>
<td>-</td>
</tr>
<tr>
<td>3</td>
<td>-0.5 &lt; V &lt; 0.5</td>
<td>-3 &lt; V &lt; -0.5</td>
<td>V &lt; -3.0</td>
</tr>
<tr>
<td>4</td>
<td>0.5 &lt; V &lt; +3</td>
<td>-0.5 &lt; V &lt; +0.5</td>
<td>-3 &lt; V &lt; -0.5</td>
</tr>
<tr>
<td>5</td>
<td>V &gt; +3.0</td>
<td>0.5 &lt; V &lt; +3</td>
<td>-0.5 &lt; V &lt; +0.5</td>
</tr>
<tr>
<td>6</td>
<td>-</td>
<td>V &gt; +3.0</td>
<td>0.5 &lt; V &lt; +3</td>
</tr>
</tbody>
</table>

All values are set to zero for category 4. The other categories have additional formulas for the meteorological correction in the different categories:

**63 Hz**
- \( K_{4, category 1} = -38.9 + 26.4 \log d - 2.84 (\log d)^2 - 0.234 (\log d)^3 \)
- \( K_{4, category 2} = 16.1 - 28.43 (\log d) + 14.4 (\log d)^2 - 2.1 (\log d)^3 \)
- \( K_{4, category 3} = -4 + 2 (\log d) \)
- \( K_{4, category 5} = 3.35 - 2.26 (\log d) + 0.407 (\log d)^2 - 0.0572 (\log d)^3 \)
- \( K_{4, category 6} = 69.3 - 73.2 (\log d) + 24.688 (\log d)^2 - 2.7531 (\log d)^3 \)

**125 Hz**
- \( K_{4, category 1} = -137 + 142 (\log d) - 46.8 (\log d)^2 + 5.14 (\log d)^3 \)
- \( K_{4, category 2} = -23.2 + 19.53 (\log d) - 4.646 (\log d)^2 + 0.3358 (\log d)^3 \)
- \( K_{4, category 3} = -3 + 1.5 (\log d) \)
- \( K_{4, category 5} = 6.8 - 3.4 (\log d) \)
- \( K_{4, category 6} = 29.5 - 25.62 (\log d) + 6.286 (\log d)^2 - 0.4904 (\log d)^3 \)

**250 Hz**
- \( K_{4, category 1} = -104 - 100 (\log d) - 30.3 (\log d)^2 - 3.03 (\log d)^3 \)
- \( K_{4, category 2} = -84.9 + 91.93 (\log d) - 30.873 (\log d)^2 - 3.4295 (\log d)^3 \)
- \( K_{4, category 3} = -100.6 + 101.23 (\log d) - 32.352 (\log d)^2 + 3.4306 (\log d)^3 \)
- \( K_{4, category 5} = 7.4 - 4.2 (\log d) \)
- \( K_{4, category 6} = 31.7 - 23.81 (\log d) + 4.055 (\log d)^2 - 0.1043 (\log d)^3 \)

**500 Hz**
- \( K_{4, category 1} = -20.9 + 3.86 (\log d) + 6.39 (\log d)^2 - 1.43 (\log d)^3 \)
- \( K_{4, category 2} = -133.7 + 142.63 (\log d) - 47.851 (\log d)^2 + 5.3118 (\log d)^3 \)
- \( K_{4, category 3} = -96.8 + 102.98 (\log d) - 34.868 (\log d)^2 + 3.9016 (\log d)^3 \)
- \( K_{4, category 5} = 7.4 - 4.2 (\log d) \)
- \( K_{4, category 6} = 19.8 - 8.8 (\log d) - 2.035 (\log d)^2 + 0.6747 (\log d)^3 \)
### 1000 Hz

<table>
<thead>
<tr>
<th>Category</th>
<th>Equation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category 1</td>
<td>$K_{4,1} = -54.3 + 39 \log(d) - 4.92 \log(d)^2 - 0.239 \log(d)^3$</td>
</tr>
<tr>
<td>Category 2</td>
<td>$K_{4,2} = -148.2 + 164.99 \log(d) - 56.287 \log(d)^2 + 6.3422 \log(d)^3$</td>
</tr>
<tr>
<td>Category 3</td>
<td>$K_{4,3} = -150 + 160.95 \log(d) - 54.786 \log(d)^2 + 6.1604 \log(d)^3$</td>
</tr>
<tr>
<td>Category 5</td>
<td>$K_{4,5} = 104.6 -108.03 \log(d) + 35.295 \log(d)^2 - 3.8227 \log(d)^3$</td>
</tr>
<tr>
<td>Category 6</td>
<td>$K_{4,6} = 123.4 -127.6 \log(d) + 42.017 \log(d)^2 - 4.584 \log(d)^3$</td>
</tr>
</tbody>
</table>

### 2000 Hz

<table>
<thead>
<tr>
<th>Category</th>
<th>Equation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category 1</td>
<td>$K_{4,1} = -69.9 + 63.6 \log(d) -16.9 \log(d)^2 + 1.43 \log(d)^3$</td>
</tr>
<tr>
<td>Category 2</td>
<td>$K_{4,2} = -143 + 142.18 \log(d) -44.509 \log(d)^2 + 4.6195 \log(d)^3$</td>
</tr>
<tr>
<td>Category 3</td>
<td>$K_{4,3} = -116.3 + 120.85 \log(d) - 39.944 \log(d)^2 + 4.378 (log d)^3$</td>
</tr>
<tr>
<td>Category 5</td>
<td>$K_{4,5} = 60.3 - 64.07 \log(d) + 21.458 \log(d)^2 - 2.3784 \log(d)^3$</td>
</tr>
<tr>
<td>Category 6</td>
<td>$K_{4,6} = 82.3 - 90.98 \log(d) + 31.444 \log(d)^2 - 3.584 \log(d)^3$</td>
</tr>
</tbody>
</table>

### 4000 Hz

<table>
<thead>
<tr>
<th>Category</th>
<th>Equation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category 1</td>
<td>$K_{4,1} = -126 + 128 \log(d) -40.4 \log(d)^2 + 4.24 \log(d)^3$</td>
</tr>
<tr>
<td>Category 2</td>
<td>$K_{4,2} = -125.4 + 124.75 \log(d) -38.807 \log(d)^2 + 4.017 \log(d)^3$</td>
</tr>
<tr>
<td>Category 3</td>
<td>$K_{4,3} = -127.5 + 135.12 \log(d) - 45.709 \log(d)^2 + 5.113 \log(d)^3$</td>
</tr>
<tr>
<td>Category 5</td>
<td>$K_{4,5} = 28.7 - 20.1 \log(d) + 2.68 \log(d)^2 + 0.0957 \log(d)^3$</td>
</tr>
<tr>
<td>Category 6</td>
<td>$K_{4,6} = 66.4 - 60.77 \log(d) + 16.409 \log(d)^2 - 1.4457 \log(d)^3$</td>
</tr>
</tbody>
</table>

The wind direction is always defined as the component in the direction to or from the source. Crosswind components are ignored. If the wind speed was entered without the wind direction, the program uses the worst case scenario for all directions.

$K_{4,1}$ = source and receiver height correction if the propagation line of sight is more than 2 meters above the ground.

For $(K_3 + K_4) > -3$ dB,

$K_5 = (K_3 + K_4 + 3) \times (\gamma - 1)\ dB$

$\gamma = \arctan \left( \frac{H_s + H_r}{d} \right)$

$H_s =$ height of the source above the ground

$H_r =$ height of the receiver above the ground

$K_6 =$ screening based on the Fresnel number $N$ derived from the diffraction theory. As the equations from the Nordic General prediction method were used here, see details in "General Prediction Method" on page 431.

$K_7 =$ in plant scattering. As no details are given in the standard, details from volume attenuation apply (see "Volume Type Absorption" on page 383).

### Traps and Solutions

As the formulas use third order polygons with large constants, their border value for the distance 0 meters would be the constant. Therefore the formulas are only valid for distances greater than 100 meters. As there is no guarantee that the formulas are not used at smaller distances, SoundPLAN extrapolates the formulas for the area.
between zero and 100 meters. The value at the distance is set to zero and the value at
100 meters is calculated using the formulas. Values between 0 and 100 meters are
calculated with linear interpolation.

Screening, double screening and the change of ground attenuation in the screened
case are not explicitly detailed in the CONCAWE standard, which only provides
references to other papers. SoundPLAN uses the Nordic procedures for the
screening.

Calculations Inside Buildings

Calculations inside buildings are used for many different reasons. The acoustics in a
concert hall is calculated before the hall is built, and the acoustical quality can be
fine-tuned for music or for speech. Noise calculations, on the other hand, are used to
protect workers exposed to a noisy environment. There are many different
applications for different purposes and each one has special requirements.

Models in the category of tuning concert halls require large amounts of data for
modeling every surface larger than a certain size. The model in SoundPLAN is not
suited for these calculations. The Indoor Factory Noise model calculates noise in the
workplace for noise control purposes. The noise model must be built quickly and
deliver results for receivers inside, as well as information for modeling the noise
outside the factory.

The VDI 3760 E was chosen as a model because it does not require detailed data on
all surfaces inside the building, yet is flexible enough to solve the questions for
noise in the workplace. The geometry of the room is not significant, the only
limitation is that the floor must be flat and the floor and ceiling parallel to each
other. Different sections of the walls can have different absorptive properties.

The interaction with outside geometry uses a ray tracing model, with the scattering
of smaller objects following the Sabine principles. Both the inside and outside
calculations use the same ray tracing technique for 2 dimensions. The floor and
ceiling need to be parallel because the third dimension of reflections is taken care of
by mirroring the sources at floor and ceiling.

VDI 3760E

The following chapter provides a brief summary of the mathematical concepts
SoundPLAN uses in the Indoor Noise Module.

Basic Assumptions VDI 3760E

Simplifications are required for calculating indoor sound pressure levels. As
proposed in the VDI 3760E, this model assumes the following:

The laws of geometrical acoustics are used. Therefore wave type phenomena are
absent. Surfaces, which are all planes, reflect the sound energy spectrally as if from
an infinite plane. Any surface absorbs sound energy according to an energy
absorption coefficient, which is independent from the angle of incidence. Sound is
treated as an energy function, not as a pressure function. Therefore energies may be summed directly and phase effects are absent.

**General Equations VDI 3760E**

Scattering of sound from obstacles in the room (tables, machines, etc.) is accounted for statistically. Thus, a characteristic is the scattering object density:

\[
q = \frac{S}{4\pi V}
\]  

or the mean free path \( l_m \) of the sound rays between succeeding scatterings

\[
l_m = \frac{1}{q} = \frac{4\pi V}{S}
\]  

\( S \) is the total surface of everything in the room volume \( V \) with objects bigger than the wavelength.

The sound energy in the room consists of direct and scattered sound. Direct sound is that part of the sound energy which hasn't been scattered on its way to the receiver. For a point sound source in an homogeneous, infinitely large room filled with scattering objects, this part of the energy density is:

\[
E_d(r) = \frac{P}{4\pi c r^2} e^{-(q+m)r}
\]

\( P \) = Sound power of the source [W]
\( q \) = Scattering object density [1/m] defined in (1)
\( c \) = Speed of sound [m/s]
\( r \) = Distance between sound source and receiver [m]
\( m \) = damping constant of air

The energy density of the direct sound in a closed room is the sum of the energy densities from the original and all mirror sources. For the mirror sources, the reflection losses must be taken into account. This sum is:

\[
E_{d} = \sum_{i=-\infty}^{\infty} \sum_{j=-\infty}^{\infty} \sum_{k=-\infty}^{\infty} (1-\alpha)^{il} (1-\alpha)^{jl} (1-\alpha)^{kl} E_{d}(r_{ij})
\]

\( \alpha_x, \alpha_y, \alpha_z \) are the mean absorption coefficients of the room boundary planes (mirror planes). \( r_{ij,k} \) is the distance between the mirror source of order \( i,j,k \) and the receiver.

In SoundPLAN, a ray tracing algorithm in the x,y plane finds the position of the mirror sources and the direction of the sound to the receiver. The z direction assumes the plane has a horizontal floor and ceiling. This allows the user to calculate buildings with arbitrary floor plans, having parallel floor and ceiling.
Calculation of the Scattering Energy Density

The method used is a 1986 development of S. Jovicic, based on his 1979 ("2") paper. According to ("2"), the energy density of the scattered sound in an infinitely wide flat room is:

\[ E_s(r) = \frac{3q*p}{4\pi*c*r} * e^{-r*sqrt(3*q*a)} \]  

(5)

with

\[ a = b + \alpha_s'q + m \]  

(6)

The \( \alpha_s' \) is the mean absorption exponent of the scattering objects

\[ \alpha_s' = -\ln(1 - a_s) \]  

(7)

The exponent b describes the sound energy losses due to absorption of floor and ceiling. It is calculated as follows:

for \( qh<1 \)

\[ b(\alpha_i) = -q*ln(qh*1 - \frac{\alpha_i}{4}) + (1 - \frac{\alpha_i}{2}) * \frac{2}{h} * [1 - \exp(-\frac{\alpha_s'}{2} * (\frac{1}{qh} - 1))] \]  

(8)

and for \( qh>=1 \)

\[ b(\alpha) = -q*ln(1 - \frac{\alpha}{4} * qh) \]  

(9)

\[ b = b(\alpha_{\text{floor}}) + b(\alpha_{\text{ceiling}}) \]  

(10)

\( h = \) mean height of the room

\( \alpha_{\text{floor}}, \alpha_{\text{ceiling}} = \) mean absorption coefficient of floor and ceiling

The energy density in an infinite closed room is analogue to Eq. (4)

\[ E_d = \sum_{i=-\infty}^{\infty} \sum_{j=-\infty}^{\infty} \sum_{k=-\infty}^{\infty} (1 - \alpha_x)^\| * (1 - \alpha_y)^\| * E_s(r_{\text{inf}}) \]  

(11)

The reflection coefficients for floor and ceiling are omitted because they are already included in the derivation of equations (8) or (9). A ray tracing method is again used in the summation.

Sound Propagation Curves (SPC)

The SPC measurements or calculations are an indication of the acoustical quality of the room, just as is the reverberation time. Except for rooms where Sabine's Theory applies, the reverberation time depends on the positions of the source and
microphone and therefore can not serve as a 'merit figure' of the room. In contrast, if proper SPC paths are selected, the SPC provide an overview on the acoustical quality of the entire room.

In the SPC measurement procedure, a point source with a uniform distribution of sound energy (e.g. a Dodekeader Loudspeaker System) and a known power level per octave is used. The sound pressure level along a certain measurement path is measured with the source at the beginning.

If you measure the sound pressure level at the distance r from the source in the same octave band \( L_{p,f}(r) \), then the Sound Propagation Curve is the row of numbers

\[
D_f(r) = L_{p,f}(r) - L_{w,f}
\]

These values (numeric differences between measured sound pressure levels and the sound power level of the sources) correspond to the real sound pressure level calculated from a source with 0 dB sound power level in each octave band.

In practice, as SPC should refer to a given spectrum of the source, an over all SPC-value is:

\[
D = 10 \times \log \left( \sum \frac{10^{(D_f + L_{w,f})/10dB}}{10^{L_{w,f}/10dB}} \right) dB
\]

The following spectrum normalizes the frequency (A-weighted) Sound Propagation Curve \( SPC_\omega \).

<table>
<thead>
<tr>
<th>Frequency [Hz]</th>
<th>63</th>
<th>125</th>
<th>250</th>
<th>500</th>
<th>1000</th>
<th>2000</th>
<th>4000</th>
<th>8000</th>
</tr>
</thead>
<tbody>
<tr>
<td>( L_{w,f,0} )</td>
<td>-26.5</td>
<td>-22.1</td>
<td>-12</td>
<td>-12</td>
<td>-8.4</td>
<td>-7.1</td>
<td>-5.7</td>
<td>-5.7</td>
</tr>
</tbody>
</table>

The path of the Sound Propagation Curves is not critical if the room has a simple structure. The measurement can be used to estimate the sound pressure level for a group of sources at a receiver.

Assessment of the SPC provides two characteristics. The first is the excess level above free field, and the second is the decay per doubling of distance. Both characteristics are calculated for three different distance regions.

near \( 1m \leq r \leq 5m \)

In this region, the SPC is dependent on the direct sound field of the source. The relative position of the source to the reflecting surface has a major influence on the sound propagation (i.e. a source in a corner of the room).

middle \( 5m \leq r \leq 16m \)

This is the most important region for the acoustical assessment of a room. According to VDI3760, this region should be used to evaluate the acoustical quality.

far \( 16m \leq r \leq 64m \)

The SPC usually depends on the facilities in the room (scattering objects).
Excess Level Above Free Field DLf

The free field value for the distance $r_i$ is defined:

$$D_{i,B} = 20 \times \log \left( \frac{r_0}{r_i} \right) \text{dB} - 11 \text{dB} \quad \text{with} \quad r_0 = 1\text{m}$$

The higher the SPC is above the free field curve, the greater the influence of the room and its reflecting objects, and the more negative the acoustical quality.

The difference level between free field curve and SPC of sample $i$ is:

$$DL_f = D_i - D_{i,B}$$

The mean excess level above free field between $r_n$ and $r_m$ with the samples $i = n..m$ is:

$$DL_f(r_n, r_m, f) = \frac{\sum (D_{i,f} + D_{i+1,f}) \times \log \left( \frac{r_i}{r_{i+1}} \right)}{2 \times \log \left( \frac{r_m}{r_n} \right)} \quad \text{with } \Sigma \text{ from } i=n+1 \text{ to } m$$

Decay per Doubling of Distance DL2

This is another value used to evaluate the influence of the room.

The DL2 from the samples $i = n..m$ of the SPC-values $D_i$ in the frequency-band $f$ is calculated using a regression analyses:

$$DL_2(r_n, r_m, f) = \frac{Z \times \sum D_i \times \log \left( \frac{r_i}{r_0} \right) - \sum D_i \times \sum \log \left( \frac{r_i}{r_0} \right)}{Z \times \sum (\log \left( \frac{r_i}{r_0} \right))^2 - (\sum \log \left( \frac{r_i}{r_0} \right))^2}$$

with $z=m-n+1$ ; with $\Sigma$ from $i=n+1$ to $m$

The Indoor Factory Noise Module Calculation Method

Integration of indoor and outdoor noise
SoundPLAN has implemented the calculation inside buildings as a two dimensional ray tracing method with a calculation of the diffuse scattered noise from a statistical assessment. The principles are explained in Chapter 6.5.

There are several restrictions that must be observed when using the Indoor Factory Noise Module:

- Floor and ceiling need to be parallel to one another.
- All reflecting walls need to have the same height.
- The ceiling can only have an average absorption coefficient.
- Walls can be segmented but the absorptive properties are uniform for the whole wall segment.
- Diffractions cannot be handled inside the factory building.

Indoor Factory Noise calculates the model in octaves, so it is wise to enter the data in octave bands. The calculations inside the building continue until the margin of error is less than 0.5 dB. This creates long calculation times for rooms with low interior absorption.

Calculations for different types of receivers are as follows:

- Single receiver calculation with all post processing options as the calculation outdoors.
- Grid Noise Map to create noise contour maps inside the building. Here the calculation area shall not be bigger than the building.
- Calculation of the Sound Propagation Curve (SPC). This calculation provides a more in-depth characteristic of the room's acoustical quality than the reverberation time. SoundPLAN places receivers along a defined measurement path and then calculates the noise. A source with a test spectrum is placed at the beginning of the path. The receivers are spaced along the path beginning with very short distances with distances increasing with greater distance from the receiver. The SPC results are written in a file which can graphically display the SPC curve. The curve compares the noise decay to free field conditions.

- Noise calculation needed for calculating the noise from the building. After defining the noise transmission for all walls, SoundPLAN calculates receivers for the middle of each section of the room.

**Interpretation of the SPC**

The acoustical quality of a room depends on the two parameters $DL_f$ and $DL_2$, the higher $DL_2$ and the smaller $DL_f$, the better the quality of the room. If the middle part of an industrial hall (distance 5 to 16 meters) shows $DL_2$ greater than or equal to 4 dB and $DL_f$ is smaller than 8 dB, the room can be evaluated as a good room in the view of the industrial noise control. (Quote from VDI 3760)
Special Noise Calculation Cases

All calculation standards use situations with normal free field conditions, spreading, screening and ground effect. In practice, there are always cases for which the models are not prepared. Often the easiest way to deal with the problem is to measure the effect and make the assessments. As there is nothing to be measured in the planning stage, a model estimate must be used. The next sub chapters outline cases with special inlaid sources for noise radiating buildings, effects of tunnels, noise galleries and bridges.

Buildings as Sources

The sound power radiated from a building is usually derived from the noise levels inside the building and the transmission losses at the outer walls and the roof. The noise level inside the building can be measured or simulated and sometimes a typical setup is found in the literature. Regardless how the noise levels on the inside are acquired, the procedures for calculating the noise on the outside are the same:

1. DATA TRANSFER
   Building -> Sources

2. Desintegration
   Insertion of windows and openings

3. Assignment of source data to surfaces
   - Noise level inside for every component from the library added up or directly derived from an inside calculation
   - Transmission losses from the library
   - Calculation of the emitted sound power in the “New Source Entry Sheet”

4. Calculation Run for the outside noise

Calculation procedures from noise inside a building to outside

SoundPLAN can transfer a building into a source. A new source can automatically be generated for the walls and for the ceiling. If the roof is not flat, there is no automatic procedure available.

Defining inlaid areas of windows and doors reduces the size of the different faces of the building. At loading time, SoundPLAN transfers every source into a list of triangles and cuts inlaid sources out of the outer shell. This guarantees that the combined area size of the wall and the window yields the total facade area. No surface is counted twice.
If the noises levels on the inside of the building were calculated from an Indoor Factory Noise calculation, they can be used for the calculation on the outside. Detailed descriptions of procedures are in the chapter describing file entry and manipulations of the Geo-Database.

**Tunnel**

The mouth of the tunnel has the characteristic of an area source. It is very important not to assume the noise originates 0.5 meters above the ground - especially when noise screens are connected to the tunnel. The shape of the tunnel and the acoustic treatment inside the tunnel influences the directivity associated with the tunnel. As there is no traffic model managing directivity, this chapter assumes a uniform directivity of the noise emitted from tunnels. The procedures and formulas are describing a simplified model, more complex models would use directivities to describe the source.

The calculation can be completed using the traffic or industry model. The German RLS 90 and VDI 2714 were used as examples.

**Calculation of a Tunnel with the road model**

The area source of the mouth of the tunnel is replaced with line sources for every meter of the tunnel portal. The emission for the road sections is as follows:

\[
L_{m25} = L_{mFBR} + D_{Tunnel} - 19.2 + K \text{ dB(A)}
\]

- \(L_{m25}\) Emission of the line sources per meter of tunnel portal
- \(L_{mFBR}\) Noise level calculated for the curb position from an infinitely long linesource
- \(D_{Tunnel}\) Adjustment factor for the tunnel (derived from Internoise papers)
  - reflecting walls of the tunnel (concrete) addition = + 13 dB
  - absorbent walls with absorbent material inside the tunnel at least as far as 3 times the diameter of the tunnel. addition = + 5 dB
- \(K = 3\text{dB}\) for transmission of the noise into the quarter sphere

Note that the above listed emission needs to cover the tunnel from one side to the other, stacking source lines every meter.
Tunnel geometry

**Calculation of a Tunnel with the Industry Model**

The tunnel portal is defined as an area source with the sound power $L_w$ as:

$$L_{w*} = L_{mFBR} + D_{Tunnel} + K \text{ dB(A)}$$

- $L_{w*}$ sound power per square meter of tunnel portal
- $L_{mFBR}$ Noise level calculated for the curb position from an infinitely long line source
- $D_{Tunnel}$ Adjustment factor for the tunnel (derived from Internoise papers)
  - reflecting walls of the tunnel (concrete) addition = + 13 dB
  - absorbent walls with absorbent material inside the tunnel at least as far as 3 times the diameter of the tunnel. addition = + 5 dB
- $K_{Wall} = 3 \text{dB}$ for transmission of the noise into the quarter sphere

**Bridges**

Noise emitted from bridges can sometimes pose a big modeling problem. The side of the bridge provides some shielding effect from the noise of vehicles passing over the bridge. For most other sources, the bridge does not generate additional shielding as the noise must be able to pass underneath.

Bridges themselves can shield noise or they may have a noise screen mounted on the side. For road and railroad, SoundPLAN defines screening edges as those that are "visible" for the assigned source line. Activate the bridge in the tab index card BRIDGE and define the width between the road axis and the bridge edge and, if necessary the screening edges on the bridge.
Bridge definition

SoundPLAN's ray tracing procedure finds all geometry in the search direction. For screening and ground absorption, only objects located between the source and the receiver are evaluated. This means that a noise screen with an angled top like in the following picture will not be evaluated for the nearest road because the distance from the screen to the receiver is bigger than from the source to the receiver.

Noise screen with angled top

The solution for this situation is to define a bridge. The command can even be used if the noise wall completely covers the road like a gallery. For a gallery, the screening will be underestimated but the reverberation chamber increases the noise so that the two effects compensate each other for a first order estimate.

Gallery

As noted above, the conditional bridge commands simulate galleries for a rough estimate. This approach accounts for the direct influence of the sources upon the receiver. Due to reflections between the ceiling and the road, there is a diffuse sound field inside the gallery. The noise from this diffuse scattering must be added to the direct impact.
One possibility is to calculate the direct impact using conditional screens and defining a set of sources at the opening of the gallery similar to the tunnel procedure.

![Cross-section through a noise gallery with an extra screen](image)

**Calculation of the diffuse component in a gallery as industry noise**

The opening of the gallery is defined as an area source. The sound power is derived from the diffuse sound field inside the gallery. The numbers in the examples are prepared for the German RLS 90 and VDI 2714.

\[
L_{w,diffuse} = L_{mE} + 10 \cdot \log \left( S_{b0} \right) - 10 \cdot \log \left( \alpha_m \right) - 10 \cdot \log \left( h_{open} \right) - 10 \cdot \log ( n ) - 14.6 \ [\text{dB(A)}]
\]

- \( L_{w,diffuse} \): sound power per square meter. \([\text{dB(A)/m}^2]\) covering the opening of the noise gallery to account for the diffuse multiple reflections inside.
- \( L_{mE} \): sound pressure from the road inside the gallery calculated for the reference distance of 25 meters. \([\text{dB(A)}]\)
- \( \beta \): angle of coverage of the road inside the gallery (see next picture)
- \( \alpha_m \): average absorption coefficient inside the gallery (for frequencies 500-800 Hz)

\[
\alpha_m = \frac{\sum (\alpha_x \cdot A_x)}{\sum A_x} \quad \alpha_x \quad \text{abso. coefficient of surface x}
\]

- \( \alpha_x \): abso. coefficient of surface x
- \( A_x \): area of surface x
- \( \sum A_x \): sum of all surfaces in \( \text{m}^2 \) in gallery (road, ceiling, back)

- \( h_{open} \): height of the opening in front of the gallery. \([\text{m}]\)
- \( n \): number of lanes inside the gallery.

**Calculation of the diffuse component in a gallery as a road source**

\[
L_{mE,diffuse} = L_{mE} + 10 \cdot \log \left( S_{b0} \right) - 10 \cdot \log \left( \alpha_m \right) - 10 \cdot \log \left( h_{open} \right) - 10 \cdot \log ( n ) - 33.8 \ [\text{dB(A)}]
\]

- \( L_{mE,diffuse} \): sound pressure in 25 meters from the road. For every meter of height of the gallery opening, a separate emission band needs to simulate the diffuse noise component.
The rest of the components are analog to the industry model.

Definition of $\beta$

Some data entry details need to be observed for calculations at the closed side of the gallery. Regardless if roads or an industry area source simulate the opening of the gallery, the top of the gallery represents a screen for that noise component. If a road source simulates the opening, the top can be simulated with conditional screens, otherwise the top must be a regular elevation line or screen. If a regular elevation line or screen is used, remember that only geometry between the source position and the receiver is evaluated. In this case the extra screening element is between the area source and the receiver.
Implementation of the EU Directive on Environmental Noise

The EU Directive on the Assessment and Management of Environmental Noise passed in June 2002. However, the work on this directive is not yet completely finished.

For example, the EU Directive indicated which calculation standards should be preferentially used. But statements for the emission and meteorology for all member countries for road noise, railway noise and aircraft noise are still missing. The Dutch railway noise standard is not even available in English. There are plans, to solve these issues by June 2003. National standards, as far as they already exist, can be put on an equivalent state thereafter. Limit levels and time ranges must be defined by June 2004.

There are relatively clear definitions for evaluating health aspects and for the demands on strategic noise mapping and action plans, so they can be implemented for the most part. The dose-effect relation in comparison with the different noise types is still not clear.

SoundPLAN can only provide the implementation of the present state of affairs. We implemented some of the criteria very flexible, so you are able to adjust the settings, for example the definition of the time ranges, additional noise indices or the entry of the expected limit levels.

The Interim Calculation methods

With the implementation of the Dutch railway model RMR 2002 the Interim-calculation standards required for the EU Noise Mapping for road noise, railway noise and industry noise are implemented in SoundPLAN. The methods described in the final report for road (NMPB 96) and for industry (ISO9613) were already implemented in past versions but slightly revised to align them with the final report.

EMISSION CALCULATION "GUIDE DU BRUIT": constants and calculations for the parameter E were changed. The additions for the road surface type are now selected from the list defined in ISO 11819-1.

PROPAGATION CALCULATION NMPB96: Calculation of the air absorption according to standards conform parameters rather than fixed values. The percentage value p for the homogenate case can now be entered separately for each of the Lden time slices.

ISO 9613-2: The factor C0 was extended for the 3 time slices day, evening and night. This modification will cause changes in the documentation of the parameter Cmet in the mean propagation table.

Additional information concerning the Interim Calculation Methods can be downloaded from the website

http://forum.europa.eu.int/Public/irc/env/noisedir/library
Definition of Time Ranges and Standards

Call **OPTIONS -> SETTINGS** in the SoundPLAN Manager. You can define the time ranges and standards globally and for the current project.

Check the pre-settings of the **TIME RANGES**. They may not overlap and must include all 24 hours.

If you only want to utilize the time ranges day and night, enter e.g. 6-22 in the time range day, 0-0 in the time range evening and 22-6 in the time range night.

Go to **STANDARDS** in the tree view and select whether the emission calculation should be executed as before or according to the EU environmental noise standard.

The SoundPLAN home screen shows the selection of the emission calculation:

**Changes in the Assessment Library**

The assessment library has a new field, **TAKE PENALTIES INTO ACCOUNT** in the definition of the time ranges. Remove the mark in this field so the penalties in the library element *Lden* are not taken into account for the time ranges evening and night.

Annoyance Analysis

Facade Noise Map or City Noise Map is necessary for creating annoyance analyses and other implementation of the EU Directive on Environmental Noise. Both modules store additional building information and exclude the reflection of the own facade of the buildings. The Facade Noise Map automatically excludes the facade reflection. You can set the City Noise Map to exclude the facade reflection, by selecting the appropriate property in the tab index card **CITY NOISE MAP** in the run properties.
Supplementary Necessary Information

For an annoyance analysis, add additional information to the building properties (e.g. number of occupants, employees or pupils per building, or the zone type) and import them to the SoundPLAN spreadsheet for analysis.

In most cases, you won't know the occupants per building, but you can also use the number of occupants per area, or calculate them in the SoundPLAN spreadsheet using the floor area.

Define the usage areas in building blocks, in order to prepare the graphical display of affected people per hectare.

It would be useful to select the buildings where no one lives or works, store them in separate Geo-Files and assign 'auxiliary buildings' in the building properties. In this way, these buildings won't be taken into account in a Facade Noise Map calculation, the SoundPLAN spreadsheet filters out the results at auxiliary buildings of a City Noise Map calculation.

Working on an Annoyance Analysis in SoundPLAN

Check the document settings of the SoundPLAN spreadsheet at OPTIONS -> DOCUMENT SETTINGS -> NEW DOCUMENTS. For the exact realization of the EU Directive on Environmental Noise, load only the receiver with the highest level per building.

Load the results file and exclude unnecessary columns in the TABLE SETTINGS.

Call FILE -> LOAD RESULTS AND ADDITIONAL INFORMATION -> ADD COLUMNS WITH BUILDING INFORMATION, select a situation that includes the buildings and choose the information, that should be loaded.

Then create a new value column and interpret the information using formulas.

Example:
"Building area x number of floors" has been loaded in column 25. Assuming that all buildings are residential buildings and there is one inhabitant per 40 m² floor area, create a value column and enter the formula "x25/40;" to obtain the number of occupants per building.

If you want to determine the number of affected people over a $L_{den}$ of 65 dB(A), add another value column and calculate the affected inhabitants per building with the formula

IF "Column Lden" > 65
    THEN "column number of occupants per building"
ELSE 0;

to calculate the number of occupants per building.

Use TABLE -> TABLE STATISTICS to show the affected people for the whole area.

For the graphical result check and presentation the magnitude of the conflict should be mapped in the Graphics using a colored scale. Within the SoundPLAN spreadsheet create a new area table (FILE -> FILE TYPE -> AREA TABLE) with the
building blocks that were previously prepared in the Geo-Database. Select FILE -> NEW and load the Situation or Geo-File containing the building blocks as area usages. Then load the column with the affected occupants per building from the original SoundPLAN spreadsheet (which is a table referenced to a point list):

FILE -> LOAD RESULTS AND ADDITIONAL INFORMATION -> ADD POINT TABLE COLUMN and select the Spreadsheet and appropriate column.

Use the column operation to select how to insert the contents of the column in the area table:

Select if only values > 0 should be loaded.

In order to obtain a convincing statement of the annoyance, the affected people per building block must be standardized to a specific reference size (e.g., to affected people per km²).

Create another value column and enter the appropriate formula:

"Column affected people" / "Column size of the building block in m²" * 1000000;

Call the Graphics, load the situation and select the file type AREA MAP (CONFLICT MAP) in the file selection manager.

Select the column you want displayed. Additional selections are possible.

The result "affected people per km²" might appear as:
Index

2
2D-Directivity · 171
2-Dimensional Directivity · 137

3
3D directivity · 137
3D Wire Frame
GeoDB · 68
3D wire model · 66
3D-Graphics
Description · 308
graphics card · 1
Switch to 3D model · 310

A
Absorption Library · 170
Acceleration of Grid Noise Map calculations: · 201
Acoustical Schools ( ISO / Nordic / CONCAWE) · 422
Activate Elements · 275
Activate object · 95
Add an existing/new Geo-File · 74
Add result columns
Spreadsheet · 225
Add result table
Spreadsheet · 225
Additional Graphics Features
Cartography · 303
Air Absorption · 375
Air Pollution · see MISKAM
Air Traffic Calculator · 341
Aircraft Classes Library · 336
Aircraft Noise · 331
Calculation Core · 343

SoundPLAN Handbook

Documentation · 344
GeoDatabase · 343
Graphics · 345
Aircraft Noise in SoundPLAN 6
New features · 345
Aircraft Traffic Data · 338
Airport Definition · 332
Aligning elements · 278
Animation · 312
Annoyance Analysis · 452
Approach- and Departure Flight Paths · 334
ArcView export · 85
ArcView-Interface · 85
Area Usage
Assign to Buildings · 145
Aarial photography data · 90
ASCII-Interface · 86
Assessment Library · 175
Create · 176
Assign texts to buildings · 109
Assigning Sources to Buildings · 135
Assignment of Situations and Geo-Files in the run file · 186
Assignment of terrain elevations to Objects · 90
Attenuation Library · 170
Attribute operations · 100
Automatic Scaling · 297
Available Libraries and their File Names · 163

B
Batch calculation · 183
Bavarian Parking Lot Study · 126
Berms · 152
Bitmap
load · 79
Box Properties · See. Element Properties
Boxes
Base Settings · 264
Branching into SoundPLAN modules · 58
Break Lines · 150
Bridges · 447
Building information columns
Spreadsheet · 226
Building Properties · 143
additional settings for MISKAM · 362
Buildings · 143
Connecting Receivers · 158
Decisive Floor · 144
Buildings as Sources · 445
C

Calculate elevation for objects without elevation · 90
Calculating object height from a DGM · 109
Calculating Principles · 371
Calculation
  assignment of Situations and Geo-Files · 186
e error message object (GeoDB) · 102
Calculation area
  MISKAM · 359
Calculation Area · 161
Calculation enabled · 183
Calculation of Railway Traffic Noise · 416
Calculation of Road Traffic Noise (CoRTN) · 396
Calculation of the Emission Level of Parking Lots · 126
Calculation of the insertion loss
  Floating screens and bridges · 157
Calculation run properties · 182
Calculation run-info · 191
Calculation settings
  MISKAM · 364
Calculation settings for noise calculations · 195
Calculation types · 196
Calculations · 181
Capture coordinates · 78
Card/1-Interface · 88
Cartography - Creating user defined object types · 272
Change display options
  SP Manager · 48
Change Geo-File-assignment · 99
Changing the Viewport · 292
City Noise Map
  calculation parameters · 207
City Noise Map calculation · 206
Clear selection · 97
Clear selection · 97
Color Pallet · 262
Colored Scale · 294
Colored scale layout · 298
Colored scale types · 295
Column layout
  Spreadsheet · 235
Column Layout
  Diagrams · 214
Column optimization tools
  Spreadsheet · 229
Column setup (ResTab) · 211
Combination Tables (Master/Detail) · 210
Comments and Numeric Values
  Libraries · 167
Compute object height from DGM · 90
CONCAWE · 436
Connect lines · 106
Connecting Receivers to Buildings · 158
Contour line texts · 303
Convert object type · 99
Coordinate
  capture · 78
Coordinate functions · 99
Coordinate table · 66
Coordinate transformation · 108
Copy
  Library records · 167
  Project · 50
Copy and paste projects · 50
Copy calculation run · 186
Copy object · 102
Correct or recalculate a Grid Noise Map · 201
Correction Factors $k_{\Omega}$ · 136
CoRTN
  Emission Calculation · 123
Create
  Elements · 276
  New Assessment Record · 176
  North arrow · 276
  Scale Bar · 276
Create buffer · 105
Create intersections and split · 105
Create new project · 48
Cross section
  Entry · 160
Cross Section Maps
  Layout Settings · 267
  Cross Section Parameters · 294
  Cross Sections
    Road Profile · 118
  Cross-sectional Noise Map · 202
D

Data entry
  with bitmap basis · 80
Data Entry · 78
  Aircraft Noise · 332
  Data organization · 47
  Data structures in the GeoDB · 64
  Day Histogram Library · 174
  Deactivate facades · 110
Decisive Floor
  Buildings · 144
Default Standards and Run Commands · 190
Defining New Colors · 262
Definition of the LME According to Schall03 · 131
Delete
  point or object · 97
  project · 51
Index

Viewport (GeoDB) · 92
Design Spreadsheet tables · 235
DGM
  Use elevations · 88
Difference Maps · See File Operations
Digitizing
  from scanned maps · 78
Digitizing mode · 78
DIN 18005 · 391
Directivity · 380
Directivity Library · 171
Distance
  measure · 74
Distributed Computing · 191
  Settings · 52
Divide sections · 104
Documentation · 209
  Emission level road · 118
  Presentation of numerical values · 212
  Documentation of the emission level of railways · 130
DXF Export
  Geometry data · 84
DXF Import · 81

E

Edit
  library Records · 166
  object properties · 93
  Situation · 76
Edit data · 92
Edit mode · 92
Editing geometry data · 92
Element Properties · 277
Elements
  Activate · 275
  Create · 276
  Enlarge, Shrink, Move · 276
  Process · 275
Elevation dialog · 70
Elevation entry · 70
Elevation Lines · 148
Elevation stretch factor
  Projections GeoDB · 68
Elevations from a DGM · 88
Emission Calculation
  CoRTN · 123
  Parking Lots · 126
  RLS 90 · 120
Emission documentation
  Road · 118
  Emission Level Calculation Road · 120
  Emission Library · 170
  Additional Parameters · 170
  Enter Objects · 69
  Entry
    elevations · 114
    Entry of a new object · 114
    Error message object (Calc)
    Search object (GeoDB) · 102
  ESRI Shape file · 85
  Export
    ArcView · 85
    Geometry data as DXF · 84
    Result table · 220
  Extract
    project · 51

F

Facade Noise Map
  Layout Setting · 271
  Prepare buildings · 110
  Selection of Parameters · 284
  Façade Noise Map
    calculation parameters · 203
  Façade Noise Map calculation · 203
  Façade Noise Map Operations · 289
  Façade Noise Maps
    Active Facades · 145
  Federal Highway Model (FHWA · 405
    File number of the results · 187
  File Operations · 286
  File Selection Manager · 282
  Fill and Hatch Patterns
    Object Setup · 267
  Filter coordinates · 102
  Filter definition
    ASCII-Interface · 87
  Filter for new tables in the Spreadsheet · 226
  Filter value · 269
  Fixed Wing
    Flight Path Description · 335
  Flight Paths · 334
  Floating Screens · 156
  Format string and sort order
    Examples · 57
  Formula editor · 229
  Formula for Cell Layout · 234
  Frame Properties
    Plan · 291
  Front elevation · 66
  Functions of the SoundPLAN Manager · 47
G

Gallery · 448
General Prediction Method · 431
Generate and edit Situations and Geo-Files · 74
Generate areas · 106
Generate parallel object · 106
Generate Table Sheets according to AzB · 338
Geo-Database · 61
Structure · 63
Geo-File
  change assignment · 99
Geo-Files and Situations
  Structure · 63
Geometry bitmaps
  Print problems · 305
Geometry Parameter · 292
Geometry Texts · 161
GeoTools
  calculate object height from DGM · 109
  connect lines · 106
  coordinate transformation · 108
  generate areas · 106
  generate parallel object · 106
  prepare buildings · 110
GeoTools for (marked) selected line objects · 102
Graphical presentation in calculations · 193
Graphical user interface · 65
Graphics · 259
Graphics-Object type · 98
Grid Maps
  Layout Settings · 267
Grid Noise Map
  acceleration of calculation · 201
  calculation parameters · 199
  Interpolation during the calculation · 200
  recalculation · 201
  Selection of parameters · 283
Grid Noise Map calculation · 198
Grid Operations · 287
Ground absorption · 156
Ground areas · 156
Ground effect · 156
Ground Effect · 380
Group Reference
  Libraries · 168

H

Hardware requirements · 1
Hatch Types of Buildings for Plotter Graphics · 147
Headers and Footers · 218
Helicopters

I

Identical points
  move · 98
Import
  ArcView · 85
  DXF · 81
  SoundPLAN DOS (GeoDB) · 84
Import Libraries
  ASCII · 164
  Excel · 164
  SoundPLAN DOS · 164
Import of Aircraft Traffic Data · 339
Import of measurement data · 313
Indoor Factory Noise Module Calculation Method · 444
Indoor Noise · 141
Industrial building · 138
  Properties · 139
Industrial Building for Indoor Noise Calculations · 142
Industrial Noise Sources
  Definition in the Geo-Database · 133
Industry Noise · 422
Input and display of the object number · 55
Insert point · 97
Installation
  SoundPLAN · 1
  Update · 2
Installation and Service · 1
Interpolation
  constant segment size · 103
  Create a point in a defined distance · 104
  Grid Maps · 200
  n points per segments · 103
  Intersections with the terrain · 106
  Invert entry direction · 98
  Invert the selection · 96
  ISO 9613 · 428

K

km posts
  Railway · 129
  Road · 117
Index

K_{omega} · 381

L

Legend
  Graphics · 299
  ResTab · 214
  Length scale · 301
  Level charts · 285
  Level tables · 304
  Libraries · 163
    Edit records · 166
  License update · 2
  LIMA BNA-Interface · 86
  Load
    Bitmap · 79
  Logbook, Error messages and default settings · 188

M

Mark
  all objects · 95
  objects via line/ area · 96
  objects via the attributes · 96
  objects with an area <= [m²] · 97
  objects with elevation <= [m] · 97
  objects with length <= [m] · 97
  objects with the Alt + left mouse button · 95
  objects with the right mouse button · 95
  Measure distances · 74
  Measurement data · 313
  Minimizing costs
    Wall Design · 254
  MISKAM
    Air Pollution · 347
    Background Material · 348
    Calculation Core · 347
    Calculation settings · 364
    under SoundPLAN · 354
  MISKAM project flow under SoundPLAN · 359
  MISKAM Screening · see MISKAM
  MISKAM Sources · 362
  Mitigation Areas · 154
  Model Numerics · 354
  Modeling the Real World · 371
  Move point · 97
    create identical points · 98
  Moving Through a List of Coordinates · 116
  Multiple bitmaps · 80
  Multiple Screening · 435

N

New
  Situation · 76
  New installation of SoundPLAN · 2
  Nordic Rail Prediction Method · 419
  North Arrow · 301
    Create · 276
    number of reflections · 383

O

ÖAL 28 · 431
ÖAL 30 · 414
Object
  copy · 102
  delete · 97
  generate parallel object · 106
  search (GeoDB) · 102
  select · 95
  Object dots · 72
  Object height from DGM · 109
  Object Numbering · 54
  Object properties
    edit · 93
  Object Types · 265
  Object zoom · 91
  Objects · 113
    rotate · 108
  Objecte
    activate · 95
  On, Rn - Table · 337
  Options
    Process Plan · 265
  Options -> Settings · 52
  Overview Geo-Database · 62

P

Pack
  project · 51
  Page Format · 216
  Page Layout · 216, 217
  Parent - Child Relationship of elements · 275
  Parking Lots · 125
  Philosophy of Modeling · 389
  Photo Documentation · 111
  Physical Descriptors of Noise · 370
  Plan · 282
  Plan Properties · 290
  Plotting · 302

SoundPLAN Handbook
<table>
<thead>
<tr>
<th>Index</th>
<th>Page - 462</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Point</strong></td>
<td></td>
</tr>
<tr>
<td>delete · 97</td>
<td></td>
</tr>
<tr>
<td>Insert · 97</td>
<td></td>
</tr>
<tr>
<td>select · 95</td>
<td></td>
</tr>
<tr>
<td>Preparation of a noise control concept · 324</td>
<td></td>
</tr>
<tr>
<td>Prepare buildings · 110</td>
<td></td>
</tr>
<tr>
<td>Presentation of numerical Values in the Columns · 212</td>
<td></td>
</tr>
<tr>
<td>Print geometry bitmaps · 305</td>
<td></td>
</tr>
<tr>
<td>Print libraries · 180</td>
<td></td>
</tr>
<tr>
<td>Print Result table · 219</td>
<td></td>
</tr>
<tr>
<td>Printing (Graphics) · 302</td>
<td></td>
</tr>
<tr>
<td>Process Elements · 275</td>
<td></td>
</tr>
<tr>
<td>Process Plan</td>
<td></td>
</tr>
<tr>
<td>Options · 265</td>
<td></td>
</tr>
<tr>
<td>Process Plan Content · 292</td>
<td></td>
</tr>
<tr>
<td>Profile Lines · 148</td>
<td></td>
</tr>
<tr>
<td>Program Settings · 52</td>
<td></td>
</tr>
<tr>
<td>Project</td>
<td></td>
</tr>
<tr>
<td>copy and paste · 50</td>
<td></td>
</tr>
<tr>
<td>delete · 51</td>
<td></td>
</tr>
<tr>
<td>rename · 51</td>
<td></td>
</tr>
<tr>
<td>Project Settings</td>
<td></td>
</tr>
<tr>
<td>Global and Current Project · 54</td>
<td></td>
</tr>
<tr>
<td>Project-Info · 48</td>
<td></td>
</tr>
<tr>
<td><strong>R</strong></td>
<td></td>
</tr>
<tr>
<td>Railway bridges · 130</td>
<td></td>
</tr>
<tr>
<td>Railway emission documentation · 130</td>
<td></td>
</tr>
<tr>
<td>Railway Noise · 409</td>
<td></td>
</tr>
<tr>
<td>Railway Properties · 129</td>
<td></td>
</tr>
<tr>
<td>Railways</td>
<td></td>
</tr>
<tr>
<td>Definition · 128</td>
<td></td>
</tr>
<tr>
<td>Terrain Elevation · 128</td>
<td></td>
</tr>
<tr>
<td>Rearranging Columns (ResTab · 212</td>
<td></td>
</tr>
<tr>
<td>Reassign receivers to buildings · 109</td>
<td></td>
</tr>
<tr>
<td>Receivers in Front of the Building and in the free Field · 160</td>
<td></td>
</tr>
<tr>
<td>Reconstruct calculation run from the result file · 188</td>
<td></td>
</tr>
<tr>
<td>Reference axis</td>
<td></td>
</tr>
<tr>
<td>Road properties · 118, 130</td>
<td></td>
</tr>
<tr>
<td>Reference points</td>
<td></td>
</tr>
<tr>
<td>Bitmap · 79</td>
<td></td>
</tr>
<tr>
<td>Reference road or railroad</td>
<td></td>
</tr>
<tr>
<td>Spreadsheet · 225</td>
<td></td>
</tr>
<tr>
<td>Reference Scale · 267</td>
<td></td>
</tr>
<tr>
<td>Reflection · 382</td>
<td></td>
</tr>
<tr>
<td>Reflection depth · 383</td>
<td></td>
</tr>
<tr>
<td>Reflection Loss</td>
<td></td>
</tr>
<tr>
<td>Buildings · 146</td>
<td></td>
</tr>
<tr>
<td>Walls · 151</td>
<td></td>
</tr>
<tr>
<td>Reflections</td>
<td></td>
</tr>
<tr>
<td>Number of · 383</td>
<td></td>
</tr>
<tr>
<td>Regenerate new object numbers · 111</td>
<td></td>
</tr>
<tr>
<td>Relative Elevation · 115</td>
<td></td>
</tr>
<tr>
<td>Relative elevations · 70</td>
<td></td>
</tr>
<tr>
<td>Rename</td>
<td></td>
</tr>
<tr>
<td>Project · 51</td>
<td></td>
</tr>
<tr>
<td>Rename or delete a viewport · 92</td>
<td></td>
</tr>
<tr>
<td>Restrictions when working with bitmaps · 81</td>
<td></td>
</tr>
<tr>
<td>Result Object Types · 267</td>
<td></td>
</tr>
<tr>
<td>Result table</td>
<td></td>
</tr>
<tr>
<td>Export · 220</td>
<td></td>
</tr>
<tr>
<td>Result Tables · 209</td>
<td></td>
</tr>
<tr>
<td>New features in SoundPLAN 6 · 220</td>
<td></td>
</tr>
<tr>
<td>Right Angle Calculation</td>
<td></td>
</tr>
<tr>
<td>Buildings · 146</td>
<td></td>
</tr>
<tr>
<td>Right angle mode · 71</td>
<td></td>
</tr>
<tr>
<td>RLS 90 · 391</td>
<td></td>
</tr>
<tr>
<td>Emission Calculation · 120</td>
<td></td>
</tr>
<tr>
<td>Rounding (Facade Noise Map) · 271</td>
<td></td>
</tr>
<tr>
<td>Road Alignments</td>
<td></td>
</tr>
<tr>
<td>Definition in the Geo-Database · 117</td>
<td></td>
</tr>
<tr>
<td>Road bridges · 119</td>
<td></td>
</tr>
<tr>
<td>Road Noise · 389</td>
<td></td>
</tr>
<tr>
<td>Road Profiles · 118</td>
<td></td>
</tr>
<tr>
<td>Road Properties · 117</td>
<td></td>
</tr>
<tr>
<td>Additional settings for MISKAM · 362</td>
<td></td>
</tr>
<tr>
<td>Roads</td>
<td></td>
</tr>
<tr>
<td>Terrain elevation · 117</td>
<td></td>
</tr>
<tr>
<td>Rotate</td>
<td></td>
</tr>
<tr>
<td>Geodatabase · 68</td>
<td></td>
</tr>
<tr>
<td>Rotate objects · 108</td>
<td></td>
</tr>
<tr>
<td>Rounding</td>
<td></td>
</tr>
<tr>
<td>Spreadsheet · 236</td>
<td></td>
</tr>
<tr>
<td>Run file</td>
<td></td>
</tr>
<tr>
<td>assignment of Situations and Geo-Files · 186</td>
<td></td>
</tr>
<tr>
<td>Run file and calculations · 181</td>
<td></td>
</tr>
<tr>
<td>Run Settings · 189</td>
<td></td>
</tr>
<tr>
<td>Runaways for Start and Landing · 333</td>
<td></td>
</tr>
<tr>
<td><strong>S</strong></td>
<td></td>
</tr>
<tr>
<td>Scale · See Colored scale</td>
<td></td>
</tr>
<tr>
<td>Scale Bar · 301</td>
<td></td>
</tr>
<tr>
<td>Create · 276</td>
<td></td>
</tr>
<tr>
<td>Scale of y-axis</td>
<td></td>
</tr>
<tr>
<td>Libraries · 169</td>
<td></td>
</tr>
<tr>
<td>Schall 03 / DIN 18005 / Transrapid · 410</td>
<td></td>
</tr>
<tr>
<td>Screening · 376</td>
<td></td>
</tr>
<tr>
<td>Search Angle Method · 385</td>
<td></td>
</tr>
<tr>
<td>Search for an object known by it's ID number · 102</td>
<td></td>
</tr>
<tr>
<td>Search object (GeoDB) · 102</td>
<td></td>
</tr>
<tr>
<td>Section layout · 300</td>
<td></td>
</tr>
<tr>
<td>Spreadsheet · 240</td>
<td></td>
</tr>
</tbody>
</table>
Select
  all · 95
  objects via line/area · 96
  objects via the attributes · 96
  objects with an area <= [m²] · 97
  objects with elevation <= [m] · 97
  objects with length <= [m] · 97
  objects with the Alt + left mouse button · 95
  objects with the right mouse button · 95
Select an existing project · 49
Select points or objects · 95
Settings for 3D · 274
Settings for Cross Sections · 273
Settings for Distributed Computing · 52
Settings for Site Maps · 273
Sheet · 280
  Base Settings · 263
  Sheet Size Settings For HP DesignJet With Roll Medium · 303
Side Diffraction · 378
Side projection · 66
Signal-Intersection Addition · 124
Single calculation · 183
Single point calculations · 196
Single Point Receivers · 157
Situation
  edit · 76
  new · 76
Situation Manager · 74
Smooth elevations · 104
SoundPLAN-Manager · 47, 48
Source Emission · 372
Source Properties · 133
Sources
  Industrial Noise Sources · 133
  Railways · 128
  Road Alignments · 117
Special Noise Calculation Cases · 445
Split objects · 98
Spot Heights · 147
Spreading · 372
Spreading / Komega / Ground Effect Industry Noise · 423
Spreadsheet · 221
  Getting started · 222
  Spreadsheet in Graphics · 307
Standard deviation
  initialize Bitmap · 79
Start or terminate a calculation run · 190
Starting the optimization
  Wall Design · 249, 252
Statens Planverk · 48, 401
Stationing
  Railway · 129
Road · 117
Statistics
  Calculation · 191
  Store Viewport (GeoDB) · 91
  Storing designed wall · 255
  Stratis-Interface · 88
  Structure of a formula · 230
  Structure of the Geo-Database · 63
  Structured table
    Spreadsheet · 240
  Supply of Elevation Information · 148
  Symbol Bar of SoundPLAN Objects · 113
  System Settings · 53
T
  Table Settings
    Result tables · 214
  Table Setup
    Spreadsheet · 228
  Table statistics · 242
  Technical Acoustics in SoundPLAN · 369
  Terminate or start a calculation run · 190
  Terrain edges · 150
  Terrain elevation
    Roads · 117
  Terrain Elevation
    Railways · 128
  Terrain Points · 147
  Text attributes in the Graphics · 306
  Text Boxes · 300
  Texts
    Geometry Texts · 161
    The Coordinate System · 116
    The Road Day Histogram Library · 177
    Top View, Side Projection and 3D-Wire Model · 66
    Transmission Library · 170
    Triangle Map Operations · 289
    Tunnel · 446
    Tutorial · 5
U
  Undo
    GeoDB · 94
  Update
    Installation · 2
    Update results · 235
  Upgrading SoundPLAN · 2
  Using a DGM for the calculation · 196
  Using Wall Design · 248
Index

V

VDI 2714 / 2720 · 428
VDI 3760E · 439
View filters for Geo-Files · 76
Viewport (GeoDB)
  delete · 92
  rename · 92
  store · 91
Volume Type Absorption · 154, 383

W

Wall Design · 243
  Internal organization · 244
  Model restrictions · 256
  Performance · 247
  Tasks in the Calculation · 249
  Tasks in the Geo-Database · 248
Walls · 150
Weather statistics
  MISKAM · 354
Wind roses
  MISKAM · 354
Working with Elements · 274
Working with the Geo-Database · 61

Z

Z,V,H - Table · 337
Zoom mode · 91
Zoom Plan · 274
Zoom Plan (Graphics) · 274